
Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

В этом руководстве описываются настройка и использование камеры Interchangeable Lens Digital Camera  ILME-
FR7 / ILME-FR7K.

По мере необходимости пользуйтесь настоящим руководством и инструкциями по эксплуатации связанных
устройств.

Обзор

Типичные способы применения

Конфигурация системы

Управление одним устройством с помощью инфракрасного пульта управления из комплекта поставки

Управление одним устройством с помощью планшета или компьютера

Управление одним устройством с помощью внешнего пульта управления

Управление несколькими устройствами с помощью внешнего пульта управления

Расположение и назначение компонентов

Вид спереди

Вид сзади

Блок разъемов

Вид сбоку

Вид сверху

Вид снизу

Опора объектива

Расположение и назначение элементов инфракрасного пульта управления (входит в комплект
поставки)

Экран веб-приложения

Обзор экрана веб-приложения

Структура общей области экранов

Структура операционного экрана

Структура экрана воспроизведения
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Подготовка к эксплуатации

Структура экрана настроек

Меню камеры

Индикация на экране камеры

Установка устройства

Вертикальная установка в фиксированном месте

Вертикальная установка в фиксированном месте на большой высоте

Установка на потолке

Присоединение и снятие объектива

Меры предосторожности при установке и снятии объектива

Проверка переключателей объектива

Меры предосторожности при использовании объективов с масштабированием

Присоединение объектива

Снятие объектива

Подключение кабелей

Подключение данного устройства к сетевому устройству по проводному подключению

Подключение источника питания

Использование электропитания переменного тока

Использование питания PoE++

Сброс поворота/наклона

Настройка перед съемкой

Инициализация устройства с помощью веб-приложения

Доступ к веб-приложению из веб-браузера

Инициализация устройства

Настройка основных операций

Подготовка карт памяти

Поддерживаемые карты памяти

Установка карт памяти
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Съемка

Извлечение карты памяти

Форматирование (инициализация) карт памяти

Проверка оставшегося времени записи

Восстановление карт памяти

Основные операции

Запуск/остановка записи

Переключение между картами памяти

Проверка звука

Указание данных времени

Перемотка записи назад (Rec Review)

Настройка кадрирования

Экран настройки кадрирования

Настройка направления съемки

Настройка направления съемки с помощью веб-приложения

Задание скорости работы поворота/наклона

Задание ускорения при повороте/наклоне

Настройка направления съемки с помощью инфракрасного пульта управления из комплекта поставки

Регулировка масштаба

Установка типа масштабирования

Настройка масштабирования с помощью веб-приложения

Задание скорости работы масштабирования

Настройка масштабирования с помощью инфракрасного пульта управления из комплекта поставки

Сохранение и восстановление положения поворота/наклона/масштаба камеры (предварительно заданного
положения)

Калибровка объектива с байонетом E

Сохранение и восстановление поворота/наклона, положения масштабирования и настройки фокусировки с помощью веб-
приложения

Переименование предварительно заданных положений с помощью веб-приложения

Замена сохраненного предварительно заданного положения новым положением с помощью веб-приложения
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Удаление сохраненного предварительно заданного положения с помощью веб-приложения

Синхронизация поворота/наклона и масштабирования/фокусировки при восстановлении предварительно заданного
положения

Изменение скорости перехода (поворот/наклон/масштаб/фокус) при восстановлении предварительно заданного положения

Сохранение и восстановление поворота/наклона и положения масштабирования с помощью инфракрасного пульта
управления из комплекта поставки

Запись/воспроизведение операций кадрирования камеры (PTZ Trace, сохранение настроек поворота/
наклона/масштаба)

Запись операций кадрирования камеры с помощью веб-приложения

Воспроизведение операций кадрирования камеры с помощью веб-приложения

Удаление записанных операций кадрирования камеры с помощью веб-приложения

Запись операций кадрирования камеры с помощью инфракрасного пульта управления из комплекта поставки

Воспроизведение операций кадрирования камеры с помощью инфракрасного пульта управления из комплекта поставки

Настройка фокусировки

Экран настройки фокусировки

Регулировка фокусировки вручную (Manual Focus)

Настройка вручную с помощью веб-приложения

Настройка вручную с помощью инфракрасного пульта управления из комплекта поставки

Фокусировка путем указания места фокусировки (Spot Focus)

Временное использование автоматической фокусировки (Push Auto Focus (AF))

Использование покадровой автоматической фокусировки (Push Auto Focus (AF-S))

Автоматическая регулировка фокусировки (Auto Focus)

Автоматическая настройка с помощью веб-приложения

Автоматическая настройка с помощью инфракрасного пульта управления из комплекта поставки

Задание области/положения автоматической фокусировки (Focus Area)

Быстрое изменение области фокусировки (Focus Setting)

Перемещение рамки области фокусировки с помощью сенсорных операций (область сенсорной фокусировки)

Настройка работы автоматической фокусировки (скорость изменения AF, чувствительность к смене объекта AF)

Настройка целевой области фокусировки вручную (AF Assist) с помощью веб-приложения

Ручная фокусировка во время автоматической фокусировки с помощью инфракрасного пульта управления из комплекта
поставки

Временное использование ручной фокусировки во время автоматической фокусировки (Push Manual Focus)
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Отслеживание с использованием обнаружения лиц и глаз (Face/Eye Detection AF)

Отслеживание указанного объекта (Realtime Tracking AF)

Регулировка яркости

Экран настройки яркости

Задание базовой чувствительности

Задание целевого уровня для автоматической регулировки яркости

Регулировка диафрагмы

Автоматическая регулировка диафрагмы

Регулировка диафрагмы вручную

Регулировка усиления

Автоматическая регулировка усиления

Регулировка усиления вручную

Регулировка выдержки

Автоматическая регулировка выдержки

Регулировка выдержки вручную

Регулировка уровня освещенности (фильтр ND)

Сведения о фильтре нейтральной плотности

Настройка в предустановленном режиме

Автоматическая настройка в переменном режиме

Настройка вручную в переменном режиме

Обеспечение естественных цветов (баланс белого)

Экран настройки баланса белого

Автоматическая регулировка баланса белого

Регулировка баланса белого вручную

Выполнение автоматической регулировки баланса белого

Настройка записываемого звука

Экран настройки звука

Выбор устройства, подающего входной аудиосигнал

Автоматическая регулировка уровня записи звука
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Полезные функции

Регулировка уровня записи звука вручную

Использование прямого меню

Программируемые кнопки

Съемка с замедлением/ускорением движения

Запись видео с промежутками (Interval Rec)

Запись кэшированных изображений (Picture Cache Rec)

Одновременная запись на карты памяти A и B (2-slot Simul Rec)

Монитор видеосигнала

Флаги клипов

Компенсация дыхания

Запись прокси

Обзор записи прокси

Запись прокси

Съемка с требуемым видом

Обзор видов

Выбор вида

Импорт требуемого базового вида

Настройка вида

Сохранение вида

Удаление базового вида

Съемка с последующей регулировкой вида в студии

Съемка с последующей регулировкой вида в студии

Применение таблицы LUT к выходу HDMI и потоковой передаче

Изменение таблицы соответствия LUT

Изменение распределения темных и ярких областей на записанном изображении

Запись RAW

Запись видео в формате RAW
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Сетевые функции

Экран эскизов

Запись видео в формате RAW в режиме с замедлением/ускорением движения

Регулировка боке (функция Bokeh Control)

Включение и выключение функции управления эффектом боке

Регулировка степени эффекта боке

Сохранение и загрузка данных конфигурации

Обзор сохранения и загрузки данных конфигурации

Сохранение файла ALL

Загрузка файла ALL

Передача файлов

О передаче файлов

Регистрация места назначения передачи файлов

Выбор файла и его отправка

Отправка файла прокси на карте памяти с экрана эскизов

Отправка оригинального файла на карте памяти с экрана эскизов

Проверка состояния передачи файлов

Отправка с использованием протокола Secure FTP

Настройка потоковой передачи

О потоковой передаче

Задание формата потоковой передачи

Задание видеокодека для потоковой передачи

Задание аудиокодека для потоковой передачи

Запуск/остановка потоковой передачи

Экран эскизов

Воспроизведение клипов и другие операции с ними

Воспроизведение записанных клипов

Операции с записанными клипами
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Меню камеры и подробные настройки

Конфигурация меню камеры

Использование меню камеры

Использование меню камеры

Ввод строки символов

Меню User

User

Меню Edit User

Edit User

Меню Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Меню Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set
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Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Меню Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Меню Pan-Tilt

P/T Acceleration

Меню TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Меню Monitoring

Output Format
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Display On/Off

Video Signal Monitor

Marker

Меню Audio

Audio Input

Audio Output

Меню Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Меню Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Меню Network

Wired LAN

File Transfer

Меню Maintenance

Language
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Веб-меню и подробные настройки

Clock Set

Hours Meter

Настройки и значения по умолчанию меню Shooting

Настройки и значения по умолчанию для ISO/Gain

Настройки и значения по умолчанию для AGC Limit

Настройки качества изображения, сохраненные для каждого режима съемки

Конфигурация веб-меню

Использование веб-меню

Меню Shooting

Focus

Меню Project

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Меню Paint/Look

Base Look

Меню Pan-Tilt

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Меню Monitoring

11



Output Format

Output Display

Меню Audio

Audio Input

Audio Output

Меню Technical

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Меню Network

Camera Name

User

Wired LAN

File Transfer

FTP Server 1–3

SSL

Referer Check

Brute Force Attack Protection

Меню Stream

Stream

Video Stream

Audio Stream

Меню Maintenance

Language

Accessibility

Clock Set
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Подключение внешних устройств

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software

Подключение внешних мониторов и устройств записи

Подключение RCP/MSU (приобретается дополнительно)

Подключение к RCP/MSU

Прямое подключение между устройством и RCP

Использование устройства в среде нескольких камер с MSU/программным обеспечением для
дистанционного управления камерами

Список поддерживаемых функций

Управление с помощью пульта дистанционного управления RM-IP500 (приобретается
дополнительно)

Об управлении с помощью пульта дистанционного управления RM-IP500 (приобретается дополнительно)

Подключение пульта дистанционного управления RM-IP500

Синхронизация с внешним устройством

О синхронизации с внешними устройствами

Синхронизация фазы видеосигнала (Genlock)

Привязка временного кода к другим устройствам

Подключение внешнего микрофона или внешнего аудиоустройства

Монтаж клипов и управление ими на компьютере

Вывод оптоволоконного сигнала

Подключение сигнала съемки

Вывод данных отслеживания (free-d)

Подключение контроллера объектива
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Приложение

5-041-958-03(1) Copyright 2022 Sony Corporation

Регулировка масштаба с помощью контроллера объектива

Предупреждения

Форматы и ограничения для выходов

Устранение неисправностей

Предупреждения относительно эксплуатации

Список пунктов меню

Сохраняемые пункты предварительно заданных положений

Блок-схемы

Обновление программного обеспечения объектива с байонетом E

Установка крышки кнопки отсоединения объектива

Лицензии

Технические характеристики

Товарные знаки

14



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Конфигурация системы

Данное устройство в сочетании с периферийными устройствами позволяет создавать различные конфигурации
системы.

Объектив с байонетом E1.

Адаптер байонета A LA-EA3 / LA-EA42.

Инфракрасный пульт управления (входит в комплект поставки)3.

Карты памяти CFexpress Type A / карты памяти SDXC4.

Устройство чтения карт CFexpress Type A / устройство чтения карт SD5.

Микрофон ECM-680S, ECM-678*, ECM-674*6.
Требуется переходной XLR-кабель EC-0.5X3F5M (3-контактный → 5-контактный).*

Адаптер переменного тока (входит в комплект поставки)7.

Видеомонитор8.

Пульт дистанционного управления RM-IP5009.
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5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Управление одним устройством с помощью инфракрасного пульта управления
из комплекта поставки

Одним устройством можно дистанционно управлять с помощью инфракрасного пульта управления из комплекта
поставки.

 Видеосигнал
 Направление передачи сигналов

5-041-958-03(1) Copyright 2022 Sony Corporation

Инфракрасный пульт управления (входит в комплект поставки)1.

Видеомонитор2.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Управление одним устройством с помощью планшета или компьютера

К устройству можно подключить планшет или компьютер и управлять устройством с помощью веб-браузера.

 Видеосигнал
 Сигнал дистанционного управления

  Направление передачи сигналов

5-041-958-03(1) Copyright 2022 Sony Corporation

Видеомонитор1.

Планшет2.

Компьютер3.

Точка доступа4.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Управление одним устройством с помощью внешнего пульта управления

Одним устройством можно дистанционно управлять с помощью пульта дистанционного управления.

 Видеосигнал
 Сигнал дистанционного управления

  Направление передачи сигналов

5-041-958-03(1) Copyright 2022 Sony Corporation

Видеомонитор1.

Пульт дистанционного управления RM-IP5002.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Управление несколькими устройствами с помощью внешнего пульта управления

С помощью одного пульта дистанционного управления можно управлять несколькими устройствами (до 100).

 Видеосигнал
 Сигнал дистанционного управления
 Сигнал индикатора записи/контакта

  Направление передачи сигналов

5-041-958-03(1) Copyright 2022 Sony Corporation

Видеомонитор1.

Коммутатор видеосигналов2.

Коммутатор Ethernet3.

Пульт дистанционного управления RM-IP5004.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Вид спереди

В этом разделе рассматриваются расположение и назначение компонентов на передней панели устройства.

Совет

В описании используется изображение устройства без установленного объектива.

Головка камеры

Примечание

Не допускайте сильных ударов по головке камеры.

1.

Индикатор записи/съемки
Если настроен как индикатор записи, загорается красным цветом при записи на карту памяти. Этот индикатор
мигает, если на носителе для записи осталось мало свободного места или если произошла ошибка.

2.
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Подробнее см. в разделе “Предупреждения относительно эксплуатации”.

Если настроен как индикатор съемки, загорается красным или зеленым цветом в зависимости от внешнего
сигнала съемки.

Подробнее см. в разделе “Подключение сигнала съемки”.
Датчик изображения

Примечание

Не дотрагивайтесь голыми руками.

3.

Кнопка отсоединения объектива
Нажмите, чтобы снять объектив.

Подробнее см. в разделе “Снятие объектива”.

4.

Контакты сигналов объектива

Примечание

Не дотрагивайтесь голыми руками.

5.

Индикаторы POWER6.

Индикаторы NETWORK
Статус устройства обозначается с помощью сочетания цвета и состояния (горит, мигает, не горит) индикаторов
POWER и NETWORK.

7.

Индикаторы
POWER

Индикаторы
NETWORK Статус устройства

Горит
зеленым*1

Горит зеленым Питание включено (сеть подключена)

Не горит Питание включено (сеть не подключена)

Мигает
зеленым

Не горит Питание включено, процесс выполняется

Горит
оранжевым

Не горит Режим ожидания электропитания

Мигает желтым Не горит Выполняется обновление программного обеспечения

Редко мигает
оранжевым*2

Редко мигает
зеленым*2

Устройство не может нормально работать. Подробнее см. в системном
журнале. Если проблема сохраняется даже после перевода устройства
в режим ожидания или выключения питания и его повторного
включения, обратитесь в службу технического обслуживания Sony.

Часто мигает
оранжевым*3

Часто мигает
зеленым*3

В устройстве возникла неполадка. Обратитесь в службу технического
обслуживания Sony.

Мигает зеленым при получении команды от входящего в комплект поставки инфракрасного пульта дистанционного управления.*1

Редко мигает: мигает один раз в секунду*2

Часто мигает: мигает четыре раза в секунду*3

Инфракрасный датчик дистанционного управления8.
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См. также
Предупреждения относительно эксплуатации

Подключение сигнала съемки

Снятие объектива

5-041-958-03(1) Copyright 2022 Sony Corporation

Служит для приема сигнала управления от инфракрасного датчика дистанционного управления из комплекта
поставки.
Впускное вентиляционное отверстие

Примечание

Не закрывайте поток воздуха. Это приведет к повреждению устройства.

9.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Вид сзади

В этом разделе рассматриваются расположение и назначение компонентов на задней панели устройства.

См. также

Вид сбоку

5-041-958-03(1) Copyright 2022 Sony Corporation

Рычаг блокировки головки камеры
Блокирует перемещение головки камеры вперед/назад.

Примечание

Всегда блокируйте головку камеры за исключением случаев, когда необходимо сменить объектив.

При транспортировке устройства всегда снимайте объектив и блокируйте головку камеры.

Чтобы не прищемить пальцы, перед использованием этого рычага блокировки выключите питание устройства и
заблокируйте головку камеры горизонтально с помощью рычага блокировки поворота/наклона. Подробнее о рычаге
блокировки поворота/наклона см. в пункте “Рычаг блокировки поворота/наклона” раздела “Вид сбоку”.

1.

Основание с направляющими2.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Блок разъемов

В этом разделе рассматриваются расположение и назначение компонентов на блоке разъемов устройства.

Подключение  (заземление)
Служит для заземления путем подключения к линии заземления розетки электрической сети или к шине
заземления.

1.

Разъем DC-IN (стандартный разъем постоянного тока)
Подключается к сетевому блоку питания.

Примечание

Запрещается использовать любые другие сетевые блоки питания, кроме блока из комплекта поставки. Подключение
другого блока питания может привести к возгоранию или неполадкам в работе.

2.

Разъем  LAN (сеть) (RJ-45)
Служит для подключения сетевого кабеля (категории не ниже 5e) для передачи данных по сети и подачи
питания PoE++*.

Состояние индикатора скорости связи
Показывает скорость сетевого подключения.

3.

PoE++: технология питания по сетевому кабелю Power over Ethernet Plus Plus. Соответствует стандарту IEEE802.3bt (тип 4, класс 8).
Сведения о подключении см. в инструкции по эксплуатации устройства питания.

*
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Состояние индикатора Link/ACT
Показывает состояние сетевого подключения.

Примечание

При подключении этого изделия к Интернету выполняйте подключение через систему, которая обеспечивает функцию
защиты, такую как маршрутизатор или брандмауэр. При подключении без такой защиты могут возникнуть проблемы с
безопасностью.

Отображение Скорость подключения

Не горит
10 Мбит/с

100 Мбит/с

Горит оранжевым 1000 Мбит/с

Отображение Состояние подключения

 Не горит Нет подключения

Мигает зеленым Подключение установлено, данные активны

Горит зеленым Активное подключение

Разъем TC IN
Вход для внешнего опорного сигнала временного кода.

Подробнее см. в разделе “Привязка временного кода к другим устройствам”.

4.

Разъем HDMI
Служит для вывода видео с данного устройства в виде сигнала HDMI.

Подробные сведения см. в пункте “Разъем HDMI (разъем типа A)” в разделе “Подключение внешних
мониторов и устройств записи”.

5.

Крепежный винт для пластины крепления кабеля HDMI
Чтобы исключить отсоединение кабеля HDMI, закрепите входящую в комплект поставки пластину крепления
кабеля HDMI с помощью прилагаемого крепежного винта (M2.6×6) и закрепите кабель HDMI с помощью
кабельной стяжки или хомута из числа имеющихся в продаже.

Сведения об установке пластины крепления кабеля HDMI см. в разделе “Подключение кабелей”.

6.

Разъем OPTION
Служит для подключения сигнала съемки от внешнего устройства или контроллера объектива.

Подробнее см. в разделах “Подключение сигнала съемки” и “Подключение контроллера объектива”.

7.

Зажим для кабеля питания
Служит для крепления кабеля питания переменного тока.

8.

Переключатель RESET
Нажмите и удерживайте не менее 5 секунд с помощью кончика шариковой ручки или аналогичного предмета,
чтобы сбросить настройки устройства и восстановить заводские значения по умолчанию.
С помощью переключателя SETUP 1 можно выбрать сброс только настроек сетевого подключения или сброс
всех настроек.

9.

Выходной разъем OPTICAL10.
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Служит для вывода преобразованного в оптический формат сигнала SDI, если подключен модуль SFP+
(приобретается дополнительно).

Подробнее см. в разделе “Вывод оптоволоконного сигнала”.
Переключатели SETUP

Задает следующие параметры.
Переключатель 1: задает настройки, которые сбрасываются при нажатии переключателя RESET.

Переключатель 2: задает, будет ли включено или выключено питание +48 В (фантомное питание) при
подключении устройства ввода звука. Настройка применяется немедленно.
Эта функция включена, когда в меню камеры для параметра [Audio] > [Audio Input] > [AUDIO IN Select] задано
значение [MIC].

Примечание

Если установить переключатель 2 в положение ON и подключить микрофон, который несовместим с источником
питания +48 В, это может привести к повреждению подключенного устройства. Проверьте настройку перед
подключением устройства.

Переключатель 3: включение/отключение связи по протоколу VISCA over IP. Эти настройки применяются при
включении камеры.
Установите в положение ON для использования устройства, когда оно подключено к пульту дистанционного
управления (RM-IP500).

Примечание

11.

Настройка Описание

OFF (по
умолчанию)

Сбрасываются только настройки сетевого подключения. Будут сброшены сетевые
настройки, настройки безопасности и информация о пользователе (имя пользователя и
пароль) устройства.

ON Сброс всех настроек на заводские значения по умолчанию.

Настройка Описание

OFF (по
умолчанию)

Не подавать питание +48 В (фантомное питание). Задавайте эту настройку при
использовании внешнего аудиоустройства (например, микшера), динамического
микрофона или микрофона со встроенным аккумулятором.

ON
Подавать питание +48 В (фантомное питание) на поддерживающий фантомное питание
микрофон, подключенный к разъему AUDIO IN (CH-1 или CH-2).

Настройка Описание

OFF (по умолчанию) Не будет реагировать на команды протокола VISCA over IP.

ON Принимает команды протокола VISCA over IP.
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См. также

Привязка временного кода к другим устройствам

Подключение внешних мониторов и устройств записи

Подключение кабелей

Подключение сигнала съемки

Подключение контроллера объектива

Вывод оптоволоконного сигнала

Инициализация устройства

Синхронизация фазы видеосигнала (Genlock)

Подключение внешнего микрофона или внешнего аудиоустройства

Если пароль администратора не задан, связь по протоколу VISCA over IP отключена независимо от положения этого
переключателя. Сведения о задании пароля администратора см. в разделе “Инициализация устройства”.

Переключатель 4: изменение скорости операций поворота/наклона, отправляемых с инфракрасного пульта
управления. Настройка применяется немедленно.

Настройка Описание

OFF (по умолчанию) Работа на обычной скорости.

ON Работа на максимальный скорости.

Разъем SDI OUT
Служит для вывода видео с данного устройства в виде сигнала 12G/6G/3G/HD-SDI.
Устройство можно также настроить для вывода сигнала RAW.

Подробнее см. в пункте “Разъем SDI OUT (типа BNC)” в разделе “Подключение внешних мониторов и
устройств записи”.

12.

 Инфракрасный датчик дистанционного управления (задний)
Инфракрасный датчик для инфракрасного пульта управления, входящего в комплект поставки.

13.

Вентиляционное отверстие вентилятора
Служит для отвода тепла из устройства.

Примечание

Не закрывайте выпускное вентиляционное отверстие. Это приведет к повреждению устройства.

Обратите внимание, что область рядом с вентиляционным отверстием может быть горячей.

14.

Разъем GENLOCK
Служит для подачи внешнего сигнала синхронизации.

Подробнее о внешней синхронизации см. в разделе “Синхронизация фазы видеосигнала (Genlock)”.

15.

Разъем AUDIO IN (5-контактный разъем типа XLR)
Служит для подачи сигнала с внешнего микрофона или аудиоустройства.
Работает как разъем AUDIO IN CH-1 или как разъем AUDIO IN CH-2.

Подробнее см. в разделе “Подключение внешнего микрофона или внешнего аудиоустройства”.

16.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Вид сбоку

В этом разделе рассматриваются расположение и назначение компонентов на боковой панели устройства.

Совет

В описании используется изображение устройства без установленного объектива.

Рычаг блокировки поворота/наклона
Блокирует механизм поворота/наклона устройства. Используйте в следующих случаях.

При транспортировке или упаковке устройства.
При установке или снятии объектива. Подробнее см. в разделе “Присоединение объектива” или “Снятие
объектива”.
При использовании объектива, который не поддерживает поворот/наклон (например, объективы Sony
SEL100400GM / SEL200600G / SEL400F28GM / SEL600F40GM).
При транспортировке устройства всегда снимайте объектив и блокируйте головку камеры.

1.
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См. также

Присоединение объектива

Снятие объектива

Установка карт памяти

Доступ к веб-приложению из веб-браузера

5-041-958-03(1) Copyright 2022 Sony Corporation

Совет

Положение поворота/наклона может быть зафиксировано с указанными ниже углами.

Основание с направляющими2.

Отверстия для винтов для внешних устройств (4 места)
Для винтов M3 длиной не более 6 мм.

Примечание

Не используйте винты длиннее 6 мм. Это приведет к повреждению устройства.

3.

Индикатор доступа A4.

Индикатор доступа B
Индикатор горит или мигает при установленном носителе для записи.

Подробнее см. в разделе “Установка карт памяти”.

5.

Гнездо карты CFexpress Type A / SD-карты (A)6.

Гнездо карты CFexpress Type A / SD-карты (B)
Служат для установки носителя для записи.

Подробнее см. в разделе “Установка карт памяти”.

7.

QR-код для подключения к сети
Используйте при задании начальных настроек.

Подробнее см. в разделе “Доступ к веб-приложению из веб-браузера”.

8.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Вид сверху

В этом разделе рассматриваются расположение и назначение компонентов на верхней панели устройства.

Совет

В описании используется изображение устройства без установленного объектива.

5-041-958-03(1) Copyright 2022 Sony Corporation

Отверстия для винтов для внешних устройств (2 места)
Совместимы с винтами 1/4-20 UNC для штатива.
Максимальная длина 6 мм.

1.

ɸ (метка датчика изображения)
Метка датчика изображения находится в одной плоскости со светочувствительной матрицей изображения.
Используйте эту метку датчика изображения в качестве опорной точки для точного измерения расстояния
между устройством и объектом съемки.

2.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Вид снизу

В этом разделе рассматриваются расположение и назначение компонентов на нижней панели устройства.

Совет

В описании используется изображение устройства без установленного объектива.

Отверстия для винтов крепления к потолочному кронштейну (6 мест, эффективная глубина резьбы
5,5 мм)
При установке устройства на потолок или высоко расположенную полку закрепите кронштейн корпуса
(приобретается дополнительно) на основании устройства, завернув шесть винтов крепления кронштейна
корпуса в эти отверстия.

Подробнее об установке см. в разделах “Вертикальная установка в фиксированном месте на большой
высоте” и “Установка на потолке”.

1.

Винты для крепления к штативу (2 места)2.
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См. также

Вертикальная установка в фиксированном месте на большой высоте

Установка на потолке

5-041-958-03(1) Copyright 2022 Sony Corporation

Служат для установки устройства на штатив для камеры (приобретается дополнительно, винты 1/4–20 UNC
длиной до 5,5 мм).

Примечание

Не используйте винты длиннее 5,5 мм. Это приведет к повреждению устройства.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Опора объектива

В этом разделе рассматриваются расположение и назначение компонентов опоры объектива устройства.

Совет

В описании используется изображение устройства без установленного объектива.

Штанга опоры объектива (2)
Служит для поддержки объектива.
Может также использоваться для установки аксессуаров общего назначения для штанг Ø15.

1.
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Блок опоры объектива
Опору объектива можно сдвинуть вперед или назад в зависимости от объектива, затем закрепить.

2.

Винт крепления основания опоры объектива
Крепится к основанию опоры объектива. Положение винта можно регулировать вверх/вниз в соответствии с
высотой основания опоры объектива.

3.

Рычаг зажима штанги опоры объектива (2 места)
Служит для фиксации положения блока опоры объектива в направлении вперед/назад.

4.

Рычаг зажима винта крепления основания опоры объектива
Служит для фиксации положения винта крепления основания опоры объектива по вертикали.

Совет

Если рычаг зажима находится в положении, в котором сложно поворачивать винт, освободите рычаг зажима и
поверните его под углом, упрощающим выполнение операции. Когда винт будет в нужном положении, закройте рычаг
зажима.

A: Рычаг зажима винта крепления основания опоры объектива
B: Рычаг зажима штанги опоры объектива

Примечание

Чтобы опора объектива не мешала повороту/наклону, когда блок опоры объектива не используется, переместите его
вплотную к головке камеры, а винт крепления основания опоры объектива установите в самое верхнее положение
(ближайшее к объективу).

5.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Расположение и назначение элементов инфракрасного пульта управления
(входит в комплект поставки)

В этом разделе рассматриваются расположение и назначение компонентов инфракрасного пульта управления
(входит в комплект поставки).

Кнопка REC● (START/STOP (запуск/остановка записи))
Нажмите для запуска или остановки записи.

1.

Кнопка MENU
Нажмите для отображения или скрытия меню камеры.

2.

Кнопки управления графическим пользовательским интерфейсом
Нажимайте для управления операциями в меню камеры, в диалоговых окнах сообщений, содержащих кнопки,
и в других функциях с экранной индикацией.

3.

Кнопка CANC./BACK4.
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Элементы питания инфракрасного пульта управления

Инфракрасный пульт управления питается от двух элементов питания AA (LR6).
Вставьте элементы питания в инфракрасный пульт управления, как показано на следующем рисунке.

Служит для отмены настройки или для возврата на предыдущий пункт меню камеры на устройстве.
Кнопки управления поворотом и наклоном
Нажимайте кнопки со стрелками для управления поворотом и наклоном камеры. Нажмите кнопку HOME для
возврата камеры в положение, в котором она направлена прямо вперед.

5.

Кнопки управления предварительно заданными положениями
Нажмите кнопку PRESET и, удерживая ее нажатой, нажмите кнопку с номером от 1 до 3, чтобы сохранить
направление камеры, положение масштабирования и состояние настройки фокуса для этой кнопки.
Нажмите кнопку с номером с сохраненными настройками для вызова сохраненного состояния.

6.

Кнопки управления фокусировкой
Служат для настройки фокусировки.
Для автоматической фокусировки нажмите кнопку AF.
Чтобы настроить фокусировку вручную, нажмите кнопку MF, затем нажмите кнопку F (Дальше) для
фокусировки на удаленные объекты или кнопку N (Ближе) для фокусировки на ближние объекты.

7.

Программируемые кнопки с 1 до 3
Служат для выполнения функций, назначенных программируемым кнопкам с помощью меню камеры.
Если назначить функцию [Direct Menu] программируемой кнопке, с помощью кнопок управления графическим
пользовательским интерфейсом можно настраивать экспозицию, баланс белого и другие настройки.

Подробнее о назначении с помощью меню камеры см. в разделе “Программируемые кнопки”.

Подробнее о прямом меню см. в разделе “Использование прямого меню”.

8.

Кнопка  (питание)
Нажмите для включения устройства или для переключения питания в режим ожидания.

9.

Кнопка THUMBNAIL
Служит для отображения экрана эскизов с клипами, записанными на карту памяти устройства.

Подробнее об экране эскизов см. в разделе “Экран эскизов”.

На экране эскизов можно выбирать клипы и управлять воспроизведением с помощью кнопок управления
графическим пользовательским интерфейсом.

Подробнее о выборе клипов и управлении воспроизведением см. в разделах “Воспроизведение
записанных клипов” и “Операции с записанными клипами”.

10.

Кнопка SLOT SEL (выбор гнезда для карт памяти (A)/(B))
Если установлены две карты памяти, чтобы переключаться между картами памяти для записи, нажимайте эту
кнопку.
Если нажать эту кнопку на экране эскизов, производится переключение между просматриваемыми картами
памяти.

11.

Кнопка P/T RESET (сброс поворота/наклона)
Служит для сброса функции поворота/наклона. Нажимайте эту кнопку, когда одновременно мигают
индикаторы POWER и NETWORK или когда в веб-приложении в панели управления кадрированием
отображается [Execute Pan-Tilt Reset].

12.

Кнопки управления масштабированием
Для увеличения нажимайте кнопку T (телефото).
Для уменьшения нажимайте кнопку W (широкоугольный).

13.
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Примечание

Запрещается использовать любые другие элементы питания, кроме марганцевых и щелочных, так как они могут
взорваться.

Использованные элементы питания необходимо утилизировать в соответствии с законами и предписаниями,
действующими в стране или регионе.

См. также

Программируемые кнопки

Использование прямого меню

Экран эскизов

Воспроизведение записанных клипов

Операции с записанными клипами

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Обзор экрана веб-приложения

Подключив планшет или компьютер, можно выполнять операции поворота/наклона, масштабирования, записи,
воспроизведения записанного видео и настройки устройства из веб-браузера (далее эта функция называется
“веб-приложением”).

Подробнее о запуске веб-приложения см. в разделе “Доступ к веб-приложению из веб-браузера”.

Примечание

Веб-приложение не поддерживает вывод звука с камеры.

При запуске веб-приложения открывается следующий операционный экран.

Операционный экран

Подробнее об операционном экране см. в разделе “Структура операционного экрана”.
Вверху экрана отображаются кнопки и значки, общие для операционного экрана и экрана воспроизведения.

Подробнее об общей области экранов см. в разделе “Структура общей области экранов”.
Между экранами можно переключаться, нажимая вкладки переключения экранов в общей области.
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Экран воспроизведения

Для отображения экрана воспроизведения нажмите вкладку [Playback].

Подробнее об экране воспроизведения см. в разделе “Структура экрана воспроизведения”.

Экран настроек

Для отображения экрана настроек (далее называется веб-меню) нажмите вкладку [Settings].

41



Примечание

В веб-меню настройки не применяются, пока не будет нажата кнопка [OK]. Если настройки изменяются на странице
с кнопкой [OK], обязательно нажмите кнопку [OK].

Подробнее об экране настроек см. в разделе “Структура экрана настроек”.
В этом справочном руководстве экран настроек веб-приложения называется веб-меню.

См. также
Доступ к веб-приложению из веб-браузера

Структура операционного экрана

Структура общей области экранов

Структура экрана воспроизведения

Структура экрана настроек

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Структура общей области экранов

В этом разделе описывается структура общей области экранов.

Имя камеры
Отображается имя камеры.
Имя можно изменить в пункте [Network] > [Camera Name] веб-меню.
Цвет фона изменяется в соответствии с внешним сигналом съемки.

1.

Выключатель питания
При включении устройства отображается индикатор [Power ON]. Можно нажать этот переключатель и выбрать
[Power Standby], чтобы перевести питание устройства в режим ожидания.
Когда отображается индикатор [Power Standby], можно нажать этот переключатель и выбрать [Power ON],
чтобы включить питание устройства.

2.

Вкладки переключения операционного экрана
Нажмите вкладку для отображения соответствующего операционного экрана.
Вкладка [Live]: отображение операционного экрана.
Вкладка [Playback]: отображение экрана воспроизведения.
Вкладка [Settings]: отображение экрана настроек (веб-меню).

3.

Метка уведомлений
При поступлении сообщения метка уведомлений изменяется, как показано ниже.

 (Уведомления включены)
Примите необходимые меры в соответствии с сообщением, отображаемым на панели изображений с камеры.

Примечание

Сообщения не отображаются, когда в веб-меню для параметра [Monitoring] > [Output Display] > [HDMI/Stream] задано
значение [Off]. Для проверки содержимого сообщений установите значение [On].

4.

Кнопка  (Состояние камеры)
Нажмите эту кнопку для отображения на отдельном экране информации о записанном камерой изображении/
выходном сигнале изображения, сведений об объективе и статуса контроллера объектива (приобретается
дополнительно).

5.
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5-041-958-03(1) Copyright 2022 Sony Corporation

При появлении уведомления, связанного с контроллером объектива (приобретается дополнительно), вид
кнопки изменяется, как показано ниже.

Переключатель блокировки операций с экраном
 (Операции разблокированы): установите переключатель в левое положение, чтобы управлять

операциями на операционном экране и экране воспроизведения.
 (Операции заблокированы): установите переключатель в правое положение, чтобы заблокировать

операции на операционном экране и экране воспроизведения во избежание случайного срабатывания.

6.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Структура операционного экрана

В этом разделе описывается структура операционного экрана.

Панель управления предварительно заданными положениями
Здесь с помощью эскиза отображается зарегистрированное положение предварительно заданного положения.
Дважды нажмите эскиз, чтобы вернуться к положению, сохраненному в предварительно заданном положении.

Подробнее о предварительно заданном положении см. в разделе “Сохранение и восстановление
поворота/наклона, положения масштабирования и настройки фокусировки с помощью веб-приложения”.
Подробнее о функции PTZ trace (сохранение настроек поворота/наклона/масштаба) см. в разделе “Запись
операций кадрирования камеры с помощью веб-приложения”.

1.

Панель изображения с камеры
Отображаются текущее изображение с камеры и состояние устройства.
Отображается то же изображение, что и в выходном сигнале HDMI.
Над изображением отображается указанное ниже состояние. Кроме того, вокруг изображения отображается
красная или зеленая рамка в соответствии с полученным внешним сигналом съемки.

2.
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Кнопка [Display]
Нажмите эту кнопку для отображения на изображении информации о камере.
Нажмите еще раз, когда отображается информация о камере, чтобы скрыть ее.

Помимо маркеров, в зависимости от состояния, отображаются индикаторы и сообщения, связанные
с автофокусировкой, которые невозможно скрыть нажатием кнопки [Display].

Сведения об отображаемой информации о камере см. в разделе “Индикация на экране камеры”.

№ Отображение Описание

2-
1

Индикатор режима
фокусировки

См. пункт “Индикатор режима фокусировки” в разделе “Индикация на
экране камеры”.

2-
2

Режим съемки, гнездо A/B,
индикатор интервала
интервальной съемки

См. пункт “Режим съемки, гнездо A/B, индикатор интервала
интервальной съемки” в разделе “Индикация на экране камеры”.

2-
3

Индикатор состояния
потоковой передачи

Отображается во время потоковой передачи (только когда для
параметра [Stream Setting] задано значение [RTMP] или [SRT-Caller]).

2-
4

Индикатор состояния операции
вывода RAW

Отображение состояния вывода сигнала RAW. Подробнее о формате
RAW см. в разделе “Запись видео в формате RAW”.

2-
5

Индикатор оставшейся емкости
носителя для записи

См. пункт “Индикатор оставшейся емкости носителя” в разделе
“Индикация на экране камеры”.

2-
6

Индикатор положения
масштабирования

См. пункт “Индикатор положения масштабирования” в разделе
“Индикация на экране камеры”.
При подключении контроллера объектива (приобретается
дополнительно) отображается индикатор . Если в контроллере
объектива (приобретается дополнительно) возникает ошибка,
отображается индикатор .

2-
7

Индикатор режима AE/уровня
AE

См. пункт “Индикатор режима AE/уровня AE” в разделе “Индикация
на экране камеры”.
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Кнопка остановки автофокусировки с отслеживанием в реальном времени
Нажмите эту кнопку для остановки отслеживания объекта.

Подробнее см. в разделе “Отслеживание указанного объекта (Realtime Tracking AF)”.
Кнопка START/STOP (пуск/остановка записи)
Нажмите эту кнопку, чтобы начать запись. Во время записи кнопка пуска/остановки записи START/STOP горит
красным цветом.
Нажмите во время записи, чтобы остановить запись.
Можно установить переключатель Hold в состояние удержания, чтобы исключить случайное срабатывание
кнопки пуска/остановки записи START/STOP.

3.

Панель основных настроек камеры
На кнопках отображаются настройки базовых функций, необходимые для съемки. Нажмите кнопку для
отображения соответствующего экрана настройки для каждой из функций на показанной ниже панели
настройки базовой конфигурации камеры (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Подробные сведения см. в описании каждой из функций.

4.

Функция Ссылка

FPS “Съемка с замедлением/ускорением движения”

ISO/Gain
“Задание базовой чувствительности”, “Автоматическая регулировка усиления” и “Регулировка
усиления вручную” в разделе “Регулировка усиления”

Exposure
Index

“Задание базовой чувствительности” и “Изменение распределения темных и ярких областей
на записанном изображении”

Shutter
“Автоматическая регулировка выдержки” и “Регулировка выдержки вручную” в разделе
“Регулировка выдержки”

Iris
“Автоматическая регулировка диафрагмы” и “Регулировка диафрагмы вручную” в разделе
“Регулировка диафрагмы”

ND Filter
“Сведения о фильтре нейтральной плотности” в разделе “Регулировка уровня освещенности
(фильтр ND)”
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Функция Ссылка

Scene File “Обзор видов” и другие темы в разделе “Съемка с требуемым видом”

Base
Look/LUT

“Съемка с последующей регулировкой вида в студии”

White
Balance

“Экран настройки баланса белого”

Программируемые кнопки/панель настройки базовой конфигурации камеры
Служит для отображения программируемых кнопок во время обычной работы. Нажимайте кнопки панели
основных настроек камеры (пункт 4) для отображения соответствующих пунктов настройки. Для возврата
к отображению программируемых кнопок нажмите кнопку [X] или еще раз нажмите кнопку панели настройки
камеры.

Подробнее о программируемых кнопках см. в разделе “Программируемые кнопки”.
Сведения о панели настройки базовой конфигурации камеры см. в описании каждой из функций.

5.

Панель управления кадрированием / панель управления графическим пользовательским
интерфейсом
Для переключения между панелью управления кадрированием и панелью управления графическим
пользовательским интерфейсом служат расположенные сверху вкладки.
Чтобы предотвратить непреднамеренное выполнение операций, для скрытия панели управления можно
нажать кнопку  (Закрыть) в верхнем правом углу экрана. Если панель управления не отображается, для ее
отображения нажмите кнопку  (Открыть).
Панель управления кадрированием служит для настройки кадрирования. Для отображения панели
управления кадрированием нажмите вкладку  (Поворот/наклон/зум).

Подробнее о порядке использования см. в разделе “Настройка кадрирования”.

Совет

Если поворот/наклон заблокированы или требуется инициализация поворота/наклона, относящаяся к джойстику часть
индикации управления кадрированием отображается так, как показано ниже.

Когда поворот/наклон заблокированы с помощью рычага блокировки поворота/наклона

6.
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Когда поворот/наклон не инициализированы

Когда необходимо выполнить сброс поворота/наклона

Когда поворот/наклон отключены

Когда поворот/наклон не инициализированы или когда требуется их сброс, можно быстро перейти к кнопке 
(Сброс поворота/наклона) на панели управления камерой, нажав сообщение, отображаемое под джойстиком.

Панель управления графическим пользовательским интерфейсом служит для управления меню камеры,
воспроизведением клипов и другими функциями. Для отображения панели управления графическим
пользовательским интерфейсом нажмите вкладку  (Строки графического интерфейса камеры).
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Сведения о порядке работы см. в разделах “Использование меню камеры” и “Воспроизведение
записанных клипов”.

Панель управления камерой
Служит для настройки функций, необходимых для работы с камерой.
Для переключения между экранами служат расположенные вверху вкладки.
Чтобы предотвратить непреднамеренное выполнение операций, для скрытия панели управления можно
нажать кнопку  (Закрыть) в верхнем правом углу экрана. Если панель управления не отображается, для ее
отображения нажмите кнопку  (Открыть).

Подробнее см. в описании каждой из функций.

Вкладка  (Main)
Отображаются пункты настройки для часто используемых функций.
Функции верхнего и нижнего ползунков можно изменить, нажав кнопку [▼] и выбрав из открывшегося списка.
Можно выбирать указанные ниже функции.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

Вкладка  (Focus)

7.

Отображается в соответствии с настройками меню.*
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Отображаются пункты настройки, связанные с фокусировкой.

Вкладка  (Audio)

Отображаются пункты настройки, связанные со звуком.

Вкладка  (Stream)
Отображаются пункты настройки, связанные с потоковой передачей.
Отображаемые элементы зависят от настройки формата потоковой передачи.
Если задано значение [RTMP] или [SRT-Caller], потоковую передачу можно запускать и останавливать с этого
экрана.

Подробнее см. в пункте “О потоковой передаче” и других темах раздела “Настройка потоковой передачи”.
При сбое подключения выводится информация об ошибке. Сведения об отображаемой информации об
ошибке см. в разделе “Предупреждения относительно эксплуатации”.
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См. также

Сохранение и восстановление поворота/наклона, положения масштабирования и настройки фокусировки с
помощью веб-приложения

Запись операций кадрирования камеры с помощью веб-приложения

Индикация на экране камеры

Запись видео в формате RAW

Отслеживание указанного объекта (Realtime Tracking AF)

Вкладка  (Others)
Отображаются пункты настройки, связанные с прочими функциями.

Нажатие кнопки [Full Screen Display] открывает новую вкладку в веб-браузере и показывает изображение
с панели изображения с камеры во весь экран.
Изображение только отображается; сенсорная автофокусировка и другие функции недоступны.

Примечание

Операционный экран на исходной вкладке продолжает работать. Если выполнять какие-либо операции не требуется,
эту вкладку рекомендуется закрыть, чтобы уменьшить число одновременных подключений.

Нажмите кнопку  (Инициализировать контроллер объектива), чтобы инициализировать
контроллер объектива (стороннее оборудование, приобретаемое дополнительно). Эта функция включена,
когда в веб-меню для параметра [Technical] > [Lens Controller] > [Zoom] > [Setting] задано значение [On].
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Съемка с замедлением/ускорением движения

Задание базовой чувствительности

Автоматическая регулировка усиления

Регулировка усиления вручную

Изменение распределения темных и ярких областей на записанном изображении

Автоматическая регулировка выдержки

Регулировка выдержки вручную

Автоматическая регулировка диафрагмы

Регулировка диафрагмы вручную

Сведения о фильтре нейтральной плотности

Обзор видов

Съемка с последующей регулировкой вида в студии

Экран настройки баланса белого

Программируемые кнопки

Воспроизведение записанных клипов

Использование меню камеры

О потоковой передаче

Предупреждения относительно эксплуатации

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Структура экрана воспроизведения

В этом разделе описывается структура экрана воспроизведения.

Панель изображения с камеры
Служит для отображения воспроизводимого изображения и связанной информации. Когда воспроизведение
остановлено, отображается экран изображения с камеры.

1.
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1-1 Дата и время съемки
1-2 Индикатор состояния воспроизведения
1-3 Индикатор формата воспроизведения (размера изображения)
1-4 Индикатор формата воспроизведения (кодека)
1-5 Отображение названия клипа
1-6 Номер клипа/общее количество клипов
1-7 Отображение названия таблицы соответствия LUT
1-8 Индикатор состояния потоковой передачи
1-9 Индикатор формата воспроизведения (частоты кадров и метода развертки)
1-10 Индикатор вида при записи

Панель управления воспроизведением

Служит для отображения кнопок управления воспроизведением.

Кнопка [Display]
Нажимайте для переключения между экранной индикацией на изображении.
Кнопка [Thumbnail]
Служит для отображения записанных на карту памяти клипов в виде эскизов на панели изображения с
камеры.

2.

Кнопка Функция

Кнопка  (Воспроизведение/пауза) Воспроизведение клипа. Во время воспроизведения служит для
приостановки клипа.

Кнопка  (Перемотка вперед),
кнопка  (Перемотка назад)

Воспроизведение клипа на высокой скорости. Когда эта кнопка
нажата, скорость воспроизведения изменяется в три ступени.

Кнопка  (Следующий), кнопка 
(Предыдущий)

Переход в начало клипа или к предыдущему/следующему клипу.

Кнопка  (Стоп) Остановка воспроизведения.
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См. также
Экран эскизов

Программируемые кнопки

Воспроизведение записанных клипов

5-041-958-03(1) Copyright 2022 Sony Corporation

Если нажать кнопку [Thumbnail], когда отображается экран эскизов, экран закрывается и появляется
изображение с камеры.

Подробнее об экране эскизов см. в разделе “Экран эскизов”.

Кнопка [Slot Select]
Служит для переключения между воспроизводимыми носителями.

Программируемые кнопки
Отображаются программируемые кнопки, назначенные функциям устройства.

Подробнее о программируемых кнопках см. в разделе “Программируемые кнопки”.

3.

Панель управления графическим пользовательским интерфейсом
Панель управления графическим пользовательским интерфейсом служит для управления меню камеры,
воспроизведением клипов и другими функциями.

Сведения о порядке работы см. в разделах “Использование меню камеры” и “Воспроизведение
записанных клипов”.

4.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Структура экрана настроек

Экран настроек служит для задания различных настроек устройства, включая исходные настройки, настройки
сети и настройки съемки/воспроизведения, с помощью веб-меню.

Примечание

В веб-меню настройки обычно не применяются, пока не будет нажата кнопка [OK]. Если настройки изменяются на
странице с кнопкой [OK], обязательно нажмите кнопку [OK].

Подробнее об экране настроек см. в разделе “Веб-меню и подробные настройки”.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Меню камеры

Нажмите кнопку [Menu] на панели управления графическим пользовательским интерфейсом операционного
экрана или экрана воспроизведения для отображения меню камеры на панели изображения с камеры.

С помощью меню камеры можно задать настройки, необходимые для съемки и воспроизведения.
Когда отображается меню камеры, нажмите кнопку [Menu], чтобы скрыть меню камеры.
Для работы с меню камеры используется панель управления графическим пользовательским интерфейсом.

Подробнее о меню камеры см. в разделе “Меню камеры и подробные настройки”.

Примечание

Если в веб-меню для параметра [Monitoring] > [Output Display] > [HDMI/Stream] установлено значение Off (отключено
наложение информации на экранную индикацию), меню камеры не отображается на панели изображения с камеры.
Однако помните, что операции с меню на панели управления графическим пользовательским интерфейсом по-прежнему
работают. Во избежание непреднамеренного выполнения операций не выполняйте никаких операций с помощью панели
управления графическим пользовательским интерфейсом, когда для параметра [HDMI/Stream] задано значение Off.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Индикация на экране камеры

Состояние и настройки устройства могут накладываться на выходное изображение с камеры. Выходы, для
которых включена экранная индикация, можно задать с помощью параметра [Monitoring] > [Output Display] в веб-
меню.
Информацию можно вывести/скрыть с помощью кнопки [Display]. Даже если эта информация скрыта, она
отображается при выполнении операций в прямом меню.
Пункты можно индивидуально отображать/скрывать с помощью пункта [Monitoring] > [Display On/Off] в меню
камеры.

Информация, отображаемая на экране во время съемки

Индикатор отправки/индикатор оставшихся файлов

Подробнее о передаче файлов см. в пункте “О передаче файлов” и других темах в разделе “Передача
файлов”.

1.

Индикатор области фокусировки
Отображает область фокусировки для автоматической фокусировки.

Подробнее об автоматической регулировке фокусировки см. в пункте “Автоматическая настройка с
помощью веб-приложения” и других темах раздела “Автоматическая регулировка фокусировки (Auto
Focus)”.

2.

Режим съемки, гнездо A/B, индикатор интервала интервальной съемки

Подробнее об интервальной съемке см. в разделе “Запись видео с промежутками (Interval Rec)”.

3.

Отображение Значение

●Rec Запись

Stby Ожидание съемки
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Индикатор глубины поля4.

Индикатор режима Imager Scan Mode
Значок  (несоответствие) отображается на экране при несоответствии размера круга изображения
объектива и эффективного размера изображения, заданного в настройке режима Imager Scan Mode.
Если в параметре Imager Scan Mode задано значение FF, в режимах с более узким полем зрения
(кадрированных) отображается метка “C”.
Кадрирование происходит в следующих режимах.

Если установлен формат записи 3840×2160, а для частоты кадров S&Q Motion задано значение 100 или
120 кадров/с
Если для параметра [Codec] задано значение RAW или RAW & XAVC-I и задан выходной формат RAW
3840×2160
Подробнее о режиме сканирования датчика изображения см. в пункте “Задание режима сканирования
датчика изображения” в разделе “Настройка основных операций”.

5.

Индикатор состояния операции вывода RAW
Отображение состояния вывода сигнала RAW.

Подробнее о формате RAW см. в разделе “Запись видео в формате RAW”.

6.

Индикатор частоты кадров при замедленной и ускоренной съемке

Подробнее о съемке с замедлением/ускорением движения см. в разделе “Съемка с замедлением/
ускорением движения”.

7.

Индикатор положения фокуса

Указывает положение фокуса.

8.

Индикатор режима фокусировки

AF с обнаружением лица или глаз

9.

Отображение Значение

Focus Hold Режим Focus Hold

MF Режим MF

AF Режим AF

 (Режим автофокуса с отслеживанием в реальном
времени)

Режим автофокуса с отслеживанием в реальном
времени

Отображение Значение

 (AF с обнаружением лица или
глаз)

Указывает, что автофокусировка с обнаружением лица или глаз
включена

 (AF только для лица или глаз) Указывает, что включена только AF на лица или глаза

 (Сохраненное отслеживаемое
лицо)

Указывает, что отслеживаемое лицо сохранено

 (Приостановка AF) Указывает, что функция AF приостановлена*
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Подробнее об AF с обнаружением лица или глаз см. в разделе “Отслеживание с использованием
обнаружения лиц и глаз (Face/Eye Detection AF)”.

Отображается, когда нет сохраненного отслеживаемого лица и никакое лицо не обнаружено, или когда имеется сохраненное лицо и
это лицо не обнаружено.

*

Индикатор положения масштабирования
Отображает положение масштабирования в диапазоне от 0 (широкоугольный режим) до 99 (режим телефото)
(если используется объектив, который поддерживает отображение положения масштабирования).
С помощью параметра [Technical] > [Lens] > [Zoom Position Display] в меню камеры можно также изменить вид
индикатора на индикацию шкалы или индикацию фокусного расстояния.
При включении режима Clear Image Zoom на экран добавляются следующие элементы.

Подробнее о масштабировании см. в пункте “Установка типа масштабирования” и других темах раздела
“Регулировка масштаба”.

10.

Отображение Значение

 (Режим Clear Image Zoom включен) Режим Clear Image Zoom включен

Значение увеличения При использовании режима Clear Image Zoom

Индикатор режима стабилизации изображения11.

Индикатор состояния управления съемкой выхода SDI/выхода HDMI
Отображение состояния выдачи сигнала управления съемкой.

Подробные сведения см. в разделе “Подключение внешних мониторов и устройств записи”.

12.

Индикатор фокусировки

Подробнее см. в пункте “Использование покадровой автоматической фокусировки (Push Auto Focus (AF-
S))” раздела “Настройка фокусировки”.

13.

Индикатор оставшейся емкости носителя для записи
Если карта памяти защищена от записи, отображается значок  (защита).

14.

Индикатор режима баланса белого15.

Отображение Значение

 (ATW) Режим Auto

 (ATW Hold) Режим Auto приостановлен

W:P Режим предустановки

W:A Режим из ячейки памяти A

Индикатор внешней привязки временного кода/отображение данных времени
Отображает значение “EXT-LK”, когда установлена привязка к временному коду внешнего устройства.

Подробнее о временном коде см. в разделе “Указание данных времени”.

16.

Индикатор фильтра ND17.
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Подробные сведения о фильтрах нейтральной плотности см. в разделе “Регулировка уровня
освещенности (фильтр ND)”.
Подробные сведения об управлении эффектом боке см. в разделе “Регулировка боке (функция Bokeh
Control)”.

Отображение Значение

 (A) Режим Auto

 (B) Режим управления боке

Индикатор файла сцен

Подробнее о файлах сцен см. в пункте “Обзор видов” и других темах раздела “Съемка с требуемым
видом”.

18.

Индикатор диафрагмы
Отображает положение диафрагмы (значение F), (если используется объектив, который поддерживает
отображение установки диафрагмы).

Подробнее о диафрагме см. в разделах “Автоматическая регулировка диафрагмы” и “Регулировка
диафрагмы вручную”.

19.

Индикатор предупреждения об уровне видеосигнала20.

Индикатор усиления
В режиме Cine EI/Cine EI Quick показывает значение EI.

Подробнее об усилении см. в разделах “Автоматическая регулировка усиления” и “Регулировка усиления
вручную”.
Подробнее о режиме сканирования Cine EI/Cine EI Quick см. в пункте “Задание режима съемки” в разделе
“Настройка основных операций”.

21.

Отображение Значение

 (A) Режим Auto

L Режим предустановки L

 (Режим временной регулировки) Режим временной регулировки

 (B) Режим управления боке

Отображение названия клипа
Отображается название текущего записываемого клипа или следующего записываемого клипа.
Мигание указывает на несоответствие между последним клипом на носителе для записи и настройками
[Camera ID] или [Reel Number]. Подробнее см. описание пунктов [Clip Name Format] > [Auto Naming].

22.

Индикатор затвора

Подробнее о выдержке см. в разделах “Автоматическая регулировка выдержки” и “Регулировка выдержки
вручную”.

23.

Индикатор режима AE/уровня AE

Подробнее об автоматической экспозиции (AE) см. в разделе “Задание целевого уровня для
автоматической регулировки яркости”.

24.
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Индикатор уровня
Отображается горизонтальный уровень с шагом ±1° вплоть до ±15°.

25.

Измеритель уровня аудио
Показывает уровень звука для каждого из каналов.

26.

Монитор видеосигнала
Отображает форму сигнала, вектороскоп и гистограмму.
Оранжевая линия указывает заданное значение маркера уровня яркости.
В режимах Log-съемки над изображением выводится тип таблицы соответствия LUT целевого монитора.

Подробные сведения см. в разделе “Монитор видеосигнала”.
Подробнее о режиме Log-съемки см. в пункте “Задание режима съемки” в разделе “Настройка основных
операций”.

27.

Индикатор Base Sensitivity/индикатор Base ISO
В режиме Custom он показывает базовую чувствительность, заданную с помощью кнопки [ISO/Gain / Exposure
Index] на панели основных настроек камеры или с помощью параметра [Shooting] > [ISO/Gain/EI] > [Base
Sensitivity] в меню камеры.
В режиме Log-съемки он показывает чувствительность Base ISO, заданную с помощью кнопки [ISO/Gain /
Exposure Index] на панели основных настроек камеры или с помощью параметра [Shooting] > [ISO/Gain/EI] >
[Base ISO] в меню камеры.

Подробные сведения о базовой чувствительности см. в разделе “Выбор базовой чувствительности”.
Подробнее о режиме Log-съемки см. в пункте “Задание режима съемки” в разделе “Настройка основных
операций”.

28.

Индикатор вида при контроле
В режиме Log-съемки отображается настройка таблицы соответствия LUT монитора.

Подробные сведения о настройке таблицы LUT см. в разделе “Съемка с последующей регулировкой вида
в студии” и связанных темах.
Подробнее о режиме Log-съемки см. в пункте “Задание режима съемки” в разделе “Настройка основных
операций”.

29.

Индикатор базового вида/вида при записи
Показывает настройку Base Look.
В режиме Log-съемки отображается видеосигнал для записи на карты памяти.

Подробнее о базовом виде см. в пункте “Обзор видов” раздела “Съемка с требуемым видом”.
Подробнее о режиме Log-съемки см. в пункте “Задание режима съемки” в разделе “Настройка основных
операций”.

30.

Индикатор состояния прокси31.

Индикатор формата записи (кодека)
Отображает имя формата, в котором выполняется запись на карты памяти.
Формат записи (кодек) задается с помощью параметра [Project] > [Rec Format] > [Codec] в веб-меню или в
меню камеры.

32.

Индикатор формата записи (частоты кадров и метода развертки)33.

Индикатор формата записи (размера изображения)
Отображает размер изображения, которое записывается на карты памяти.
Формат записи (размер изображения) задается с помощью параметра [Project] > [Rec Format] > [Codec] в веб-
меню или в меню камеры.

34.

Индикатор съемки35.
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Информация, отображаемая на экране во время воспроизведения

Следующая информация отображается поверх воспроизводимого изображения.

См. также

Отображается в виде красной или зеленой рамки вокруг изображения в соответствии с полученным внешним
сигналом съемки.

Индикатор отправки/индикатор оставшихся файлов1.

Номер клипа2.

Индикатор состояния воспроизведения3.

Индикатор формата воспроизведения (частоты кадров и метода развертки)4.

Индикатор формата воспроизведения (размера изображения)5.

Индикатор формата воспроизведения (кодека)6.

Индикатор носителя
Если карта памяти защищена от записи, отображается значок  (защита).

7.

Отображение данных времени8.

Отображение названия клипа9.

Индикатор помощь в отображении гамма10.

Измеритель уровня аудио
Отображение уровня звука при воспроизведении.

11.

Индикатор базового вида/вида при записи12.

Индикатор съемки13.
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О передаче файлов

Автоматическая настройка с помощью веб-приложения

Запись видео с промежутками (Interval Rec)

Настройка основных операций

Запись видео в формате RAW

Съемка с замедлением/ускорением движения

Отслеживание с использованием обнаружения лиц и глаз (Face/Eye Detection AF)

Установка типа масштабирования

Подключение внешних мониторов и устройств записи

Использование покадровой автоматической фокусировки (Push Auto Focus (AF-S))

Указание данных времени

Обзор видов

Автоматическая регулировка диафрагмы

Регулировка диафрагмы вручную

Автоматическая регулировка усиления

Регулировка усиления вручную

Автоматическая регулировка выдержки

Регулировка выдержки вручную

Задание целевого уровня для автоматической регулировки яркости

Монитор видеосигнала

Съемка с последующей регулировкой вида в студии

Clip Name Format

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Вертикальная установка в фиксированном месте

В этом разделе описывается установка устройства на столе или штативе.

Примечание по установке
Чтобы защитить объектив и блок разъемов объектива устройства, колпачок и крышка устройства должны быть
всегда установлены, пока не будет установлен объектив.
Во избежание отказа объектива не держитесь за детали объектива во время работы.
Во избежание отказа устройства не держитесь за головку камеры во время работы.

Проверьте размеры области установки.

При установке на столе
Устанавливайте данное устройство на ровную поверхность с учетом пространства, необходимого для
поворота объектива и для прокладки проводов позади устройства.

Примечание

Устанавливайте устройство в устойчивом месте, не подверженном вибрации. В местах, подверженных вибрации,
изображение может дрожать.

Если необходимо установить устройство на наклонной поверхности, наклон не должен превышать более ±15° от
горизонтали. Кроме того, примите меры против опрокидывания устройства.

При установке на штативе
Закрепите штатив с помощью отверстия для винта крепления штатива на нижней панели.
Используйте винт крепления штатива с указанным на рисунке размером выступа от установочной
поверхности и затяните его отверткой от руки.

A: Винты крепления штатива 1/4-20 UNC, ISO 1222 (6,35 мм)

1
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Затем установите объектив. См. раздел “Присоединение объектива” с учетом информации из разделов “Меры
предосторожности при установке и снятии объектива”, “Проверка переключателей объектива” и “Меры
предосторожности при использовании объективов с масштабированием”.

См. также

Меры предосторожности при установке и снятии объектива

Проверка переключателей объектива

Меры предосторожности при использовании объективов с масштабированием

Присоединение объектива

5-041-958-03(1) Copyright 2022 Sony Corporation

B: Выступ (от 4,5 до 5,5 мм)

Не используйте винты штатива для установки устройства на большой высоте.

Примечание

Выберите штатив, который не опрокинется даже при повороте объектива.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Вертикальная установка в фиксированном месте на большой высоте

В этом разделе описывается процедура вертикальной установки на большой высоте с использованием
потолочного кронштейна (CIB-PCM1 (приобретается дополнительно)).

Для установки устройства на большой высоте обращайтесь к профессиональным исполнителям.
При установке на большой высоте убедитесь, что монтажная поверхность и монтажный материал (за
исключением аксессуаров) могут выдержать вес 200 кг и более, и установите устройство так, как описано
в данном справочном руководстве. Если крепление недостаточно прочное, устройство может упасть и
причинить серьезные травмы.
Для предотвращения падения устройства закрепите входящий в комплект поставки страховочный тросик на
потолочном кронштейне CIB-PCM1 (приобретается дополнительно).
При установке устройства на большой высоте раз в год проверяйте надежность крепления. В зависимости от
условий эксплуатации может потребоваться сократить интервал проверки.

Примечание по установке
Чтобы защитить объектив и блок разъемов объектива устройства, крышка объектива и крышка на устройстве
должны быть установлены.
Во избежание отказа объектива не держитесь за детали объектива во время работы.
Во избежание отказа устройства не держитесь за головку камеры во время работы.

Проверьте аксессуары для установки на большой высоте и пространство для установки.

Комплект потолочного кронштейна CIB-PCM1 (приобретается дополнительно)
Перед началом работы убедитесь в наличии следующих деталей.

Кронштейн корпуса (1)
Потолочный кронштейн (1)
Крышка кнопки отсоединения объектива (1)
Страховочный тросик (1)
Винты +PSW M3×8 (9)
Винт +PSW M4×8 из нержавеющей стали для страховочного тросика (1)

1
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Примечание

Страховочный тросик предназначен для удержания устройства, если оно повиснет на тросике. Не прикладывайте к
нему никакую другую нагрузку, кроме веса устройства.

Область установки
При определении места и ориентации установки см. следующий рисунок и учитывайте пространство,
необходимое для поворота объектива и для прокладки проводов позади устройства.

A: Диапазон движения головки камеры (например, SEL70200GM2 (с установленным SEL20TC): Ø370)
B: Потолочный кронштейн (отверстие на стороне монтажной поверхности (Ø150))
C: Установочное отверстие для монтажа

Примечание

Устанавливайте устройство в устойчивом месте, не подверженном вибрации. В местах, подверженных вибрации,
изображение может дрожать.

Если необходимо установить устройство на наклонной поверхности, наклон не должен превышать более ±15° от
горизонтали. Кроме того, примите меры против опрокидывания устройства.

Переместите рычаг блокировки поворота/наклона в положение LOCK, чтобы заблокировать поворот/
наклон головки камеры.

2
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Примечание

Если поворот/наклон головки камеры не блокируется при установке рычага блокировки в положение LOCK, вручную
перемещайте головку камеры, пока она не зафиксируется.

Установите кронштейн корпуса на нижнюю панель устройства с помощью шести прилагаемых
винтов (M3×8).

3
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Используйте винты из комплекта поставки. При использовании винтов не из комплекта поставки можно
повредить внутренние части устройства.

Закрепите страховочный тросик на кронштейне корпуса.4
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A: Тросик из комплекта поставки 
B: Винты Phillips (M4×8) из комплекта поставки
C: Металлическая петля для тросика

Используйте винт из комплекта поставки. При использовании винта не из комплекта поставки может
снизиться эффективность тросика.

Установите потолочный кронштейн на поверхность (например, на полку), на которой требуется
установить устройство.

5
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A: Стена 
B: Метка △ (направление камеры вперед)
C: Отверстие для соединительных кабелей
D: Полка или другая монтажная поверхность

Закрепите страховочный тросик в месте рядом с монтажной поверхностью.

Используйте винт M5 (3/16 дюйма) с головкой под внутренний шестигранник (приобретается дополнительно)
и закрепите его на предмете рядом с полкой или поверхностью, на которой будет установлен потолочный
кронштейн.

6
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A: Тросик 
B: Винт с головкой под внутренний шестигранник (M5, 3/16 дюйма)

Совместите отверстие под винт 〇 на передней части кронштейна корпуса с отверстием ◇
потолочного кронштейна, вставьте устройство и временно закрепите кронштейн корпуса в
потолочном кронштейне, повернув устройство по часовой стрелке.

7
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A: Отверстие 〇
B: Отверстие ◇

Закрепите кронштейн корпуса в потолочном кронштейне тремя винтами со стопорами (M3×8) из
комплекта поставки.

8
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Затем установите объектив. См. раздел “Присоединение объектива” с учетом информации из разделов “Меры
предосторожности при установке и снятии объектива”, “Проверка переключателей объектива” и “Меры
предосторожности при использовании объективов с масштабированием”.

Примечание

После установки объектива проверьте надежность его крепления.
Для объектива нет никакой страховки от падения. Компания Sony не несет никакой ответственности за падение
объектива с устройства.

См. также
Меры предосторожности при установке и снятии объектива

Проверка переключателей объектива

Меры предосторожности при использовании объективов с масштабированием

Присоединение объектива

Проверьте состояние установки.

В частности, проверьте следующее. 

Правильность установки винтов крепления.
Правильность установки страховочного тросика без скручивания.
Горизонтальность установки устройства (без наклона или шатания).
При повороте устройство не начинает свободно поворачиваться.

9
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Установка на потолке

В этом разделе описывается процедура установки на потолке с использованием потолочного кронштейна (CIB-
PCM1 (приобретается дополнительно)).

Для установки устройства на потолке обращайтесь к профессиональным исполнителям.
При установке на потолке убедитесь, что монтажная поверхность и монтажный материал (за исключением
аксессуаров) могут выдержать вес 200 кг и более, и установите устройство так, как описано в данном
справочном руководстве. Если крепление недостаточно прочное, устройство может упасть и причинить
серьезные травмы.
Для предотвращения падения устройства закрепите входящий в комплект поставки страховочный тросик на
потолочном кронштейне CIB-PCM1 (приобретается дополнительно).
При установке устройства на потолке раз в год проверяйте надежность крепления. В зависимости от условий
эксплуатации может потребоваться сократить интервал проверки.

Примечание по установке
Чтобы защитить объектив и блок разъемов объектива устройства, крышка объектива и крышка на устройстве
должны быть установлены.
Во избежание отказа объектива не держитесь за детали объектива во время работы.
Во избежание отказа устройства не держитесь за головку камеры во время работы.

Проверьте аксессуары для установки на потолке и пространство для установки.

Комплект потолочного кронштейна CIB-PCM1 (приобретается дополнительно)
Перед началом работы убедитесь в наличии следующих деталей.

Кронштейн корпуса (1)
Потолочный кронштейн (1)
Крышка кнопки отсоединения объектива (1)
Страховочный тросик (1)
Винты +PSW M3×8 (9)

1
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Винт +PSW M4×8 из нержавеющей стали для страховочного тросика (1)

Примечание

Страховочный тросик предназначен для удержания устройства, если оно повиснет на тросике. Не прикладывайте к
нему никакую другую нагрузку, кроме веса устройства.

Область установки
При определении места и ориентации установки см. следующий рисунок и учитывайте пространство,
необходимое для поворота объектива и для прокладки проводов позади устройства.

A: Диапазон движения головки камеры (например, SEL70200GM2 (с установленным SEL20TC): Ø370)
B: Потолочный кронштейн (отверстие на стороне потолка (Ø150))
C: Установочное отверстие для монтажа

Примечание

Установка должна производиться на достаточно прочный потолок (например, бетонный).

Чтобы установить устройство на недостаточно прочный потолок, обеспечьте достаточное усиление.

Устанавливайте устройство в устойчивом месте, не подверженном вибрации. В местах, подверженных вибрации,
изображение может дрожать.

Если необходимо установить устройство на наклонной поверхности, наклон не должен превышать более ±15° от
горизонтали. Кроме того, примите меры против опрокидывания устройства.

Сторона, противоположная отверстию △ на потолочном кронштейне, соответствует направлению съемки (передней
стороне камеры).

Переместите рычаг блокировки поворота/наклона в положение UNLOCK, чтобы разблокировать
поворот/наклон, и разверните головку камеры на 180° в направлении наклона.

2

Переместите рычаг блокировки поворота/наклона в положение LOCK, чтобы заблокировать поворот/
наклон головки камеры.

3
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Головка камеры развернута на 180°

Примечание

Если поворот/наклон головки камеры не блокируется при установке рычага блокировки в положение LOCK, вручную
перемещайте головку камеры, пока она не зафиксируется.

Установите кронштейн корпуса на нижнюю панель устройства с помощью шести прилагаемых
винтов (M3×8).

4
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Используйте винты из комплекта поставки. При использовании винтов не из комплекта поставки можно
повредить внутренние части устройства.

Установите потолочный кронштейн на монтажную пластину (приобретается дополнительно), затем
закрепите пластину на потолке.

5
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A: Потолочный кронштейн
B: Потолок
C: Монтажная пластина
D: Отверстие △
Закрепите кронштейн в соответствии с ориентацией потолочного кронштейна
Обратите внимание, что при установке на потолке передняя часть камеры обращена к противоположной
стороне потолочного кронштейна по сравнению с обычной вертикальной установкой. Убедитесь в
правильности установки в соответствии со схемой, на которой показано направление установки.

A: Передняя сторона для вертикальной установки (ориентация отверстия △)
B: Передняя сторона для установки на потолке

Примечание

Ответственность за решение о возможности установки на конкретную поверхность лежит на клиенте.

Закрепите страховочный тросик к потолку.6
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A: Потолочный кронштейн
B: Винт с головкой под внутренний шестигранник (M5, 3/16 дюйма)
C: Тросик (из комплекта поставки)
D: Монтажная пластина
E: Потолок

Пропустите страховочный тросик через отверстие в центре потолочного кронштейна и закрепите его
на кронштейне корпуса.

Проложите страховочный тросик через металлическую петлю для тросика на кронштейне корпуса и надежно
закрепите тросик прилагаемым винтом из нержавеющей стали (M4×8).

A: Тросик из комплекта поставки
B: Винты Phillips (M4×8) из комплекта поставки
C: Металлическая петля для тросика

7
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Используйте винт из комплекта поставки. При использовании винта не из комплекта поставки может
снизиться эффективность тросика.

Примечание

Рекомендуется, чтобы во время установки устройства один человек держал его, как показано на рисунке, а второй
производил установку.

При установке устройства не держите его за головку камеры или объектив. В случае падения устройства имеется
риск повреждения или травмы.

Во время прокладки проводки следите, чтобы страховочный тросик не вызвал короткого замыкания в электрических
разъемах и кабелях.

Крепление рассчитано на подвешенную массу не более 8,8 кг (включая объектив). Во избежание падения
устройства не превышайте максимальную ожидаемую массу.

Совместите отверстие для винта (A) на кронштейне корпуса с отверстием ◇ (B) на потолочном
кронштейне, вставьте устройство и поверните его приблизительно на 60 градусов по часовой
стрелке до совмещения отверстия для винта (A) с отверстием для винта (C).

8
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A: Отверстие для винта на кронштейне корпуса
B: Отверстие для винта на потолочном кронштейне (отверстие ◇)
C: Отверстие для винта
D: Потолок
E: Монтажная пластина

Закрепите кронштейн корпуса в потолочном кронштейне тремя винтами со стопорами (M3×8) из
комплекта поставки.

9
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Затем установите объектив. См. раздел “Присоединение объектива” с учетом информации из разделов “Меры
предосторожности при установке и снятии объектива”, “Проверка переключателей объектива” и “Меры
предосторожности при использовании объективов с масштабированием”.

Примечание

Для правильной работы поворота/наклона при установке устройства на потолке задайте для параметра [Pan-Tilt] >
[Direction] > [Ceiling] в веб-меню значение [On].

После установки объектива проверьте надежность его крепления.
Для объектива нет никакой страховки от падения. Компания Sony не несет никакой ответственности за падение
объектива с устройства.

См. также

Проверьте состояние установки.

В частности, проверьте следующее.

Правильность установки винтов крепления.
Правильность установки страховочного тросика без скручивания.
Горизонтальность установки устройства (без наклона или шатания).
При повороте устройство не начинает свободно поворачиваться.

10
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Меры предосторожности при установке и снятии объектива

Проверка переключателей объектива

Меры предосторожности при использовании объективов с масштабированием

Присоединение объектива

5-041-958-03(1) Copyright 2022 Sony Corporation
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Меры предосторожности при установке и снятии объектива

Не оставляйте объектив на солнечном свете. Прямые солнечные лучи могут пройти через объектив,
сфокусироваться в устройстве и привести к возгоранию.

Примечание

Присоединять и снимать объектив следует, когда питание устройства отключено.

Объектив является точным прибором. Не кладите объектив на поверхность байонетом вниз. Устанавливайте входящую в
комплект поставки крышку байонета объектива.

Совет

Подробные сведения о том, какие объективы поддерживает устройство, можно получить у представителя службы
технического обслуживания компании Sony.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Проверка переключателей объектива

В зависимости от типа объектива, необходимо выполнить следующие проверки и настройки.

Для объективов с переключателем режима фокусировки

Установите переключатель в положение AF/MF или AF.
Если переключатель фокусировки на объективе установлен в положение MF или Full MF, фокус может
настраиваться только при помощи кольца объектива.

Примечание

При использовании объектива с байонетом A ручная настройка с пульта дистанционного управления может быть
недоступна.

Для объективов с переключателем масштабирования

Установите переключатель в положение SERVO.
Если переключатель установлен в положение MANUAL, масштабирование может настраиваться только с
помощью кольца масштабирования. Управление масштабированием с устройства не работает.

Для объективов с переключателем Auto Iris

Установите переключатель в положение AUTO.
Если этот переключатель не установлен в положение AUTO, диафрагма может настраиваться только при помощи
кольца объектива. Регулировка диафрагмы с устройства не работает.

Для объективов с переключателем стабилизации изображения

Установите переключатель в положение OFF.
Если этот переключатель установлен в положение ON, поведение во время операции поворота/наклона может
отличаться от ожидаемого.

SELP28135G

A: Переместите кольцо фокусировки в переднее положение (режим AF/MF).
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B: Установите переключатель ZOOM в положение SERVO.
C: Установите кольцо диафрагмы в положение “A”, а переключатель IRIS LOCK — в положение LOCK.
D: Установите переключатель стабилизации изображения в положение OFF.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Меры предосторожности при использовании объективов с масштабированием

При использовании объективов с масштабированием (кроме объективов с сервоприводом масштабирования)
положение масштабирования может изменяться в зависимости от среды, в которой установлено устройство.
Закрепите кольцо масштабирования в требуемом положении с помощью ленты в соответствии с назначением
камеры.

Пластиковая пленка: 471 BLA 50 или аналогичная

5-041-958-03(1) Copyright 2022 Sony Corporation
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Присоединение объектива

В этом разделе рассматривается порядок установки объектива с байонетом E или A.

Примечание

Не транспортируйте устройство с установленным объективом.

При использовании объективов с байонетом A диафрагма устанавливается вручную, а для фокусировки устанавливается
режим MF.

Переместите рычаг блокировки поворота/наклона в положение LOCK, чтобы заблокировать поворот/
наклон головки камеры.

Примечание

Если поворот/наклон головки камеры не блокируется при установке рычага блокировки в положение LOCK, вручную
перемещайте головку камеры, пока она не зафиксируется.

1

Поверните рычаг зажима винта крепления основания опоры объектива против часовой стрелки,
чтобы освободить блокировку, затем переместите винт крепления основания опоры объектива в
положение, в котором он не будет мешать движению объектива.

2
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A: Правильно
B: Неправильно

Поверните рычаг блокировки головки камеры в направлении стрелки, чтобы разблокировать
головку камеры.

Примечание

Пока головка камеры не будет снова заблокирована, имеется опасность, что она будет перемещаться под своим
собственным весом. Во время выполнения операции придерживайте головку камеры рукой.

3

Сдвиньте головку камеры в самое переднее положение.4
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Поверните рычаг блокировки головки камеры в направлении стрелки, чтобы заблокировать головку
камеры.

Примечание

Во избежание помех наклону следите за тем, чтобы рычаг блокировки головки камеры не касался других частей
камеры.

5

Снимите колпачок и крышку с устройства и объектива.6

Совместите установочную метку (белую) на объективе с устройством, аккуратно вставьте объектив в
головку камеры, затем поверните объектив по часовой стрелке до щелчка в фиксированном
положении.

A: Установочные метки (белые)

Примечание

Для использования объективов с байонетом A сначала установите адаптер байонета объектива (не входит в
комплект поставки) на устройство, затем установите объектив с байонетом A.

7

Поверните рычаг блокировки головки камеры в направлении стрелки, чтобы разблокировать
головку камеры.

8
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Примечание

Пока головка камеры не будет снова заблокирована, имеется опасность, что она будет перемещаться под своим
собственным весом. Во время выполнения операции придерживайте головку камеры рукой.

Подберите баланс головки камеры вперед/назад, чтобы основание с направляющими было
расположено горизонтально.

Если используется один из перечисленных ниже объективов, устройство и объектив можно грубо
сбалансировать по шкале на основании с направляющими.

9

Положение на шкале Название объектива

0,5 SEL70200GM (с установленным конвертером SEL20TC)

1,7 SEL70200GM

2,0 SEL70200GM2 (с установленным конвертером SEL20TC)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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Примечание

Используйте шкалу на основании с направляющими для грубой балансировки.

При установке объектива выполните соответствующую регулировку баланса, чтобы устройство не наклонялось
назад или вперед.

Настраивайте баланс на горизонтальной поверхности.

При использовании SELC1635G снимите блок опоры объектива.

Положение на шкале Название объектива

5,0 и более SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Поверните рычаг блокировки головки камеры в направлении стрелки, чтобы заблокировать головку
камеры.

Примечание

Во избежание помех наклону следите за тем, чтобы рычаг блокировки головки камеры не касался других частей
камеры.
Способ проверки: переместите рычаг блокировки поворота/наклона в положение UNLOCK, рукой поверните камеру
таким образом, чтобы она была направлена вверх, визуально убедитесь в том, что рычаг не касается других частей.
Если он касается их, снова поверните рычаг блокировки головки камеры в направлении, указанном стрелкой.

10

Поверните рычаги зажима опоры объектива против часовой стрелки, чтобы освободить блок опоры
объектива.

11

96



A: Рычаг зажима штанги опоры объектива (2 места)
B: Блок опоры объектива

Переместите блок опоры объектива, чтобы основание опоры объектива совместилось с винтом
крепления основания опоры объектива, затем вращайте винт по часовой стрелке для фиксации
основания опоры объектива.

Примечание

Убедитесь, что основание опоры объектива перпендикулярно винту крепления основания опоры объектива, затем
затяните винт.

12

Поверните рычаг зажима винта крепления основания опоры объектива по часовой стрелке, чтобы
заблокировать этот винт.

A: Винт крепления основания опоры объектива
B: Отверстие под винт крепления
C: Рычаг зажима винта крепления основания опоры объектива

Совет

Если рычаг зажима находится в положении, в котором сложно поворачивать винт, освободите рычаг зажима и
поверните его под углом, упрощающим выполнение операции. Когда винт будет в нужном положении, закройте

13
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См. также
Калибровка объектива с байонетом E

5-041-958-03(1) Copyright 2022 Sony Corporation

рычаг зажима.

A: Рычаг зажима винта крепления основания опоры объектива
B: Рычаг зажима штанги опоры объектива

Поверните два рычага зажима штанги опоры объектива по часовой стрелке, чтобы зафиксировать
блок опоры объектива.

14

Убедитесь, что оба рычага затянуты и не болтаются, объектив правильно установлен и
переключатели на объективе установлены в правильные положения.

Если рычаг не затянут или объектив неправильно установлен, объектив может упасть и получить
повреждения.
При использовании объектива с сервоприводом масштабирования и байонетом E этот объектив также
необходимо отдельно откалибровать, чтобы точно восстанавливать положения масштабирования,
хранящиеся в камере в качестве предварительно заданных положений. Подробные сведения см. в
разделе “Калибровка объектива с байонетом E”.

15

98



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Снятие объектива

Объектив снимается в порядке, обратном порядку его установки.

Примечание

Надежно держите объектив рукой, чтобы он не упал.

Если не планируется сразу же установить другой объектив, обязательно установите крышку корпуса.

См. также

Присоединение объектива

5-041-958-03(1) Copyright 2022 Sony Corporation

Убедитесь, что поворот/наклон заблокированы.1

Поверните рычаг зажима винта крепления блокировки против часовой стрелки, чтобы освободить
блокировку.

2

Снимите винт крепления основания опоры объектива на блоке опоры объектива и переместите его в
положение, в котором он не мешает снятию объектива.

3

Разблокируйте головку камеры и сдвиньте ее в самое переднее положение.

Подробнее см. в шагах с 3 по 5 раздела “Присоединение объектива”.

4

Нажав и удерживая кнопку отсоединения объектива, поверните объектив против часовой стрелки,
поддерживая его.

5

Когда установочные метки (белые) на камере и объективы совместятся, потяните объектив вперед.6
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Подключение кабелей

В этом разделе рассматриваются подключения кабелей.

5-041-958-03(1) Copyright 2022 Sony Corporation

Подключите требуемые кабели к разъемам на задней панели.

Чтобы исключить отсоединение кабеля HDMI, выверните крепежный винт для пластины крепления кабеля
HDMI (M2.6×6, черный) из блока разъемов и закрепите входящую в комплект поставки пластину крепления
кабеля HDMI с помощью крепежного винта. Закрепите кабель HDMI на пластине крепления кабеля HDMI
кабельной стяжкой или хомутом из числа имеющихся в продаже.

A: Крепежный винт для пластины крепления кабеля HDMI (M2.6×6, черный)
B: Кабельная стяжка или хомут из числа имеющихся в продаже
C: Пластина крепления кабеля HDMI (из комплекта поставки)

1
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Подключение данного устройства к сетевому устройству по проводному
подключению

В этом разделе рассматривается подключение данного устройства к сетевому устройству по проводному
подключению.

5-041-958-03(1) Copyright 2022 Sony Corporation

Подключите данное устройство к сетевому устройству (например, к точке доступа Wi-Fi или
концентратору-коммутатору) с помощью кабеля локальной сети категории 5e или выше.

1
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Использование электропитания переменного тока

В этом разделе рассматривается порядок питания устройства от сети переменного тока.

Переместите рычаг блокировки поворота/наклона в положение LOCK, чтобы заблокировать поворот/
наклон головки камеры.

1

Подсоедините адаптер переменного тока (входит в комплект поставки) к разъему DC IN на
устройстве, после чего подсоедините кабель питания (входит в комплект поставки) к источнику
питания переменного тока.

A: Разъем DC IN
B: Кабель питания
C: Адаптер переменного тока

2

Закрепите кабель адаптера переменного тока в зажиме для кабеля питания, чтобы исключить его
отсоединение.

Откройте зажим для кабеля питания, проложите кабель через зажим, как показано ниже, и закройте зажим.

3
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Примечание

Запрещается использовать любые другие адаптеры переменного тока или кабели питания, кроме входящих в комплект
поставки устройства. Подключение другого адаптера или кабеля питания может привести к возгоранию или неполадкам в
работе.

Не располагайте адаптер переменного тока в ограниченном пространстве, например, между стеной и мебелью.

A: Зажим для кабеля питания
B: Фиксатор зажима для кабеля питания
C: Кабель адаптера переменного тока

Убедитесь, что индикатор POWER перестал мигать зеленым цветом и постоянно горит зеленым
цветом и что запуск завершился.

Когда устройство нормально запущено и подключено к компьютерной сети, горит зеленый индикатор
NETWORK.

При использовании объектива, который не поддерживает поворот/наклон, заблокируйте рычаг
блокировки поворота/наклона и пропустите приведенные ниже шаги. Подробные сведения об
объективах, которые поддерживают поворот/наклон, можно получить у дилера или представителя
службы технического обслуживания компании Sony.

4

Переместите рычаг блокировки поворота/наклона в положение UNLOCK, чтобы разблокировать
поворот/наклон головки камеры.

5

Выполните сброс поворота/наклона.

Подробные сведения см. в разделе “Сброс поворота/наклона”.

6
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Не замыкайте металлические части вилки адаптера переменного тока. Это приведет к повреждению устройства.

Подсоединяйте адаптер переменного тока к ближайшему источнику питания переменного тока. Если во время работы
возникнет неисправность, сразу же отсоедините шнур питания от источника питания переменного тока.

Для отсоединения адаптера переменного тока от устройства возьмитесь за вилку и потяните ее. Если потянуть за кабель,
это может привести к неисправности.

См. также

Сброс поворота/наклона

5-041-958-03(1) Copyright 2022 Sony Corporation
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Использование питания PoE++

Когда данное устройство подключено к другому устройству, поддерживающему подачу питания по технологии
PoE++, питание на данное устройство подается по сетевому кабелю из числа имеющихся в продаже.
Такой способ позволяет подавать питание на данное устройство без прокладки кабелей питания в местах, в
которых нет розеток электропитания рядом с местом установки.

Переместите рычаг блокировки поворота/наклона в положение LOCK, чтобы заблокировать поворот/
наклон головки камеры.

1

Соедините данное устройство и устройство, поддерживающее подачу питания по технологии PoE++,
сетевым кабелем из числа имеющихся в продаже.

A: Сетевой кабель
B: Устройство, поддерживающее подачу питания по технологии PoE++

2

Убедитесь, что индикатор POWER перестал мигать зеленым цветом и постоянно горит зеленым
цветом и что запуск завершился.

Когда устройство нормально запущено и подключено к компьютерной сети, горит зеленый индикатор
NETWORK.

3
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Примечание

Данное устройство соответствует стандарту IEEE802.3bt, тип 4, класс 8. Подробные сведения о проверенных
устройствах, поддерживающих подачу питания по технологии PoE++, можно получить у дилера или представителя
службы технического обслуживания компании Sony.

Данное устройство поддерживает мягкую авторизацию (LLDP), но может потребоваться настройка сетевых устройств
(соответствующих стандарту IEEE802.3bt).

Не подключайте адаптер переменного тока при использовании питания по технологии PoE++ с включенной мягкой
аутентификацией (LLDP).

Если адаптер переменного тока и устройство подачи питания по технологии PoE++ подключены одновременно, питание
подается от адаптера переменного тока.

При подаче питания по технологии PoE++ используйте сетевой кабель категории 5e или выше.

Подождите около 10 секунд после повторного включения устройства при подаче питания по технологии PoE++.

При использовании подачи питания по технологии PoE++ подключите клемму заземления к заземлению.

При подключении с питанием по технологии PoE++ не прокладывайте кабели вне помещений.

См. также

Сброс поворота/наклона

5-041-958-03(1) Copyright 2022 Sony Corporation

Примечание

Когда питание подается по технологии PoE++, исходная аутентификация выполняется в течение интервала до
завершения запуска.

При использовании объектива, который не поддерживает поворот/наклон, заблокируйте рычаг блокировки поворота/
наклона и пропустите приведенные ниже шаги. Подробные сведения об объективах, которые поддерживают
поворот/наклон, можно получить у дилера или представителя службы технического обслуживания компании Sony.

Переместите рычаг блокировки поворота/наклона в положение UNLOCK, чтобы разблокировать
поворот/наклон головки камеры.

4

Выполните сброс поворота/наклона.

Подробные сведения см. в разделе “Сброс поворота/наклона”.

5
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Сброс поворота/наклона

Сброс поворота/наклона, например при замене объектива, можно выполнять с помощью приведенной ниже
процедуры.

5-041-958-03(1) Copyright 2022 Sony Corporation

Переместите рычаг блокировки поворота/наклона в положение UNLOCK и убедитесь, что поворот/
наклон головки камеры разблокированы.

1

Выполните функцию сброса поворота/наклона.

Сброс поворота/наклона можно выполнять с помощью инфракрасного пульта управления, веб-приложения
или пульта дистанционного управления RM-IP500 (приобретается дополнительно).

С помощью инфракрасного пульта управления: нажмите кнопку P/T RESET.
С помощью веб-приложения: нажмите кнопку  (Сброс поворота/наклона) на вкладке  (Others)
на панели управления камерой на операционном экране.
С помощью пульта RM-IP500: см. инструкцию по эксплуатации пульта RM-IP500.

Примечание

При выполнении сброса поворота/наклона головка камеры и объектив поворачиваются. Перед выполнением
убедитесь, что движению объектива ничего не мешает.

В устройстве предусмотрена функция, которая ограничивает диапазон поворота/наклона, но при включении
устройства или при выполнении сброса поворота/наклона эта функция отключается.

Совет

После завершения сброса поворота/наклона устройство возвращается в положение, в котором оно находилось до
выполнения операции.

2
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Доступ к веб-приложению из веб-браузера

Подключив устройство к планшету или компьютеру, можно управлять устройством и настраивать его из веб-
браузера.

Проверьте, поддерживает ли планшет или компьютер работу с веб-приложением.

Примечание

Если требования к среде не удовлетворяются или планшет/компьютер сильно загружены, это может неблагоприятно
повлиять на отображение видео в веб-браузере.

В веб-приложении этого устройства используется язык JavaScript. Если на планшете или компьютере установлено
антивирусное программное обеспечение, веб-страница может отображаться неправильно.

1

Пункт Требование

Отображение

Рекомендуется разрешение 1080×810 пикселов
и более
Размер экрана планшета: рекомендуется
10 дюймов и более

Поддерживаемые ОС и веб-
браузеры

Windows

ОС Windows 10 или более поздняя версия

Веб-
браузер

Google Chrome

Mac

ОС macOS 10.15 или более поздняя версия

Веб-
браузер

Google Chrome
Safari

iPad

ОС iPadOS 15 или более поздняя версия

Веб-
браузер

Google Chrome
Safari

Android

ОС Android 12 или более поздняя версия

Веб-
браузер

Google Chrome

Убедитесь, что устройство, планшет или компьютер и периферийные устройства включены.2

Убедитесь, что устройство и планшет или компьютер подключены к сети Wi-Fi или проводному
подключению локальной сети.

3

Подключитесь к устройству из веб-браузера планшета или компьютера.

Подключение с использованием QR-кода

4
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Примечание

Если номер порта HTTP был изменен на значение, отличное от 80, введите в адресную строку “http://IP-адрес
устройства:Номер порта”.

При подключении с помощью QR-кода или путем ввода URL-адреса в адресную строку веб-браузера используйте

устройство, поддерживающее mDNS*.

Совет

Впоследствии для быстрого доступа к устройству можно использовать функцию закладок веб-браузера.

5-041-958-03(1) Copyright 2022 Sony Corporation

С помощью камеры планшета отсканируйте QR-код, напечатанный на крышке отсека носителей на боковой
стороне устройства.

Откройте появившуюся на планшете ссылку.
В веб-браузере на планшете должен запуститься и открыться экран веб-приложения устройства.

Подключение путем ввода URL-адреса в адресную строку веб-браузера
Запустите веб-браузер на планшете или компьютере и введите URL-адрес, напечатанный на крышке отсека
носителей на боковой стороне устройства.
В веб-браузере должен появиться экран веб-приложения устройства.

Подключение путем ввода IP-адреса устройства в адресную строку веб-браузера
Запустите веб-браузер на планшете или компьютере и введите в адресную строку “http://IP-адрес
устройства”.
В веб-браузере должен появиться экран веб-приложения устройства.

mDNS: протокол связи, используемый для определения IP-адреса по имени узла в локальной сети.*
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Инициализация устройства

При первом использовании устройства обязательно настройте его в соответствии с приведенной ниже
процедурой.

Совет

Если элемент резервного питания будет полностью разряжен, потребуется заново выполнить начальную настройку.

Подключитесь к устройству с планшета или компьютера и запустите веб-приложение.

При первом использовании устройства будет предложено ввести имя пользователя и пароль для веб-
браузера. Введите следующие параметры.

Имя пользователя: admin
Пароль: (оставьте пустым)

Выполните начальную настройку в соответствии с инструкциями на экране.

1

Введите имя пользователя и пароль администратора (Administrator) и нажмите кнопку [OK].

1: Введите имя пользователя для администратора.
2: Задайте пароль администратора.
3: Введите тот же пароль еще раз для подтверждения.

Примечание

В имени пользователя и пароле допускается использовать следующие символы. В составе пароля длиной от 8 до
64 символов должны быть как минимум одна буква в верхнем регистре, одна буква в нижнем регистре и одна
цифра.

2
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Появляется экран реального времени для съемки. Переходите к настройке основных операций устройства в
соответствии с режимом работы.

Совет

В некоторых случаях, например при использовании устройства в паре с планшетом, может быть проще использовать
фиксированный IP-адрес для устройства.

Буквенно-цифровые символы
Символы (!$%`*+-./<=>?@[]^_{|}~)

Веб-браузер будет перезагружен, и вам будет предложено ввести имя пользователя и пароль.

Введите имя пользователя и пароль, которые были настроены на шаге 2.

Откроется экран задания языка и времени.

3

Укажите следующие элементы и нажмите кнопку [OK].

[Language]
Выберите язык, который будет использоваться при отображении экранов Веб-приложения и камеры. При
изменении языка меняется язык, на котором отображается интерфейс Веб-приложения.
[Date & Time Format]
Выберите формат отображения даты и времени из следующих вариантов.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
“yyyy” обозначает год, “mm” обозначает месяц, “dd” обозначает день, “hh” обозначает час, “mm” обозначает
минуты и “ss” обозначает секунды, соответственно.
[12 h/24 h]
Выберите [12 h] (12-часовой формат) или [24 h] (24-часовой формат) для отображения времени.
[Time Setting]
Выберите метод настройки даты и времени.
[Synchronize with PC]: синхронизация с датой и временем, заданными в компьютере или планшете.
[Manual setting]: задание вручную. Если выбран этот метод, появляются поля для даты и времени.
[Time Zone]
Выберите часовой пояс.

4
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Чтобы задать фиксированный IP-адрес, вначале отключите параметр [Network] > [Wired LAN] > [IPv4] > [DHCP] (сдвиньте
переключатель в левое положение) в веб-меню.

Отобразятся пункты настройки, относящиеся к фиксированному IP-адресу. Настройте пункты и нажмите кнопку [OK] на
экране.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Настройка основных операций

В этом разделе рассматривается порядок настройки основных операций устройства.

Установка режима съемки

Можно выбрать режим съемки устройства, наиболее соответствующий особенностям вашей работы.

Режим Custom: гибкое создание изображений во время съемки.
Режимы Log-съемки: запись содержимого с гаммой S-Log.

Режим Flexible ISO: параметры экспозиции задаются путем корректировки значения ISO в соответствии со
снимаемой сценой.
Режим Cine EI/режим Cine EI Quick: использование устройства аналогично кинокамере (неполное создание
изображения в процессе съемки), когда отснятый материал монтируется в студии.

В режиме Cine EI Quick базовая чувствительность, соответствующая настроенному индексу экспозиции,
выбирается автоматически.
Режимы переключаются в пункте [Project] > [Base Setting] > [Shooting Mode] веб-меню или меню камеры.

Режим Custom
Позволяет выбрать видеостандарт.
Переключение производится в пункте [Project] > [Base Setting] > [Target Display] веб-меню или меню камеры.

[SDR(BT.709)]: съемка в соответствии со стандартом вещания HD
[HDR(HLG)]: съемка в соответствии со стандартом вещания нового поколения 4K

Подробнее см. в пункте “Обзор видов” и других темах раздела “Съемка с требуемым видом”.

Режимы Log-съемки
(режим Flexible ISO/режим Cine EI/режим Cine EI Quick)
В режимах Log-съемки можно выбрать базовую цветовую гамму для записываемых и выходных сигналов.
Выбранная здесь цветовая гамма используется для выходного видеосигнала, когда для параметра [LUT On/Off]
задано значение [MLUT Off].
Изменить цветовую гамму можно в пункте [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] меню камеры.

[S-Gamut3.Cine/SLog3]: простая в настройке цветовая гамма для цифровой камеры (DCI-P3).
[S-Gamut3/SLog3]: широкая гамма цветов Sony, которая охватывает цветовую гамму ITU-R BT.2020.

Подробные сведения см. в разделе “Съемка с последующей регулировкой вида в студии”.
 
Поддерживаемые функции в каждом режиме съемки приведены в следующей таблице.
●: поддерживается; –: не поддерживается

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –
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Совет

В режимах Cine EI Quick и Cine EI съемка производится при базовой чувствительности ISO без усиления, чтобы
максимально эффективно использовать датчик изображения. Яркость настраивается с помощью освещения и фильтра
нейтральной плотности, чтобы регулировать количество света, попадающего на датчик изображения.

Задание частоты системы

Переключение производится в пункте [Project] > [Rec Format] > [Frequency] веб-меню или меню камеры. В
зависимости от выбранного значения, устройство может автоматически перезагрузиться после переключения.

Примечание

Переключение частоты системы во время записи или воспроизведения невозможно.

Задание режима Imager Scan Mode

Можно задать эффективный размер изображения и разрешение датчика изображения.
Переключение производится в пункте [Project] > [Rec Format] > [Imager Scan Mode] веб-меню или меню камеры.
[FF]: полнокадровый размер.
[S35]: размер Super 35mm.

Примечание

Переключение режима Imager Scan Mode во время записи или воспроизведения невозможно.

Если задано значение S35, видеоформат ограничен значением 1920×1080.

Задание кодека

Можно задать кодек для записи.
Переключение производится в пункте [Project] > [Rec Format] > [Codec] веб-меню или меню камеры.

Примечание

Переключение кодека во время записи или воспроизведения невозможно.

Задание видеоформата

Можно задать видеоформат для записи и формат вывода для вывода сигнала из камеры.

Custom Flexible ISO Cine EI Cine EI Quick

Base ISO – ● ● ● (привязано к EI)

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(кроме Base Look)

● – – –
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Формат видео для записи переключается в пункте [Project] > [Rec Format] > [Video Format] веб-меню или меню
камеры.
Формат выходного сигнала с разъемов SDI OUT и HDMI OUT выбирается с помощью пункта [Monitoring] >
[Output Format] в веб-меню или меню камеры.

Примечание

Переключение видеоформата во время записи или воспроизведения невозможно.

В зависимости от настройки видеоформата могут накладываться ограничения на сигнал, выводимый на разъемы SDI
OUT и HDMI OUT.

См. также

Обзор видов

Съемка с последующей регулировкой вида в студии

5-041-958-03(1) Copyright 2022 Sony Corporation
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Поддерживаемые карты памяти

Устройство записывает аудио- и видеосигналы на карты памяти CFexpress Type A (не входят в комплект поставки)
или SDXC (не входят в комплект поставки), которые вставляются в гнезда для карт. Карты памяти также
используются для записи прокси.

Карты памяти CFexpress Type A

Используйте в устройстве карты памяти Sony CFexpress Type A*, перечисленные в разделе “Рекомендуемые
носители для записи”.
Подробные сведения о работе с носителями других производителей см. в инструкции по эксплуатации носителей
или в информации от производителя.

Карты памяти SDXC

Используйте в устройстве карты памяти SDXC*, перечисленные в разделе “Рекомендуемые носители для
записи”.

Рекомендуемые носители для записи

Условия гарантированной работы зависят от формата записи (Rec Format) и настроек записи (Recording).

CFexpress Type A
Совместимые со стандартом VPG400
Поддерживаются для всех форматов записи, предусмотренных в устройстве.

SDXC
Поддерживаются при условиях, указанных в приведенной ниже таблице. “●” означает, что работа была
проверена, “–” означает, что работа не гарантируется.

RAW Out & XAVC-I, 4096×2160, класс 300, обычный режим

RAW Out & XAVC-I, 3840×2160, класс 300, обычный режим

В этом справочном руководстве такие карты памяти называются “карты CFexpress”.*

В этом справочном руководстве такие карты памяти называются “карты SD”.*

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●
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RAW Out & XAVC-I, 3840×2160, класс 300, S&Q (60 кадров/с или ниже)

RAW Out & XAVC-I, 3840×2160, класс 300, S&Q (100 кадров/с, 120 кадров/с)
Проверенный носитель недоступен.

XAVC-I, 4096×2160, класс 300, обычный режим

XAVC-I, 4096×2160, класс 300, S&Q (60 кадров/с или ниже)

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●
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XAVC-I, 3840×2160, класс 300, обычный режим

XAVC-I, 3840×2160, класс 300, S&Q (60 кадров/с или ниже)

XAVC-I, 3840×2160, класс 300, S&Q (100 кадров/с, 120 кадров/с)
Проверенный носитель недоступен.

XAVC-I, 1920×1080, класс 100, обычный режим

XAVC-I, 1920×1080, класс 100, S&Q (60 кадров/с или ниже)

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

24P – – – – – – ●

23.98P – – – – – – ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I, 1920×1080, класс 100, S&Q (100 кадров/с, 120 кадров/с)

XAVC-I, 1920×1080, класс 100, S&Q (150 кадров/с, 180 кадров/с)
Проверенный носитель недоступен.

XAVC-I, 1920×1080, класс 100, S&Q (200 кадров/с, 240 кадров/с)
Проверенный носитель недоступен.

XAVC-L, 3840×2160 420, обычный режим

XAVC-L, 3840×2160 420, S&Q (60 кадров/с или ниже)

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC- L, 3840×2160 420, S&Q (100 кадров/с, 120 кадров/с)

XAVC-L, 1920×1080 HD50, обычный режим

XAVC-L, 1920×1080 HD50, S&Q (60 кадров/с или ниже)

XAVC-L, 1920×1080 HD50, S&Q (100 кадров/с, 120 кадров/с)

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 кадров/с, 180 кадров/с)

XAVC-L, 1920×1080 HD50, S&Q (200 кадров/с, 240 кадров/с)

XAVC-L, 1920×1080 HD35, обычный режим

XAVC-L, 1920×1080 HD35, S&Q (60 кадров/с или ниже)

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 кадров/с, 120 кадров/с)

XAVC-L, 1920×1080 HD35, S&Q (150 кадров/с, 180 кадров/с)

XAVC-L, 1920×1080 HD35, S&Q (200 кадров/с, 240 кадров/с)

5-041-958-03(1) Copyright 2022 Sony Corporation

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Частота системы Класс 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Установка карт памяти

В этом разделе рассматриваются меры предосторожности при установке карт памяти.

Откройте крышку отделения с гнездами для карт памяти.1

Установите карту памяти.

Для карт CFexpress этикетка обращена вверх.

Примечание

Для устройств, установленных на потолке, этикетка обращена вниз.

Для карт SD этикетка обращена вниз.

Примечание

Для устройств, установленных на потолке, этикетка обращена вверх.

Индикатор доступа загорится красным, после чего его цвет изменится на зеленый, если карта является
работоспособной.

2

123



Примечание

Сама карта памяти, гнездо для карт памяти и данные, записанные на карту памяти могут быть повреждены, если
вставлять карту в гнездо с усилием, когда она неправильно ориентирована.

При записи в оба гнезда для карт памяти CFexpress Type A / SD (A и B) вставляйте носители, рекомендуемые для работы
с соответствующим форматом.

5-041-958-03(1) Copyright 2022 Sony Corporation

Примечание

Если индикатор доступа постоянно мигает красным и не становится зеленым, выключите устройство на время,
выньте и вставьте опять карту памяти.

Закройте крышку носителя.3
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Извлечение карты памяти

Откройте крышку отделения с гнездами для карт памяти и слегка нажмите на карту памяти, чтобы извлечь ее.

Примечание

Если устройство выключается, когда карта памяти используется, или карта памяти извлекается в этот момент,
целостность находящихся на карте памяти данных не гарантируется. Все данные, записанные на карту памяти, могут
быть потеряны. Перед выключением устройства или извлечением карты памяти всегда необходимо убедиться, что
индикатор доступа горит зеленым цветом или не горит.

При извлечении карты памяти сразу после завершения съемки она может быть горячей, но это не указывает на
неисправность.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Форматирование (инициализация) карт памяти

Если в устройство вставить неформатированную карту памяти или карту памяти, которая была отформатирована
в другой системе, на панели изображения с камеры откроется сообщение “Media Needs to be Formatted”
(Носитель необходимо отформатировать).
Для форматирования карты выполните следующую процедуру.

Примечание

При форматировании карты памяти все находящиеся на ней данные, в том числе записанные видеоклипы и файлы
настройки, стираются.

В зависимости от длительности процесса форматирования во время его выполнения могут отображаться сообщения.

Если выполнить форматирование не удалось
Карты памяти, которые не поддерживаются устройством, нельзя отформатировать.
На экране появится сообщение с предупреждением. Выполните инструкции по замене карты на поддерживаемую
карту памяти.

Использование карты памяти, отформатированной в устройстве, в гнезде другого устройства
Прежде всего, создайте резервную копию находящихся на карте данных, затем отформатируйте карту на том
устройстве, где она будет использоваться.

5-041-958-03(1) Copyright 2022 Sony Corporation

Выберите пункт [TC/Media] > [Format Media] в меню камеры.1

Выберите Media(A) (гнездо A) или Media(B) (гнездо B), затем выберите способ форматирования (Full
Format или Quick Format).

Отображается сообщение с запросом подтверждения.
[Full Format]: полная инициализация носителя, включая регион данных и информацию управления
данными.
[Quick Format]: только инициализация информации управления данными носителя.

2

Выберите [Execute].

Во время выполнения форматирования на экране отображается сообщение, а индикатор доступа горит
красным.
После завершения форматирования отображается сообщение.

3

126



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Проверка оставшегося времени записи

При съемке (записи/в режиме ожидания) можно отслеживать оставшееся свободное место на картах памяти,
установленных в гнезда, по индикаторам оставшейся емкости носителей A и B, которые отображаются на панели
изображения с камеры.
Оставшееся время записи вычисляется по оставшейся емкости носителей, установленных в каждом гнезде, и
текущему формату записи (скорости передачи данных при записи). Оно отображается в минутах.

Время замены карты памяти
Когда общее оставшееся время записи на обеих картах памяти становится менее 5 минут, на экране появляется
сообщение “Media Near Full” (Носитель почти заполнен) и индикатор записи/съемки начинает мигать.
Замените на носитель с достаточным свободным местом.
Если продолжить запись до тех пор, пока вся емкость не будет исчерпана, то на экране появится сообщение
“Media Full” (Носитель заполнен) и запись будет остановлена.

Примечание

На одну карту памяти можно записать приблизительно 600 клипов.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Восстановление карт памяти

Если по какой-либо причине на карте памяти произойдет ошибка, эту карту необходимо восстановить перед
использованием.
При загрузке карты памяти, которая требует восстановления, на панели изображения с камеры отображается
сообщение с запросом, нужно ли восстановить карту.

Восстановление карты
Кнопками со стрелками выберите [Execute] на панели управления графическим пользовательским интерфейсом и
нажмите кнопку [Set].
Во время форматирования на экране отображается сообщение и ход выполнения (%), а индикатор доступа горит
красным.
После завершения восстановления отображается сообщение.

В случае сбоя восстановления
Карты памяти, на которых возникли ошибки памяти, не могут быть восстановлены. На экране появится
сообщение с предупреждением. Выполните инструкции по замене карты памяти.
При повторном форматировании карт памяти, на которых возникли ошибки памяти, эти карты могут стать
пригодными для использования.
В некоторых случаях какие-то клипы могут быть восстановлены, а другие — нет. Восстановленные клипы
воспроизводятся нормально.

Примечание

Восстановление носителя, записанного в данном устройстве, обязательно выполняйте с помощью данного устройства.

С помощью данного устройства невозможно восстановить носитель, записанный в другом устройстве или в подобном
устройстве другой версии (даже этой же модели).

Восстановление клипов длительностью менее 2 с невозможно.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Запуск/остановка записи

В этом разделе рассматривается порядок запуска и остановки записи.

Присоедините необходимые устройства и удостоверьтесь в том, что на данное устройство и
периферийные устройства подается питание.

1

Вставьте карты памяти.2

Проверьте состояние питания устройства в левом верхнем углу экрана веб-приложения.

Когда питание включено
Когда устройство включено, на переключателе питания вверху экрана веб-приложения отображается [Power
ON].

На передней панели устройства загорается индикатор POWER, и на операционном экране веб-приложения
появляется изображение с камеры.

Примечание

Если пароль администратора не настроен, появляется экран, предлагающий настроить этот пароль. См. раздел
“Инициализация устройства”.

Когда питание находится в состоянии ожидания
Когда питание устройства находится в состоянии ожидания, на переключателе питания в веб-приложении
отображается индикатор [Power Standby].

В этом состоянии нажмите переключатель питания и выберите [Power ON]. Устройство включается, на его
передней панели загорается зеленым индикатор POWER, и на операционном экране веб-приложения
появляется изображение с камеры.

3
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Переключение питания устройства в состояние ожидания
Нажмите переключатель питания в веб-приложении и выберите [Power Standby], чтобы перевести питание
устройства в режим ожидания.

Совет

Совет

Устройство можно также включить кнопкой питания на инфракрасном пульте управления, входящем в комплект
поставки.

Нажмите кнопку START/STOP (пуск/остановка записи).

Начинается запись, и на устройстве загорается индикатор записи/съемки (в 2 местах).
Во время записи горит кнопка пуска/остановки записи START/STOP. Кроме того, отображаются значок
целевого носителя для записи и значок [●Rec].

4

Чтобы остановить запись, нажмите кнопку START/STOP (пуск/остановка записи) еще раз.

Запись останавливается, и индикатор записи/съемки (в 2 местах) на устройстве выключается.
В состоянии ожидания записи кнопка пуска/остановки записи START/STOP не горит. Кроме того,
отображаются значок целевого носителя для записи и значок [Stby].

Совет

Запись можно также запускать и останавливать с помощью кнопки пуска/остановки записи START/STOP на
инфракрасном пульте управления, входящем в комплект поставки.

5
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Режим ожидания для питания можно также установить кнопкой питания на инфракрасном пульте управления, входящем в
комплект поставки.

См. также
Инициализация устройства

5-041-958-03(1) Copyright 2022 Sony Corporation
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Переключение между картами памяти

Когда установлены две карты памяти, переключаться между ними можно с помощью кнопки [Slot Select] на
панели управления воспроизведением веб-приложения.

Совет

Между картами памяти можно также переключаться, нажимая кнопку SLOT SEL (выбор гнезда для карт памяти (A)/(B)) на
инфракрасном пульте управления из комплекта поставки.

О записи с переключением

Во время записи устройство автоматически переключается на вторую карту памяти непосредственно перед тем,
как оставшаяся емкость первой карты памяти уменьшится до нуля (запись с переключением). Можно продолжать
непрерывную съемку с переключением карт памяти, заменяя заполненную карту памяти новой.

Примечание

Переключаться между картами памяти в режиме воспроизведения нельзя. Кроме того, непрерывное воспроизведение
клипов с носителей, вставленных в гнезда A и B, не поддерживается.

О записанных данных

Когда запись останавливается, видео, звук и сопутствующие данные от начала до конца записи сохраняются в
виде единого “клипа” на карту памяти.

Имя клипа записанных данных

Имя каждого клипа, записанного устройством, автоматически назначается с использованием значения, заданного
в пункте [TC/Media] > [Clip Name Format] меню камеры.

Максимальная продолжительность клипа

До 6 часов на клип.
Максимальная длительность непрерывной съемки совпадает с максимальной длительностью клипа. Если время
съемки превышает максимальную длительность клипа, автоматически создается новый клип и съемка
продолжается. На экране эскизов новый клип отображается как отдельный клип.
Несколько клипов записывается последовательно во время записи с переключением карт, но запись
останавливается автоматически приблизительно через 24 часа.

Примечание

Не извлекайте карту памяти в тот момент, когда на нее ведется запись. Во время записи заменяйте карты памяти только
в гнездах, для которых не горит индикатор доступа к гнезду.

Когда на карте памяти, на которую выполняется запись, остается места менее чем на одну минуту видео, а в другое
гнездо вставлена доступная для записи карта памяти, на экране открывается сообщение “Will Switch Slots Soon” (Гнезда
скоро будут переключены). Это сообщение исчезнет после того, как переключение гнезд будет произведено.

Запись с переключением карт памяти может не работать, если запись запускается в тот момент, когда на карте памяти
осталось свободного места менее чем на одну минуту видео. Во избежание ошибок при выполнении записи с
переключением карт памяти перед началом записи удостоверьтесь, что на карте памяти осталось больше свободного
места, чем на одну минуту видео.
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На устройстве невозможно бесшовное воспроизведение видео, созданного устройством с использованием функции
записи с переключением.

Для объединения видео, записанного в данном устройстве с помощью функции записи с переключением, используйте
программное обеспечение Catalyst Browse.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Проверка звука

Звук выводится на разъемы SDI и HDMI устройства. Сочетание аудиоканалов, которые выводятся на разъем
HDMI, выбирается с помощью пункта [Audio] > [Audio Output] > [HDMI/Stream Output CH] в меню камеры.
CH1/CH2: сочетание каналов CH1 и CH2
CH3/CH4: сочетание каналов CH3 и CH4
При контроле звука в веб-приложении используйте индикатор уровня звука внизу справа от изображения с
камеры.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Указание данных времени

В этом разделе рассматривается порядок задания данных времени.

Установка временного кода

Задайте временной код для записи с помощью пункта [TC/Media] > [Timecode] в меню камеры.

Задание пользовательских битов

В записанное изображение можно добавить 8-значный шестнадцатеричный номер в виде пользовательских
битов. Можно также задать для пользовательских битов текущее время. Задание производится в пункте
[TC/Media] > [Users Bit] меню камеры.

Отображение данных времени

Задайте временной код для отображения с помощью пункта [TC/Media] > [TC Display] > [Display Select] в меню
камеры.
Нажатием программируемой кнопки, которой назначена функция [DURATION/TC/U-BIT], отображаемые на экране
данные последовательно переключаются между временным кодом, битами пользователя и продолжительностью.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Перемотка записи назад (Rec Review)

Последний записанный клип можно просмотреть на экране (просмотр записи).

Примечание

Функция Rec Review не будет работать при изменении формата видео после записи клипа.

Задание начальной позиции функции Rec Review

С помощью настройки [Technical] > [Rec Review] из меню камеры можно задать одну из следующих позиций
начала воспроизведения.

Последние 3 секунды клипа
Последние 10 секунд клипа
Начало клипа

Совет

Если требуется просмотреть конкретный клип после съемки нескольких клипов, нажмите кнопку [Thumbnail], чтобы
открыть экран эскизов, и выберите клип для начала воспроизведения.

Можно также нажать кнопку THUMBNAIL на входящем в комплект поставки инфракрасном пульте управления, чтобы
открыть экран эскизов.

Способ просмотра записи

Заранее назначьте функцию Rec Review одной из программируемых кнопок на панели настройки базовой
конфигурации.

Подробные сведения о назначении см. в пункте “Программируемые кнопки” раздела “Полезные функции”.

Остановите запись, затем нажмите программируемую кнопку, которой назначена функция просмотра записи,
чтобы начать воспроизведение ранее записанного клипа.
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Клип будет воспроизведен до конца, работа функции Rec Review будет завершена, и устройство вернется в
режим Stby (режим ожидания).

Остановка работы функции Rec Review
Нажмите программируемую кнопку, которой назначена функция Rec Review, или нажмите кнопку [Cancel/Back].
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Совет

Работу функции Rec Review можно также остановить, нажав кнопку [Cancel/Back] на входящем в комплект поставки
инфракрасном пульте управления.

См. также

Программируемые кнопки

5-041-958-03(1) Copyright 2022 Sony Corporation
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Экран настройки кадрирования

Кадрирование настраивается с помощью следующих частей операционного экрана.

Примечание

В зависимости от направления камеры, фокусного расстояния объектива и положения масштабирования могут быть
видны части устройства или кабели, подключенные к блоку разъемов. Перед съемкой проверяйте поле зрения для
используемого объектива и фокусного расстояния. Диапазоном поворота/наклона можно также управлять с помощью
пункта [Pan-Tilt] > [P/T Range Limit] в веб-меню. При включении устройства или при выполнении сброса поворота/наклона
это ограничение диапазона игнорируется. Подробные сведения см. в пункте [Pan-Tilt] > [P/T Range Limit] в веб-меню.

Совет

Кадрированием можно также управлять с помощью инфракрасного пульта управления из комплекта поставки.

5-041-958-03(1) Copyright 2022 Sony Corporation

Панель управления предварительно заданными положениями1.

Вкладка  (Main) / вкладка  (Others)2.

Панель управления кадрированием3.
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Настройка направления съемки с помощью веб-приложения

Горизонтальное перемещение камеры называется поворотом, вертикальное — наклоном.
Направление съемки можно настраивать с помощью операций поворота/наклона.

Совет

Если под джойстиком отображается сообщение [Execute Pan-Tilt Reset], это означает, что возникла несогласованность в
информации об исходной точке поворота/наклона устройства. Для обновления информации об исходной точке выполните
функцию сброса поворота/наклона. Подробные сведения см. в разделе “Сброс поворота/наклона”.

Чтобы снова направить камеру вперед
Нажмите кнопку  (Начальное положение поворота/наклона) на вкладке  (Others) на панели управления
камерой.

Примечание

В зависимости от направления камеры, фокусного расстояния объектива и положения масштабирования могут быть
видны части устройства или кабели, подключенные к блоку разъемов. Перед съемкой проверяйте поле зрения для
используемого объектива и фокусного расстояния. Диапазоном поворота/наклона можно также управлять с помощью
пункта [Pan-Tilt] > [P/T Range Limit] в веб-меню. При включении устройства или при выполнении сброса поворота/наклона
это ограничение диапазона игнорируется. Подробные сведения см. в пункте [Pan-Tilt] > [P/T Range Limit] в веб-меню.

См. также

Сброс поворота/наклона

Для отображения джойстика выберите вкладку  (Поворот/наклон/зум) на панели управления
кадрированием.

1

Контролируя панель изображения с камеры, перетащите центр джойстика в направлении, которое
требуется просматривать.

Направление и скорость перемещения камеры изменяются в соответствии с направлением и величиной
перетаскивания.
Для точной настройки поворота/наклона нажимайте периферийные области джойстика.

2
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Задание скорости работы поворота/наклона

Скорость выполнения поворота/наклона можно изменить ползунком [Pan-Tilt Speed] на панели управления
камерой с помощью джойстика на панели управления кадрированием.

Примечание

Если в диапазоне перемещения камеры имеется стена или другие препятствия, соблюдайте осторожность, чтобы камера
или объектив не ударились об них во время поворота/наклона.

Ускорение поворота/наклона зависит от физических характеристик, таких как баланс массы объектива. Настройку
ускорения можно изменить в пункте [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] веб-меню или меню камеры.

5-041-958-03(1) Copyright 2022 Sony Corporation

Нажмите вкладку  (Main) на панели управления камерой.1

Выберите в списке ползунок [Pan-Tilt Speed].

Если ползунок [Pan-Tilt Speed] не отображается, для его отображения выберите любую из двух кнопок
выбора функции ползунка.

2

Переместите ручку ползунка влево или вправо.

При перемещении ручки влево скорость работы уменьшается, при перемещении вправо — увеличивается.

3
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Задание ускорения при повороте/наклоне

В пункте [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] веб-меню или меню камеры можно задать одно из девяти
значений ускорения. Увеличьте это значение для более быстрого изменения скорости или уменьшите его для
более плавного изменения скорости.
Для повышения отзывчивости при использовании поворота/наклона выбирайте значение в диапазоне от 7 до 9.
Для повышения точности позиционирования в начала/конце перемещения в предварительно заданную позицию
рекомендуется задавать значение в диапазоне от 1 до 6.

Подробнее о предварительно заданном положении см. в разделе “Сохранение и восстановление положения
поворота/наклона и масштабирования”.

Примечание

Если установлено большое значение, функция может неправильно работать с тяжелыми объективами. Проверяйте
работу перед фактическим применением.

Взаимосвязь настройки [Ramp Curve] и работы функции поворота/наклона

При использовании поворота/наклона

При вызове предварительно заданного положения
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Настройка направления съемки с помощью инфракрасного пульта управления
из комплекта поставки

Направление съемки можно настраивать с помощью кнопок управления поворотом/наклоном на инфракрасном
пульте управления из комплекта поставки.

Чтобы снова направить камеру вперед
Нажмите кнопку HOME.

Примечание

В зависимости от направления камеры, фокусного расстояния объектива и положения масштабирования могут быть
видны части устройства или кабели, подключенные к блоку разъемов. Перед съемкой проверяйте поле зрения для
используемого объектива и фокусного расстояния. Диапазоном поворота/наклона можно также управлять с помощью
пункта [Pan-Tilt] > [P/T Range Limit] в веб-меню. При включении устройства или при выполнении сброса поворота/наклона
это ограничение диапазона игнорируется. Подробные сведения см. в пункте [Pan-Tilt] > [P/T Range Limit] в веб-меню.
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Нажимайте кнопки со стрелками для управления поворотом и наклоном.

Контролируя изображение с камеры, нажмите кнопку со стрелкой в направлении, в котором требуется
изменить угол обзора.
Для короткого перемещения нажмите и сразу отпустите кнопку со стрелкой.
Для перемещения на большое расстояние нажмите кнопку со стрелкой и удерживайте ее нажатой.
Для перемещения по диагонали нажмите и удерживайте кнопку  (стрелка вверх) или  (стрелка вниз) и
нажмите кнопку  (стрелка влево) или  (стрелка вправо).

1

145



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Установка типа масштабирования

Задайте тип масштабирования с помощью пункта [Technical] > [Zoom] > [Zoom Type] в меню камеры.
Тип масштабирования зависит от типа установленного объектива.

Примечание

Функция Clear Image Zoom недоступна в следующих случаях.

Если для параметра [Shooting] > [S&Q Motion] > [Setting] в меню камеры задано значение On, а значение настройки
[Frame Rate] больше 60 кадров/с
Если для параметра [Project] > [Rec Format] > [Codec] в меню камеры задано значение [RAW] или задан вариант,
который включает в себя RAW

При использовании переключателя выбора SERVO/MANUAL на объективе значение увеличения функции Clear Image
Zoom сбрасывается на 1×.

Во время работы Clear Image Zoom функция AF-S не поддерживается.

Clear Image Zoom

Устройство оснащено функцией масштабирования с обработкой сигнала изображения, называемой Clear Image
Zoom. Когда функция Clear Image Zoom включена, масштабирование поддерживается даже для объективов с
фиксированным фокусным расстоянием. Ее также можно использовать для расширения диапазона
масштабирования за пределы оптического диапазона на объективах с сервоприводом масштабирования.
Максимальный коэффициент масштабирования с помощью функции Clear Image Zoom зависит от разрешения
записи.

Для разрешения записи QFHD/4K: 1,5×
Для разрешения записи HD: 2×

5-041-958-03(1) Copyright 2022 Sony Corporation

Тип установленного объектива
Настройка [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Объектив с фиксированным фокусным
расстоянием/объектив с ручным
масштабированием

Операция масштабирования
не поддерживается.

Поддерживается функция Clear
Image Zoom.

Объектив с сервоприводом
масштабирования

Поддерживается только
оптическое
масштабирование.

Поддерживаются оптическое
масштабирование и функция Clear
Image Zoom.
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Настройка масштабирования с помощью веб-приложения

Масштабирование устройства можно настроить с использованием оптического масштабирования или с помощью
функции Clear Image Zoom. В этом разделе рассматривается порядок настройки масштабирования с помощью
веб-приложения. Подробные сведения о функции Clear Image Zoom см. в разделе “Установка типа
масштабирования”.

Примечание

В зависимости от направления камеры, фокусного расстояния объектива и положения масштабирования могут быть
видны части устройства или кабели, подключенные к блоку разъемов. Перед съемкой проверяйте поле зрения для
используемого объектива и фокусного расстояния. Диапазоном поворота/наклона можно также управлять с помощью
пункта [Pan-Tilt] > [P/T Range Limit] в веб-меню. При включении устройства или при выполнении сброса поворота/наклона
это ограничение диапазона игнорируется. Подробные сведения см. в пункте [Pan-Tilt] > [P/T Range Limit] в веб-меню.

Фактическая скорость и точность масштабирования зависят от объектива. Проверяйте работу перед применением.

Совет

Управлять масштабированием объектива с ручным масштабированием можно с помощью контроллера объектива
(приобретается дополнительно), совместимого с данным устройством. Подробнее см. в разделах “Подключение
контроллера объектива” и “Регулировка масштаба с помощью контроллера объектива”.

См. также

Установка типа масштабирования

Подключение контроллера объектива

Регулировка масштаба с помощью контроллера объектива

Для отображения панели управления поворотом/наклоном выберите вкладку  (Поворот/
наклон/зум) на панели управления кадрированием.

1

Для настройки масштабирования переместите ручку ползунка [Zoom] в направлении [T] (Телефото)
или [W] (Широкоугольный).

Скорость масштабирования изменяется с перемещением ползунка.

2
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Задание скорости работы масштабирования

Скорость выполнения масштабирования ползунком [Zoom] на панели управления кадрированием с помощью
ползунка [Zoom Speed] на панели управления камерой.

Примечание

Фактическая скорость и точность масштабирования зависят от объектива. Проверяйте работу перед применением.

5-041-958-03(1) Copyright 2022 Sony Corporation

Нажмите вкладку  (Main) на панели управления камерой.1

Выберите в списке ползунок [Zoom Speed].

Если ползунок [Zoom Speed] не отображается, для его отображения выберите любую из двух кнопок выбора
функции ползунка.

 

2

Переместите ручку [Zoom Speed] ползунка влево или вправо.

При перемещении ручки влево скорость работы уменьшается, при перемещении вправо — увеличивается.

3
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Настройка масштабирования с помощью инфракрасного пульта управления из
комплекта поставки

Масштабирование устройства можно настроить с использованием оптического масштабирования или с помощью
функции Clear Image Zoom. В этом разделе описывается порядок настройки с помощью инфракрасного пульта
управления из комплекта поставки. Подробные сведения о функции Clear Image Zoom см. в разделе “Установка
типа масштабирования”.

Примечание

В зависимости от направления камеры, фокусного расстояния объектива и положения масштабирования могут быть
видны части устройства или кабели, подключенные к блоку разъемов. Перед съемкой проверяйте поле зрения для
используемого объектива и фокусного расстояния. Диапазоном поворота/наклона можно также управлять с помощью
пункта [Pan-Tilt] > [P/T Range Limit] в веб-меню. При включении устройства или при выполнении сброса поворота/наклона
это ограничение диапазона игнорируется. Подробные сведения см. в пункте [Pan-Tilt] > [P/T Range Limit] в веб-меню.

Совет

Управлять масштабированием объектива с ручным масштабированием можно с помощью контроллера объектива
(приобретается дополнительно), совместимого с данным устройством. Подробнее см. в разделах “Подключение
контроллера объектива” и “Регулировка масштаба с помощью контроллера объектива”.

См. также
Установка типа масштабирования

Подключение контроллера объектива

Регулировка масштаба с помощью контроллера объектива

Нажмите кнопку масштабирования для настройки масштаба.

Для настройки масштаба нажимайте кнопку T (Телефото) или W (Широкоугольный), контролируя
изображение на экране.
Для увеличения нажимайте кнопку T.
Для уменьшения нажимайте кнопку W.

1
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Калибровка объектива с байонетом E

Калибровка корректирует разницу в положении масштабирования из-за различий экземпляров объективов с
сервоприводом масштабирования и байонетом E.
Для точного расчета положения масштабирования выполните приведенную ниже процедуру калибровки своего
объектива, чтобы учесть индивидуальные отличия объектива.

Данные калибровки
В устройстве можно сохранить данные калибровки максимум для пяти объективов. При калибровке 6-го и
последующих объективов самые старые данные калибровки будут перезаписаны.
Наличие данных калибровки для установленного объектива можно проверить, нажав кнопку  (Состояние
камеры) в общей области экрана веб-приложения и выбрав [Lens] > [Calibration Data].

5-041-958-03(1) Copyright 2022 Sony Corporation

Если на объективе есть переключатель SERVO/MANUAL, установите его в положение SERVO.

Примечание

Если этот переключатель установлен в положение MANUAL, объектив не сможет принимать команды
масштабирования от устройства.

1

Выполните калибровку с помощью пункта [Technical] > [Lens] > [Lens Calibration] в меню камеры.

Во время калибровки положение масштабирования объектива изменяется и измеряется автоматически.

2
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Сохранение и восстановление поворота/наклона, положения масштабирования и
настройки фокусировки с помощью веб-приложения

С помощью веб-приложения можно сохранить поворот/наклон, положение масштабирования и настройку
фокусировки и вызывать их по мере необходимости (функция предварительно заданного положения).

Подробные сведения о параметрах, допускающих сохранение и восстановление, см. в разделе “Сохраняемые
пункты предварительно заданных положений”.

Примечание

Предварительно заданное положение нельзя сохранить, если коэффициент масштабирования функции Clear Image Zoom
превышает 1×.

При изменении в веб-меню настройки [Pan-Tilt] > [P/T Direction] [Ceiling] все сохраненные предварительно заданные
положения удаляются.

Выберите для режима PTZ Assist значение [Pos.] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

1

С помощью операций поворота/наклона и масштабирования установите положение, которое
требуется сохранить.

2

Нажмите кнопку [+] на панели управления предварительно заданными положениями.

На панели управления предварительно заданными положениями отображается изображение с сохраненным
положением.

Совет

3
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Отмена восстановления предварительно заданного положения
Чтобы отменить операцию восстановления, нажмите кнопку  (Отмена восстановления), отображаемую на
панели управления предварительно заданными положениями во время восстановления предварительно
заданного положения. Используйте джойстик и ползунок [Zoom] для настройки кадрирования.

Если панель управления предварительно заданными положениями не отображается, для ее отображения нажмите
кнопку  (Открыть).

Положения сохраняются последовательно, начиная с [Preset1].

Если в последовательности предварительно заданных положений есть неиспользованные места, положения будут
сохраняться, начиная с неиспользованных предварительно заданных положений. Например, если предварительно
заданные положения сохранены в параметрах [Preset1] и [Preset3], но не в [Preset2], следующие предварительно
заданные положения будут сохранены в параметрах [Preset2], затем в [Preset4].

Можно сохранить не более 100 предварительно заданных положений.

Название каждого предварительно заданного положения можно изменить. Подробнее см.
в разделе“Переименование предварительно заданных положений с помощью веб-приложения”.

Восстановите сохраненное положение.

Для восстановления предварительно заданного положения дважды нажмите эскиз этого положения на
панели управления предварительно заданными положениями.

Совет

Положение можно также восстановить, нажав изображение и появившуюся кнопку  (Меню предустановленного
положения) и выбрав пункт [Recall].

Скорость перехода к сохраненному положению определяется настройкой [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-
Tilt Speed for Common] в веб-меню на момент сохранения положения. Скорость перехода можно также изменить
после сохранения. Подробнее см. в разделе “Изменение скорости перехода (поворот/наклон/масштаб/фокус) при
восстановлении предварительно заданного положения”.

Степень изменения положения поворота/наклона при перемещении в предварительно заданное положение можно
настроить с помощью скорости перехода и параметров [Ramp Curve]. Подробнее см. в разделах “Изменение
скорости перехода (поворот/наклон/масштаб/фокус) при восстановлении предварительно заданного положения” и
“Задание ускорения при повороте/наклоне”.

Если во время воспроизведения предварительно заданного положения вызывается другое предварительно
заданное положение, то предварительно заданное положение, вызванное первым, игнорируется и активируется
следующее вызванное положение.

Примечание

Если температура окружающей среды значительно изменилась с момента сохранения предварительно заданного
положения до момента его воспроизведения, кадрирование может быть неточным.

Во время восстановления предварительно заданного положения выполнение каких-либо операций, кроме
восстановления или отмены предварительно заданного положения, невозможно.

4
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См. также

Сохраняемые пункты предварительно заданных положений

Переименование предварительно заданных положений с помощью веб-приложения

Изменение скорости перехода (поворот/наклон/масштаб/фокус) при восстановлении предварительно
заданного положения

Задание ускорения при повороте/наклоне

5-041-958-03(1) Copyright 2022 Sony Corporation
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Переименование предварительно заданных положений с помощью веб-
приложения

Названия предварительно заданных положений можно изменить.

5-041-958-03(1) Copyright 2022 Sony Corporation

Выберите для режима PTZ Assist значение [Pos.] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

1

Выберите предварительно заданное положение, название которого требуется изменить.

В правом верхнем углу изображения появляется кнопка  (Меню предустановленного положения).

2

Нажмите кнопку  (Меню предустановленного положения) и выберите пункт [Rename]
в появившемся меню.

3

Введите новое название предварительно заданного положения.4
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Замена сохраненного предварительно заданного положения новым положением
с помощью веб-приложения

Можно заменить сохраненное предварительно заданное положение новым положением.

5-041-958-03(1) Copyright 2022 Sony Corporation

Выберите для режима PTZ Assist значение [Pos.] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

1

С помощью операций поворота/наклона и масштабирования установите положение, которое
требуется сохранить.

2

На панели управления предварительно заданными положениями нажмите изображение положения,
которое требуется заменить.

В правом верхнем углу изображения появляется кнопка  (Меню предустановленного положения).

3

Нажмите кнопку  (Меню предустановленного положения) и выберите пункт [Replace]
в появившемся меню.

Новое положение заменяет текущую настройку.

4
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Удаление сохраненного предварительно заданного положения с помощью веб-
приложения

Предварительно заданные положения можно удалить.

5-041-958-03(1) Copyright 2022 Sony Corporation

Выберите для режима PTZ Assist значение [Pos.] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

1

На панели управления предварительно заданными положениями нажмите изображение положения,
которое требуется удалить.

В правом верхнем углу изображения появляется кнопка  (Меню предустановленного положения).

2

Нажмите кнопку  (Меню предустановленного положения) и выберите пункт [Delete] в появившемся
меню.

Сохраненное положение удаляется.

3
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Синхронизация поворота/наклона и масштабирования/фокусировки при
восстановлении предварительно заданного положения

Для более плавного кадрирования можно синхронизировать операции поворота/наклона и масштабирования при
восстановлении сохраненного предварительно заданного положения.

Совет

Можно заранее задать параметры, используемые для регистрации предварительно заданного положения. В веб-меню
установите в пункте [Pan-Tilt] > [P/T Preset] > [Default] > [Zoom Sync] значение [On].

Если для параметра [Pan-Tilt] > [P/T Preset] > [Speed Select] задано значение [Common], восстановление всех
предварительно заданных положений производится на скорости, заданной параметром [Pan-Tilt] > [P/T Preset] > [Common
Speed].

По завершении масштабирования камера переходит в сохраненное положение фокусировки.

Выберите для режима PTZ Assist значение [Pos.] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

1

Нажмите изображение предварительно заданного положения, для которого требуется изменить
скорость перехода.

В правом верхнем углу изображения появляется кнопка  (Меню предустановленного положения).

2

Нажмите кнопку  (Меню предустановленного положения) и выберите пункт [Edit…] в появившемся
меню.

Откроется экран настройки для выбранного предварительно заданного положения.

3

Переместите переключатель [Zoom Sync] вправо, чтобы включить функцию и нажмите кнопку [OK].

В следующий раз при восстановлении сохраненного положения камера будет перемещаться с настроенной
скоростью.

4
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По завершении перемещения для параметра [AF Transition Speed] возвращается исходное значение.
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Изменение скорости перехода (поворот/наклон/масштаб/фокус) при
восстановлении предварительно заданного положения

Скорость перехода (операции поворота, наклона, масштабирования и фокусировки) при восстановлении
сохраненного предварительно заданного положения можно изменить.

Совет

Если для параметра [Pan-Tilt] > [P/T Preset] > [Speed Select] задано значение [Common], восстановление для всех
положений производится на заданной скорости [Pan-Tilt] > [P/T Preset] > [Common Speed].

В веб-меню установите в пункте [Pan-Tilt] > [P/T Preset] > [Speed Select] значение [Separate].1

Выберите для режима PTZ Assist значение [Pos.] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

2

Нажмите изображение предварительно заданного положения, для которого требуется изменить
скорость перехода.

В правом верхнем углу изображения появляется кнопка  (Меню предустановленного положения).

3

Нажмите кнопку  (Меню предустановленного положения) и выберите пункт [Edit…] в появившемся
меню.

Откроется экран настройки для выбранного предварительно заданного положения.

4

Задайте скорости перехода (поворот/наклон/масштаб/фокус), которые требуется изменить,
с помощью ползунков или введите значения и нажмите кнопку [OK].

В следующий раз при восстановлении сохраненного положения камера будет перемещаться с настроенной
скоростью.

5
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По завершении масштабирования камера переходит в сохраненное положение фокусировки.

По завершении перемещения для параметра [AF Transition Speed] возвращается исходное значение.

5-041-958-03(1) Copyright 2022 Sony Corporation

162



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Сохранение и восстановление поворота/наклона и положения масштабирования
с помощью инфракрасного пульта управления из комплекта поставки

Можно сохранить поворот/наклон и положение масштабирования и вызывать их по мере необходимости с
помощью инфракрасного пульта управления из комплекта поставки.

См. также
Изменение скорости перехода (поворот/наклон/масштаб/фокус) при восстановлении предварительно
заданного положения

Настройте поворот/наклон и масштаб камеры.1

Выберите для режима PTZ Assist значение [Pos.] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями в веб-приложении.

2

Нажав и удерживая нажатой кнопку PRESET, нажмите одну из кнопок от 1 до 3.

Положение сохраняется.

3

Восстановите сохраненное положение.

Нажмите одну из кнопок 1–3, чтобы восстановить это предварительно заданное положение.

Совет

Скорость перехода при восстановлении предварительно заданного положения определяется сохраненным
значением параметра [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed] в веб-меню. Скорость перехода можно изменить
после сохранения значения. Подробнее см. в разделе “Изменение скорости перехода (поворот/наклон/масштаб/
фокус) при восстановлении предварительно заданного положения”.

4
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Запись операций кадрирования камеры с помощью веб-приложения

С помощью веб-приложения можно записывать операции кадрирования камеры.

Настройте исходное положение камеры для работы.1

Выберите для режима PTZ Assist значение [Trace] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

2

Нажмите кнопку [+] на панели управления предварительно заданными положениями.

Будет добавлен эскиз, и камера перейдет в режим ожидания записи.

Совет

3
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Совет

Оставшееся время записи отображается в верхней части панели изображения с камеры во время записи.

Примечание

Записанные операции кадрирования будут удалены при переходе в режим установки на потолке.

Изменение системной частоты может привести к удалению записанных операций кадрирования.

При подключении контроллера объектива операции масштабирования не записываются.

Максимальная продолжительность записи одной операции кадрирования составляет 3 минуты. Запись автоматически
прекратится, когда продолжительность записи достигнет 3 минут.

Запись операции кадрирования невозможно начать, если коэффициент масштабирования Clear Image Zoom больше 1×.

Если во время записи операции кадрирования управление камерой осуществляется с другого устройства, то будут
записаны и операции, выполняемые на другом устройстве. Чтобы получить более подробные сведения об операциях
записи с использованием пульта дистанционного управления стороннего производителя обратитесь к соответствующему
производителю.

Данная функция не записывает настройки фокусировки и качества изображения.

Для выхода из режима ожидания записи и возврата в обычный режим работы нажмите кнопку  (Закрыть) на
эскизе.

Начните кадрирование с помощью джойстика и ползунка [Zoom].

Запись начинается с момента начала операции кадрирования.

4

Чтобы остановить запись, нажмите кнопку  (Остановить запись) на эскизе.5
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Операции поворота/наклона/масштабирования, записываемые вместе с операцией кадрирования, невозможно точно
воспроизвести при воспроизведении кадрирования.

Если после записи операции кадрирования задать ограничение диапазона поворота/наклона с помощью параметра [Pan-
Tilt] > [P/T Range Limit] в веб-меню, то при воспроизведении кадрирования ограничение диапазона поворота/наклона не
будет применяться. Если требуется использовать операцию кадрирования вместе с функцией ограничения диапазона
поворота/наклона, задайте ограничение диапазона поворота/наклона перед записью операции кадрирования.

Записанные операции кадрирования нельзя воспроизвести, если выбран выходной видеосигнал RAW.

Записанные операции кадрирования нельзя воспроизвести, если видеосигнал не выводится через разъем выхода SDI.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Воспроизведение операций кадрирования камеры с помощью веб-приложения

С помощью веб-приложения можно воспроизводить записанные операции кадрирования камеры.

Выберите для режима PTZ Assist значение [Trace] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

1

Выберите эскиз с операцией кадрирования, которую необходимо воспроизвести.

На эскизе появится кнопка  (Подготовка).

2

Нажмите кнопку  (Подготовка).

Камера переместится в положение запуска операции кадрирования и перейдет в режим ожидания
воспроизведения.

3

Нажмите кнопку  (Воспроизведение) на эскизе.4
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Совет

Начинается воспроизведение кадрирования.
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В режиме ожидания воспроизведения и во время воспроизведения можно отменить воспроизведение и вернуться
в штатный режим работы, выполнив любую из следующих операций.

Нажмите кнопку  (Стоп) на эскизе или на панели управления предварительно заданными положениями.
Используйте джойстик.
Используйте ползунок [Zoom].

Оставшееся время воспроизведения отображается в верхней части панели изображения с камеры во время
воспроизведения.

Примечание

Если настройки Clear Image Zoom, заданные при записи и воспроизведении операций кадрирования, различаются,
возможно поведение, отличное от ожидаемого.

При подключении контроллера объектива воспроизведение операций масштабирования не поддерживается. При
использовании функции масштабирования воспроизведение операций кадрирования прекратится.

Во время воспроизведения операций кадрирования изменение ограничения диапазона поворота/наклона с помощью
параметра [Pan-Tilt] > [P/T Range Limit] в веб-меню не работает. Задайте ограничение диапазона поворота/наклона перед
записью операции кадрирования.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Удаление записанных операций кадрирования камеры с помощью веб-
приложения

С помощью веб-приложения можно удалить записанные операции кадрирования камеры.

5-041-958-03(1) Copyright 2022 Sony Corporation

Выберите для режима PTZ Assist значение [Trace] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

1

Выберите эскиз с операцией кадрирования, которую необходимо удалить.

На эскизе появится кнопка  (Меню кадрирования).

2

Нажмите кнопку  (Меню кадрирования).

Появится меню.

3

В появившемся меню выберите [Delete].

Выбранная операция кадрирования будет удалена.

4
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Запись операций кадрирования камеры с помощью инфракрасного пульта
управления из комплекта поставки

Запись операций кадрирования может осуществляться с помощью инфракрасного пульта управления из
комплекта поставки.

Подробнее о воспроизведении записанной операции кадрирования см. в разделе “Воспроизведение операций
кадрирования камеры с помощью инфракрасного пульта управления из комплекта поставки”.

Примечание

Максимальная продолжительность записи одной операции кадрирования составляет 3 минуты. Запись автоматически
прекратится, когда продолжительность записи достигнет 3 минут.

Если во время записи операции кадрирования управление камерой осуществляется с другого устройства, то вместе
с операцией кадрирования будут записаны и операции, выполняемые на другом устройстве.

Если во время записи операции кадрирования качество изображения изменяется, это изменение не записывается.

См. также
Воспроизведение операций кадрирования камеры с помощью инфракрасного пульта управления из комплекта
поставки

5-041-958-03(1) Copyright 2022 Sony Corporation

Перейдите в операционный экран веб-приложения.1

Выберите для режима PTZ Assist значение [Trace] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

2

Настройте исходное положение камеры для работы с помощью инфракрасного пульта управления.3

Нажав и удерживая нажатой кнопку PRESET, нажмите одну из кнопок POSITION от 1 до 3.

Камера перейдет в режим ожидания записи.

4

Выполните операцию кадрирования, которую необходимо записать.5

Чтобы закончить запись, нажмите кнопку POSITION, выбранную на шаге 4 при нажатой кнопке
PRESET.

6
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Воспроизведение операций кадрирования камеры с помощью инфракрасного
пульта управления из комплекта поставки

Воспроизведение операций кадрирования может осуществляться с помощью инфракрасного пульта управления
из комплекта поставки.

Примечание

При использовании функции поворота/наклона/масштабирования воспроизведение прекратится.

См. также

Запись операций кадрирования камеры с помощью инфракрасного пульта управления из комплекта поставки
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Перейдите в операционный экран веб-приложения.1

Выберите для режима PTZ Assist значение [Trace] в раскрывающемся списке в верхней части панели
управления предварительно заданными положениями.

2

Выберите и нажмите одну из кнопок POSITION от 1 до 3, для которой была записана операция
кадрирования.

Механизмы поворота/наклона/масштабирования камеры перемещаются в исходное положение
воспроизведения.

3

После перемещения камеры в исходное положение воспроизведения снова нажмите ту же кнопку
POSITION.

Начнется воспроизведение.

4
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Экран настройки фокусировки

Фокусировка настраивается с помощью следующих частей операционного экрана.
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Панель изображения с камеры
Фокусировку можно настраивать, касаясь изображения с камеры. Сенсорную операцию можно отключить
в веб-приложении, выключив переключатель [Touch Focus] на вкладке  (Focus) на панели управления
камерой.

1.

Панель управления камерой — вкладка  (Focus)2.

Панель управления графическим пользовательским интерфейсом3.

174



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Настройка вручную с помощью веб-приложения

Фокусировку можно настраивать вручную, например в следующих случаях.

Объекты, частично перекрытые каплями воды
Объекты, которые сливаются с фоном
Объекты, находящиеся дальше расположенных поблизости объектов

Примечание

Во время выполнения операции масштабирования управление ручной фокусировкой из веб-приложения невозможно.

Совет

Когда основным методом управления является ручная регулировка, можно использовать автоматическую фокусировку.
Подробнее см. в разделе “Настройка целевой области фокусировки вручную (AF Assist) с помощью веб-приложения”.

См. также

Проверка переключателей объектива

Настройка целевой области фокусировки вручную (AF Assist) с помощью веб-приложения

5-041-958-03(1) Copyright 2022 Sony Corporation

Если объектив оборудован селекторным переключателем фокуса, установите его в положение
“AF/MF” или “AF”.

Примечание

Если переключатель установлен в положение “Full MF” или “MF”, устройство не может управлять фокусировкой
объектива. См. пункт “Для объективов с переключателем режима фокусировки” в разделе “Проверка
переключателей объектива”.

1

На панели управления камерой сдвиньте переключатель [Auto Focus] в левое положение, чтобы
отключить автоматическую фокусировку.

Включен режим фокусировки вручную.

 (MF)

2

Выполните настройку с помощью ползунка в нижней части вкладки  (Focus).3
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Настройка вручную с помощью инфракрасного пульта управления из комплекта
поставки

С помощью инфракрасного пульта управления из комплекта поставки можно настраивать фокусировку вручную.

Совет

Когда основным методом управления является ручная регулировка, можно использовать автоматическую фокусировку.
Подробнее см. в разделе “Ручная фокусировка во время автоматической фокусировки с помощью инфракрасного пульта
управления из комплекта поставки”.

См. также
Ручная фокусировка во время автоматической фокусировки с помощью инфракрасного пульта управления из
комплекта поставки
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Нажмите кнопку MF на инфракрасном пульте управления.1

Вручную настройте фокусировку кнопками F (Дальше) и N (Ближе).

Для фокусировки на далекий объект нажмите кнопку F.
Для фокусировки на близкий объект нажмите кнопку N.

2
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Фокусировка путем указания места фокусировки (Spot Focus)

В режиме ручной фокусировки на панели изображения с камеры можно указать место, на которое требуется
навести фокус.

Примечание

Функция Spot Focus не работает, если в объективе задана фокусировка вручную.

Совет

В режиме точечной фокусировки можно нажать программируемую кнопку, которой назначена функция [Push AF/MF],
чтобы приостановить точечную фокусировку и использовать автоматическую фокусировку, пока эта кнопка удерживается
нажатой. После того как кнопка будет отпущена, восстанавливается ручная фокусировка.
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В веб-меню или меню камеры установите в пункте [Shooting] > [Focus] > [Touch Function in MF]
значение [Spot Focus].

1

Сдвиньте переключатель [Touch Focus] на вкладке  (Focus) в правое положение, чтобы включить
его.

2

Переместите переключатель [Auto Focus] на вкладке  (Focus) в левое положение, чтобы
выключить его.

3

Укажите положение фокуса.

Появляется маркер фокусировки, и настраивается фокусировка на это место изображения.

Пример указания положения касанием

4
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Временное использование автоматической фокусировки (Push Auto Focus (AF))

В режиме ручной фокусировки можно временно настраивать фокус с помощью автоматической фокусировки,
нажав кнопку [Push AF/MF]. Пока эта кнопка нажата, выполняется автоматическая фокусировка.
Это удобно, когда требуется медленно перемещать фокус с одного объекта на другой во время ручной
фокусировки.

Примечание

Функция временной автоматической фокусировки Push Auto Focus не работает, если в объективе задана фокусировка
вручную.

Совет

Эта же операция поддерживается с помощью программируемой кнопки, которой назначена функция [Push AF/MF].
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В меню камеры установите в пункте [Shooting] > [Focus] > [Push AF Mode] значение [AF].1

Переместите переключатель [Auto Focus] на вкладке  (Focus) в левое положение, чтобы
выключить его.

2

Нажмите кнопку [Push AF/MF].

Автоматическая фокусировка производится, пока нажата эта кнопка.

После того как кнопка будет отпущена, временная автоматическая фокусировка отменяется и
восстанавливается ручная фокусировка.

3
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Использование покадровой автоматической фокусировки (Push Auto Focus (AF-
S))

Нажмите кнопку [Push AF/MF] при работе в режиме ручной фокусировки, чтобы автоматически сфокусироваться
с высокой скоростью.
Эта функция удобна, когда требуется сфокусироваться на объект перед съемкой.

Примечание

В веб-меню или меню камеры установите в пункте [Shooting] > [Focus] > [Push AF Mode] значение
[Single-shot AF(AF-S)].

1

Укажите положение, для которого требуется настроить фокусировку, используя пункт [Shooting] >
[Focus] > [Focus Area (AF-S)] в меню камеры.

Совет

Положение можно изменить, нажав программируемую кнопку, которой назначена функция [Focus Setting], чтобы
вокруг области фокусировки появилась оранжевая рамка, и выбрав положение касанием экрана.

2

Переместите переключатель [Auto Focus] на вкладке  (Focus) в левое положение, чтобы
выключить его.

3

Нажмите кнопку [Push AF/MF].

Если отпустить эту кнопку до завершения фокусировки, временная автоматическая фокусировка будет
прекращена.

Во время временной автоматической фокусировки состояние фокусировки отображается с помощью
индикатора фокусировки.
Горит: фокус фиксируется в положении фокусировки.
Мигает: не в фокусе. Поскольку устройство не фокусируется автоматически, измените композицию и
настройки фокусировки, чтобы установить фокус.
После того как кнопка будет отпущена, восстанавливается ручная фокусировка.

4
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Функция временной автоматической фокусировки Push Auto Focus не работает, если в объективе задана фокусировка
вручную.

При использовании кнопки [Display] рамка области фокусировки не скрывается.

Во время выполнения операции Clear Image Zoom задать положение рамки [Focus Area (AF-S)] невозможно. Во время
выполнения временной автоматической фокусировки функция автофокуса также отдает приоритет центральной части
изображения.

Совет

Эта же операция поддерживается с помощью программируемой кнопки, которой назначена функция [Push AF/MF].

Функцию [Push AF Mode] также можно назначить программируемой кнопке.

Функцию [Focus Area (AF-S)] также можно назначить программируемой кнопке.

Рамку области фокусировки можно отобразить или скрыть с помощью параметра [Monitoring] > [Display On/Off] > [Focus
Area Ind.(AF-S)] в меню камеры.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Автоматическая настройка с помощью веб-приложения

В устройстве используется фазовая AF для быстрой фокусировки и контрастная AF для точной фокусировки.
Сочетание этих двух методов автофокусировки обеспечивает быструю и точную автоматическую фокусировку.

Примечание

Требуется объектив, поддерживающий автоматическую фокусировку.

В некоторых условиях съемки точность может не обеспечиваться.

Фокус невозможно настроить автоматически на объективе с байонетом A.

Совет

В режиме автоматической фокусировки фокусировку можно настраивать с помощью ползунка Focus на панели
управления камерой. Подробнее см. в разделе “Настройка целевой области фокусировки вручную (AF Assist) с помощью
веб-приложения”.

См. также
Проверка переключателей объектива

Настройка целевой области фокусировки вручную (AF Assist) с помощью веб-приложения

5-041-958-03(1) Copyright 2022 Sony Corporation

Если объектив оборудован селекторным переключателем фокуса, установите его в положение
“AF/MF” или “AF”.

Примечание

Если переключатель установлен в положение “Full MF” или “MF”, устройство не может управлять фокусировкой
объектива. См. пункт “Для объективов с переключателем режима фокусировки” в разделе “Проверка
переключателей объектива”.

1

На панели управления камерой сдвиньте переключатель [Auto Focus] в правое положение, чтобы
включить его.

Автоматическая фокусировка включена.

 (AF)

2
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Автоматическая настройка с помощью инфракрасного пульта управления из
комплекта поставки

С помощью инфракрасного пульта управления из комплекта поставки можно настраивать фокусировку
автоматически.

Примечание

Когда основным методом управления является ручная регулировка, можно использовать автоматическую фокусировку.
Подробнее см. в разделе “Ручная фокусировка во время автоматической фокусировки с помощью инфракрасного пульта
управления из комплекта поставки”.

См. также
Ручная фокусировка во время автоматической фокусировки с помощью инфракрасного пульта управления из
комплекта поставки

5-041-958-03(1) Copyright 2022 Sony Corporation

Нажмите кнопку AF на инфракрасном пульте управления.

Фокусировка на объект настраивается автоматически.

1
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Задание области/положения автоматической фокусировки (Focus Area)

Можно задать целевую область для автоматической фокусировки и настраивать фокус в этой области.

Нажмите кнопку [Menu] на панели управления графическим пользовательским интерфейсом, чтобы
открыть меню камеры.

1

Задайте целевую область для автоматической фокусировки с помощью параметра [Shooting] >
[Focus] > [Focus Area] в меню камеры.

[Wide]:
При фокусировке производится поиск объекта по широкому углу изображения. Рамка не отображается.

[Zone]:
Автоматический поиск положения фокусировки в указанной зоне.
После выбора укажите положение с помощью кнопок со стрелками на панели управления графическим
пользовательским интерфейсом.

Вернуться в центральное положение можно, нажав и удерживая кнопку [Set].

2
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Примечание

При использовании кнопки [Display] на панели изображения с камеры рамка области фокусировки не скрывается.

При работе функции Clear Image Zoom устанавливается широкая область фокусировки [Wide] (фиксированная).

Совет

Рамку области фокусировки можно отобразить или скрыть с помощью параметра [Monitoring] > [Display On/Off] > [Focus
Area Indicator] в меню камеры.

5-041-958-03(1) Copyright 2022 Sony Corporation

[Flexible Spot]:
Производит фокусировку на указанное положение изображения.
После выбора укажите положение с помощью кнопок со стрелками на панели управления графическим
пользовательским интерфейсом.

Вернуться в центральное положение можно, нажав и удерживая кнопку [Set].
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Быстрое изменение области фокусировки (Focus Setting)

Чтобы иметь возможность быстро изменять положение и размер области автоматической фокусировки во время
съемки, назначьте функцию [Focus Setting] программируемой кнопке.

Подробнее о программируемых кнопках см. в разделе “Программируемые кнопки”.

Работа функции зависит от настройки области фокусировки.

Когда в меню камеры для параметра [Shooting] > [Focus] > [Focus Area] установлено
значение [Flexible Spot] или [Zone]

Чтобы изменить положение области фокусировки, нажмите программируемую кнопку, которой назначена
функция [Focus Setting], и выполните настройку с помощью панели управления графическим
пользовательским интерфейсом. Чтобы вернуть область фокусировки в центр во время настройки ее
положения, нажмите кнопку [Set].
Чтобы изменить размер области фокусировки, нажмите и удерживайте программируемую кнопку, которой
назначена функция [Focus Setting]. После изменения размера можно изменять положение области
фокусировки, нажимая кнопку [Set]. Завершив настройку, нажмите программируемую кнопку, которой
назначена функция [Focus Setting], чтобы вернуться на исходный экран.

Когда в меню камеры для параметра [Shooting] > [Focus] > [Focus Area] задано значение
[Wide]

Чтобы изменить только размер области фокусировки, нажмите и удерживайте программируемую кнопку, которой
назначена функция [Focus Setting]. Чтобы изменить положение, сначала необходимо изменить тип на [Flexible
Spot] или [Zone].

Совет

Если в меню камеры для параметра [Shooting] > [Focus] > [Push AF Mode] задано значение [Single-shot AF(AF-S)] и
переключатель [Auto Focus] установлен в выключенное положение (режим ручной фокусировки), можно изменить
положение области фокусировки [Focus Area (AF-S)].

Рамка области фокусировки отображается оранжевым цветом, когда положение области фокусировки можно изменить.

См. также

Программируемые кнопки

5-041-958-03(1) Copyright 2022 Sony Corporation
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Перемещение рамки области фокусировки с помощью сенсорных операций
(область сенсорной фокусировки)

Положение области фокусировки можно изменить, нажав программируемую кнопку, которой назначена функция
[Focus Setting], чтобы изменить цвет индикации области фокусировки на оранжевый, а затем переместив рамку
области фокусировки с помощью сенсорных операций на панели изображения с камеры.
Нажмите экран для перемещения центра области фокусировки в место нажатия. Перетаскивайте экран, чтобы
область фокусировки перемещалась вслед за пальцем.

Совет

Сенсорные области фокусировки на экране съемки можно включать и выключать с помощью программируемой кнопки,
которой назначена функция [Focus Setting].

Нажмите в любом месте.

Нажатое место становится центром области фокусировки.

1

Перетащите для перемещения области фокусировки вслед за пальцем.2
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Примечание

Если нажать в некотором положении или перетащить область фокусировки в положение вне диапазона настройки,
область фокусировки устанавливается на верхнем, нижнем, левом или правом краю диапазона настройки.

В указанных ниже условиях эта функция недоступна.

Когда выключен переключатель [Touch Focus] на панели управления камерой
Когда рамка области фокусировки отображается серым цветом или вообще не отображается

5-041-958-03(1) Copyright 2022 Sony Corporation
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Настройка работы автоматической фокусировки (скорость изменения AF,
чувствительность к смене объекта AF)

Работу автоматической фокусировки можно настраивать, изменяя скорость изменения и чувствительность к
смене объекта.

Задание скорости изменения AF

Скорость изменения фокусировки при изменении объекта можно задать с помощью кнопки [AF Transition Speed]
на панели управления камерой.

Выберите скорость в диапазоне от [Speed 1] (Медленно) до [Speed 7] (Быстро) с шагом 1. Нажимайте кнопку <
для уменьшения значения (медленнее) или кнопку > для увеличения значения (быстрее).
Если задана низкая скорость, при изменении объекта фокусировки фокус перемещается медленно, что позволяет
снимать впечатляющие кадры.
Если задана высокая скорость, фокус быстро переключается между объектами. В приведенном ниже примере
фокус быстро переключается со здания на заднем плане на человека, идущего на переднем плане. Камера
моментально фокусируется на объекте съемки, попадающем в кадр, что делает эту настройку идеальным
вариантом для документальной съемки, требующей быстрой фокусировки.

Чувствительность к смене объекта AF

Чувствительность к смене объектов можно задать с помощью кнопки [AF Subj. Shift Sens.] на панели управления
камерой.
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Выберите чувствительность в диапазоне от [Sens 1] (Фокус фиксирован) до [Sens 5] (Отзывчивая фокусировка)
с шагом 1. Нажимайте кнопку < для уменьшения значения (более медленное изменение) или кнопку > для
увеличения значения (более быстрое изменение).
Когда задана низкая чувствительность, фокус не будет сразу же изменяться, если перед объектом, на который
наведен фокус, появляется другой объект.

Когда задана высокая чувствительность, фокусировка изменяется, отдавая приоритет объекту, появившемуся
впереди.

Совет

Если функция [AF Speed/Sens.] назначена программируемой кнопке, при каждом нажатии этой кнопки на панели
изображения с камеры отображаются полосы уровня для регулировки значений, позволяя изменять скорость изменения
AF и чувствительность к смене объекта AF.
Скорость изменения AF → Чувствительность к смене объекта AF → Нет индикации …

5-041-958-03(1) Copyright 2022 Sony Corporation
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Настройка целевой области фокусировки вручную (AF Assist) с помощью веб-
приложения

После смещения и настройки фокусировки вручную можно передать управление фокусировкой системе
автоматической фокусировки для точной настройки фокусировки.

Примечание

В состоянии AF Assist смещение фокуса затруднено, независимо от настройки [Shooting] > [Focus] > [AF Subj. Shift Sens.] в
меню камеры.

Состояние AF Assist отменяется в следующих случаях.

Когда объект, фокусировка на который произведена с помощью ползунка [Focus], пропадает из вида
При переключении на ручную фокусировку
При запуске функции автоматической фокусировки с отслеживанием в режиме реального времени

Совет

В меню камеры установите в пункте [Shooting] > [Focus] > [AF Assist] значение [On].1

В веб-меню установите в пункте [Shooting] > [Focus] > [AF Assist Control] значение [On].2

На панели управления камерой сдвиньте переключатель [Auto Focus] в правое положение, чтобы
включить его.

Автоматическая фокусировка включена.

3

Задайте целевую область фокусировки с помощью ползунка [Focus] на панели управления камерой.

[Near]: фокусировка на близкий объект.
[Far]: фокусировка на дальний объект.

В состоянии AF Assist производится автоматическая фокусировка на объект, который находится на
расстоянии, заданном ползунком [Focus].

4
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Состояние AF Assist можно быстро отменить с помощью программируемой кнопки, которой назначена функция [Push
AF/MF].

Функция автоматической фокусировки с отслеживанием в режиме реального времени останавливается при
использовании ползунка [Focus].

В режиме Face/Eye Only AF автоматическая фокусировка производится на лицо, ближайшее к положению фокусировки,
заданному ползунком [Focus].

5-041-958-03(1) Copyright 2022 Sony Corporation
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Ручная фокусировка во время автоматической фокусировки с помощью
инфракрасного пульта управления из комплекта поставки

Когда в меню камеры для параметра [Shooting] > [Focus] > [AF Assist] задано значение [On], можно настраивать
фокусировку на объект кнопками F (Дальше) и N (Ближе) на инфракрасном пульте управления из комплекта
поставки даже во время автоматической фокусировки.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Временное использование ручной фокусировки во время автоматической
фокусировки (Push Manual Focus)

Нажмите кнопку [Push AF/MF] при работе в режиме автоматической фокусировки, чтобы фокусироваться
вручную, пока нажата эта кнопка. После того как кнопка будет отпущена, восстанавливается автоматическая
фокусировка.
Это позволяет временно останавливать автоматическую фокусировку и фокусироваться вручную, когда что-либо,
не являющееся объектом съемки, проходит перед ним.

Совет

Эта же операция поддерживается с помощью программируемой кнопки, которой назначена функция [Push AF/MF].

5-041-958-03(1) Copyright 2022 Sony Corporation

193



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Отслеживание с использованием обнаружения лиц и глаз (Face/Eye Detection AF)

Устройство может обнаруживать лица и глаза людей в качестве цели для отслеживания и настраивать фокус на
лица и глаза в пределах области фокусировки.
Если обнаружены лица, отображаются серые рамки обнаружения лица или глаз. Если возможна автоматическая
фокусировка, цвет рамки изменяется на белый и начинается отслеживание. Если обнаружены глаза и
настраивается фокусировка, рамка обнаружения лица/глаз отображается на глазах. Если обнаружено несколько
человек, главный объект определяется автоматически.
Эта функция доступна только при использовании режима фокусировки AF или во время автофокусировки при
нажатой кнопке.

Совет

Если задана область фокусировки [Zone] или [Flexible Spot] и лица или глаза перекрываются в указанной области
фокусировки, цвет рамок обнаружения лиц/глаз изменяется на белый и устройство фокусируется на эти лица или глаза
автоматически.

Если используется функция автоматической фокусировки при нажатой кнопке (AF-S), цвет рамок обнаружения лиц/глаз,
находящихся в фокусе, изменяется на зеленый.

Настройка с помощью кнопки [Face/Eye Detection AF] на панели управления камерой

Нажмите кнопку [Face/Eye Detection AF] и задайте режим работы AF с обнаружением лица или глаз.

[Face/Eye Only AF]: камера обнаруживает лица или глаза объектов (людей), а также фокусируется и ведет
отслеживание только их лиц или глаз. Если лицо или глаза не обнаружены, AF временно останавливается и
отображается значок  (автоматическая фокусировка в режиме Face/Eye Only AF приостановлена). Этот режим
эффективен, если требуется автоматическая фокусировка и отслеживание только лиц или глаз.
[Face/Eye Priority AF]: камера обнаруживает лица или глаза объектов (людей) и устанавливает приоритет
фокусировки/отслеживания лиц или глаз. Если лицо или глаза не обнаружены, фокусировка производится
в режиме AF (настройка по умолчанию).
[AF]: функция автоматической фокусировки с обнаружением лиц или глаз отключена.

Примечание

Во время использования автоматической фокусировки при нажатой кнопке включается режим [Face/Eye Priority AF], даже
если выбран режим [Face/Eye Only AF].
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Если переключатель [Auto Focus] установлен в выключенное положение, AF с обнаружением лиц/глаз отключена (кроме
автоматической фокусировки при нажатой кнопке).

Если выключить видеокамеру, когда выбран режим [Face/Eye Only AF], при следующем включении видеокамеры
автоматически устанавливается режим [Face/Eye Priority AF].

Совет

Режим работы функции AF с обнаружением лиц и глаз можно задавать с помощью пункта [Shooting] > [Focus] > [Face/Eye
Detection AF] в меню камеры.

Скрытие рамок обнаружения лиц или глаз
Рамки обнаружения лиц и глаз можно отображать или скрывать с помощью параметра [Monitoring] > [Display
On/Off] > [Face/Eye Detection Frame] в меню камеры.

Примечание

Зеленые рамки обнаружения лиц или глаз отображаются для лиц и глаз, находящихся в фокусе при использовании
автофокусировки при нажатой кнопке (AF-S), и они не скрываются с помощью кнопки [Display] или когда для пункта
[Face/Eye Detection Frame] задано значение [Off].

Переключение режима AF с обнаружением лиц и глаз с помощью программируемой кнопки
Назначьте функцию [Face/Eye Detection AF] программируемой кнопке. Затем режим с обнаружением лиц и глаз
будет переключаться при каждом нажатии этой кнопки в следующем порядке: [Face/Eye Priority AF], [Face/Eye
Only AF] и [AF].

Настройка с помощью прямого меню

Режим работы функции AF с обнаружением лиц и глаз можно задавать также с помощью прямого меню.

Подробнее о прямом меню см. в разделе “Использование прямого меню”.

См. также

Использование прямого меню

5-041-958-03(1) Copyright 2022 Sony Corporation
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Отслеживание указанного объекта (Realtime Tracking AF)

Можно удерживать объект в фокусе, указав его касанием или выбрав рамку отслеживания лица на панели
управления камерой.
После выбора объекта отображается белая рамка отслеживания, после чего начинается само отслеживание.

Совет

Отслеживание ведется во всей области изображения независимо от заданной настройки области фокусировки.

Когда в веб-меню или меню камеры параметру [Shooting] > [Focus] > [Touch Function in MF] задано значение [Tracking AF],
автоматическая фокусировка с отслеживанием в реальном времени поддерживается даже тогда, когда выбран режим MF.

В зависимости от настройки режима AF с обнаружением лиц или глаз, с целью отслеживания выполняются
следующие действия.

[Face/Eye Only AF] или [Face/Eye Priority AF]: фокусировка на указанном объекте и отслеживание этого
объекта.
Если отслеживается человек и обнаружено лицо/глаза, камера фокусируется на лице/глазах.
При обнаружении лица/глаз отслеживаемого объекта его лицо сохраняется. При этом отображается значок 
(значок сохраненного отслеживаемого лица).

Примечание

Если AF с отслеживанием запускается в режиме ручной фокусировки, лицо целевого объекта отслеживания не
сохраняется.

[AF]: используется для фокусировки на указанном объекте и отслеживания этого объекта. Обнаружение лица/
глаз не производится, даже если объектом отслеживания является человек.

Примечание

Функция автоматической фокусировки с отслеживанием в реальном времени не работает, если в объективе задана
фокусировка вручную.

Запуск автоматической фокусировки с отслеживанием в реальном времени

Когда в качестве цели отслеживания указывается определенный объект, начинается отслеживание этой цели.
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Указание касанием
Передвиньте переключатель [Touch Focus] на вкладке  (Focus) на панели управления камерой в правое
положение, чтобы включить его, затем нажмите требуемый объект, чтобы отслеживать его в любом из следующих
состояний.

Во время ручной фокусировки или во время ручной фокусировки по нажатию кнопки и когда в веб-меню или
меню камеры для параметра [Shooting] > [Focus] > [Touch Function in MF] задано значение [Tracking AF]
Во время автоматической фокусировки или временной автоматической фокусировки по нажатию кнопки (AF)

Указание путем выбора рамки обнаружения лица
С помощью кнопок со стрелками панели управления графическим пользовательским интерфейсом переместите
указатель выбора лица (оранжевое подчеркивание) на целевой объект и нажмите кнопку [Set].

A: Рамки обнаружения лиц (серые)
B: Рамка отслеживания
C: Курсор выбора лица (оранжевый)

Примечание

В режиме ручной фокусировки нельзя запустить отслеживание выбором рамки обнаружения лица.

Совет

Целевой объект, который требуется отслеживать в режиме AF с отслеживанием в реальном времени, можно изменять.

Остановка автоматической фокусировки с отслеживанием в реальном времени

Нажмите кнопку  (остановка автофокусировки с отслеживанием в реальном времени).

Совет

Автоматическая фокусировка с отслеживанием в реальном времени останавливается в следующих случаях:
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При изменении положения переключателя [Auto Focus] или переключателя AUTO/MANUAL на объективе
При изменении режима фокусировки
Когда работает режим AF Assist
При изменении настройки области фокусировки или работы автоматической фокусировки с обнаружением лица/глаз
При нажатии программируемой кнопки, которой назначена функция [Push AF/MF]
Когда целевой объект отслеживания не находится в пределах съемочного экрана или когда объект уходит из фокуса на
несколько секунд

Когда отслеживаемое лицо сохраняется (когда отображается значок  (сохраненное отслеживаемое лицо)),
автоматическая фокусировка с отслеживанием в реальном времени возобновляется, когда такое лицо окажется в
области изображения. Чтобы удалить отслеживаемое лицо, остановите автоматическую фокусировку с отслеживанием в
реальном времени, выполнив приведенную выше процедуру.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Экран настройки яркости

Яркость можно регулировать путем настройки диафрагмы, усиления, выдержки, а также уровня освещенности с
помощью фильтров ND в следующих панелях управления операционного экрана веб-приложения. Яркость также
может настраиваться автоматически.

Примечание

Усиление нельзя регулировать, когда для параметра [Shooting Mode] задано значение [Cine EI Quick] или [Cine EI]. Кроме
того, если задано значение [Cine EI Quick] или [Cine EI], то яркость нельзя регулировать автоматически с помощью
выдержки. Автоматическая регулировка яркости с использованием диафрагмы и фильтра нейтральной плотности
поддерживается.

Совет

Панель управления камерой — вкладка  (Main)1.

Панель основных настроек камеры
На кнопках отображается состояние настройки базовых функций, необходимых для съемки. Нажмите кнопку
для отображения соответствующего экрана настройки для каждой из функций на показанной ниже панели
настройки базовой конфигурации камеры.

2.

Панель регулировки основных настроек камеры
Отображается панель регулировки для пунктов настройки, выбранных на панели основных настроек камеры.

3.
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Режим Cine EI — это режим для съемки с базовой чувствительностью без усиления, чтобы максимально эффективно
использовать датчик изображения. Яркость настраивается с помощью освещения и фильтра нейтральной плотности,
чтобы регулировать количество света, попадающего на датчик изображения. Сведения о параметре Exposure Index (EI)
см. в разделе “Изменение распределения темных и ярких областей на записанном изображении”.

См. также

Изменение распределения темных и ярких областей на записанном изображении

5-041-958-03(1) Copyright 2022 Sony Corporation
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Задание базовой чувствительности

Перед началом настройки яркости можно задать базовую чувствительность.

Когда для параметра [Shooting Mode] установлено значение [Custom]

Нажмите кнопку [ISO/Gain] на панели основных настроек камеры и задайте для параметра [Base Sensitivity] на
панели регулировки ISO/Gain значение [High] или [Low].
Выбирайте значение [Low] в нормальных условиях освещения, а значение [High] выбирайте в условиях низкой
освещенности.
Вид экрана, когда параметр [AGC] выключен

Вид экрана, когда параметр [AGC] включен

Когда для параметра [Shooting Mode] установлено значение [Flexible ISO] или [Cine EI]

Нажмите кнопку [Base ISO/Exposure Index] на панели основных настроек камеры и задайте для параметра [Base
ISO] панели регулировки Base ISO/Exposure Index значение [ISO 12800] или [ISO 800].
Выбирайте значение [ISO 800] в нормальных условиях освещения, а значение [ISO 12800] выбирайте в условиях
низкой освещенности.
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Совет

Эти параметры можно также задать на вкладке  (Main) панели управления камерой.

Задание также возможно в пункте [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] или [Base ISO] меню камеры.

Функцию [Base ISO/Sensitivity] также можно назначить программируемой кнопке.

В режиме съемки [Cine EI Quick] базовая чувствительность задается автоматически в соответствии с настроенным
индексом экспозиции.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Задание целевого уровня для автоматической регулировки яркости

Целевой уровень для автоматической регулировки яркости задается ползунком [AE Level] на панели управления
камерой.

5-041-958-03(1) Copyright 2022 Sony Corporation

Нажмите вкладку  (Main) на панели управления камерой.

Если ползунок [AE Level] не отображается, для его отображения выберите любую из двух кнопок выбора
функции ползунка и выберите ползунок [AE Level] из списка.

Появляется ползунок [AE Level].

1

Выберите целевой уровень этим ползунком.

Перемещайте ручку ползунка влево, чтобы сделать изображение темнее. Перемещайте ручку ползунка
вправо, чтобы сделать изображение светлее.

Совет

Задание также возможно в пункте [Shooting] > [Auto Exposure] > [Level] меню камеры.

2
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Автоматическая регулировка диафрагмы

Можно автоматически регулировать яркость в соответствии с объектом. Требуется совместимый объектив.

Примечание

Диафрагму невозможно настроить автоматически на объективе с байонетом A.

Совет

Функцию [Auto Iris] также можно назначить программируемой кнопке.

5-041-958-03(1) Copyright 2022 Sony Corporation

Если установлен объектив с переключателем Auto Iris, переведите переключатель в положение
AUTO.

1

Нажмите кнопку [Iris] на панели основных настроек камеры.

Цвет рамки кнопки [Iris] изменяется на оранжевый.

Появляется панель регулировки Iris.

2

Сдвиньте переключатель [Auto] в правое положение, чтобы включить его.

Диафрагма переключается в режим автоматической настройки. Автоматически настроенное значение
диафрагмы отображается с правой стороны переключателя.

3
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Регулировка диафрагмы вручную

Яркость может настраиваться вручную.

Временная автоматическая регулировка диафрагмы

Если установлен объектив с переключателем Auto Iris, переведите переключатель в положение
AUTO.

Примечание

Если переключатель Auto Iris на объективе установлен в положение MANUAL, функции [Auto Iris] и [Push Auto Iris] на
устройстве не работают. Регулировка диафрагмы вручную на устройстве также не приведет к каким-либо
изменениям.

1

Нажмите кнопку [Iris] на панели основных настроек камеры.

Цвет рамки кнопки [Iris] изменяется на оранжевый.

Появляется панель регулировки Iris.

2

Сдвиньте переключатель [Auto] в левое положение, чтобы выключить его.

Диафрагма переключается в режим регулировки вручную.

3

Настройте диафрагму с помощью ползунка [Iris] или кнопок регулировки [Iris].

Совет

Настройки ползунка и кнопок регулировки связаны.

Можно также назначить диафрагму ползунку на вкладке  (Main) на панели управления камерой.

4
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Можно также нажать кнопку [Push Auto] на панели регулировки Iris, чтобы при нажатой кнопке диафрагма
регулировалась автоматически.

Совет

Нажмите программируемую кнопку, которой назначена функция [Push Auto Iris], для автоматической регулировки
диафрагмы при нажатой кнопке.
После того как кнопка будет отпущена, восстанавливается режим регулировки диафрагмы вручную.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Автоматическая регулировка усиления

Автоматическая регулировка яркости с помощью настройки усиления возможна, когда для параметра [Shooting
Mode] установлено значение [Custom] или [Flexible ISO].

5-041-958-03(1) Copyright 2022 Sony Corporation

В веб-меню или меню камеры установите в пункте [Project] > [Shooting Mode] значение [Custom].1

Нажмите кнопку [ISO/Gain] на панели основных настроек камеры.

Цвет рамки кнопки [ISO/Gain] изменяется на оранжевый.

Появляется панель регулировки ISO/Gain.

2

Сдвиньте переключатель [AGC] в правое положение, чтобы включить его.

Усиление переключается в режим автоматической настройки. Автоматически настроенное значение
усиления отображается с правой стороны переключателя.

Совет

Это же действие можно выполнить, задав для параметра [Shooting] > [Auto Exposure] > [AGC] значение [On] в меню
камеры.

Функцию [AGC] также можно назначить программируемой кнопке.

3

207



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Регулировка усиления вручную

Регулировка яркости вручную с помощью настройки усиления возможна, когда для параметра [Shooting Mode]
установлено значение [Custom] или [Flexible ISO].
Управлять усилением можно, когда требуется отрегулировать экспозицию при использовании фиксированного
значения диафрагмы, либо если вы хотите воспрепятствовать увеличению усиления из-за AGC.

Временная регулировка усиления вручную
Усиление можно также временно настраивать вручную, назначив функцию [ISO/Gain] кнопке выбора функции
ползунка на вкладке  (Main) на панели управления камерой и используя этот ползунок.
Это полезно, когда требуется отрегулировать экспозицию по одному шагу, не меняя глубину поля.
После выполнения любой из следующих операций для результата настройки восстанавливается предварительно
установленное значение, настроенное с помощью функции [ISO/Gain<L>].

В веб-меню или меню камеры установите в пункте [Project] > [Shooting Mode] значение [Custom].1

Нажмите кнопку [ISO/Gain] на панели основных настроек камеры.

Цвет рамки кнопки [ISO/Gain] изменяется на оранжевый.

Появляется панель регулировки ISO/Gain.

2

Сдвиньте переключатель [AGC] в левое положение, чтобы выключить его.

Усиление переключается в режим настройки вручную.

3

Настройте усиление с помощью ползунка [ISO/Gain] или кнопок регулировки [ISO/Gain].

Совет

Настройки ползунка и кнопок регулировки связаны.

4
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Изменение параметров регулировки ISO/Gain
Переключение базовой чувствительности
Установка переключателя AGC во включенное положение
Переключение питания устройства в режим ожидания

Временная автоматическая регулировка усиления с помощью программируемой кнопки
Нажмите программируемую кнопку, которой назначена функция [Push AGC], для автоматической регулировки
усиления при нажатой кнопке.
После того как кнопка будет отпущена, восстанавливается режим регулировки усиления вручную.
После выполнения любой из следующих операций для результата настройки восстанавливается предварительно
установленное значение, настроенное с помощью функции [ISO/Gain<L>].

Изменение параметров регулировки ISO/Gain
Переключение базовой чувствительности
Установка переключателя AGC во включенное положение
Переключение питания устройства в режим ожидания

Примечание

Выполнение этой функции невозможно, когда в меню камеры для параметра [Shooting] > [Iris] > [Bokeh Control] задано
значение [On].

5-041-958-03(1) Copyright 2022 Sony Corporation
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Автоматическая регулировка выдержки

Выдержка может регулироваться автоматически в зависимости от яркости изображения.

5-041-958-03(1) Copyright 2022 Sony Corporation

Нажмите кнопку [Shutter] на панели основных настроек камеры.

Цвет рамки кнопки [Shutter] изменяется на оранжевый.

Появляется панель регулировки Shutter.

1

Нажмите кнопку [Shutter Type] и выберите [Auto] из списка.

Совет

Это же действие можно выполнить, задав для параметра [Shooting] > [Auto Exposure] > [Auto Shutter] значение [On] в
меню камеры.

Функцию [Auto Shutter] также можно назначить программируемой кнопке.

2
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Регулировка выдержки вручную

Выдержка может настраиваться вручную.

Нажмите кнопку [Shutter] на панели основных настроек камеры.

Цвет рамки кнопки [Shutter] изменяется на оранжевый.

Появляется панель регулировки Shutter.

1

Нажмите кнопку [Shutter Type] и выберите [Speed] из списка.2

Настройте выдержку с помощью ползунка [Speed] или кнопок регулировки [Speed].

Для настройки времени экспозиции в соответствии с интервалом между кадрами выберите значение [Off] на
шаге 2. Можно также задать фиксированное значение, используя [ECS] (частота), или автоматически
настраивать его с помощью значения [Auto].
Пример: задание с использованием варианта [ECS] (частота)

Совет

Настройки ползунка и кнопок регулировки связаны.

Чтобы использовать тип [Angle] вместо [Speed] или [Off], задайте для параметра [Shooting] > [Shutter] > [Mode] в
меню камеры значение [Angle].

3
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Сведения о фильтре нейтральной плотности

Когда освещенность слишком яркая, ее уровень можно понизить с помощью фильтра ND.
Если при съемке ярко освещенного объекта слишком сильно закрыть диафрагму, может возникнуть
дифракционное размытие, в результате чего изображение начнет выходить из фокуса (типичное явление
в камерах). С помощью диска фильтр ND можно подавить это явление для улучшения результатов съемки.
В устройстве предусмотрены следующие режимы фильтра нейтральной плотности.
Режим предустановки

См. раздел “Настройка в предустановленном режиме”.

Переменный режим (автоматическая настройка)

См. раздел “Автоматическая настройка в переменном режиме”.

Переменный режим (настройка вручную)

См. раздел “Настройка вручную в переменном режиме”.

См. также

Настройка в предустановленном режиме

Автоматическая настройка в переменном режиме

Настройка вручную в переменном режиме

5-041-958-03(1) Copyright 2022 Sony Corporation

213



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Настройка в предустановленном режиме

Можно заранее выбрать три значения коэффициента пропускания фильтра нейтральной плотности и быстро
выбирать одно из них во время съемки.

Совет

При нажатии программируемой кнопки, которой назначена функция [ND Filter Position], фильтр нейтральной плотности
переключается в следующем порядке: [Clear] → [Preset1] → [Preset2] → [Preset3] → [Clear].

5-041-958-03(1) Copyright 2022 Sony Corporation

В меню камеры установите в пункте [Shooting] > [ND Filter] > [Mode] значение [Preset].1

Нажмите кнопку [ND Filter] на панели основных настроек камеры.

Цвет рамки кнопки [ND Filter] изменяется на оранжевый.

Появляется панель регулировки ND Filter.

2

Нажмите кнопку [ND Filter] и выберите из списка один из следующих вариантов.

[Clear]: фильтр нейтральной плотности не используется.
[Preset1]: коэффициент пропускания, заданный в параметре [Shooting] > [ND Filter] > [Preset1] меню камеры.
[Preset2]: коэффициент пропускания, заданный в параметре [Shooting] > [ND Filter] > [Preset2] меню камеры.
[Preset3]: коэффициент пропускания, заданный в параметре [Shooting] > [ND Filter] > [Preset3] меню камеры.

Если для фильтра нейтральной плотности выбрано одно из значений [Preset1] – [Preset3], рядом с
названием фильтра нейтральной плотности отображается значение коэффициента пропускания.

3
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Автоматическая настройка в переменном режиме

Можно включить автоматическую регулировку экспозиции с помощью фильтра нейтральной плотности.

Примечание

Если во время съемки фильтр нейтральной плотности переключается на значение [Clear], на изображении отображается
рамка фильтра нейтральной плотности и подается звук срабатывания.

Совет

Можно также назначить функцию [Auto ND Filter] программируемой кнопке и нажимать эту кнопку для переключения
между режимами [Auto] и [Manual].
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В меню камеры установите в пункте [Shooting] > [ND Filter] > [Mode] значение [Variable].1

Нажмите кнопку [ND Filter] на панели основных настроек камеры.

Цвет рамки кнопки [ND Filter] изменяется на оранжевый.

Появляется панель регулировки ND Filter.

2

Нажмите кнопку [ND Filter] и выберите [Auto] из списка.

Рядом с кнопкой [ND Filter] отображается автоматически настроенное значение коэффициента пропускания
фильтра нейтральной плотности.

3
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Настройка вручную в переменном режиме

Можно вручную регулировать экспозицию с помощью фильтра нейтральной плотности.

Временная автоматическая регулировка
Можно назначить функцию [Push Auto ND] программируемой кнопке и временно включать автоматическую
настройку фильтра нейтральной плотности, пока эта кнопка нажата. При отпускании кнопки автоматическая
настройка фильтра нейтральной плотности снова выключается.
Задайте для фильтра нейтральной плотности значение [Manual].

Примечание

Если во время съемки фильтр нейтральной плотности переключается на значение [Clear], на изображении отображается
рамка фильтра нейтральной плотности и подается звук срабатывания.

В меню камеры установите в пункте [Shooting] > [ND Filter] > [Mode] значение [Variable].1

Нажмите кнопку [ND Filter] на панели основных настроек камеры.

Цвет рамки кнопки [ND Filter] изменяется на оранжевый.

Появляется панель регулировки ND Filter.

2

Нажмите кнопку [ND Filter] и выберите [Manual] из списка.3

Настройте коэффициент пропускания фильтра нейтральной плотности ползунком [ND Filter] или
кнопками регулировки [ND Filter].

Совет

Настройки ползунка и кнопок регулировки связаны.

Можно также настраивать фильтр нейтральной плотности на вкладке  (Main) на панели управления камерой.

4
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Совет

Можно также назначить функцию [ND Filter Position] программируемой кнопке и нажимать эту кнопку для переключения
между режимами [Manual] и [Clear].

Можно также нажать кнопку [Push Auto] на панели регулировки ND Filter, чтобы при нажатой кнопке фильтр нейтральной
плотности регулировался автоматически.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Экран настройки баланса белого

Баланс белого можно настраивать на операционном экране веб-приложения, чтобы получить баланс белого,
обеспечивающий более естественный вид изображения.

5-041-958-03(1) Copyright 2022 Sony Corporation

Панель основных настроек камеры1.

Панель регулировки основных настроек камеры
Отображается панель регулировки для пунктов настройки, выбранных на панели основных настроек камеры.

2.
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Автоматическая регулировка баланса белого

Подходящий настроенный баланс белого можно всегда получить с помощью функции ATW (автоматическое
отслеживание баланса белого).
Когда функция ATW включена, баланс белого автоматически регулируется по мере изменения цветовой
температуры источника света.

Примечание

Функция ATW не может использоваться, когда для параметра [Shooting Mode] задано значение [Cine EI] или [Cine EI
Quick].

Обеспечить запись правильных цветов с помощью функции ATW не всегда возможно. Это зависит от условий
освещенности и объекта съемки.
Примеры приведены ниже.

Когда в объекте съемки, например небе, море, земле или цветах, имеется один доминирующий цвет.
Когда цветовая температура чрезвычайно высокая или низкая.

Если скорость автоматического отслеживания ATW низкая или если не удается получить соответствующий эффект,
нажмите кнопку [WB SET] для выполнения автоматической регулировки баланса белого.

Совет

Для скорости отклика в режиме ATW можно выбрать одну из пяти ступеней (1, 2, 3, 4, 5) с помощью параметра [Shooting]
> [White Setting] > [ATW Speed] в меню камеры. Чем меньше номер, тем выше скорость отклика.

Можно фиксировать текущее значение баланса белого, назначив функцию [ATW Hold] одной из программируемых кнопок
и нажимая эту кнопку, чтобы приостановить работу функции ATW в режиме ATW.

Нажмите кнопку [White Balance] на панели основных настроек камеры.

Цвет рамки кнопки [White Balance] изменяется на оранжевый.

Появляется панель регулировки White Balance.

1

Нажмите кнопку [White Mode] и выберите [ATW] из списка.2
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Регулировка баланса белого вручную

Баланс белого может настраиваться вручную.

Нажмите кнопку [White Balance] на панели основных настроек камеры.

Цвет рамки кнопки [White Balance] изменяется на оранжевый.

Появляется панель регулировки White Balance.

1

Нажмите кнопку [White Mode] и выберите из списка один из следующих вариантов.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Настройте баланс белого с помощью ползунков или кнопок регулировки.

Совет

Настройки ползунка и кнопок регулировки связаны.

Варианты [Memory A(T/T)] и [Memory A(R/B)] различаются осью регулировки, но результаты регулировки
взаимосвязаны.

Для [Memory A(T/T)]
В этом режиме баланс белого, сохраненный в памяти A, настраивается благодаря изменению цветовой
температуры (Temp) и оттенка Tint.

3
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Цветовую температуру можно задавать с интервалом 20 K в диапазоне от 2000 K до 5600 K. Значения более
5600 K можно задавать с интервалом, равным величине изменения цвета (в Майредах): от 5580 K до 5600 K.
При нажатии кнопки [Reset] справа от параметра [Temp] или [Tint] восстанавливается соответствующее
значение по умолчанию.
Для [Memory A(R/B)]
В этом режиме баланс белого, сохраненный в памяти A, настраивается благодаря изменению параметров R
Gain и B Gain.
При нажатии кнопки [Reset] для соответствующей настройки усиления восстанавливается значение по
умолчанию.
Для [Preset]
В этом режиме для цветовой температуры устанавливается заранее заданное значение.
Значение можно задавать с шагом 100 K.
В предустановленном режиме можно также назначить функцию [Preset White Select] программируемой
кнопке и нажимать эту кнопку для переключения на заранее заданное значение.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…
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Выполнение автоматической регулировки баланса белого

В режиме ячейки памяти A сохраняемый баланс белого настраивается автоматически.

Нажмите кнопку [White Balance] на панели основных настроек камеры.

Цвет рамки кнопки [White Balance] изменяется на оранжевый.

Появляется панель регулировки White Balance.

1

Нажмите кнопку [White Mode] и выберите [Memory A(T/T)] или [Memory A(R/B)] из списка.

[Memory A(T/T)]

[Memory A(R/B)]

2

Поместите лист белой бумаги (или другой предмет) в место, в котором имеются такой же источник и
такие же условия освещения, как у объекта съемки, затем увеличьте масштаб и заполните белым
весь экран.

3

Отрегулируйте яркость.

Настройте диафрагму с помощью процедуры из раздела “Регулировка диафрагмы вручную”.

4

Нажмите кнопку [WB SET] на панели настройки баланса белого.

[Memory A(T/T)]

5
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Примечание

Если регулировка завершится неудачно, на экране будет примерно в течение трех секунд отображаться сообщение об
ошибке. Если после повторных попыток настроить баланс белого сообщение об ошибке появляется снова, обратитесь к
представителю службы технического обслуживания компании Sony.

Совет

Возможно также выполнение в режиме ATW. Это можно использовать, если требуется быстро настроить баланс белого во
время работы функции ATW. После настройки восстанавливается обычный режим работы ATW.

См. также
Регулировка диафрагмы вручную

5-041-958-03(1) Copyright 2022 Sony Corporation

[Memory A(R/B)]

Если автоматический баланс белого выполняется в режиме ячейки памяти, то заданное в результате
автоматической регулировки значение сохраняется в памяти A.
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Экран настройки звука

Уровень звука, записываемого устройством, можно настраивать на операционном экране веб-приложения.
Настройте переключатели на блоке разъемов устройства и настройте звук с помощью меню камеры или веб-
меню.

5-041-958-03(1) Copyright 2022 Sony Corporation

Панель управления камерой — вкладка  (Audio)1.
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Выбор устройства, подающего входной аудиосигнал

Установите указанные ниже переключатели в соответствии с устройством, подключенным к разъему AUDIO IN.

Примечание

В режиме Interval Rec или Slow & Quick Motion звук не записывается.
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Если подключен микрофон, установите переключатель SETUP 2 на блоке разъемов на задней панели
данного устройства.

CH-1 и CH-2 имеют общие настройки.

1

Настройка Описание

OFF (по
умолчанию)

Выберите при использовании динамического микрофона или микрофона, работающего
от аккумуляторов. При этом отключается фантомное питание +48 В и в качестве
источника звука CH-1 и CH-2 задается вход LINE или MIC.

ON
Выберите при использовании микрофона, совместимого с фантомным питанием +48 В.
При этом включается фантомное питание +48 В и в качестве источника звука CH-1 и CH-
2 задается микрофон, совместимый с фантомным питанием.

Задайте тип подключенного устройства с помощью пункта [Audio] > [Audio Input] > [AUDIO IN Select] в
меню камеры.

2

Выберите звуковой вход в пунктах [Audio] > [Audio Input] > [CH1 Input Select] – [CH4 Input Select] веб-
меню или меню камеры.

3
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Автоматическая регулировка уровня записи звука

Задайте для каналов, в которых требуется автоматическая регулировка уровня записи звука, значение [Auto] на
странице [Audio] веб-меню или с помощью параметров [Audio] > [Audio Input] > [CH1 Level Control] – [CH4 Level
Control] в меню камеры.
Каналы, для которых задана автоматическая настройка звука, отображаются значком  (Auto) рядом с
соответствующими каналами на вкладке  (Audio) операционного экрана.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Регулировка уровня записи звука вручную

Уровень записи звука может настраиваться вручную.
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Задайте для каналов, в которых требуется ручная регулировка уровня записи звука, значение
[Manual] на странице [Audio] веб-меню или с помощью параметров [Audio] > [Audio Input] > [CH1 Level
Control] – [CH4 Level Control] в меню камеры.

1

Нажмите вкладку  (Audio) на панели управления камерой.2

На экране [Audio] панели управления камерой задайте уровень записи звука с помощью ползунка
или кнопок регулировки для канала, уровень записи звука в котором требуется настроить вручную.

Примечание

Каналы, для которых отображается значок  (Auto), настраиваются автоматически. Изменения значений,
сделанные с помощью ползунка или кнопок, не применяются к записываемому звуку.

Совет

Настройки ползунка и кнопок регулировки в каждой строке взаимосвязаны.

Уровень входного звукового сигнала можно контролировать в режиме реального времени с помощью индикатора
уровня звука на экране съемки.

3
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Использование прямого меню

Состояние и настройки устройства можно контролировать по индикации, накладываемой на изображение с
камеры, а выбирать и изменять настройки можно с помощью кнопок управления графическим пользовательским
интерфейсом на инфракрасном пульте управления.
Можно настроить указанные ниже пункты.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Значение [ND Filter]
[Auto Iris]
Значение [Iris]
[AGC]
Значение [Gain]
Значение [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
Значение [Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] и [Frame Rate]

Совет

Эту же функцию можно также выполнить с помощью программируемой кнопки и панели управления графическим
пользовательским интерфейсом в веб-приложении.

На инфракрасном пульте управления нажмите программируемую кнопку, которой назначена функция
[Direct Menu].

В заводских настройках по умолчанию кнопка [Direct Menu] назначена программируемой кнопке 1.
Только элементы, которые допускают настройку с помощью прямого меню, можно выбрать на экране с
помощью оранжевого курсора.

1

Кнопками со стрелками на панели управления графическим пользовательским интерфейсом
переместите курсор на элемент, который требуется задать, и нажмите кнопку [Set].

Открывается меню, или пункт отображается на белом фоне.

2

Выберите настройку кнопками со стрелками и нажмите кнопку [Set].

Меню или белый фон исчезает, и на экране появляется новая настройка с оранжевым курсором.
Чтобы закрыть прямое меню, снова нажмите программируемую кнопку, которой назначена функция [Direct
Menu], или подождите 3 секунды, не выполняя никаких действий.

3
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Программируемые кнопки

В веб-приложении устройства есть десять программируемых кнопок, которым можно назначать функции.
Программируемые кнопки отображаются на операционном экране и экране воспроизведения.

Примечание

При настройке параметров с помощью панели основных настроек камеры на операционном экране список
программируемых кнопок не отображается. Чтобы завершить операцию, нажмите кнопку [X] в правом верхнем углу
панели настроек.

В заводских настройках по умолчанию кнопкам назначены следующие функции.
Кнопка 1: [Direct Menu]
Кнопка 2: [Focus Setting]
Кнопка 3: [Rec Review]

Кнопки с 1 по 3 эквивалентны кнопкам с тем же номером на инфракрасном пульте управления из комплекта
поставки.

Кнопка 4: [Push Auto ND]
Кнопка 5: [Crop Select]
Кнопка 6: [Marker]
Кнопка 7: [Video Signal Monitor]
Кнопка 8: [Clip Flag OK]
Кнопка 9: [Color Bars]
Кнопка Focus Hold: [Focus Hold]

Кнопка Focus Hold эквивалентна кнопке Focus Hold на объективах с байонетом E.

Изменение функции кнопки
Используйте пункт [Project] > [Assignable Button] в меню камеры.
При изменении назначения изменяется список программируемых кнопок.
Подробнее о назначаемых функциях см. в пункте “Assignable Button” в разделе “Меню камеры и подробные
настройки”.

См. также
Assignable Button
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Съемка с замедлением/ускорением движения

Если для формата записи задано одно из следующих значений, можно установить разную частоту кадров записи
и частоту кадров воспроизведения.
В следующей таблице указаны допустимые значения частоты кадров.

Частота системы: 59.94/50/29.97/25/23.98, режим Imager Scan Mode: FF

Частота системы: 59.94/50/29.97/25/23.98, режим Imager Scan Mode: S35

Частота системы: 24, режим Imager Scan Mode: FF

Примечание

Режим с замедлением/ускорением движения нельзя задать во время записи, воспроизведения, либо когда отображается
экран эскизов.

В режиме с замедлением/ускорением движения запись звука не поддерживается.

Функции автоматической регулировки диафрагмы и автоматического управления затвором отключаются в режиме
с замедлением/ускорением движения.

Для функции автоматической фокусировки в режиме с замедлением/ускорением движения действуют следующие
ограничения.

Ограничения, связанные с моделью объектива, частотой системы и частотой кадров съемки

Кодек Формат видео Допустимые значения частоты кадров

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Кодек Формат видео Допустимые значения частоты кадров

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Кодек Формат видео Допустимые значения частоты кадров

XAVC-I 4096×2160P 1–60
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Функция автофокусировки временно отключается, если диафрагма установлена в положение F18 или выше.

Подробнее об использовании выхода RAW см. в разделе “Запись видео в формате RAW”.

См. также

Запись видео в формате RAW

5-041-958-03(1) Copyright 2022 Sony Corporation

Объектив Sony Частота системы Возможность автофокусировки

Отличный от SEL16F28 – Поддерживается при частоте 7 кадров/с или выше

SEL16F28

59,94/29,97/23,98 Поддерживается при частоте 30, 60, 120, 240 кадров/с

50,00/25,00 Поддерживается при частоте 25, 50, 100, 200 кадров/с

24,00 Не поддерживается
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Запись видео с промежутками (Interval Rec)

С помощью функции Interval Rec можно записывать видео с промежутками во внутреннюю память устройства.
Эта функция обеспечивает эффективный способ съемки медленно движущихся объектов.
При начале записи устройство автоматически записывает заданное количество кадров (Number of Frames) через
указанный временной интервал (Interval Time).

A: Интервал съемки (Interval Time)
B: Количество кадров в одном дубле (Number of Frames)

Примечание

Одновременно можно использовать только одну функцию записи в особом режиме, например Interval Rec.

При включении другого особого режима записи в то время, когда используется функция Interval Rec, она будет
автоматически отключена.

Работа в режиме Interval Rec автоматически завершается после изменения таких системных настроек, как формат видео.

Настройки функции Interval Rec нельзя изменить во время съемки или воспроизведения, либо, когда отображается экран
эскизов.

Ограничения во время записи
Звук не записывается.
Просмотр записи (Rec Review) невозможен.

Если устройство выключается во время записи
Если источник питания устройства переводится в состояние ожидания, устройство обращается к носителю на
несколько секунд, чтобы записать на него изображения, сохраненные в памяти вплоть до этого момента,
после чего устройство автоматически переключается в режим ожидания.
Если был отсоединен кабель питания постоянного тока (DC), было выключено питание от блока питания
переменного тока или было отсоединено питание по технологии PoE++, могут быть потеряны кадры, снятые
до данного момента (не более 10 секунд). Соблюдайте осторожность.

Задание количества кадров и интервала между съемкой
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В веб-меню установите в пункте [Project] > [Interval Rec] > [Setting] значение [On] и задайте значения параметров
[Number of Frames] и [Interval Time].
Устройство выходит из режима Interval Rec при отключении питания, но при этом значения параметров [Number of
Frames] и [Interval Time] сохраняются. Их не нужно будет снова задавать в следующий раз при использовании
режима Interval Rec.

Совет

Задание также возможно в пункте [Project] > [Interval Rec] меню камеры.

Начало съемки

Нажмите кнопку START/STOP (пуск/остановка записи), чтобы начать съемку. Попеременно отображаются
индикаторы “Int●Rec” и “Int●Stby”.

Остановка съемки

Остановите съемку.
Когда съемка завершается, видеоданные, которые были сохранены в памяти вплоть до этого момента,
записываются на носитель.
Для выхода из режима Interval Rec выполните одно из следующих действий.

Установите питание устройства в режим ожидания.
В режиме ожидания съемки установите для параметра [Project] > [Interval Rec] > [Setting] значение [Off].

Кроме того, работа в режиме Interval Rec автоматически завершается при перезагрузке устройства.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Запись кэшированных изображений (Picture Cache Rec)

Функция Picture Cache Rec позволяет записывать видео задним числом при начале съемки поддерживая
внутреннюю кэш-память заданной продолжительности при съемке.

Задание размера кэша

В веб-меню установите в пункте [Project] > [Picture Cache Rec] > [Setting] значение [On] и задайте размер кэша с
помощью параметра [Cache Size].

Примечание

Функцию Picture Cache Rec нельзя использовать в сочетании с функцией Interval Rec, одновременной записью в 2 гнезда
и записью прокси. Когда функция Picture Cache Rec включена (On), остальные перечисленные особые режимы записи
принудительно отключаются (Off).

Режим Picture Cache Rec нельзя выбрать во время записи, либо когда выполняется функция Rec Review.

Когда для функции Picture Cache Rec задано значение On, временной код записывается в режиме [Free Run], даже если
задан режим [Regen] или [Rec Run].

Иногда задать значение параметра [Output Format] в режиме Picture Cache Rec бывает невозможно. В этом случае
временно задайте параметру Picture Cache Rec значение Off, после чего измените эту настройку.

Совет

Время кэша может быть короче (это зависит от формата записи). Проверьте время, отображаемое в пункте [Project] >
[Picture Cache Rec] > [Cache Rec Time] веб-меню.

Задание также возможно в пункте [Project] > [Picture Cache Rec] меню камеры.

Переключать значение параметра [Picture Cache Rec] между On и Off также можно с помощью программируемой кнопки.

Запуск функции Picture Cache Rec

Когда для функции [Picture Cache Rec] задано значение On, отображается индикатор “●Cache” (● — зеленый).
При нажатии кнопки START/STOP (пуск/остановка записи) запись запускается, и видео записывается на карты
памяти, начиная с видео, которое хранится в кэш-памяти.

Примечание

При изменении формата записи видео или Basic Look, хранящиеся в кэш-памяти видео удаляется, и кэширование
начинается заново. Соответственно, запись картинки в кэш изображения перед изменением формата невозможна, даже
если начать запись сразу же после смены формата.

Настройка [Cache Size] Cache time (приблизительно)

[Short] 5 секунд

[Medium] 10 секунд

[Long] 20 секунд

[Max] Максимальное значение для каждого формата записи
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Если для функции Picture Cache Rec задается значение On или Off сразу же после установки карты памяти, данные из
кэша нельзя будет записывать на карту.

Видео сохраняется в кэш-памяти, когда функция Picture Cache Rec включена (On). Видео до момента установки для этой
функции значения On не кэшируется.

Во время доступа к карте памяти, например при воспроизведении, работе функции Rec Review или при отображении
экрана эскизов, видео в кэш-память не сохраняется. Запись видео в кэш изображения в это время невозможна.

Отмена функции Picture Cache Rec

Установите для параметра [Project] > [Picture Cache Rec] > [Setting] в веб-меню значение [Off] или нажмите
программируемую кнопку, которой назначена функция [Picture Cache Rec].

5-041-958-03(1) Copyright 2022 Sony Corporation
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Одновременная запись на карты памяти A и B (2-slot Simul Rec)

Можно одновременно записывать на карты памяти A и B, задав для параметра [Project] > [Simul Rec] > [Setting] в
веб-меню или меню камеры значение [On].

Раздельная запись на карту памяти A и на карту памяти B

Запускать и останавливать запись можно будет для каждой карты памяти отдельно с помощью кнопок записи
START/STOP или кнопки [2nd Rec START/STOP] на вкладке  (Others).
По умолчанию обе кнопки настроены запускать и останавливать одновременную запись на обе карты памяти (A и
B).
Когда кнопки настраиваются для управления записью на различные карты памяти, параметр управления началом
и остановкой съемки [SDI/HDMI Rec Control] следует за состоянием записи гнезда A.

Изменение настройки

Выполните следующее с помощью пункта [Project] > [Simul Rec] > [Rec Button Set] в меню камеры.

5-041-958-03(1) Copyright 2022 Sony Corporation

Настройка [Rec
Button Set] Кнопки и карты памяти

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:
<Slot A> <Slot B>

Запуск/остановка одновременной записи на карты памяти A и B с помощью любой из
двух кнопок.

Rec Button: <Slot A>
2nd Rec Button:
<Slot B>

Кнопка записи START/STOP запускает/останавливает запись на карту памяти A, а кнопка
[2nd Rec START/STOP] на вкладке  (Others) запускает/останавливает запись на карту
памяти B.

Rec Button: <Slot B>
2nd Rec Button:
<Slot A>

Кнопка записи START/STOP запускает/останавливает запись на карту памяти B, а кнопка
[2nd Rec START/STOP] на вкладке  (Others) запускает/останавливает запись на карту
памяти A.
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Монитор видеосигнала

С помощью параметра [Monitoring] > [Video Signal Monitor] > [Setting] в меню камеры можно задать тип
отображения видеосигнала на панели изображения с камеры: форма сигнала, вектороскоп или гистограмма.
Оранжевая линия указывает заданные значения параметров [Level Marker 1] и [Level Marker 2].
Функцию [Video Signal Monitor] также можно назначить программируемой кнопке.

Отображение цели мониторинга
В режиме Log-съемки в правом верхнем углу монитора видеосигнала для индикации цели мониторинга
отображается информация о настройке цветовой гаммы или о таблице соответствия монитора LUT.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Флаги клипов

Чтобы добавить в клип флаг клипа [OK], нажмите программируемую кнопку, которой назначена функция [Clip Flag
OK], и выберите [Add OK].
Чтобы удалить флаг клипа [OK], дважды нажмите эту кнопку и выберите [Delete Clip Flag].

Совет

Флаг клипа можно также добавить с помощью пункта [Thumbnail] > [Set Clip Flag] в меню камеры.

Экран эскизов может отображаться с сортировкой по типу флага клипа (фильтрованный экран эскизов клипов).
Подробнее см. в пункте “Операции с записанными клипами” в разделе “Экран эскизов”.

См. также

Операции с записанными клипами

5-041-958-03(1) Copyright 2022 Sony Corporation
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Компенсация дыхания

С помощью параметра [Technical] > [Lens] > [Breathing Compensation] в меню камеры можно задать для
объектива, следует ли компенсировать дыхание.
Эта функция корректирует явление, при котором угол обзора изменяется при перемещении положения фокуса.
При выполнении компенсации дыхания часть изображения электронным образом обрезается для поддержания
неизменного угла обзора, чтобы избежать появления явления дыхания фокуса.

Примечание

Когда функция компенсации дыхания включена, угол обзора и качество изображения могут слегка измениться.

В некоторых случаях (которые зависят от объектива) скорректировать изменение угла обзора, когда включена функция
компенсации дыхания, невозможно.

Компенсация дыхания невозможна, когда установлен объектив, который не поддерживает эту функцию.

В следующих случаях этой функции задается значение Off (без возможности изменения).

Когда в меню камеры для параметра [Technical] > [Lens] > [Distortion Comp.] задано значение [Off]
В веб-меню или меню камеры установите в пункте [Shooting] > [S&Q Motion] > [Setting] значение [On]
В веб-меню или меню камеры установите в пункте [Project] > [Rec Format] > [Codec] значение [RAW] или [RAW & XAVC-
I]

5-041-958-03(1) Copyright 2022 Sony Corporation
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Обзор записи прокси

Эта функция позволяет записывать прокси-данные низкого разрешения одновременно с записью исходных
видеоданных высокого разрешения.

Сведения о поддерживаемых картах памяти, форматировании карт памяти и проверке оставшейся емкости
см. в пункте “Поддерживаемые карты памяти” раздела “Подготовка карт памяти”.

О записываемом файле
Файл имеет расширение “.mp4”.
Одновременно записывается временной код.

Место сохранения записанного файла
Записанный файл сохраняется в следующем каталоге.

Об имени файла
Имя файла состоит из названия клипа, записанного на карту памяти, и суффикса “S03”.
Сведения о названиях клипов см. в пункте [TC/Media] > [Clip Name Format] в меню камеры.

См. также

Поддерживаемые карты памяти

5-041-958-03(1) Copyright 2022 Sony Corporation

Носитель для записи Путь к папке

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Запись прокси

Можно начинать запись, когда включена запись прокси.

Остановка съемки
Остановите съемку.

Задание аудиоканала для записи прокси
Аудиоканал для записи данных прокси задается в пункте [Project] > [Proxy Rec] > [Audio Channel] меню камеры.

5-041-958-03(1) Copyright 2022 Sony Corporation

В веб-меню или меню камеры установите в пункте [Project] > [Proxy Rec] > [Setting] значение [On].1

Установите карту памяти в гнездо для карт CFexpress Type A / SD-карт.

Карты CFexpress вставляются этикеткой вверх.
SD-карты вставляются этикеткой вниз.

Примечание

Для параметра Proxy Rec невозможно задать значение On одновременно с параметрами S&Q Motion или Interval
Rec. При задании для параметра Proxy Rec значения On для этих остальных режимов записи принудительно
устанавливается значение Off.

2

Нажмите кнопку START/STOP (пуск/остановка записи).

Начинается запись прокси.

Примечание

Если устройство выключается, когда карта памяти используется, или карта памяти извлекается в этот момент,
целостность находящихся на карте памяти данных не гарантируется.
Все данные, записанные на карту памяти, могут быть потеряны. Перед выключением устройства или извлечением
карты памяти необходимо обязательно убедиться, что индикатор доступа к карте памяти не горит.

При установке карты памяти следите, чтобы она не выскочила из гнезда.

3
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Обзор видов

Когда в устройстве установлен режим Custom, можно добавить регулировки черного, матрицы и других
параметров для создания “вида” на основе базового вида.

Можно также быстро выбрать другой вид, если сохраните другие сочетания настроек в файлах сцен.
Устройство поставляется с семью предварительно настроенными видами.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Выбор вида

В этом разделе рассматривается порядок выбора вида.

В веб-меню или меню камеры убедитесь, что в пункте [Project] > [Base Setting] > [Shooting Mode]
задано значение [Custom].

Совет

В режиме [Custom] на панели основных настроек камеры отображаются кнопки [ISO/Gain] и [Scene File].

1

Нажмите кнопку [Scene File] на панели основных настроек камеры.

Цвет рамки кнопки [Scene File] изменяется на оранжевый.

Появляется панель регулировки Scene File.

2

Нажмите кнопку [Scene File] на этой панели регулировки и выберите в списке файл сцены с
требуемым видом.

Следующие предварительно заданные настройки сконфигурированы по умолчанию.

Совет

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Файл сцены 1 [S-Cinetone] [HLG Live]

Файл сцены 2 [Standard] [HLG Natural]

Файл сцены 3 [Still] (Не зарегистрирован)

Файл сцены 4 [ITU709] (Не зарегистрирован)

Файл сцены 5 [709tone] (Не зарегистрирован)

Файлы сцены с 6 по 16 (Не зарегистрирован) (Не зарегистрирован)
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Вид можно также выбрать с помощью пункта [Paint/Look] > [Scene File] > [Recall] в меню камеры. Предварительно
заданный вид можно также вызвать с помощью пункта [Scene File] > [Preset Recall].

Примечание

Начиная с версии программного обеспечения 2.0, для файла сцены 5 задано значение [709tone]. Он отображается
при выполнении команды [Maintenance]> [Reset] > [Factory Default] из веб-меню.
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Импорт требуемого базового вида

Можно импортировать созданный на компьютере или другом устройстве файл 3D LUT в качестве базового вида.
Можно импортировать не более 16 файлов.
Формат файла: файл CUBE (*.cube) для таблицы соответствия 3D LUT на 17 ячеек или 33 ячейки, созданный
с помощью программы Catalyst Browse, RAW Viewer или DaVinci Resolve* (от компании Blackmagic Design Pty.
Ltd.).

Входная цветовая гамма/гамма: [S-Gamut3.Cine/S-Log3] или [S-Gamut3/S-Log3]

Проверено с программой Resolve V9.0, V10.0 и V11.0.*

Сохраните файл 3D LUT на устройстве, на котором выполняется веб-приложение.1

В веб-меню откройте пункт [Paint/Look] > [Base Look].

Открывается список зарегистрированных базовых видов.

2

Нажмите кнопку [Import] в строке, в которую требуется импортировать файл.

Открывается диалоговое окно выбора файла.

3

Выберите подготовленный файл 3D LUT.

Импортированный файл 3D LUT становится базовым видом в устройстве.

4

Выберите импортированный файл 3D LUT с помощью пункта [Paint/Look] > [Base Look] > [Select] в
меню камеры.

5

Задайте параметры [Paint/Look] > [Base Look] > [Input] и [Output] в меню камеры в соответствии с
атрибутами импортированного файла 3D LUT.

6
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Регулировка в случае недостаточной экспозиции
Если при автоматической экспозиции с выбранным импортированным базовым видом наблюдается тенденция к
недостаточной экспозиции, настройте вид с помощью пункта [Paint/Look] > [Base Look] > [AE Level Offset] в веб-
меню.

Примечание

Если просто импортировать файл 3D LUT, это не повлияет на изображение. Загрузите импортированный файл 3D LUT с
помощью пункта [Paint/Look] > [Base Look] > [Select] в меню камеры.

Если параметр [Input] задан неправильно, требуемый вид не будет получен.

Настройки пунктов меню [Input], [Output] и [AE Level Offset] применяются к базовому виду, выбранному с помощью пункта
[Select]. Если импортировано несколько файлов 3D LUT, выберите каждый файл 3D LUT с помощью пункта [Select] и
настройте параметры [Input], [Output] и [AE Level Offset] отдельно для каждого файла.

Заданные настройки [Input], [Output] и [AE Level Offset] сохраняются для каждого файла 3D LUT.

Варианты выбора базового вида/LUT для импортированных файлов 3D LUT являются общими для режимов
[SDR(BT.709)], [HDR(HLG)] и Log-съемки, но преобразование цветовой гаммы и гамма-кривой в соответствии с этими
режимами не выполняется.

Файлы 3D LUT не удаляются при выполнении команды [Maintenance] > [Reset] > [All Reset (except for Network Settings)] в
веб-меню.

Значок  (ошибка добавления файла 3D LUT), отображаемый поверх экрана [Base Look Name], указывает, что файлы
3D LUT невозможно прикрепить к клипам, записанным в режимах Log-съемки. Выполните импорт файла 3D LUT
повторно.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Настройка вида

Вид можно настраивать на основе базового вида с помощью ползунков [Master Black], [R Black] и [B Black] на
панели настройки Scene File на панели основных настроек камеры, а также параметра [Paint/Look] > [Matrix] и
других пунктов настройки в меню камеры.
Подключите устройство к телевизору или монитору и настройте качество изображения, контролируя его на экране
телевизора или монитора.

1: Ползунок/кнопки регулировки [R Black]
2: Ползунок/кнопки регулировки [B Black]
3: Ползунок/кнопки регулировки [Master Black]

Примечание

При импорте файла 3D LUT и применении его к изображению требуемый вид, определенный в файле 3D LUT, не будет
получен, если в меню камеры был изменен параметр [Paint/Look] > [Matrix] и другие настройки, отличные от настроек
базового вида.

Все настроенные параметры можно сбросить с помощью команды [Paint/Look] > [Reset Paint Settings] > [Reset without
Base Look] в меню камеры.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Сохранение вида

С помощью пункта [Paint/Look] > [Scene File] > [Store] в меню камеры можно сохранить текущий вид как файл
сцены во внутренней памяти.
Сохраненный вид можно быстро вызывать с помощью панели регулировки Scene File или с помощью операций
прямого меню.

Примечание

Если выбрать другой вид без сохранения текущего вида, текущий вид будет удален.

Совет

Предварительно заданные файлы сцен можно перезаписать. Чтобы восстановить предварительно заданный файл сцены,
загрузите восстанавливаемый вид с помощью пункта [Paint/Look] > [Scene File] > [Preset Recall] в меню камеры, затем
сохраните файл сцены с помощью пункта [Scene File] > [Store].

Удаление сохраненного вида
С помощью пункта [Paint/Look] > [Scene File] > [Delete] в меню камеры можно удалить файл сцены из внутренней
памяти.

Совет

Удаленный файл больше не будет отображаться ни на панели регулировки Scene File, ни в прямом меню.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Удаление базового вида

Импортированные файлы 3D LUT можно удалять по отдельности с помощью пункта [Paint/Look] > [Base Look] >
[Delete] в меню камеры.
С помощью пункта [Paint/Look] > [Base Look] > [Delete All] в меню камеры можно удалить все импортированные
файлы 3D LUT.

Примечание

Перед удалением убедитесь, что базовый вид не используется ни в одном из файлов сцен. Если будет удален
используемый базовый вид, вид из соответствующих файлов сцен будет неправильным.

Импортированные файлы 3D LUT не удаляются при выполнении команды [Maintenance] > [Reset] > [All Reset (except for
Network Settings)] в веб-меню.

Удаленный базовый вид больше не может использоваться как таблица LUT в режимах Log-съемки.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Съемка с последующей регулировкой вида в студии

Используя устройство в режимах Log-съемки*1 и равномерно записывая градации от темных до ярких областей,
впоследствии в студии можно выполнять тонкую настройку, например локально восстанавливая градации
в темных и ярких областях.
Однако при просмотре снятых изображений на обычном мониторе общая контрастность будет выглядеть низкой,
что затрудняет регулировку фокусировки и экспозиции.
Можно применить таблицу соответствия LUT к целевому монитору на устройстве, чтобы упростить различные
регулировки во время съемки. При автоматической съемке можно также применить таблицу соответствия LUT
к воспроизводимому видео для проверки конечного результата.
Таблицы соответствия LUT применяются следующими системами. Однако можно применить только одну таблицу
соответствия LUT.

Выход SDI
Выход HDMI и потоковая передача
Клип прокси, записанный на носитель для записи
Клип высокого разрешения (основной), записанный на носитель для записи

5-041-958-03(1) Copyright 2022 Sony Corporation

Общий термин для режима Flexible ISO/Cine EI/Cine EI Quick*1
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Применение таблицы LUT к выходу HDMI и потоковой передаче

Таблицу LUT можно применить к выходу HDMI и потоковой передаче.

Примечание

Изображение на панели изображения с камеры в веб-приложении также относится к изображениям потоковой передачи.

Совет

Это можно задать также в пункте [Shooting] > [LUT On/Off] > [HDMI/Stream] меню камеры.

Выход SDI можно задать аналогичным образом.

Для видео на носителе для записи это можно задать с помощью пунктов [Shooting] > [LUT On/Off] > [Internal Rec] и [Proxy]
в меню камеры.

Значок  (ошибка добавления файла 3D LUT), отображаемый поверх экрана [Base Look/LUT], указывает, что файлы
3D LUT невозможно прикрепить к клипам, записанным в режимах Log-съемки. Выполните импорт файла 3D LUT
повторно.
Этот значок отображается также, если файл не удается прикрепить из-за временной перегрузки при обработке.

В веб-меню или меню камеры убедитесь, что в пункте [Project] > [Base Setting] > [Shooting Mode]
задано значение [Flexible ISO], [Cine EI] или [Cine EI Quick].

Совет

В режиме Log-съемки на панели основных настроек камеры отображаются кнопки [Base ISO/Exposure Index] и [Base
Look/LUT].

1

Нажмите кнопку [Base Look/LUT] на панели основных настроек камеры.

Цвет рамки кнопки [Base Look/LUT] изменяется на оранжевый.

Появляется панель регулировки Base Look/LUT.

2

Выберите [HDMI/Stream] > [MLUT].3
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Изменение таблицы соответствия LUT

Можно изменить применяемую таблицу LUT.

Совет

Данное устройство предоставляет предустановленные таблицы LUT [s709], [709(800%)] и [S-Log3].

Можно также импортировать и применить файл 3D LUT. Подробные сведения см. в разделах “Импорт требуемого
базового вида” и “Удаление базового вида”.

Это можно задать также в пункте [Paint/Look] > [Base Look] > [Select] меню камеры.

См. также
Импорт требуемого базового вида

Удаление базового вида

5-041-958-03(1) Copyright 2022 Sony Corporation

Нажмите кнопку [Base Look/LUT] на панели основных настроек камеры.

Цвет рамки кнопки [Base Look/LUT] изменяется на оранжевый.

Появляется панель регулировки Base Look/LUT.

1

Нажмите кнопку [Base Look/LUT] и выберите базовый вид, который требуется применить.2
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Изменение распределения темных и ярких областей на записанном изображении

В режимах съемки Cine EI и Cine EI Quick можно изменить распределение темных и ярких областей, например
если требуется задать приоритет тона темных областей над тоном ярких областей, изменив значение параметра
Exposure Index в базовой чувствительности.

Нажмите кнопку [Base Look/LUT] на панели основных настроек камеры.

Цвет рамки кнопки [Base Look/LUT] изменяется на оранжевый.

Появляется панель регулировки Base Look/LUT.

1

Выберите [HDMI/Stream] > [MLUT].

Таблица LUT применяется к выходу HDMI и потоковой передаче.

2

Нажмите кнопку [Base ISO/Exposure Index] на панели основных настроек камеры.

Цвет рамки кнопки [Base ISO/Exposure Index] изменяется на оранжевый.

Появляется панель регулировки Base ISO/Exposure Index.

3

С помощью ползунка [Exposure Index] или кнопок регулировки [Exposure Index] настройте индекс
экспозиции в соответствии с требуемым распределением темных и светлых областей.

Для [Cine EI]

Для [Cine EI Quick]
Базовая чувствительность задается автоматически в соответствии с настроенным индексом экспозиции.

4
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Совет

Это можно задать также в пункте [Shooting] > [ISO/Gain/EI] > [Exposure Index] меню камеры.

Выход SDI можно использовать аналогичным образом.

Второе числовое значение настройки указывает, сколько ступеней информации о яркости назначено ярким областям (с
яркостью более 18% серого). Более яркие области будут передержаны.
Пример: в “400EI/5.0E,” 5,0 ступеней назначены яркой стороне.

Это можно также использовать как руководство для проверки темных и ярких областей перед съемкой. После проверки
экспозиции не забудьте вернуть исходное значение индекса экспозиции EI. Кроме того, в режиме Cine EI Quick следует
проявлять осторожность во избежание негативного влияния на базовую чувствительность.

5-041-958-03(1) Copyright 2022 Sony Corporation

Настройте освещенность и/или фильтр нейтральной плотности, чтобы обеспечить подходящую
экспозицию изображения с камеры, выводимого на выход [HDMI/Stream].

5
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Запись видео в формате RAW

Выходной видеосигнал RAW с разъема SDI OUT устройства можно записывать на внешнее устройство записи.
Ниже приведены поддерживаемые форматы выходных сигналов RAW.

Частота системы [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Подключите внешнее устройство записи RAW к разъему SDI OUT данного устройства.1

В веб-меню или меню камеры установите в пункте [Project] > [Base Setting] > [Shooting Mode]
значение [Cine EI], [Cine EI Quick] или [Flexible ISO].

2

Задайте угол обзора (только FF) с помощью параметра [Project] > [Rec Format] > [Imager Scan Mode] в
веб-меню или меню камеры.

3

В веб-меню или меню камеры установите в пункте [Project] > [Rec Format] > [Codec] значение [RAW].

При выборе значения [RAW & XAVC-I] одновременно записываются видеосигнал на внешнее устройство
записи RAW и видеосигнал на карты памяти в устройстве.

4

Задайте разрешение в пункте [Project] > [Rec Format] > [RAW Output Format] веб-меню или меню
камеры.

5

Убедитесь, что внешнее устройство записи включено, затем нажмите кнопку START/STOP (пуск/
остановка записи) на операционном экране.

Состояние записи видео в формате RAW обозначается значком на панели изображения с камеры.

6
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Примечание

Если запустить запись на внешнем устройстве записи без использования кнопки записи START/STOP на операционном
экране, клипы могут не записываться должным образом.

5-041-958-03(1) Copyright 2022 Sony Corporation

Примечание

Сигнал управления записью выводится на разъем SDI OUT устройства, но получить состояние внешнего устройства
записи невозможно. Соответственно, устройство может показывать, что выполняется видеозапись в формате RAW,
когда фактически внешнее устройство записи ничего не записывает. Для получения правильного состояния работы
проверяйте индикатор на внешнем устройстве записи.
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Запись видео в формате RAW в режиме с замедлением/ускорением движения

Можно записывать видео в формате RAW в режиме с замедлением/ускорением движения.

Подробные сведения о поддерживаемых значениях частоты кадров при съемке см. в разделе “Съемка с
замедлением/ускорением движения”.

См. также
Съемка с замедлением/ускорением движения

5-041-958-03(1) Copyright 2022 Sony Corporation
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Включение и выключение функции управления эффектом боке

Можно с легкостью отрегулировать степень эффекта боке, связав фильтр ND и усиление и операцией задания
значения диафрагмы.

Включение и выключение функции управления эффектом боке

Включить эту функцию можно только при регулировке экспозиции вручную. Установите фильтр ND в переменный
режим, затем установите ручную регулировку для диафрагмы, усиления, затвора и фильтра нейтральной
плотности.
Функцию управления эффектом боке можно включать и выключать с помощью пункта [Shooting] > [Iris] > [Bokeh
Control] в меню камеры.
Когда функция управления эффектом боке включена (On), на индикаторах фильтра ND и усиления отображается
значок  (B).

Примечание

Эта функция может работать только при использовании объективов с байонетом E, которые могут обмениваться данными
с устройством.

Максимального эффекта от этой функции можно добиться при использовании объектива Sony с байонетом E.

При выполнении любых из перечисленных далее операций функция управления боке выключается (Off).

Когда устройство выключается
Когда регулировка диафрагмы, усиления, выдержки или фильтра ND переводится в режим Auto
При переключатель режима съемки
Когда фильтр ND переводится в режим Clear или Preset
При снятии объектива
При перезагрузке устройства, например после переключения частоты

Совет

Функцию [Bokeh Control] также можно назначить программируемой кнопке, после чего с ее помощью можно будет и
включать (On), и выключать (Off) функцию управления боке.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Регулировка степени эффекта боке

Настройте параметры на шагах 2–4 в соответствии с требованиями.

Примечание

Внешний вид зависит от скорости работы, объектива, настроек и объекта съемки. Также может меняться яркость.
Настоятельно рекомендуется выполнить тестирование с использованием камеры перед съемкой.

Яркость может меняться при изменении направления регулировки диафрагмы, например, при открытии диафрагмы
после ее закрытия или при закрытии диафрагмы после ее открытия. В этом случае сначала поверните кольцо
регулировки сильнее, чем требуется, а затем верните его немного назад, проверьте яркость и начните съемку. Например,
если вы хотите открыть диафрагму до значения F8, чтобы замылить фон, сначала закройте диафрагму сильнее, чем F8,
а затем верните кольцо на значение F8, проверьте яркость и начните съемку.

Выполнять управление боке следует медленно. Если работу требуется ускорить, постараетесь производить регулировку
постепенно, постоянно проверяя, как меняется изображение.

Совет

Когда функция управления боке включена (On), значение фильтра ND и усиления совместно компенсируют изменение
экспозиции, вызванное регулировкой диафрагмы, что позволяет менять степень эффекта боке.

Сначала управление боке связывается с фильтром ND в ответ на изменение диафрагмы. Когда менять значение фильтра
ND будет невозможно, задействуется значение усиления.

В режиме MF рекомендуется сначала задать диафрагму, а затем отрегулировать фокус.

Если вместо функции управления боке используется автоматический фильтр ND, фильтр ND будет зависеть от изменения
яркости объекта съемки.

Отображение, когда задействовано значение усиления
Когда функция управления боке включена (On), усиление может меняться по мере регулировки диафрагмы.

Установите для функции управления боке значение On.1

Полностью откройте диафрагму.2

Установите фильтр нейтральной плотности на значение 1/128.3

Установите усиление на значение 0 дБ и используйте освещение для достижения правильной
экспозиции.

4

Настройте фокусировку.5

Отрегулируйте диафрагму.

Степень эффекта боке изменится.

6
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Когда связь с усилением активна и усиление меняется, в верхней части экрана отображается сообщение, а
значок  (B) на индикаторе усиления начинает мигать.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Обзор сохранения и загрузки данных конфигурации

С помощью веб-приложения настройки устройства можно сохранить в виде данных конфигурации. Это позволяет
быстро восстановить набор настроек меню, соответствующий текущей ситуации.
С помощью данного устройства почти все настройки, относящиеся к функциям камеры, кроме указанных в
приведенном ниже примечании, можно сохранить в виде файла ALL (файл со всеми настройками).

Примечание

Настройки функции сети и сведения для аутентификации не сохраняются. Сведения о сохраненных пунктах см. в разделе
“Список пунктов меню”.

См. также

Список пунктов меню

5-041-958-03(1) Copyright 2022 Sony Corporation
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Сохранение файла ALL

В этом разделе рассматривается порядок сохранения файла ALL.

5-041-958-03(1) Copyright 2022 Sony Corporation

В веб-меню откройте пункт [Project] > [All File].1

Нажмите кнопку [Save All File] > [Save].

Веб-браузер сразу загрузит файл с именем all-file.ALL.

2

Укажите расположение и имя для загруженного файла all-file.ALL и сохраните его.

Сведения об операциях с файлами см. в инструкции по эксплуатации вашего устройства.

3
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Загрузка файла ALL

В этом разделе рассматривается порядок загрузки файла ALL.

Примечание

После загрузки данных конфигурации устройство автоматически перезагружается. После перезагрузки заново загрузите
страницу в веб-браузере.

5-041-958-03(1) Copyright 2022 Sony Corporation

В веб-меню откройте пункт [Project] > [All File].1

Нажмите кнопку [Load All File] > [Load].

На устройстве, на котором запущено веб-приложение, откроется диалоговое окно открытия файла.

2

Откройте файл, который требуется загрузить.

Сведения об операциях с файлами см. в инструкции по эксплуатации вашего устройства.

3

При появлении экрана подтверждения имени загруженного файла нажмите кнопку [OK].4

При появлении экрана результата выполнения нажмите кнопку [OK].5

Дождитесь завершения перезагрузки данного устройства, затем заново подключите веб-приложение.6
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О передаче файлов

Записанный устройством файл прокси или оригинальный файл можно отправить на сервер в Интернете или на
сервер в локальной сети.

Примечание

При установке питания в состояние ожидания передача файлов приостанавливается, хотя питание на устройство по
прежнему подается.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Регистрация места назначения передачи файлов

Перед началом передачи файлов можно зарегистрировать сервер назначения передачи.

В веб-меню выберите [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (или
[Server Settings2], [Server Settings3]).

Совет

Имя выбранного варианта изменится в соответствии со значением [Display Name], настроенным на следующем
шаге.

1

Настройте следующие параметры для пунктов [Network] > [FTP Server 1] – [FTP Server 3] в веб-меню.

[Display Name]
Введите имя сервера для отображения в списке заданий передачи при выборе сервера назначения
передачи.
[Service]
Отображается тип сервера.
[FTP]: FTP-сервер
[Host Name]
Введите адрес или имя узла сервера.
[Port]
Введите номер порта для подключения к серверу.
[User Name]
Введите имя пользователя.
[Password]
Введите пароль.
[Passive Mode]
Включение и выключение пассивного режима.
[Destination Directory]
Введите имя каталога на целевом сервере.

Примечание

Если в параметре [Destination Directory] введены символы, недопустимые на целевом сервере, файлы будут
переданы в главный каталог пользователя. Недопустимые символы зависят от сервера.

[Using Secure Protocol]
Задает, требуется ли выполнять безопасную передачу по FTP.
[Root Certificate]
Загрузка или очистка сертификата.
[Load]: загрузка сертификата CA. Служит для загрузки сертификатов в формате PEM.
[Clear]: очистка сертификата CA.
[None]: не загружать и не удалять сертификат.

Примечание

Перед загрузкой сертификата CA установите правильное время на часах устройства.

При записи в формате XAVC-I 4096×2160P/3840×2160P 59.94/50P пункт [Load] недоступен.

2
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[Root Certificate Status]: отображение состояния загрузки сертификата.
[Reset]: сброс настроек Server Settings на заводские значения по умолчанию.
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Отправка файла прокси на карте памяти с экрана эскизов

Записанные на карту памяти файлы прокси можно индивидуально отправлять с экрана эскизов.

Примечание

Можно зарегистрировать до 200 заданий передачи.

5-041-958-03(1) Copyright 2022 Sony Corporation

Нажмите кнопку [Thumbnail] на операционном экране веб-приложения.

Экран переключается с изображения с камеры на экран эскизов.

1

Выберите пункт [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] в меню камеры.

Чтобы одновременно передать все файлы прокси, выберите пункт [Transfer Clip (Proxy)] > [All Clips].
Клипы можно передавать с экрана эскизов или с экрана отфильтрованных эскизов клипов.

2

Кнопкой [Set] выберите клип, который требуется передать, и нажмите кнопку [Menu].

Открывается экран подтверждения передачи.

3

Выберите [Execute].

Файл прокси, соответствующий выбранному клипу, регистрируется как задание на передачу, после чего
начинается отправка файла.
После успешной регистрации задания по передаче открывается экран результатов передачи.

4

Нажмите кнопку [OK].5
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Отправка оригинального файла на карте памяти с экрана эскизов

Передачу оригинального файла с карты памяти можно выполнить с экрана эскизов.

Примечание

Можно зарегистрировать до 200 заданий передачи.

5-041-958-03(1) Copyright 2022 Sony Corporation

Нажмите кнопку [Thumbnail] на операционном экране веб-приложения.

Экран переключается с изображения с камеры на экран эскизов.

1

Выберите пункт [Thumbnail] > [Transfer Clip] > [Select Clip] в меню камеры.

Чтобы одновременно передать все оригинальные файлы, выберите пункт [Transfer Clip] > [All Clips].
Клипы можно передавать с экрана эскизов или с экрана отфильтрованных эскизов клипов.

2

Кнопкой [Set] выберите клип, который требуется передать, и нажмите кнопку [Menu].

Открывается экран подтверждения передачи.

3

Выберите [Execute].

Оригинальный файл, соответствующий выбранному клипу, регистрируется как задание на передачу, после
чего начинается отправка файла.
После успешной регистрации задания по передаче открывается экран результатов передачи.

4

Нажмите кнопку [OK].5
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Проверка состояния передачи файлов

Состояние передачи файлов можно проверить, выбрав пункт [Network] > [File Transfer] > [View Job List] в меню
камеры.

Примечание

Можно зарегистрировать до 200 заданий передачи.

Задания на передачу сохраняются при переключении устройства в состояние ожидания, однако в случае отключения
питания любыми другими способами может пропасть до 10 последних минут информации о ходе выполнения.

Если во время передачи файла произошла ошибка, передача клипа с тем же именем, что и переданный клип, может не
возобновиться — это зависит от настроек и состояния целевого сервера передачи. В таким случае проверьте настройки и
состояние целевого сервера передачи.

Совет

Если для параметра [Network] > [File Transfer] > [Auto Upload (Proxy)] в меню камеры задано значение [On] и имеется
сетевое подключение, по завершении записи файлы прокси автоматически отправляются на сервер, указанный в пункте
[Default Upload Server].

5-041-958-03(1) Copyright 2022 Sony Corporation
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Отправка с использованием протокола Secure FTP

Файлы можно отправлять в зашифрованном виде с использованием для подключения к целевому файловому
серверу протокола FTPS в явном режиме (FTPES).
Для безопасной передачи по FTP задайте на целевом файловом сервере для параметра [Using Secure Protocol]
значение [On] и загрузите сертификат.

Подробное описание конфигурации см. в разделе “Регистрация места назначения передачи файлов”.

См. также

Регистрация места назначения передачи файлов

5-041-958-03(1) Copyright 2022 Sony Corporation
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О потоковой передаче

Устройство может одновременно выполнять потоковую передачу видео и звука, выводимых на разъем HDMI.

Примечание

Чтобы использовать потоковую передачу в качестве основного видео, в веб-меню задайте для параметра [Monitoring] >
[Output Display] > [SDI] значение [On] и для параметра [HDMI/Stream] значение [Off] и контролируйте состояние камеры на
мониторе SDI.

Если монитор, подключенный к разъему HDMI, не поддерживает формат вывода HDMI, настроенный в меню [Monitoring] в
веб-меню или меню камеры, изображение с камеры не будет выводиться в веб-приложение. Вывод потокового видео
также будет невозможен.

Для потокового видео невозможно задать разрешение, превышающее разрешение выходного сигнала HDMI.

При просмотре несколькими пользователями изображение может искажаться в зависимости от настроек кодека.

Устройство поддерживает следующие методы потоковой передачи. В скобках указаны видеокодеки, доступные
для выбора.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Задайте настройку формата потоковой передачи, настройку видеокодека и настройку аудиокодека в указанном
порядке.

●: Включено, –: Отключено

Совет

Формат потоковой передачи
Задание кодека

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Веб-приложение – – ● –

Формат RTMP можно выбрать, когда в веб-меню для параметра [Stream] > [Audio Stream] задано значение [On].*1

При значении частоты системы 59.94 или 50 и формате выходного сигнала HDMI 3840×2160 или выше вывод сигнала video 2
недоступен.

*2
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Изображение на панели изображения с камеры в веб-приложении также относится к системе потоковой передачи.
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Задание формата потоковой передачи

Задайте формат потоковой передачи с помощью пункта [Stream] > [Stream] > [Stream Setting] > [Setting] в веб-
меню.

Когда для параметра [Setting] установлено значение [RTSP]

При потоковой передаче RTSP изображение с одной камеры могут одновременно просматривать не более пяти
пользователей.
Можно задать до двух режимов видеокодеков.
[Port Number]
Задает номер порта, используемого для потоковой передачи RTSP. Значение по умолчанию — 554.
При изменении этой настройки сервер RTSP перезагружается.
[Time Out]
Задает время ожидания команды проверки активности для потоковой передачи RTSP. Время ожидания можно
задавать в диапазоне от 0 до 600 секунд. Значение по умолчанию — 60 секунд.
Если задано значение 0 секунд, событие истечения времени ожидания из-за команды проверки активности
никогда не происходит.
[Authentication]
Задает необходимую аутентификацию.
[Video Port Number 1], [Video Port Number 2]
Задает номер порта связи для данных изображения, который будет использоваться для одноадресной потоковой
передачи RTSP. Заводское значение по умолчанию для параметра Video Port Number 1 — 51000. Заводское
значение по умолчанию для параметра Video Port Number 2 — 53000. Введите четное число в диапазоне от 1024
до 65534. Заданное здесь число и последующее нечетное число, полученное добавлением 1, становятся
номерами двух портов, используемых для передачи данных изображения и управления.
[Video Port Number 1] и [Video Port Number 2] соответствуют [Stream] > [Video Stream] > [Video Stream 1] и [Video
Stream 2].
[Audio Port Number]
Задает номер порта связи для аудиоданных, который будет использоваться для одноадресной потоковой
передачи RTSP. Значение по умолчанию — 57000. Введите четное число в диапазоне от 1024 до 65534. Заданное
здесь число и последующее нечетное число, полученное добавлением 1, становятся номерами двух портов,
используемых для передачи аудиоданных и управления.

Когда для параметра [Setting] установлено значение [RTMP]

В качестве режима видеокодека для RTMP может использоваться только H.264. Чтобы использовать RTMP, в веб-
меню для параметра [Stream] > [Audio Stream] задайте значение [On].
[Server URL]
Задает URL-адрес пункта назначения отправки. Введите строку символов, начинающуюся с “rtmp://” или “rtmps://”.
[Stream Key]
Введите ключ потоковой передачи, полученный от используемого сайта. При нажатии кнопки [Clear] введенная
информация удаляется.

Примечание

Соблюдайте осторожность при работе с ключом потоковой передачи. Если ключ потоковой передачи становится известен
посторонним, существует риск подмены потока.

[Root Certificate]
Импорт корневого сертификата, необходимого для потоковой передачи по протоколу RTMPS. Для импорта
корневого сертификата нажмите кнопку [Load] и выберите корневой сертификат. Нажмите кнопку [OK]
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в диалоговом окне выбора файла, чтобы импортировать выбранный файл в устройство. Если в устройстве
имеется импортированный корневой сертификат, то он будет обновлен. Чтобы удалить импортированный
корневой сертификат, нажмите кнопку [Delete] на экране настройки. Статус корневого сертификата отображается
в экране [Root Certificate Status].

Примечание

Импортируйте корневой сертификат, требуемый сервисом потоковой передачи.

Когда для параметра [Setting] установлено значение [SRT-Caller] или [SRT-Listener]

Режим видеокодека может быть только H.264.
[Destination]
Отображается, если установлен режим потоковой передачи [SRT-Caller]. Задает URL-адрес пункта назначения
подключения.
[Port Number]
Отображается, если установлен режим потоковой передачи [SRT-Listener]. Задает номер порта для
прослушивания. Значение по умолчанию — 4201.
[Latency]
Задает задержку в диапазоне от 20 до 8000 мс. Значение по умолчанию — 120.
[TTL]
Задает значение TTL в диапазоне от 1 до 255. Значение по умолчанию — 64.
[Encryption]
Выбирает способ шифрования. Выберите Off, AES128 или AES256. Значение по умолчанию — Off.
[Passphrase]
Задает парольную фразу, которая используется для шифрования. При нажатии кнопки [Clear] настроенная
парольная фраза сбрасывается.
[ARC]
Для включения функции адаптивного управления скоростью установите значение On.
Когда функция адаптивного управления скоростью включена, количество прерываний изображения, вызванных
перегрузкой линии связи, может быть уменьшено.

Когда для параметра [Setting] установлено значение [NDI|HX]

Устройство соответствует требованиям NDI|HX версии 2 от NewTek.
Для использования NDI|HX необходимо приобрести лицензионный ключ.
Приобретение лицензионного ключа
Приобрести можно по следующему URL-адресу NewTek.
https://www.newtek.com/ndihx/products/upgrade/

Примечание

Загрузите новейший драйвер NDI|HX и установите его в продукт NewTek.

Сведения о регистрации и использовании NDI|HX см. в инструкции по эксплуатации продукта NewTek.

[License]
Служит для отображения сведений о включенной лицензии.
[Source Name]
Служит для отображения имени источника.
[Group]
Чтобы включить функцию группирования NDI, установите значение On.
[Group Name]: задание имени группы NDI. Можно задать несколько значений, разделяемых запятыми.
[Discovery Server 1], [Discovery Server 2]
Служат для задания сервера обнаружения NDI 1 и сервера обнаружения NDI 2.
[Reliable UDP Mode]
Чтобы включить режим Reliable UDP, задайте значение On.
[Multicast Mode]
Чтобы включить многоадресную потоковую передачу, задайте значение On.

278



[Multicast Prefix]: задает префикс для использования при многоадресной потоковой передаче.
[Multicast Netmask]: задает маску сети, которая определяет диапазон адресов многоадресной передачи.
[Multicast TTL]: задает значение TTL для многоадресной потоковой передачи в диапазоне от 1 до 256. Значение
по умолчанию — 3.
[Multi-TCP Mode]
Чтобы включить режим Multi-TCP, задайте значение On.
[Unicast UDP Mode]
Чтобы включить режим Unicast UDP, задайте значение On.

Об услугах и программном обеспечении независимых разработчиков
Могут действовать различные условия использования.

Предоставление услуг и обновления программного обеспечения может быть прервано или прекращено без
уведомления.
Описания услуг и программного обеспечения могут быть изменены без уведомления.
Может требоваться отдельная регистрация и подписка.

Компания Sony не несет ответственности в отношении любых претензий, предъявляемых пользователями или
сторонними лицами в отношении услуг или программного обеспечения других компаний.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Задание видеокодека для потоковой передачи

Задайте видеокодек с помощью пункта [Stream] > [Video Stream] в веб-меню.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Можно задать до трех режимов кодеков изображения. Следующие параметры задаются раздельно для каждого
режима изображения.
[Video Stream 3] используется для отображения панели изображения с камеры в веб-приложении.

Примечание

Когда для параметра [Stream] > [Stream Setting] > [Setting] задано значение [RTMP], [SRT-Caller] или [SRT-Listener],
некоторые из настроек [Video Stream 1], [Video Stream 2] и [Video Stream 3] ([Codec], [Size], [Frame Rate], [Bit Rate
Compression Mode]) принимают значения по умолчанию.

[Codec 1], [Codec 2], [Codec 3]
Выберите [H.264], [H.265] или [Off]. Обратите внимание, что для параметра [Codec 1] невозможно задать
значение [Off]. Кроме того, для параметра [Codec 3] задано значение [JPEG] (фиксированное).

Примечание

В зависимости от сочетания различных настроек, таких как размер изображения, частота кадров и скорость передачи
данных для пунктов [Codec 1], [Codec 2] и [Codec 3] возможно появление следующих симптомов.

Увеличенная задержка видео.
Пропуск кадров во время воспроизведения.
Прерывание звука.
Медленная реакция камеры на различные команды.
Медленная реакция камеры на команды с пульта дистанционного управления.
Медленное отображение экрана монитора и медленное выполнение операций настройки.

Если появились такие симптомы, уменьшите значения параметров размера изображения, частоты кадров и скорости
передачи данных или измените значения других параметров настройки, чтобы устранить проблемы.

Когда для параметра [Stream] > [Stream Setting] > [Setting] задано значение [RTMP], [SRT-Caller] или [SRT-Listener], для
параметра [Codec 1] задается значение [H.264] (фиксированное). Для параметра [Codec 2] задается значение [Off]
(фиксированное).

Когда изменяется размер изображения или частота системы для выхода HDMI, для параметра [Codec 2] задается
значение [Off].

[Size 1], [Size 2], [Size 3]
Служат для выбора размера изображения потоковой передачи с камеры.
Доступные варианты размера изображения зависят от размера изображения на выходе HDMI.

Примечание

Когда изменяется размер изображения или частота системы для выхода HDMI, будет выбран максимальный размер
изображения.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Служат для задания частоты кадров изображения.
Единицы “fps” указывают количество передаваемых кадров в секунду.
Доступные варианты частоты кадров зависят от размера изображения на выходе HDMI.
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Примечание

Когда изменяется размер изображения или частота системы для выхода HDMI, будет выбрана максимальная частота
кадров.

[I-Picture Mode 1], [I-Picture Mode 2]
Задает метод указания интервала вставки I-изображений для кодеков H.264 и H.265: [Time] или [Frame].
Не может задаваться для параметра [Codec 3].
[Time]: задает интервал вставки I-изображения в виде времени.
[Frame]: задает интервал вставки I-изображения в виде числа кадров.
[I-Picture Interval 1], [I-Picture Interval 2]
Задает интервал вставки I-изображений в секундах. Значение задается в диапазоне от 1 до 5 секунд. Значение по
умолчанию — 1 секунда.
Не может задаваться для параметра [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Задает интервал вставки I-изображений для кодеков H.264 и H.265 в виде количества кадров в диапазоне от 15
до 300. Значение по умолчанию — 300 кадров.
Не может задаваться для параметра [Codec 3].
[Profile 1], [Profile 2]
Задает профиль кодека изображений H.264 или H.265.
[H.264]: выберите профиль [high], [main] или [baseline].
[H.265]: выберите профиль [main] или [main10]. Если включены два видеокодека, для выбора доступен только
профиль [main].
Эффективность сжатия изображений увеличивается в порядке [high], [main] и [baseline]. Выберите профиль,
поддерживаемый вашей системой.
Когда для пункта [H.265] задано значение [main10], для работы используется значение [main10] для выходного
сигнала HDMI в формате YCrCb или значение [main] для выходного сигнала HDMI в формате RGB.
Не может задаваться для параметра [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Выберите [CBR] или [VBR].
Для поддержания постоянной скорости передачи данных выберите значение [CBR]. Для поддержания качества
изображения выберите значение [VBR].
Не может задаваться для параметра [Codec 3].

Примечание

В зависимости от размера изображения, снимаемой сцены, сетевой среды и других факторов, фактическая частота
кадров и скорость передачи данных при потоковой передаче могут отличаться от заданных значений.

Когда для параметра [Stream] > [Stream Setting] > [Setting] задано значение [RTMP], [SRT-Caller] или [SRT-Listener], для
параметра [Bit Rate Compression Mode 1] задается значение [CBR] (фиксированное).

[Bit Rate 1], [Bit Rate 2]
Когда для параметра [Bit Rate Compression Mode] задано значение [CBR], можно задать скорость передачи
данных для каждого видеопотока. Задание высокой скорости передачи данных обеспечивает потоковую передачу
с высоким качеством видеоизображения.
Не может задаваться для параметра [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Задает качество изображения в диапазоне от 1 до 10. Значение 10 задает самое высокое качество изображения.
Значение по умолчанию — 6.
Для [Quality 1] и [Quality 2] качество изображения H.264 можно задать, задав для параметра [Bit Rate Compression
Mode] значение [VBR], а для параметра [Codec] — значение [H.264]. Качество изображения H.265 можно задать,
задав для параметра [Bit Rate Compression Mode] значение [VBR], а для параметра [Codec] — значение [H.265].

5-041-958-03(1) Copyright 2022 Sony Corporation
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Задание аудиокодека для потоковой передачи

Задайте аудиокодек с помощью пункта [Stream] > [Audio Stream] в веб-меню.
[Setting]
Чтобы включить потоковую передачу звука, задайте значение On.

Примечание

Перед выбором RTMP всегда предварительно устанавливайте значение On.

[Codec]
Служит для выбора типа кодека, используемого для потоковой передачи звука.
[AAC (256kbps)]: выберите, чтобы задать приоритет качества звука.
[AAC (128kbps)]: выберите, чтобы задать приоритет пропускной способности.
Эта настройка не влияет на клип, записываемый в устройстве, или на аудиосигнал, внедренный в сигнал
HDMI/SDI.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Запуск/остановка потоковой передачи

Для [RTSP], [SRT-Listener] и [NDI|HX]

Устройство ожидает запроса начала потоковой передачи.
Запустите клиентское приложение для просмотра потоковой передачи и откройте URL-адрес, указанный
в следующей таблице.
Введите значения для имени пользователя и пароля, настроенные в устройстве.

<camera_address>: IP-адрес данного устройства
<Port>: порт прослушивателя, настроенный с помощью параметра [Port Number]

Примечание

Воспроизведение в любых приложениях или на любых устройствах не гарантируется.

Для [RTMP] и [SRT-Caller]

Чтобы начать потоковую передачу, нажмите кнопку [Stream now] на вкладке  (Stream) операционного экрана.
Надпись на кнопке изменяется на [Stop stream], и в верхней части панели изображения с камеры появляется
значок [Stream].
Чтобы остановить потоковую передачу, нажмите кнопку [Stop stream] во время потоковой передачи. Надпись на
кнопке изменяется обратно на [Stream now], и значок [Stream] вверху панели изображения с камеры исчезает.

Примечание

Воспроизведение в любых приложениях или на любых устройствах не гарантируется.

5-041-958-03(1) Copyright 2022 Sony Corporation

Формат потоковой передачи URL-адрес

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX См. инструкции по эксплуатации клиентского устройства с поддержкой NDI|HX.
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Экран эскизов

При нажатии кнопки [Thumbnail] на экране воспроизведения или кнопки THUMBNAIL на инфракрасном пульте
управления на панели изображения с камеры отображаются клипы, записанные на карту памяти. Это
отображение на панели изображения с камеры называется экраном эскизов.
На экране эскизов можно выбрать клип и запустить его воспроизведение.
Если нажать кнопку [Thumbnail], когда отображается экран эскизов, экран закрывается и появляется снимаемое
изображение.

Примечание

На экране эскизов отображаются только клипы, записанные в выбранном в данный момент формате. Если нужного клипа
нет на экране, проверьте формат записи. На это следует обращать особое внимание перед форматированием
(инициализацией) носителя.

Компоновка экрана

Эскиз выбранного клипа отображается на оранжевом фоне.
В нижней части экрана отображается информация о выбранном клипе.
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Выбранная карта памяти
Если карта памяти защищена от записи, справа отображается значок замка.

1.

Номер клипа/общее количество клипов2.

Эскиз (индексное изображение)
Отображает индексное изображение клипа. После записи клипа его первый кадр автоматически задается в
качестве индексного изображения.
Информация о клипе/кадре отображается под эскизом. Отображаемую информацию можно изменить в пункте
[Thumbnail] > [Customize View] > [Thumbnail Caption] меню камеры.

3.

Название клипа
Отображает имя выбранного клипа.

4.

Формат записи
Отображает формат файла выбранного клипа.

5.

Информация об особой записи
Отображает режим записи, но только в том случае, если клип был записан в особом режиме.
В отношении клипов, записанных в режиме с замедлением/ускорением движения, справа отображается
частота кадров.

6.

Длительность клипа7.

Дата создания8.
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Воспроизведение записанных клипов

Воспроизводить записанные клипы можно, когда устройство находится в режиме ожидания записи (Stby).
В этом разделе рассматривается порядок воспроизведения записанных клипов с помощью панели управления
графическим пользовательским интерфейсом.

Вставьте карту памяти для воспроизведения.1

Нажмите кнопку [Thumbnail].

Появятся эскизы клипов.

2

Кнопками со стрелками на панели управления графическим пользовательским интерфейсом
переместите курсор на эскиз клипа, который требуется воспроизвести.

3
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Примечание

На границе между клипами изображение может прерываться или замирать. Управлять устройством в течение такого
периода нельзя.

Примечание

Выбрать клип касанием экрана невозможно.

Нажмите кнопку [Set] на панели управления графическим пользовательским интерфейсом.

Воспроизведение начнется с начала выбранного клипа.

4

Выполняйте требуемые операции с помощью панели управления воспроизведением.

Совет

Работой также можно управлять с помощью панели управления графическим пользовательским интерфейсом.

Воспроизведение: нажмите кнопку [Set].
Пауза воспроизведения: нажмите кнопку [Set] во время воспроизведения. Нажмите его еще раз, чтобы
возобновить воспроизведение.
Переход в начало клипа/начало следующего клипа: нажмите кнопку со стрелкой влево/вправо.
Быстрая перемотка вперед/назад: нажмите кнопку со стрелкой влево/вправо и удерживайте ее нажатой. После
того как кнопка будет отпущена, восстанавливается обычная скорость воспроизведения.
Остановка воспроизведения: нажмите кнопку [Cancel/Back].

5

Кнопка Функция

Кнопка  (Воспроизведение/пауза)
Воспроизведение клипа. Во время воспроизведения служит для
приостановки клипа.

Кнопка  (Перемотка вперед),
кнопка  (Перемотка назад)

Воспроизведение клипа на высокой скорости. Когда эта кнопка
нажата, скорость воспроизведения изменяется в три ступени.

Кнопка  (Предыдущий), кнопка 
 (Следующий)

Переход в начало клипа или к предыдущему/следующему клипу.

Кнопка  (Стоп) Остановка воспроизведения и переключение на экран съемки.
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После выбора клипа на экране эскизов и начала воспроизведения может наблюдаться кратковременное искажение
изображения в начале клипа. Чтобы начать воспроизведение клипа без искажения, приостановите воспроизведение,
нажмите кнопку  (Предыдущий), чтобы вернуться в начало клипа, и снова запустите воспроизведение.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Операции с записанными клипами

На экране эскизов для управления клипами и проверки их свойств служит меню [Thumbnail] в меню камеры.
Нажмите кнопку [Menu] на экране воспроизведения для отображения меню камеры на панели изображения
с камеры.
С помощью меню [Thumbnail] в меню камеры можно выполнять указанные ниже операции.
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Совет

Также для отображения меню камеры можно нажать кнопку [Menu] на операционном экране.

Операции с помощью меню [Thumbnail] в меню камеры
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Кнопками со стрелками на панели управления графическим пользовательским интерфейсом выберите
требуемую функцию и нажмите кнопку [Set].
Нажмите кнопку [Cancel/Back], чтобы вернуться на предыдущий экран.

Примечание

В зависимости от состояния видеокамеры в момент отображения меню некоторые его пункты будут недоступны для
выбора.

Пункты меню для операций с клипами

Меню [Thumbnail] в меню камеры содержит следующие пункты меню, относящиеся к операциям с клипами.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Подробные сведения о каждом из пунктов меню см. в разделе “Меню [Thumbnail]”.

Отображение экрана свойств клипа
Чтобы открыть экран свойств клипа, выберите пункт [Thumbnail] > [Display Clip Properties] в меню камеры.
Для перехода к предыдущему или следующему клипу нажимайте кнопку  (Предыдущий) или 
(Следующий).

Добавление флагов клипа
В клипы можно добавлять флаги клипов (метки OK, NG или KP), чтобы фильтровать отображение клипов на
основе их флагов.
Выберите эскиз клипа, в который требуется добавить флаг клипа, затем выберите флаг клипа с помощью пункта
[Thumbnail] > [Set Clip Flag] в меню камеры.

Совет

Для добавления флагов клипов можно также использовать программируемую кнопку, которой назначена функция флага
клипа.

Отображение экрана эскизов отфильтрованных клипов
Выберите пункт [Thumbnail] > [Filter Clips] в меню камеры, после чего выберите тип флага клипа, чтобы вывести
на экран только те клипы, у которых есть указанный флаг.
Для отображения всех клипов выберите [All].
Можно также нажать кнопку [Display], чтобы отсортировать отображение эскизов по флагам.

Удаление клипов
Клипы можно удалять с карт памяти.
Выберите пункт [Thumbnail] > [Delete Clip] > [Select Clip] или [All Clips] в меню камеры.

Настройка Добавленный флаг клипа

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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[Select Clip]: удаление выбранного клипа. Можно выбрать несколько клипов.
[All Clips]: удаление всех отображаемых на экране клипов.

Изменение информации, отображаемой на экране эскизов
Информацию о клипе/кадре, отображаемую под эскизом, можно изменить.
Выберите пункт [Thumbnail] > [Customize View] > [Thumbnail Caption] в меню камеры, затем выберите
информацию, которую требуется отображать.
[Date Time]: отображение даты и времени создания клипа и его последнего изменения.
[Time Code]: отображение временного кода.
[Duration]: отображение длительности клипа.
[Sequential Number]: отображение порядкового номера каждого эскиза.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Конфигурация меню камеры

При нажатии кнопки [Menu] на панели управления графическим пользовательским интерфейсом или кнопки
MENU на инфракрасном пульте управления на панели изображения с камеры отображается меню камеры для
настройки различных необходимых параметров съемки и воспроизведения.

Меню состоит из следующих меню.

Конфигурация меню

Меню [User]
Содержит пункты меню, настроенные пользователем.
Может редактироваться с помощью пункта [Edit User Menu].
Меню [Edit User]
Содержит пункты меню, предназначенные для изменения меню [User].
Меню [Shooting]
Содержит настройки, относящиеся к съемке.
Меню [Project]
Содержит базовые настройки проекта.
Меню [Paint/Look]
Содержит настройки, относящиеся к качеству изображения.
Меню [Pan-Tilt]
Содержит настройки, связанные с поворотом/наклоном.
Меню [TC/Media]
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Содержит настройки, относящиеся к временным кодам и носителю для записи.
Меню [Monitoring]
Содержит настройки, относящиеся к выводу видео и индикации на экране.
Меню [Audio]
Содержит настройки, относящиеся к звуку.
Меню [Thumbnail]
Содержит настройки, относящиеся к экрану эскизов.
Меню [Technical]
Содержит настройки для технических параметров.
Меню [Network]
Содержит настройки, относящиеся к сети.
Меню [Maintenance]
Содержит настройки устройств, такие как часты и язык.

Конфигурация и иерархия меню камеры

Уровень 1 Уровень 2

User
(Заводские настройки)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Уровень 1 Уровень 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Уровень 1 Уровень 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Уровень 1 Уровень 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Использование меню камеры

При нажатии кнопки [Menu] на панели управления графическим пользовательским интерфейсом или кнопки
MENU на инфракрасном пульте управления на панели изображения с камеры отображается меню камеры для
настройки различных необходимых параметров съемки и воспроизведения.
Для работы с меню используются кнопки на панели управления графическим пользовательским интерфейсом.

Кнопка [Menu]: нажмите для отображения меню камеры. Нажмите еще раз при открытом меню камеры, чтобы
скрыть его.
Кнопки со стрелками: нажимайте кнопки со стрелками, чтобы перемещать курсор вверх, вниз, влево и вправо в
меню камеры для выбора пунктов меню или настроек.
Кнопка [Set]: нажмите, чтобы применить выбранный элемент.
Кнопка [Cancel/Back]: нажмите для возврата к предыдущему меню. Незавершенное изменение отменяется.

Примечание

В зависимости от состояния видеокамеры в момент отображения меню некоторые его пункты будут недоступны для
выбора.

Пункты меню настройки

Кнопками со стрелками в панели управления графическим пользовательским интерфейсом переместите курсор
на элемент, который требуется задать, и нажмите кнопку [Set], чтобы применить настройку.

В области выбора пунктов меню отображается до восьми строк. Если все доступные для пункта меню
параметры не умещаются на экране, прокрутите список, перемещая курсор вверх/вниз.
Для вложенных пунктов с широким диапазоном возможных значений (например, от −99 до +99), область
параметров не отображается. Текущее значение выделяется, что указывает на возможность изменения
значения.
Если выбрать [Execute] для функции, эта функция будет выполнена.
Если выбрать пункт, перед выполнением которого требуется подтверждение, то меню будет временно скрыто
и откроется сообщение о подтверждении. Ознакомьтесь с сообщением, после чего выберите выполнение
функции или отмену.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Ввод строки символов

При выборе элемента, например, имени файла, для которого требуется ввести символы, открывается экран
ввода символов.

5-041-958-03(1) Copyright 2022 Sony Corporation

Кнопками со стрелками на панели управления графическим пользовательским интерфейсом
выберите тип символов и примените эту настройку.

[ABC]: буквенные символы в верхнем регистре
[abc]: буквенные символы в нижнем регистре
[123]: цифровые символы
[!#$]: особые символы

1

Выберите символ и нажмите кнопку [Set], чтобы применить настройку.

Курсор переместится в следующее поле.
[Space]: ввод символа пробела в положении курсора.
[←] [→]: перемещение положения курсора.
[BS]: удаление символа, расположенного слева от курсора (backspace).

2

После завершения нажмите кнопку [Done], чтобы применить настройку.

Строка символов будет подтверждена, а экран ввода символов закроется.

3
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User

В этом разделе приводится описание предназначения и настроек каждого пункта меню.

Примечание

С помощью меню [Edit User] можно добавлять пункты меню в меню [User] и удалять их из этого меню. Можно настроить
не более 20 пунктов.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Описание

Base Setting Пункт Project > Base Setting

Focus Пункт Shooting > Focus

S&Q Motion Пункт Shooting > S&Q Motion

LUT On/Off Пункт Shooting > LUT On/Off

Simul Rec Пункт Project > Simul Rec

Proxy Rec Пункт Project > Proxy Rec

Interval Rec Пункт Project > Interval Rec

Picture Cache Rec Пункт Project > Picture Cache Rec

Assignable Button Пункт Project > Assignable Button

Scene File Пункт Project > Scene File

Base Look Пункт Paint/Look > Base Look

P/T Acceleration Пункт Pan-Tilt > P/T Acceleration

Clip Name Format Пункт TC/Media > Clip Name Format

Format Media Пункт TC/Media > Format Media

Video Signal Monitor Пункт Monitoring > Video Signal Monitor

Marker Пункт Monitoring > Marker

Zoom Пункт Technical > Zoom

Lens Пункт Technical > Lens

Edit User Menu Отображение меню Edit User.
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Edit User

Меню [Edit User] отображается на верхнем уровне, когда в меню [User] выбирается пункт [Edit User Menu].
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Add Item
Добавление пункта в меню
[User]

– –
Добавление пункта меню уровня 2 в меню
[User].

Customize Reset
Сброс пунктов в меню [User]

– –
Восстановление пунктов, которые
содержатся в меню [User] по умолчанию.

Пункт меню уровня 2,
выбранный во время
редактирования

Delete –
Удаление зарегистрированного пункта
уровня 2 из меню [User].

Move –
Изменение расположения
зарегистрированных пунктов в меню
[User].

Edit Sub Item –
Изменение (регистрация/удаление)
зарегистрированных подпунктов меню
уровня 3 в меню [User].
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ISO/Gain/EI

Задание настроек усиления.

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Mode ISO/dB dB
Выбор режима настройки
усиления.

ISO/Gain<L>

Подробные сведения
о настройках см. в разделе
“Настройки и значения по
умолчанию для ISO/Gain”.

–
Задание предварительно
установленного значения
усиления <L>.

Exposure
Index<L>

Когда для параметра Base ISO
задано значение ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Когда для параметра Base ISO
задано значение ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Когда для параметра
Base ISO задано
значение ISO 800: 800EI
/ 6.0E
Когда для параметра
Base ISO задано
значение ISO 12800:
12800EI / 6.0E

Задание значения Exposure
Index<L>.

Shockless
Gain

On / Off Off
Включение или выключение
функции плавного усиления.
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См. также

Настройки и значения по умолчанию для ISO/Gain
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Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Base
Sensitivity

High / Low Low
Задание базовой
чувствительности для
режима Custom.

Base ISO ISO 12800 / ISO 800 ISO 800
Задает базовую
чувствительность ISO для
режима Cine EI/Flexible ISO.
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ND Filter

Задание предварительно установленных значений для фильтра нейтральной плотности.
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Mode Preset / Variable Variable Выбор режима фильтра нейтральной плотности.

Preset1
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/4
Задание предварительно установленного значения
1 для фильтра нейтральной плотности.

Preset2
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/16
Задание предварительно установленного значения
2 для фильтра нейтральной плотности.

Preset3 1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/64 Задание предварительно установленного значения
3 для фильтра нейтральной плотности.
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Shutter

Задание работы электронного затвора.
Используется для четкой съемки быстро движущихся объектов.

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Mode Speed / Angle Speed

Служит для выбора режима для
задания выдержки в секундах
(Speed) или в виде угла раскрытия
затвора (Angle).

Shutter
Speed
On/Off

On / Off Off

Задает, будет ли время экспозиции
при выбранном режиме Speed
следовать значению [Shutter Speed]
или будет устанавливаться полная
экспозиция.

Shutter
Speed

64F–1/8000
Возможные значения зависят от
частоты кадров выбранного формата
видео.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 1/60
/ 1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 /
1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F /
6F / 5F / 4F / 3F / 2F / 1/24 / 1/32 / 1/48 /
1/50 / 1/60 / 1/96 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Задает выдержку затвора, если
выбран режим Speed.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 360.0° / 300.0° / 270.0° / 240.0°
/ 216.0° / 210.0° / 180.0° / 172.8° / 150.0°
/ 144.0° / 120.0° / 90.0° / 86.4° / 72.0° /
45.0° / 30.0° / 22.5° / 11.25° / 5.6°

180.0°
Задает угол раскрытия затвора, если
выбран режим Angle.
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Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

ECS On/Off On / Off Off
Включение и выключение функции
Extended Clear Scan.

ECS
Frequency

23.99–8000
Возможные значения зависят от
частоты кадров выбранного формата
записи.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Установка частоты ECS, когда
параметру Mode задано значение
ECS.
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Iris

Задает настройки диафрагмы.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Bokeh
Control

On / Off Off
Включение или выключение функции
управления боке.
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Auto Exposure

Задание настроек автоматической регулировки экспозиции.

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 /
+1.75 / +1.5 / +1.25 / +1.0 / +0.75 /
+0.5 / +0.25 / ±0 / −0.25 / −0.5 / −0.75 /
−1.0 / −1.25 / −1.5 / −1.75 / −2.0 /
−2.25 / −2.5 / −2.75 / −3.0

±0
Установка уровня яркости для
автоматически определяемой
экспозиции.

Mode Backlight / Standard / Spotlight Standard

Задает режим работы автоматической
настройки экспозиции.
Backlight: режим фоновой подсветки
(режим для сокращения затемнения
объекта съемки, когда он освещен
сзади)
Standard: стандартный режим
Spotlight: режим точечной подсветки
(режим для сокращения областей
усеченного белого, когда объект съемки
освещен точечным источником)

Speed От −99 до +99 ±0
Задает скорость регулировки для
автоматической настройки экспозиции.

AGC On / Off Off
Включение и выключение функции AGC
(Auto Gain Control — Автоматическая
регулировка усиления).

AGC Limit

Подробные сведения
о настройках см. в разделе
“Настройки и значения по
умолчанию для AGC Limit”.

–
Установка максимального усиления
функции AGC.

AGC Point F2.8 / F4 / F5.6 F2.8

Задает диафрагменное число, на
котором начинается работа функции
AGC, когда функция AGC включена
(On).

Auto
Shutter

On / Off Off Включение или выключение функции
автоматического управления затвором.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Установка самой быстрой скорости
затвора функции автоматического
управления затвором.
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См. также

Настройки и значения по умолчанию для AGC Limit
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Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Задает диафрагменное число, на
котором начинает работать функция
автоматического управления затвором.

Clip High
light

On / Off Off

Включение или выключение функции,
которая игнорирует самые яркие
области для обеспечения плавного
отклика на высокую яркость.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Установка диапазона экспозиметра для
автоматической регулировки
экспозиции в соответствии с яркостью
объекта съемки. (Недоступно при
регулировке экспозиции вручную)

Detect
Window
Indication

On / Off Off
Включение и выключение индикации
диапазона экспозамера.

Custom
Width

От 40 до 999 500
Задание ширины диапазона
экспозамера.

Custom
Height

От 70 до 999 500
Задание высоты диапазона
экспозамера.

Custom H
Position

От −479 до +479 ±0
Задание положения диапазона
экспозамера по горизонтали.

Custom V
Position

От −464 до +464 ±0 Задание положения диапазона
экспозамера по вертикали.
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White

Задание настроек баланса белого.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Preset
White

От 2000K до
15000K

3200K Установка предварительно заданного значения баланса белого.

Color
Temp
<A>

От 2000K до
15000K

3200K

Задание цветовой температуры баланса белого, сохраняемой
в памяти A.

Примечание

Поскольку значение параметра Color Temp ограничивается
величинами 2000K и 15000K во время работы функции R Gain/B
Gain, правильное отображение значения Color Temp для
значения R Gain/B Gain может быть невыполнимо.

Tint<A>
От −99 до
+99

±0

Задание значения баланса белого, сохраненного в памяти
баланса белого A.

Примечание

Поскольку во время работы функции R Gain/B Gain значение
параметра Tint ограничивается величинами ±99, правильное
отображение значения оттенка для значения R Gain/B Gain
может быть невозможно.

R Gain
<A>

От −99.0 до
+99.0

±0.0 Задание усиления R баланса белого, сохраненное в памяти A.

B Gain
<A>

От −99.0 до
+99.0

±0.0 Задание усиления B баланса белого, сохраненное в памяти A.
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White Setting

Регулировка настройки баланса белого.
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Shockless
White

Off / 1 / 2 / 3 2

Установка скорости отклика баланса белого при
переключении режима баланса белого.
Off: мгновенное переключение.
1–3: чем больше число, тем медленнее
выполняется переключение.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Установка скорости реакции в режиме ATW.
1 соответствует самой высокой скорости реакции,
5 — самой низкой.
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Offset White

Задание настроек смещения баланса белого.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Offset White
<A>

On / Off Off
Указание необходимости добавлять (On) или не
добавлять (Off) значение смещения к значению
баланса белого из ячейки памяти A.

Offset Color
Temp<A>

От −99 до +99 ±0

Задание смещения цветовой температуры,
добавляемого к балансу белого из ячейки памяти A,
когда параметру [Offset White <A>] задано значение
On.

Offset Tint<A> От −99 до +99 ±0
Задание смещения значения оттенка, добавляемого
к балансу белого из ячейки памяти A, когда параметру
[Offset White <A>] задано значение On.

Offset
White<ATW>

On / Off On
Указание необходимости добавлять (On) или не
добавлять (Off) значение смещения к значению
баланса белого ATW.

Offset Color
Temp<ATW>

От −99 до +99 ±0
Задание смещения цветовой температуры,
добавляемого к балансу белого ATW, когда параметру
[Offset White<ATW>] задано значение On.

Offset
Tint<ATW>

От −99 до +99 ±0
Задание смещения значения оттенка, добавляемого
к балансу белого ATW, когда параметру [Offset
White<ATW>] задано значение On.
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Focus

Задание настроек фокусировки.

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 /
5 / 6 / 7(Fast)

5
Задание скорости изменения фокусировки в случае
изменения объекта во время автоматической
фокусировки.

AF Subj.
Shift Sens.

1(Locked On) / 2 /
3 / 4 /
5(Responsive)

5(Responsive)
Задание чувствительности изменения фокусировки на
объект во время автоматической фокусировки.

Focus Area
Wide / Zone /
Flexible Spot

Wide

Установка целевой области для автоматической
фокусировки и автоматической фокусировки при нажатой
кнопке (AF).

См. разделы “Автоматическая регулировка
фокусировки (Auto Focus)” и “Задание области/
положения автоматической фокусировки (Focus
Area)”.

Wide: при фокусировке производится поиск объекта по
широкому углу изображения.
Zone: автоматический поиск точки фокусировки
в указанной зоне.
Flexible Spot: производит фокусировку на указанное
положение изображения.

Focus Area
(AF-S)

Flexible Spot Flexible Spot
Установка целевой области для автоматической
фокусировки одним движением (AF-S).

Face/Eye
Detection
AF

Face/Eye Only AF
/
Face/Eye Priority
AF / Off

Face/Eye Priority
AF

Включение/отключение функции AF с обнаружением лиц.
См. раздел “Отслеживание с использованием
обнаружения лиц и глаз (Face/Eye Detection AF)”.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Задание режима автофокусировки при нажатой кнопке.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF
Задает операцию при касании экрана изображения
с камеры на операционном экране веб-приложения
в режиме MF.
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См. также
Задание области/положения автоматической фокусировки (Focus Area)

Отслеживание с использованием обнаружения лиц и глаз (Face/Eye Detection AF)

Настройка целевой области фокусировки вручную (AF Assist) с помощью веб-приложения

Ручная фокусировка во время автоматической фокусировки с помощью инфракрасного пульта управления из
комплекта поставки

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

AF Assist On / Off On

Если этому параметру задано значение On, пользователь
может временно переопределять автофокус и задавать
фокус вручную.

См. разделы “Настройка целевой области
фокусировки вручную (AF Assist) с помощью веб-
приложения” и “Ручная фокусировка во время
автоматической фокусировки с помощью
инфракрасного пульта управления из комплекта
поставки”.
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S&Q Motion

Задание настроек режима замедления/ускорения движения (см. раздел “Съемка с замедлением/ускорением
движения”).

См. также

Съемка с замедлением/ускорением движения

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение
по умолчанию Описание

Setting On / Off Off
Включение и выключение режима записи
с замедлением/ускорением движения.

Frame
Rate

1fps – 60fps / 100fps / 120fps /
150fps / 180fps / 200fps /
240fps

–

Установка частоты кадров для съемки с
замедлением/ускорением движения.

Примечание

Возможные значения зависят от
выбранной частоты системы, кодека и
формата видео.
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LUT On/Off

Задание настроек таблицы соответствия.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

SDI
MLUT On / MLUT
Off

MLUT Off
Позволяет выбрать, будет ли применяться таблица
соответствия LUT монитора к видеоизображению,
выводимому на разъем SDI.

HDMI/Stream MLUT On / MLUT
Off

MLUT Off

Позволяет выбрать, будет ли применяться таблица
соответствия LUT монитора к видеоизображению,
выводимому на разъем HDMI, и при потоковой
передаче.

Proxy
MLUT On / MLUT
Off

MLUT Off
Позволяет выбрать, будет ли применяться таблица
соответствия LUT монитора к записываемому
прокси-видео.

Internal Rec
MLUT On / MLUT
Off

MLUT Off
Позволяет выбрать, будет ли применяться таблица
соответствия LUT монитора к основному
записываемому видео.

LUT On/Off
Button Target

SDI / HDMI/Stream
/ SDI &
HDMI/Stream

HDMI/Stream
Задает целевой выходной сигнал, управляемый
программируемой кнопкой, которой назначена
функция LUT On/Off.
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Noise Suppression

Задание настроек шумоподавления.

Совет

Настройки [Setting(Custom)] и [Level(Custom)] отражаются в настройке [Target Display].

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Setting(Custom) On / Off On
Включение или выключение функции
подавления шума в режиме Custom.

Level(Custom) Low / Mid / High Mid
Задание уровня подавления шума в
режиме Custom.

Setting (Cine
EI/Flex. ISO)

On / Off Off
Включение или выключение функции
подавления шума в режиме Log-съемки.

Level (Cine EI/Flex.
ISO)

Low / Mid / High Mid
Задание уровня подавления шума
в режиме Log-съемки.
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Flicker Reduce

Задание настроек коррекции мерцания.
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Mode Auto / On / Off Off Установка режима коррекции мерцания.

Frequency 50Hz / 60Hz 60Hz
Установка частоты источника питания, от которого
работает освещение, вызывающее мерцание.
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SteadyShot

Задание настроек стабилизации изображения.
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Setting
Active /
Standard / Off

Off

Задание функции стабилизации изображения.

Примечание

Возможно при установке совместимого объектива.

Если задано значение Active или Standard, поведение во
время операции поворота/наклона может отличаться от
ожидаемого.
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Base Setting

Задание базовых настроек.

См. также

Настройка основных операций
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Пункт Настройка подпункта Заводское значение
по умолчанию Описание

Shooting
Mode

Custom / Flexible ISO /
Cine EI Quick / Cine EI Custom

Установка режима съемки.

См. пункт “Установка режима съемки” в
разделе “Настройка основных
операций”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Задание цветовой гаммы записи/вывода
в режиме Custom.
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Rec Format

Задание настроек формата записи.

Настройки [RAW Output Format]

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Frequency
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59.94 Выбор частоты системы.

Imager
Scan Mode

FF / S35 FF Выбор размера блока изображения.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Установка кодека записи/воспроизведения
клипов.

Примечание

Если в пункте [Imager Scan Mode] задано
значение [S35], значения [RAW] и [RAW &
XAVC-I] недоступны.

RAW Output
Format

Доступные настройки зависят
от значения в пункте
[Frequency].

См. раздел “Настройки
[RAW Output Format]” ниже.

–

Задает размер изображения RAW,
выводимого на внешнее устройство записи
в формате RAW.

Примечание

Если в пункте [Codec] задано значение
[RAW & XAVC-I], параметр [Video Format]
переключается в соответствии
с параметром [RAW Output Format].

Video
Format

Доступные настройки зависят
от значений в пунктах
[Frequency], [Imager Scan
Mode] и [Codec].

См. раздел “Настройки
[Video Format]” ниже.

– Задание размера изображения и скорости
потока данных.

Frequency Imager Scan Mode Codec Настройка

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Значения по умолчанию выделены жирным шрифтом.
Условия, при которых невозможно задать пункт [RAW Output Format], опущены.

Настройки [Video Format]

Значения по умолчанию выделены жирным шрифтом.
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Frequency Imager Scan Mode Codec Настройка

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Задание настроек режима Log-съемки (см. пункт “Установка режима съемки” в разделе “Настройка основных
операций”).

См. также

Настройка основных операций

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Задание цветовой гаммы для режимов
Log-съемки ([Flexible ISO], [Cine EI Quick],
[Cine EI]).

Embed
LUT File On / Off On

Включение или выключение записи
метаданных файла 3D LUT (файла
CUBE).
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Simul Rec

Служит для задания настроек режима одновременной записи на карты в двух гнездах (см. раздел
“Одновременная запись на карты памяти A и B (2-slot Simul Rec)”).

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение
по умолчанию Описание

Setting On / Off Off

Включение или выключение
режима одновременной
записи на карты в двух
гнездах.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec
Button:<Slot A> <Slot B> / Rec Button:<Slot
A> 2nd Rec Button:<Slot B> / Rec Button:
<Slot B> 2nd Rec Button:<Slot A>

Rec Button:<Slot A>
<Slot B> 2nd Rec
Button:<Slot A> <Slot
B>

Назначение кнопок записи,
используемых для выбора
носителей записи.
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Proxy Rec

Служит для задания настроек режима записи прокси (см. раздел “Запись прокси”).

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Setting On / Off Off
Включение или выключение режима
записи прокси.

Audio
Channel

CH1/CH2 /
CH3/CH4

CH1/CH2
Выбор аудиоканала для записи данных
прокси.
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Interval Rec

Служит для задания настроек режима интервальной съемки (см. раздел “Запись видео с промежутками (Interval
Rec)”).

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Setting On / Off Off

Включение или выключение режима
съемки с интервалом. (При задании
этому режиму значения On всем
остальным особым режимам
задается значение Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (с)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (мин)
1 / 2 / 3 / 4 / 6 / 12 / 24 (ч)

1

Задание интервала между съемкой в
режиме Interval Rec (когда для
параметра Interval Rec задано
значение On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Возможные значения зависят от
частоты кадров выбранного
формата видео.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Задание количества кадров, которое
будет записано за один дубль в
режиме Interval Rec (когда для
параметра Interval Rec задано
значение On).
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Picture Cache Rec

Служит для задания настроек режима записи в кэш изображения (см. раздел “Запись кэшированных изображений
(Picture Cache Rec)”).

См. также
Запись кэшированных изображений (Picture Cache Rec)

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Setting On / Off Off
Включение или выключение функции кэш-памяти
изображения.

Cache
Size

Short / Medium /
Long / Max

Max
Задание времени накопления изображений в кэш-
памяти изображения (время записи кэша
изображения).

Cache
Rec Time

– –
Отображение времени накопления изображений в
кэш-памяти изображения (время записи кэша
изображения).
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SDI/HDMI Rec Control

Задание настроек управления записью через выходы SDI/HDMI.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Setting
Off / SDI/HDMI
Remote I/F /
Parallel Rec

Off

Задание управления запуском и остановкой записи на
внешнем подключенном устройстве с помощью выходного
сигнала SDI/HDMI.
Off: дистанционное управление не используется.
SDI/HDMI Remote I/F: запуск/остановка записи на внешнее
подключенное устройство, когда в устройство не вставлен
носитель для записи. Без синхронизации с точностью до
кадра с носителем в устройстве.
Parallel Rec: запуск/остановка записи на внешнее
подключенное устройство, когда в устройство вставлен
носитель для записи. С синхронизацией с точностью до кадра
с носителем в устройстве.

Примечание

Для управления с помощью выходного сигнала HDMI задайте
для параметра [TC/Media] > [HDMI TC Out] > [Setting] в меню
камеры значение [On].
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Assignable Button

Служит для назначения функций программируемым кнопкам (с <1> по <9>) и кнопке [Focus Hold Button].
Можно назначать указанные ниже функции.
[Off]: никакая функция не назначена.
[Base ISO/Sensitivity]: переключение базовой чувствительности датчика изображения.
[AGC]: включение или выключение функции AGC.
[Push AGC]: включение функции AGC на время, пока нажата кнопка.
[ND Filter]

В переменном режиме: регулировка коэффициента пропускания фильтра нейтральной плотности. Нажмите и
удерживайте для переключения между значениями Clear/Manual/Auto.
В режиме предварительно заданных установок: нажмите и удерживайте между предварительно заданными
значениями.

[ND Filter Position]: переключение между фильтрами нейтральной плотности.
[Auto ND Filter]: включение или выключение функции автоматической настройки фильтра нейтральной
плотности.
[Push Auto ND]: включение функции автоматического фильтра нейтральной плотности на время, пока нажата
кнопка.
[Auto Iris]: включение или выключение функции диафрагмы.
[Push Auto Iris]: включение функции автоматической установки диафрагмы на время, пока нажата кнопка.
[Bokeh Control]: включение или выключение режима управления боке.
[Auto Shutter]: включение или выключение функции автоматической установки выдержки.
[AE Level/Mode]: регулировка уровня AE. Нажмите и удерживайте для переключения режима AE.
[Backlight]: переключение между значениями Backlight и Standard.
[Spotlight]: переключение между значениями Spotlight и Standard.
[Preset White Select]: переключение значения стандартного режима баланса белого.
[ATW]: включение или выключение функции ATW.
[ATW Hold]: приостановка работы функции ATW.
[AF Speed/Sens.]: переключение настройки скорости изменения AF и настройки чувствительности к смене
объекта AF.
[Focus Setting]: задание области фокусировки.
[Face/Eye Detection AF]: переключение настроек AF с обнаружением лиц.
[Push AF Mode]: переключение настройки режима Push AF.
[Push AF/MF]: в режиме фокусировки MF режим AF включается при нажатой кнопке. В режиме фокусировки AF
режим MF включается при нажатой кнопке.
[Focus Hold]: в режиме фокусировки AF фокус фиксируется при нажатой кнопке.
[S&Q Motion]: включение и выключение функции записи с замедлением/ускорением движения. Если нажать и
удерживать, производится установка частоты кадров при съемке.
[LUT On/Off]: включение или выключение функции LUT. Цель переключения задается с помощью пункта
[Shooting] > [LUT On/Off] > [LUT On/Off Button Target].
[SteadyShot]: переключение между значениями Active, Standard и Off.
[Crop Select]: переключение Imager Scan Mode. Переключение включено в диапазоне без изменения формата
записи.
[Rec]: запуск/остановка записи.
[Picture Cache Rec]: включение или выключение режима записи в кэш изображения.
[Rec Review]: включение или выключение функции контроля записи.
[Clip Flag OK]: выполнение команды Add OK. Нажмите дважды для выполнения команды Delete Clip Flag.
[Clip Flag NG]: выполнение команды Add NG. Нажмите дважды для выполнения команды Delete Clip Flag.
[Clip Flag Keep]: выполнение команды Add KEEP. Нажмите дважды для выполнения команды Delete Clip Flag.

329



[Slot Select]: переключение между гнездами памяти (A) и (B).
[Color Bars]: включение или выключение цветовых полос.
[DURATION/TC/U-BIT]: переключение между значениями Time Code, Users Bit и Duration.
[Display]: включение или выключение экранной индикации.
[Lens Info]: переключение индикатора глубины поля резкости.
[Video Signal Monitor]: переключение монитора видеосигнала (например, монитора формы сигнала).
[Marker]: включение или выключение функции маркера.
[Thumbnail]: отображение или закрытие экрана эскизов.
[Auto Upload (Proxy)]: включение или выключение автоматической передачи файлов прокси.
[Direct Menu]: отображение или закрытие прямого меню.
[User Menu]: отображение/закрытие меню User.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Scene File

Служит для задания настроек, относящихся к файлам сцен (см. раздел “Съемка с требуемым видом”).

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Recall – –

Загрузка файла сцены, хранящегося
во внутренней памяти, и применение
его настроек в качестве текущих
настроек качества изображения.

Store – –
Сохранение текущего состояния
качества изображения в виде файла
сцены во внутренней памяти.

Delete – –
Удаления файла сцены из
внутренней памяти.

Preset
Recall

Когда для параметра Shooting Mode
задано значение Custom и для
параметра Target Display задано
значение SDR(BT.709): S-Cinetone /
Standard / Still / ITU709/ 709tone
Когда для параметра Shooting Mode
задано значение Custom и для
параметра Target Display задано
значение HDR(HLG): HLG Live / HLG
Natural

–

Применение стандартных настроек
качества изображения (которые не
допускают перезаписи) в качестве
текущих настроек качества
изображения.
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Base Look

Задание настроек, относящихся к базовому виду.

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Select

Когда для параметра Shooting Mode
задано значение Custom и для
параметра Target Display задано
значение SDR(BT.709): S-Cinetone /
Standard / Still / ITU709 / 709tone / User1
– User16
Когда для параметра Shooting Mode
задано значение Custom и для
параметра Target Display задано
значение HDR(HLG): HLG Live / HLG
Natural / User1 – User16
Когда для параметра Shooting Mode
задано значение режимов Log-
съемки: s709 / 709(800) / S-Log3 / User1
– User16

Когда для параметра Shooting
Mode задано значение Custom и
для параметра Target Display
задано значение SDR(BT.709): S-
Cinetone
Когда для параметра Shooting
Mode задано значение Custom и
для параметра Target Display
задано значение HDR(HLG):
HLG Live
Когда для параметра Shooting
Mode задано значение режимов
Log-съемки: s709

Выбор базового вида.

Delete – –
Удаление выбранного
базового вида.

Delete
All

– –
Удаление всех
базовых видов.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 S-Gamut3.Cine/SLog3

Задание входной
гаммы для базового
вида, выбранного с
помощью пункта
[Select].

Output BT.709 / HLG BT.709

Задание выходной
цветовой гаммы для
базового вида,
выбранного с
помощью пункта
[Select].

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 5/3EV
/ 2EV

0EV

Задание опорного
значения экспозиции
для базового вида,
выбранного с
помощью пункта
[Select].
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Reset Paint Settings

Сброс настроек меню [Paint/Look], кроме базового вида.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Reset without
Base Look

Execute / Cancel –
Сброс настроек меню [Paint/Look],
кроме базового вида.
Execute: выполнение функции.
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Black

Задание настроек черного.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Master
Black

От −99.0 до +99.0 ±0.0
Установка контрольного уровня черного
цвета.

R Black От −99.0 до +99.0 ±0.0 Установка уровня R черного цвета.

B Black От −99.0 до +99.0 ±0.0 Установка уровня B черного цвета.
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Knee

Задание настроек коррекции точки излома.
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Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Setting

Когда для параметра
Target Display задано
значение SDR(BT.709): On
/ Off / ---
Когда для параметра
Target Display задано
значение HDR(HLG): On /
Off / ---

Когда для параметра
Target Display задано
значение SDR(BT.709): Off
Когда для параметра
Target Display задано
значение HDR(HLG): Off

Включение или выключение функции
коррекции колена.

Примечание

Действует только тогда, когда для
параметра [Base Look] > [Select]
задано значение [Standard], [ITU709],
[709tone], [HLG Live] или [HLG Natural].

Auto
Knee

Когда для параметра
Target Display задано
значение SDR(BT.709): On
/ Off / ---
Когда для параметра
Target Display задано
значение HDR(HLG): On /
Off / ---

Когда для параметра
Target Display задано
значение SDR(BT.709): On
Когда для параметра
Target Display задано
значение HDR(HLG): Off

Включение или выключение функции
автоматического излома.

Примечание

Действует только тогда, когда для
параметра [Base Look] > [Select]
задано значение [Standard], [ITU709]
или [709tone].

Point От 75% до 109% 90% Установка точки колена.

Slope От −99 до +99 ±0 Установка наклона колена.

336



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Detail

Задание настроек регулирования деталей.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Setting On / Off On Включение или выключение функции деталей.

Level От −7 до +7 ±0 Установка уровня деталей.

Manual
Setting

On / Off / --- Off
Включение или выключение функции ручного
регулирования деталей.

H/V Ratio От −2 до +2 ±0

Задание баланса между горизонтальной (H) и
вертикальной (V) детализацией для ручной
регулировки деталей.

Примечание

Этот элемент зависит от версии программного

обеспечения.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Задание баланса между деталями черного (B) для
темных областей и деталями белого (W) для светлых
областей при ручной регулировке деталей.

Limit От 0 до 7 7
Задание уровня ограничения деталей для ручной
регулировки деталей.

Crispening От 0 до 7 0
Задание уровня повышения резкости для ручной
регулировки деталей.

High Light
Detail

От 0 до 4 0
Задание уровня деталей для светлых областей при
ручной регулировке деталей.

В программном обеспечении версии 1.00 этот элемент меню выглядит как [V/H Balance]. В программном обеспечении версии 1.10 или
более поздней этот элемент меню выглядит как [H/V Ratio]. Диапазон настройки не изменяется и составляет от −2 до 0 до +2, однако
влияние на качество изображения различается.
Программное обеспечение версии 1.00: чем выше заданное значение, тем выше горизонтальная (H) детализация.
Программное обеспечение версии 1.10 или более поздней: чем выше заданное значение, тем выше вертикальная (V) детализация.
После обновления программного обеспечения с версии 1.00 до версии 1.10 или более поздней параметры [All File], [Scene File] и другие
сохраняются, но в обратной полярности (при сохранении качества изображения).
Если вы зарегистрировали элемент меню [V/H Balance] в меню [User], после обновления программного обеспечения он будет
автоматически заменен элементом [H/V Ratio] в меню [User].

*1
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Matrix

Задание настроек матричной коррекции.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

User Matrix On / Off Off
Включение или выключение функции
пользовательской матричной коррекции.

User Matrix
Level

От −99 до +99 ±0
Регулировка насыщенности цвета всего
изображения.

User Matrix
Phase

От −99 до +99 ±0
Регулировка оттенка цвета (фазы) всего
изображения.

User Matrix
R-G

От −99 до +99 ±0
Задание определенной пользователем матрицы
R-G.

User Matrix
R-B

От −99 до +99 ±0
Задание определенной пользователем матрицы
R-B.

User Matrix
G-R

От −99 до +99 ±0
Задание определенной пользователем матрицы
G-R.

User Matrix
G-B

От −99 до +99 ±0
Задание определенной пользователем матрицы
G-B.

User Matrix
B-R

От −99 до +99 ±0
Задание определенной пользователем матрицы
B-R.

User Matrix
B-G

От −99 до +99 ±0
Задание определенной пользователем матрицы
B-G.
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Multi Matrix

Задание настроек мультиматричной коррекции.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Setting On / Off Off
Включение или выключение функции
мультиматричной коррекции.

Reset Execute / Cancel –
Сброс оттенка и насыщенности для
каждого цвета оси на значения по
умолчанию.

Axis
B / B+ / MG− / MG / MG+ / R / R+ /
YL− / YL / YL+ / G− / G / G+ / CY /
CY+ / B−

B Выбор оси.

Hue От −99 до +99 ±0
Выбор оттенка цвета, используемого
для мультиматричной коррекции.

Saturation От −99 до +99 ±0
Выбор насыщенности цвета,
используемого для мультиматричной
коррекции.
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P/T Acceleration

Служит для задания настроек, относящихся к ускорению для операций поворота/наклона.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Ramp
Curve

От 1 до 9 8
Выбирает ускорение/замедление для операций
поворота/наклона. Чем больше значение, тем выше
ускорение.
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Timecode

Задание настроек временного кода.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Mode
Preset / Regen /
Clock

Preset

Установка режима отсчета временного кода.
Preset: начало отсчета от предварительно
заданного значения.
Regen: начало отсчета от временного кода конца
предыдущего клипа.
Clock: использование внутренних часов
в качестве временного кода.

Run
Rec Run / Free
Run

Rec Run
Rec Run: отсчет ведется только при записи.
Free Run: отсчет ведется всегда, независимо от
операции записи.

Setting – –
Установка произвольного значения временного
кода.
Set: установка значения.

Reset Execute / Cancel – Сброс временного кода до значения 00:00:00:00.
Execute: выполнение функции.

TC
Format

DF / NDF DF
Установка формата временного кода.
DF: Пропуск кадров
NDF: Без пропуска кадров
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TC Display

Задание настроек отображения данных времени.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Display
Select

Timecode / Users Bit /
Duration

Timecode
Переключение отображения данных
времени.
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Users Bit

Задание настроек, относящихся к битам пользователя.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Mode Fix / Time Fix

Установка режима битов пользователя.
Fix: использование в битах пользователя
произвольного фиксированного значения.
Time: использование текущего времени в часах,
минутах и секундах в битах пользователя.

Setting – – Установка произвольного значения для битов
пользователя.
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HDMI TC Out

Задание настроек, относящихся к выводу временного кода при использовании разъема HDMI.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Setting On / Off Off
Установка возможности передачи временного кода на
устройства для других целей через выход HDMI.
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Clip Name Format

Задание настроек, связанных с именами клипов и их удалением.
Когда для параметра [Auto Naming] задано значение [Cam ID + Reel#], для каждого носителя для записи
определяются первые четыре символа названий клипов. Когда устанавливается новый носитель для записи или
когда последний клип на носителе для записи не соответствует параметру [Camera ID] или [Reel Number],
название клипа мигает, уведомляя о несоответствии.
Когда для параметра [Auto Naming] задано значение [Title], в качестве первой части имен клипов можно
использовать произвольную символьную строку.

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Auto
Naming

Cam ID + Reel# / Title

Выбор формата имен клипов.
Cam ID + Reel#: идентификатор камеры + номер
тома + номер снимка + дата + случайная строка
Title: произвольная строка, определяемая как [Title
Prefix] + номер клипа

Camera
ID

От A до Z A

Задание идентификатора камеры, используемого
при генерировании имен клипов.

Примечание

Доступно для настройки только тогда, когда для
параметра [Auto Naming] задано значение [Cam
ID + Reel#].

Reel
Number

От 001 до 999 001

Задание номера тома, используемого при
генерации имен клипов.

Примечание

Доступно для настройки только тогда, когда для
параметра [Auto Naming] задано значение [Cam
ID + Reel#].

Camera
Position

C / L / R C

Задание первого символа номера снимка,
используемого при генерировании имен клипов.

Примечание

Доступно для настройки только тогда, когда для
параметра [Auto Naming] задано значение [Cam
ID + Reel#].
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Порядок задания [Title Prefix]

См. также
Ввод строки символов

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Title
Prefix

nnn_ (nnn — это
последние 3 цифры
порядкового номера)
(Отображается не более
7 цифр)

nnn

Задание части названия (от 4 до 46 символов) в
имени клипа.
Открывает экран ввода строки символов.

Подробные сведения о задании заголовков и
экране ввода строки символов см. в пункте
“Задание названия” ниже и в пункте “Ввод
строки символов”.

Примечание

Доступно для настройки только тогда, когда для
параметра [Auto Naming] задано значение [Title].

Number
Set

От 0001 до 9999 0001

Задание 4-значного цифрового суффикса имени
клипа.

Примечание

Доступно для настройки только тогда, когда для
параметра [Auto Naming] задано значение [Title].

Кнопками со стрелками на панели управления графическим пользовательским интерфейсом
выберите в области выбора символов тот символ, который требуется вставить в положение курсора
в области [Title Prefix] (этот символ подсвечивается), затем нажмите кнопку [Set] на панели
управления графическим пользовательским интерфейсом.

Вставляется выбранный символ, и курсор перемещается вправо.

1

Повторяйте шаг 1 для задания названия.

При необходимости используйте кнопку [BS].

2

После настройки названия нажмите кнопку [Done], чтобы закрыть экран ввода символов.

Подробные сведения о работе на экране ввода символов см. в разделе “Ввод строки символов”.

Можно выбирать указанные ниже символы.
!#$%()+,-.;=@[ ]^_~ пробел
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Служит для обновления файла управления на картах памяти (см. раздел “Восстановление карт памяти”).

См. также

Восстановление карт памяти

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Media(A) Execute / Cancel –
Обновление файла управления на карте памяти,
вставленной в гнездо A.
Execute: выполнение функции.

Media(B) Execute / Cancel –
Обновление файла управления на карте памяти,
вставленной в гнездо B.
Execute: выполнение функции.
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Format Media

Служит для форматирования (инициализации) карт памяти (см. раздел “Форматирование (инициализация) карт
памяти”).

См. также

Форматирование (инициализация) карт памяти

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Media(A)
Full Format / Quick Format
/ Cancel

–
Форматирование карты памяти,
вставленной в гнездо A.

Media(B)
Full Format / Quick Format
/ Cancel

–
Форматирование карты памяти,
вставленной в гнездо B.
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Media Life

Служит для отображения оставшегося срока службы карт памяти.

Примечание

Карты памяти должны поддерживать отображение оставшегося срока службы.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Media(A) – –
Отображение оставшегося срока службы карты
памяти в гнезде A.

Media(B) – –
Служит для отображения оставшегося срока
службы карт памяти в гнезде B.
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Output Format

Задание настроек выходного формата.

См. также

Форматы и ограничения для выходов

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение
по умолчанию Описание

SDI Подробное описание настроек см. в разделе
“Форматы и ограничения для выходов”.

– Установка разрешения
выходов SDI и HDMI.HDMI –
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Display On/Off

Задание настроек отображаемых элементов.
Для отображения отображаемого элемента выберите On. Для скрытия отображаемого элемента выберите Off.

Пункт Настройка подпункта Заводское значение по умолчанию

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Пункт Настройка подпункта Заводское значение по умолчанию

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Служит для задания параметров монитора видеосигнала.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Setting
Off / Waveform / Vector /
Histogram

Off Задает тип монитора видеосигнала.

Level
Marker 1

От 0% до 109% 70%
Задает уровень яркости для
маркера уровня 1.

Level
Marker 2

От 0% до 109% 100%
Задает уровень яркости для
маркера уровня 2.
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Marker

Задание настроек отображения маркеров.

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Setting On / Off On
Включение или выключение отображения
всех маркеров.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Выбор цвета сигнала маркера.

Center
Marker

1 / 2 / 3 / 4 / Off Off Выбор центрального маркера.

Safety
Zone

On / Off Off
Включение или выключение маркера зоны
гарантированного отображения.

Safety
Area

80% / 90% / 92.5% / 95% 90%
Выбор размера маркера зоны
гарантированного отображения (в процентах
от общего размера экрана).

Aspect
Marker

Line / Mask / Off Off Выбор типа маркера формата изображения.

Aspect
Mask

От 0 до 15 12
Задает уровень видеосигнала за пределами
маркера.

Aspect
Safety
Zone

On / Off Off
Включение или выключение маркера зоны
гарантированного отображения формата
изображения.

Aspect
Safety
Area

80% / 90% / 92.5% / 95% 90%

Выбор размера маркера зоны
гарантированного отображения формата
изображения (в процентах от общего
размера экрана).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 /
16:9 / 17:9 / 1.66:1 / 1.85:1 /
2.35:1 / 2.39:1 / Custom

2.39:1
Установка режима при отображении маркера
формата изображения.

Custom
Aspect
Ratio

Введите произвольное
значение.

01.00:01.00

Установка произвольного значения
соотношения сторон изображения.

Примечание

Доступно, когда для параметра [Aspect
Select] задано значение [Custom].

Guide
Frame

On / Off Off
Включение или выключение отображения
опорной рамки.
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Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

100%
Marker

On / Off Off Включение или выключение 100% маркера.

User Box On / Off Off
Включение или выключение отображения
маркера поля пользователя.

User Box
Width От 3 до 479 240

Установка ширины маркера поля
пользователя (расстояние от центра до
левого и правого краев).

User Box
Height

От 3 до 269 135
Установка высоты маркера поля
пользователя (расстояние от центра до
верхнего и нижнего краев).

User Box
H Position

От −476 до +476 0
Задание положения центра маркера поля
пользователя по горизонтали.

User Box
V Position

От −266 до +266 0
Задание положения центра маркера поля
пользователя по вертикали.
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Audio Input

Задание настроек аудиовхода.

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

AUDIO IN
Select

MIC / LINE MIC
Выбор типа устройства, подключенного к разъему
AUDIO IN.

Phantom
Power +48V

On / Off Off Отображение состояния фантомного питания +48 В.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1 Отображение источника входного сигнала для записи в
канал 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2
Переключение источника входного сигнала для записи в
канал 2.

CH3 Input
Select

Off / AUDIO IN
CH1

AUDIO IN CH1
Переключение источника входного сигнала для записи в
канал 3.

CH4 Input
Select

Off / AUDIO IN
CH1 / AUDIO IN
CH2

AUDIO IN CH2
Переключение источника входного сигнала для записи в
канал 4.

AUDIO IN
CH1 MIC
Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Установка эталонного уровня записи для входного
сигнала микрофона XLR из канала AUDIO IN CH1.

AUDIO IN
CH2 MIC
Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Установка эталонного уровня записи для входного
сигнала микрофона XLR из канала AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB
/ EBUL

+4dB
Выбор опорного входного уровня, когда в пункте [AUDIO
IN Select] задано значение LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB Выбор уровня записи опорного звукового сигнала 1 кГц.

CH1 Wind
Filter

On / Off Off
Включение/выключение фильтра подавления шума
ветра для записи в канале 1.

CH2 Wind
Filter

On / Off Off
Включение/выключение фильтра подавления шума
ветра для записи в канале 2.

CH3 Wind
Filter

On / Off Off Включение/выключение фильтра подавления шума
ветра для записи в канале 3.

CH4 Wind
Filter

On / Off Off
Включение/выключение фильтра подавления шума
ветра для записи в канале 4.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

CH1 Level
Control

Auto / Manual Auto
Выбор автоматической или ручной регулировки входного
уровня звука для записи канала 1.

CH2 Level
Control

Auto / Manual Auto
Выбор автоматической или ручной регулировки входного
уровня звука для записи канала 2.

CH3 Level
Control

Auto / Manual Auto
Выбор автоматической или ручной регулировки входного
уровня звука для записи канала 3.

CH4 Level
Control

Auto / Manual Auto
Выбор автоматической или ручной регулировки входного
уровня звука для записи канала 4.

CH1 Input
Level

От 0 до 99 49 Задание уровня входного сигнала для записи канала 1.

CH2 Input
Level

От 0 до 99 49 Задание уровня входного сигнала для записи канала 2.

CH3 Input
Level

От 0 до 99 49 Задание уровня входного сигнала для записи канала 3.

CH4 Input
Level

От 0 до 99 49 Задание уровня входного сигнала для записи канала 4.

Master Input
Level

От 0 до 99 99 Установка основного входного уровня звука.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Выбор характеристик ограничителя для больших
входных сигналов при регулировке уровня аудиосигнала
вручную.

CH1&2 AGC
Mode

Mono / Stereo Stereo

Установка автоматического режима регулировки уровня
для записи канала 1 и канала 2. Если задано значение
Stereo, функция AGC синхронизирована между
каналами.

CH3&4 AGC
Mode

Mono / Stereo Stereo

Установка автоматического режима регулировки уровня
для записи канала 3 и канала 4. Если задано значение
Stereo, функция AGC синхронизирована между
каналами.

AGC Spec
−6dB / −9dB /
−12dB / −15dB /
−17dB

−6dB Выбор характеристик AGC.

1kHz Tone
on Color
Bars

On / Off Off

Включение или выключение опорного тонального
сигнала частотой 1 кГц при отображении цветовых
полос.

Примечание

Когда для этого параметра установлено значение [On],
тональный сигнал частотой 1 кГц включается для записи
в каналы 3 и 4 даже в том случае, если для параметров
[CH3 Input Select] и [CH4 Input Select] установлено
значение [Off].
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Audio Output

Задание настроек аудиовыхода.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Установка сочетания аудиоканалов для
выхода HDMI/потоковой передачи.
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Display Clip Properties

Отображение экрана свойств клипа.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Display Clip
Properties

– –
Отображение экрана свойств
клипа.
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Set Clip Flag

Задание настроек флагов клипов.
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Пункт Настройка подпункта Заводское значение по умолчанию Описание

Add OK – – Добавление флага OK.

Add NG – – Добавление флага NG.

Add KEEP – – Добавление флага KEEP.

Delete Clip Flag – – Удаление всех флагов.
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Lock/Unlock Clip

Задание настроек защиты клипов.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Select Clip – –
Выбор клипа и установка/снятие его
блокировки.

Lock All Clips – – Блокировка всех клипов.

Unlock All
Clips

– – Снятие блокировки всех клипов.
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Delete Clip

Удаление клипов.
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Пункт Настройка подпункта Заводское значение по умолчанию Описание

Select Clip – – Удаление выбранных клипов.

All Clips – – Удаление всех клипов.
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Transfer Clip

Передача клипов.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Select
Clip

– – Передача выбранных клипов.

All Clips – –

Передача всех клипов.

Примечание

Можно зарегистрировать до 200 заданий
передачи.
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Transfer Clip (Proxy)

Передача клипов прокси.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Select
Clip

– –
Передача клипов прокси, соответствующих
выбранным клипам.

All Clips – –

Передача клипов прокси, соответствующих всем
клипам.

Примечание

Можно зарегистрировать до 200 заданий
передачи.
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Filter Clips

Задание настроек клипов для отображения.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

OK – – Отображение только клипов, имеющих флаг OK.

NG – – Отображение только клипов, имеющих флаг NG.

KEEP – – Отображение только клипов, имеющих флаг KEEP.

None – –
Отображение только клипов, которым не заданы
никакие флаги.

All – – Отображение всех клипов, независимо от наличия
каких-либо флагов.
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Customize View

Переключение вида экрана эскизов.
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Пункт Настройка подпункта Заводское значение
по умолчанию Описание

Thumbnail
Caption

Date Time / Time Code /
Duration / Sequential Number

Time Code
Переключение информации,
отображаемой под эскизами.
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Color Bars

Задание настроек цветных полос.
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Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Setting On / Off Off
Включение или выключение цветовых
полос.

Type
ARIB / 100% / 75% /
SMPTE

ARIB Выбор типа цветовой полосы.
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Genlock

Служит для настройки отображения состояния внешней синхронизации (см. раздел “Синхронизация фазы
видеосигнала (Genlock)”).

См. также

Синхронизация фазы видеосигнала (Genlock)
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Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Reference
Internal / External(HD) /
External(SD)

–
Отображение типа опорного сигнала
внешней синхронизации.
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Tally

Задание настроек индикатора записи/съемки (см. раздел “Подключение сигнала съемки”).

См. также
Подключение сигнала съемки
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Tally Lamp
Brightness

High / Low / Off High Задание яркости индикатора записи/съемки.

G Tally Lamp Enable / Disable Enable Включение/выключение индикатора съемки G.

Tally Control External /
Internal

Internal

Выбор целевого устройства для приема
информации управления индикатором записи/
съемки устройства.
External: внешнее управление индикатором
съемки камеры.
Internal: управление операцией записи в камере.
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Rec Review

Служит для задания соответствующих настроек просмотра записи (см. раздел “Перемотка записи назад (Rec
Review)”).

См. также

Перемотка записи назад (Rec Review)
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Setting 3s / 10s / Clip 3s
Задание времени воспроизведения только что
записанного клипа для функции просмотра записи.
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Zoom

Служит для задания настроек масштабирования (“Регулировка масштаба”).
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Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Zoom
Type

Optical Zoom Only / On(Clear
Image Zoom)

Optical Zoom Only
Задание типа
масштабирования.
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Lens

Задание настроек, относящихся к объективам.

См. также

Компенсация дыхания
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Lens Calibration Execute / Cancel –

Выполнение функции, которая корректирует
разницу в положении масштабирования для
разных экземпляров объективов с сервоприводом
масштабирования.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Установка направления вращения кольца
масштабирования.

Примечание

Доступно только при использовании объектива с
байонетом E, который поддерживает
переключение направления вращения кольца
масштабирования.

Shading
Compensation

Auto / Off Auto Задание автоматической компенсации затенения.

Chroma
Aberration
Comp.

Auto / Off Auto
Задание автоматической компенсации
хроматических аберраций.

Distortion Comp. Auto / Off Auto Задание автоматической компенсации искажения.

Breathing
Compensation

Auto / Off Off
Задание компенсации дыхания объектива.

См. раздел “Компенсация дыхания”.

Distance Display Meter / Feet Meter
Задание единиц отображения для информации об
объективе и положения фокусировки.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length
Задание формата отображения положения
масштабирования.
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APR

Выполнение APR.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

APR
Execute /
Cancel

–

Запуск APR (Automatic Pixel Restoration — Автоматическое
восстановление пикселей) для автоматической регулировки
датчика изображения.
Execute: выполнение функции.

Примечание

Перед выполнением функции APR всегда закрывайте
объектив крышкой.

374



Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Wired LAN

Задание настроек, относящихся к соединениям по проводной ЛВС.
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

HTTP Port – 80 Отображение порта доступа HTTP.

Detail
Settings

– – Отображение свойств соединения по проводной ЛВС.

DHCP
On / Off

On
Показывает, включена (On) или выключена (Off)
функция DHCP.

IP Address –
Отображение IP-адреса устройства, если для
параметра [DHCP] задано значение [Off].

Subnet Mask –
Отображение маски подсети устройства, если для
параметра [DHCP] задано значение [Off].

Gateway –
Отображение шлюза по умолчанию устройства, если
для параметра [DHCP] задано значение [Off].

DNS Auto
On / Off

On
Отображение настройки автоматического получения
DNS.
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File Transfer

Задание настроек, относящихся к передаче файлов (см. раздел “О передаче файлов”).

См. также

О передаче файлов
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Auto Upload
(Proxy)

On / Off Off
Включение или выключение автоматической отправки
файлов прокси.

Default
Upload
Server

Server
Settings1–3 >
Display Name

–

Выбор сервера для отправки файлов. Выбранный здесь
сервер становится пунктом назначения автоматической
отправки для файлов прокси, а также пунктом назначения
отправки для файлов с экрана эскизов.
Отображение параметров [Display Name], настроенных в
пунктах [Server Settings1 – 3].

Clear
Completed
Jobs

Execute /
Cancel

–
Удаление завершенных заданий передачи из списка.
Execute: выполнение функции.

Clear All
Jobs

Execute /
Cancel

–
Удаление всех заданий передачи из списка.
Execute: выполнение функции.

View Job List – – Отображение списка заданий передачи.
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Language

Установка языка интерфейса.
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Пункт Настройка подпункта Заводское значение по умолчанию Описание

Select – –
Установка языка интерфейса.
Set: установка значения.
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Clock Set

Задание настроек внутренних часов.

Примечание

Если этот параметр изменен в меню камеры. выключите питание устройства и перезапустите устройство. В случае
запуска режима ожидания электропитания с помощью инфракрасного пульта управления или веб-приложения возможно
поведение, отличное от ожидаемого.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Time
Zone

От UTC − 12:00 до
UTC + 14:00

–
Установка разницы относительно времени
UTC с дискретностью 30 минут.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY

YYMMDD

Выбор формата отображения дат.
YYMMDD: год, месяц, день
MMDDYY: месяц, день, год
DDMMYY: день, месяц, год

12H/24H 12H / 24H 24H
Выбор формата отображения часов.
12H: 12-часовой режим
24H: 24-часовой режим

Date – –
Установка текущей даты.
Set: установка значения.

Time – –
Установка текущего времени.
Set: установка значения.
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Hours Meter

Отображение общего времени работы.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Hours(System) – –
Отображение общего количества часов
использования (невозможно сбросить).

Hours(Reset) – –
Отображение общего количества часов
использования (можно сбросить).

Reset Execute / Cancel –
Сброс общего времени работы до 0.
Execute: выполнение функции.
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Настройки и значения по умолчанию для ISO/Gain

Диапазон настроек и значения по умолчанию [ISO/Gain<L>] зависят от настроек [Mode], [Base Look] > [Select] и
[Base Sensitivity].
В таблицах значения по умолчанию выделены жирным шрифтом.

Когда для параметра [Mode] установлено значение [ISO]

Когда для параметра [Base Look] > [Select] установлено значение [S-Cinetone], [Standard],
[ITU709], [709tone] или [Still]

Когда для параметра [Base Look] > [Select] установлено значение [HLG Live] или [HLG Natural]

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [Low]

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Когда для параметра [Base Look] > [Select] установлено значение [User1] – [User16]

Когда для параметра [Mode] установлено значение [dB]

Можно задать значение в диапазоне от −3dB до +30dB с шагом 1dB.
Значение по умолчанию — 0dB.
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Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [Low]

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [Low]

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Настройки и значения по умолчанию для AGC Limit

Диапазон настроек и значения по умолчанию для меню [AGC Limit] зависят от настроек [Mode], [Base Look] >
[Select] и [Base Sensitivity].
В таблицах значения по умолчанию выделены жирным шрифтом.

Когда для параметра [Mode] установлено значение [ISO]

Когда для параметра [Base Look] > [Select] установлено значение [S-Cinetone], [Standard],
[ITU709], [709tone] или [Still]

Когда для параметра [Base Look] > [Select] установлено значение [HLG Live] или [HLG Natural]

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [Low]

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Когда для параметра [Base Look] > [Select] установлено значение [User1] – [User16]

Когда для параметра [Mode] установлено значение [dB]

Выберите одно из значений: 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Значение по умолчанию — 15dB.
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Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [Low]

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [Low]

Когда для параметра [ISO/Gain/EI] > [Base
Sensitivity] установлено значение [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Настройки качества изображения, сохраненные для каждого режима съемки

Текущее состояние элементов конфигурации, связанных с качеством изображения, сохраняется для каждого из
следующих режимов съемки. При изменении режима съемки применяются соответствующие настройки,
сохраненные для целевого режима съемки.

Целевое отображение режима Custom SDR(BT.709)
Целевое отображение режима Custom HDR(HLG)
Log-съемка (Cine EI, Cine EI Quick, Flexible ISO)

В следующих таблицах указаны связанные с качеством изображения элементы конфигурации, которые
сохраняются для каждого режима съемки.
“Да” означает, что настройка сохраняется, “Нет” — что не сохраняется. “Да”, охватывающее сразу несколько
столбцов, означает, что настройки являются общими.

Пункт

Режим съемки

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Меню
Shooting

ISO/Gain/EI

ISO/Gain Да1) Да Нет

Exposure Index Нет Нет Да Да

Base Sensitivity Да Нет

Base ISO Нет Да4) Нет3) Да4)

White

Preset White Да Да

Отличные от
указанных выше

Да

White Setting Да

Offset White Да Нет

LUT On/Off Нет Да

Noise
Suppression

Setting(Custom) Да Да Нет

Level(Custom) Да Да Нет

Setting (Cine EI/Flex.
ISO)

Нет Да

Level (Cine EI/Flex.
ISO)

Нет Да
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Пункт

Режим съемки

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Меню
Paint/Look

Base Look

Select Да Да Да

Input2) Да

Output2) Да

AE Level Offset2) Да

Black Да Да Нет

Knee

Auto Knee Да Нет Нет

Отличные от
указанных выше

Да Да Нет

Detail Да Да Нет

Matrix Да Да Нет

Multi Matrix Да Да Нет

Отдельные настройки чувствительности ISO сохраняются для обоих режимов Custom SDR(BT.709) и HDR(HLG).1)

Настройки сохраняются для каждого базового вида и не зависят от режима съемки.2)

Базовая чувствительность ISO изменяется в зависимости от индекса экспозиции.3)

Общее значение параметра в режимах съемки Flexible ISO и Cine EI.4)
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Конфигурация веб-меню

Для отображения экрана настроек нажмите вкладку переключения операционного экрана [Settings].
Экран настроек служит для задания различных настроек устройства, включая исходные настройки, настройки
сети и настройки съемки/воспроизведения, с помощью веб-меню.

Меню состоит из следующих меню.

Конфигурация и иерархия меню

Уровень 1 Описание уровня 1 Уровень 2

Shooting Содержит настройки, относящиеся к съемке. Focus
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Уровень 1 Описание уровня 1 Уровень 2

Project Содержит базовые настройки проекта.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Содержит настройки, относящиеся к качеству изображения. Base Look

Pan-Tilt Содержит настройки, связанные с поворотом/наклоном.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Содержит настройки, относящиеся к выводу видео и индикации на
экране.

Output Format

Output Display

Audio Содержит настройки, относящиеся к звуку. Audio

Technical Содержит настройки для технических параметров.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Содержит настройки, относящиеся к сети.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection
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Примечание

Пункт [Accessibility] доступен только на моделях для Северной Америки.

5-041-958-03(1) Copyright 2022 Sony Corporation

Уровень 1 Описание уровня 1 Уровень 2

Stream Содержит настройки, относящиеся к потоковой передаче.

Stream

Video Stream

Audio Stream

Maintenance Содержит настройки устройств, такие как часты и язык.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Использование веб-меню

Нажмите вкладку переключения операционного экрана [Settings] для отображения экрана настроек, который
служит для задания с помощью веб-меню различных настроек устройства, включая исходные настройки,
настройки сети и настройки съемки/воспроизведения.
Настройки в веб-меню задаются на планшете с помощью сенсорных операций, а на компьютере — с помощью
мыши.
Нажмите меню с пунктами, которые требуется настроить, чтобы открыть пункты, настраиваемые из этого меню, и
их настройки.

Способ настройки

Выбор значения

Меню (уровень 1)1.

Меню (уровень 2)2.

Настройки3.
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Нажмите переключатель для пункта. Переключатель выбранного пункта отображается оранжевым цветом.

Включение или выключение пункта

Нажмите переключатель, чтобы включить или выключить пункт. Переключатель оранжевый, когда пункт включен,
и белый, когда он выключен.

Выбор значения из списка

Нажмите кнопку раскрывающегося списка и выберите пункт из открывшегося списка.

Выбор числового значения

Для изменения числового значения нажимайте < или >. Если цифровое значение подчеркнуто, его также можно
ввести напрямую.

Ввод символа/цифры

Настройка на отдельном экране
Нажмите кнопку, чтобы выполнить операции по настройке на отдельном экране.

Сообщение с указаниями

Отображается информация, которая помогает задавать некоторые настройки, и сообщения, привлекающие
внимание пользователя.

Сохранение настройки

После завершения настройки нажмите кнопку [OK], чтобы сохранить эту настройку.
Нажмите кнопку [Cancel], чтобы отменить изменения настройки и вернуться к предыдущей настройке.
Нажмите кнопку [Reload], чтобы обновить индикацию на экране.
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Примечание

Если нажать кнопку [Reload] до сохранения настройки, изменения этой настройки будут потеряны.

Если перейти на другую страницу до сохранения настройки, изменения этой настройки будут потеряны.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Focus

Задание настроек фокусировки.

См. также
Настройка целевой области фокусировки вручную (AF Assist) с помощью веб-приложения

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Push AF
Mode

AF / Single-
shot AF(AF-S)

AF Задание режима автофокусировки при нажатой кнопке.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Задает операцию при касании экрана изображения с
камеры в режиме MF.

AF Assist
Control

On / Off On

Если задано значение [On], во время автоматической
фокусировки можно настраивать положение фокуса с
помощью ползунка фокусировки в веб-приложении.

Подробнее см. в разделе “Настройка целевой области
фокусировки вручную (AF Assist) с помощью веб-
приложения”.

Примечание

Этот пункт доступен только в том случае, если для
параметра [AF Assist] в меню камеры задано значение
[On].
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Base Setting

Задание базовых настроек.

См. также

Настройка основных операций

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение
по умолчанию Описание

Shooting
Mode

Custom / Flexible ISO / Cine
EI Quick / Cine EI

Custom

Установка режима съемки.

См. пункт “Режим съемки” в разделе
“Настройка основных операций”.

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Задание цветовой гаммы записи/вывода
в режиме Custom.
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Rec Format

Задание настроек формата записи.

Настройки [RAW Output Format]

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Frequency
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59.94

Выбор частоты системы.

Примечание

В случае изменения частоты камера
перезагружается. После перезагрузки
заново загрузите страницу в веб-браузере.

Imager
Scan Mode

FF / S35 FF Выбор размера блока изображения.

Codec
RAW / RAW & XAVC-I / XAVC-I
/ XAVC-L

XAVC-I

Установка кодека записи/воспроизведения
клипов.

Примечание

Если в пункте [Imager Scan Mode] задано
значение [S35], значения [RAW] и [RAW &
XAVC-I] недоступны.

RAW Output
Format

Доступные настройки зависят
от значения в пункте
[Frequency].

См. раздел “Настройки
[RAW Output Format]”
ниже.

–

Задает размер изображения RAW,
выводимого на внешнее устройство записи в
формате RAW.

Примечание

Если в пункте [Codec] задано значение
[RAW & XAVC-I], параметр [Video Format]
переключается в соответствии
с параметром [RAW Output Format].

Video
Format

Доступные настройки зависят
от значений в пунктах
[Frequency], [Imager Scan
Mode] и [Codec].

См. раздел “Настройки
[Video Format]” ниже.

– Задает размер изображения.
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Значения по умолчанию выделены жирным шрифтом.
Условия, при которых невозможно задать пункт [RAW Output Format], опущены.

Настройки [Video Format]

Значения по умолчанию выделены жирным шрифтом.

5-041-958-03(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec Настройка

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan Mode Codec Настройка

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

Служит для задания настроек режима одновременной записи на карты в двух гнездах (см. раздел
“Одновременная запись на карты памяти A и B (2-slot Simul Rec)”).

См. также

Одновременная запись на карты памяти A и B (2-slot Simul Rec)
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Setting On / Off Off
Включение или выключение функции одновременной
записи и установка целевого носителя для записи.

Rec
Button

Slot A / Slot B /
Slot A/Slot B

Slot A/Slot B Отображение назначения кнопки записи для каждого
носителя для записи.
В меню камеры установите [Project] > [Simul Rec] >
[Rec Button Set].

2nd Rec
Button

Slot A / Slot B /
Slot A/Slot B

Slot A/Slot B
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Proxy Rec

Служит для задания настроек режима записи прокси (см. раздел “Запись прокси”).
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Setting On / Off Off
Включение или выключение режима записи
прокси.
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Interval Rec

Служит для задания настроек режима интервальной съемки (см. раздел “Запись видео с промежутками (Interval
Rec)”).

См. также

Запись видео с промежутками (Interval Rec)

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Setting On / Off Off

Включение или выключение режима
съемки с интервалом. (При задании
этому режиму значения On всем
остальным особым режимам
задается значение Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (с)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 /
15 / 20 / 30 / 40 / 50 (мин)
1 / 2 / 3 / 4 / 6 / 12 / 24 (ч)

1

Задание интервала между съемкой в
режиме Interval Rec (когда для
параметра Interval Rec задано
значение On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
Возможные значения зависят от
частоты кадров выбранного
формата видео.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Задание количества кадров, которое
будет записано за один дубль в
режиме Interval Rec (когда для
параметра Interval Rec задано
значение On).
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Picture Cache Rec

Служит для задания настроек режима записи в кэш изображения (см. раздел “Запись кэшированных изображений
(Picture Cache Rec)”).

См. также
Запись кэшированных изображений (Picture Cache Rec)
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Setting On / Off Off
Включение или выключение функции кэш-памяти
изображения.

Cache
Size

Short / Medium /
Long / Max

Max
Задание времени накопления изображений в кэш-
памяти изображения (время записи кэша
изображения).

Cache
Rec Time

– –
Отображение времени накопления изображений в
кэш-памяти изображения (время записи кэша
изображения).
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All File

Служит для выполнения операций с файлом ALL (см. раздел “Сохранение и загрузка данных конфигурации”).
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Load All
File

– –

Загрузка файла ALL в устройство из устройства, на котором
запущено веб-приложение.

Примечание

После загрузки файла ALL в данное устройство оно будет
перезагружено. После перезагрузки заново загрузите
страницу в веб-браузере.

Save All
File

– –
Сохранение настроек данного устройства в устройство, на
котором запущено веб-приложение, в виде файла ALL.
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Base Look

В устройство можно загрузить базовый вид.
На экране отображается список доступных базовых видов. Текущий примененный базовый вид обозначается
маркером ● слева от номера базового вида.

[No.]: номер базового вида
[Base Look Name]: имя базового вида
[Input]: входной сигнал базового вида
[Output]: выходной сигнал базового вида
[AE Level Offset]: опорное значение смещения для экспозиции базового вида

Добавление базового вида
Чтобы импортировать новый базовый вид, нажмите кнопку [Import]. Следуйте инструкциям на экране.
После импорта задайте соответствующие значения параметров [Input], [Output] и [AE Level Offset]. Подробные
сведения см. в разделе “Импорт требуемого базового вида”.

См. также
Импорт требуемого базового вида

5-041-958-03(1) Copyright 2022 Sony Corporation
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P/T Speed

Служит для задания настроек, связанных со скоростью поворота/наклона.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Speed
Step

Normal /
Extended

Extended

Задание количества градаций скорости привода поворота/
наклона.
Normal: для скорости можно указать одно из 24 значений.
Используйте эту настройку для совместимости с
существующими камерами дистанционного наблюдения Sony.
Extended: для скорости можно указать одно из 50 значений.

Speed
Mode

Normal / Slow Normal

Задание режима скорости привода поворота/наклона.
Доступно только тогда, когда для параметра [Speed Step]
задано значение [Normal].
Normal: работа в обычном диапазоне скоростей (от минимума
до максимума (60 градусов/с)).
Slow: работа в диапазоне низких скоростей (от минимума до
максимума (40 градусов/с)).
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P/T Acceleration

Служит для задания настроек, связанных со скоростью поворота/наклона.
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Acceleration От 1 до 9 8
Выбирает ускорение/замедление для операций
поворота/наклона. Чем больше значение, тем выше
ускорение.
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P/T Range Limit

Служит для задания настроек, относящихся к ограничению диапазона работы поворота/наклона.
Ограничения диапазона работы поворота/наклона задаются с помощью следующего экрана.

Примечание

При включении устройства или при выполнении сброса поворота/наклона это ограничение диапазона игнорируется. Эта
функция не может использоваться для исключения столкновения с препятствиями рядом с устройством.

Установите переключатель [Setting] во включенное положение.

Функция ограничения диапазона работы поворота/наклона включается.

1

Проверьте изображение с помощью элементов управления поворота/наклона камеры.2

Чтобы задать положения, в которых требуется ограничить перемещение, нажимайте кнопки [Left],
[Right], [Up], [Down] > [Set Current Value] в этих положениях.

[Left]: левая сторона камеры
[Right]: правая сторона камеры
[Up]: верхняя сторона камеры

3

404



Примечание

Положения камеры за пределами граничных положений не могут сохраняться в качестве предварительно заданного
положения.

При изменении настройки [Pan-Tilt] > [P/T Direction] > [Ceiling] для заданных настроек граничных положений
восстанавливаются заводские значения по умолчанию.

Эту настройку невозможно изменить во время воспроизведения, при отображении эскизов, при возникновении ошибки
поворота/наклона, когда поворот/наклон не инициализированы и когда поворот/наклон заблокированы.
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[Down]: нижняя сторона камеры

Граничные положения задаются и отображаются в виде численных значений (угол).
Чтобы отменить ограничение, нажимайте кнопку [Reset] для конкретных положений.

Нажмите кнопку [OK].

Операция поворота/наклона ограничивается, чтобы камера оставалась в пределах заданных граничных
положений.

4
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P/T Direction

Служит для задания настроек, связанных с направлением поворота/наклона.

Примечание

При применении измененного значения параметра [Ceiling] все предварительно заданные положения удаляются, так как
координаты поворота/наклона инвертируются.

В зависимости от значения параметра [Ceiling] диапазон работы привода поворота/наклона изменяется, как
показано на следующей диаграмме.

A: Когда для параметра [Ceiling] установлено значение [Off]
B: Когда для параметра [Ceiling] установлено значение [On]

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Ceiling On / Off Off

Когда устройство установлено на поверхности стола, задайте
значение [Off]. Когда устройство установлено на потолке, задайте
значение [On]. Если для параметра [Ceiling] задано значение
[On], для параметра [Pan Direction] автоматически задается
значение [Opposite].

Pan
Direction

Normal /
Opposite

Normal
Задает направление работы привода поворота. При изменении
значения этого параметра направление работы привода
изменяется на противоположное.

Tilt
Direction

Normal /
Opposite

Normal
Задает направление работы привода наклона. При изменении
значения этого параметра направление работы привода
изменяется на противоположное.
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P/T Preset

Задание настроек, относящихся к предварительно заданным положениям камеры.

Pan-Tilt
Задание скорости для предварительно заданных положений.

Default
Задание значений по умолчанию, которые конфигурируются при сохранении предварительно заданного
положения.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Pan-Tilt
Speed Setting
Way

Separate /
Common

Separate
Задание раздельной или общей настройки скоростей
перехода в предварительно заданные положения.

Pan-Tilt
Speed for
Common

От 1 до 50 50

Задание общей скорости для предварительно заданных
положений.

Примечание

Когда для [Pan-Tilt] > [P/T Speed] > [Speed Step] задано
значение [Normal], то если задано значение 25 или
выше, используется максимальная скорость привода 24.

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Pan-Tilt Speed
for Separate

От 1 до 50 50
Задание скорости для предварительно заданных
положений, когда в качестве метода выбора скорости
выбрано [Separate].

Zoom Sync On / Off On
Задание синхронизации операций поворота/наклона и
масштабирования при восстановлении
предварительно заданного положения.

Zoom Speed От 0 до 32767 32767 Задание скорости масштабирования.

Focus Recall On / Off On Задание восстановления настроек фокусировки.

MF Speed От 0 до 32767 32767 Задание скорости для ручной фокусировки.
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Output Format

Задание настроек выходного формата.

См. также

Форматы и ограничения для выходов
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Пункт Настройка подпункта Заводское значение
по умолчанию Описание

SDI Подробное описание настроек см. в разделе
“Форматы и ограничения для выходов”.

– Установка разрешения
выходов SDI и HDMI.HDMI –
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Output Display

Служит для задания настроек, относящихся к выходным сигналам.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

SDI On / Off Off
Задает, внедряются ли меню и состояние в выходной
сигнал SDI.

HDMI/Stream On / Off On

Задает, внедряются ли меню и состояние в выходной
сигнал HDMI.

Примечание

Эта настройка также применяется к изображению
выходного сигнала HDMI, изображению выходного сигнала
потоковой передачи и изображению на панели
изображения с камеры в веб-приложении.
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Audio Input

Служит для задания настроек, связанных с выводом звука каналов с CH1 по CH4.

Установка основного входного уровня звука. Общий входной уровень звука используется для всех каналов с 1 по
4.
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Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Level
Control

Auto / Manual Auto
Выбор автоматической или ручной
регулировки входного уровня звука.

Level От 0 до 99 49 Установка входного уровня.

Input
Select

AUDIO IN CH1 / AUDIO
IN CH2 / Off

CH1 и CH3: AUDIO IN
CH1
CH2 и CH4: AUDIO IN
CH2

Задание источника входного аудиосигнала.

Примечание

Для параметра CH1 задается значение
[AUDIO IN CH1] (фиксированное).

Wind
Filter

On / Off Off
Включение и выключение фильтра
уменьшения шума ветра.

Пункт Настройка подпункта Заводское значение по умолчанию Описание

Master От 0 до 99 99 Установка общего входного уровня.
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Audio Output

Служит для задания настроек, относящихся к выводу звука.

Примечание

Эта настройка также применяется для выходного звукового сигнала для потоковой передачи.
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Установка сочетания аудиоканалов для
выхода HDMI/потоковой передачи.
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Tracking Data Output

Задание настроек, относящихся к выводу информации об отслеживании (совместимой с протоколом free-d).
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Transfer
Mode

Off / Always /
On Demand

Off Выбор способа вывода информации об отслеживании.

Camera ID От 0 до 255 255 Служит для задания идентификатора устройства.

Destination
Address Адрес IPv4 –

Если для параметра [Transfer Mode] задано значение
[Always], определяет IP-адрес получателя информации
об отслеживании.

Destination
Port

От 1024 до
65534

40000
Если для параметра [Transfer Mode] задано значение
[Always], определяет номер порта получателя
информации об отслеживании.

Listen Port
От 1024 до
65534

40000
Если для параметра [Transfer Mode] задано значение
[On Demand], определяет номер порта на устройстве
для прослушивания запросов от клиентов.
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Tally

Задание настроек индикатора записи/съемки (см. раздел “Подключение сигнала съемки”).

См. также

Подключение сигнала съемки
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Tally Lamp
Brightness

High / Low / Off High Задание яркости индикатора записи/съемки.

G Tally Lamp Enable / Disable Enable Включение/выключение индикатора съемки G.

Tally Control
External /
Internal

Internal
Выбор целевого устройства для приема
информации управления индикатором записи/
съемки устройства.
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IR Remote

Служит для задания настроек, относящихся к инфракрасному пульту управления.
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Setting On / Off On
Включение и выключение возможности управления
устройством с инфракрасного пульта управления.
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RCP/MSU

Выполняется настройка в случае подключения RCP/MSU (приобретается дополнительно).
Подробнее см. в разделе “Подключение RCP/MSU (приобретается дополнительно)”.

Примечание

Если требуется, настройте параметры на RCP/MSU.

Для системы из нескольких камер требуется MSU.

В случае использования нескольких устройств MSU задайте одно устройство MSU в качестве ведущего и все остальные
устройства MSU в качестве клиентов.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

CNS Mode
Off / Bridge / MCS
/ PC Control

Off Задание режима подключения для RCP/MSU.

Master IP
Address Адрес IPv4 0.0.0.0

Задание IP-адреса ведущего устройства при
построении системы из нескольких камер на основе
локальной сети.

Camera
No.

Camera No. (от 1
до 96)

1
Задание уникального номера камеры в рамках
системы при построении системы из нескольких камер
на основе локальной сети.
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Lens Controller

Задание настроек подключенного контроллера объектива (приобретается дополнительно).
Подробнее см. в разделе “Подключение контроллера объектива”.

Примечание

В случае изменения [Setting] камера перезагружается. Перезагрузите страницу в веб-браузере.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Setting On / Off Off
Определяет, используется ли контроллер объектива
(приобретается дополнительно).

Mode От 0 до 15 0

Задает режим работы контроллера объектива (приобретается
дополнительно).
Доступны значения в диапазоне от 0 до 15, но фактические
значения, которые можно выбрать, зависят от контроллера
объектива (приобретается дополнительно). Подробнее см.
в руководстве по эксплуатации контроллера объектива.

Reverse On / Off Off
Изменение направления вращения контроллера объектива
(приобретается дополнительно) на противоположное.

Initialize – –
Инициализация контроллера объектива (приобретается
дополнительно).
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Camera Name

Служит для задания настроек, относящихся к названию камеры (названию устройства).

В поле Camera Name можно ввести не более восьми (от 0 до 8) символов из числа указанных ниже.
Буквенно-цифровые символы
Символы (пробел !#$`*+-./;<=>?@[\]^_`{|})
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Пункт Настройка подпункта Заводское значение по умолчанию Описание

Camera Name – FR7 Задание названия камеры.
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User

Служит для задания настроек, относящихся к доступу пользователей к устройству.

Настройки, относящиеся к пользователям-администраторам (Administrator) (обязательные)

Настройки, связанные с обычными пользователями (User 1 – User 9) (необязательно)
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

User Name – admin Задание имени пользователя.

Current
Password

– –
При изменении пароля введите текущий
пароль.

New Password – – Введите новый пароль.

Re-Type
Password

– –
Введите новый пароль еще раз для
подтверждения.

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

User Name – – Задание имени пользователя.

Current
Password

– –
При изменении пароля введите текущий
пароль.

New Password – – Введите новый пароль.

Re-Type
Password – –

Введите новый пароль еще раз для
подтверждения.
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Wired LAN

Status
Служит для отображения состояния сети.

IPv4
Задание настроек, относящихся к сети IPv4.

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Host Name – – Отображение имени узла.

MAC Address – – Отображение MAC-адреса устройства.

Ethernet Status – –
Отображение текущей скорости передачи
данных.

IP Address – – Отображение IP-адреса устройства.

Subnet Mask – –
Отображение маски подсети для
устройства.

Gateway – –
Отображение шлюза IPv4 по умолчанию
для устройства.

Primary DNS
Server

– –
Отображение основного DNS-сервера для
устройства.

Secondary DNS
Server – –

Отображение дополнительного DNS-
сервера для устройства.

IPv6 Address 1 – – Отображение IPv6-адреса 1 устройства.

IPv6 Address 2 – – Отображение IPv6-адреса 2 устройства.

IPv6 Gateway – –
Отображение шлюза IPv6 по умолчанию
для устройства.

Link-local IPv6
Address

– –
Отображение локального адреса канала
IPv6 для устройства.

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

DHCP On / Off On Включение или выключение функции [DHCP].

IP Address – –
Задание IPv4-адреса, если для параметра [DHCP]
задано значение Off.

Subnet
Mask

– –
Задание маски подсети, если для параметра [DHCP]
задано значение Off.
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IPv6
Задание настроек, относящихся к сети IPv6.

Common
Задание настроек, общих для сетей IPv4/IPv6.
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Gateway – –
Задание для устройства шлюза IPv4 по умолчанию,
если для параметра [DHCP] задано значение Off.

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Obtain an IP
Address
Automatically

On / Off On
Включение или выключение автоматического
получения IPv6-адреса.

IP Address – – Задание IPv6-адреса, если для параметра [Obtain
an IP Address Automatically] задано значение Off.

Prefix Length – –
Задание префикса, если для параметра [Obtain an
IP Address Automatically] задано значение Off.

Gateway – –
Задание для устройства шлюза IPv6 по
умолчанию, если для параметра [Obtain an IP
Address Automatically] задано значение Off.

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

HTTP Port
80, от 1024 до
65534

80 Задание номера порта HTTP.

DNS Auto On / Off On
Задание получения адресов DNS с сервера
DHCP.

Primary DNS
Server

Адрес IPv4/IPv6 –
Задание основного сервера DNS, если для
параметра [DNS Auto] задано значение Off.

Secondary DNS
Server

Адрес IPv4/IPv6 –
Задание дополнительного сервера DNS, если для
параметра [DNS Auto] задано значение Off.
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File Transfer

Задание настроек, относящихся к передаче файлов.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Auto
Upload
(Proxy)

On / Off Off
Включение или выключение автоматической отправки
файлов прокси.

Default
Upload
Server

Server
Settings1–3 >
Display Name

Server Settings1

Выбор сервера для отправки файлов. Выбранный здесь
сервер становится пунктом назначения автоматической
отправки для файлов прокси, а также пунктом назначения
отправки для файлов с экрана эскизов.
Отображение параметров [Display Name], настроенных в
пунктах [Server Settings1 – 3].
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FTP Server 1–3

Задание настроек, относящихся к передаче файлов по FTP.
Эти настройки являются общими для параметров FTP Server 1 – 3.
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Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Display Name – –
Задание имени, отображаемого в меню настройки
пункта назначения передачи.

Service – – Отображение типа сервера.

Host Name – –
Задание имени узла сервера назначения
передачи.

Port
21, 990, 1024–
65534

21
Задание номера порта сервера назначения
передачи.

User Name – –
Задание имени пользователя для аутентификации
подключения сервера назначения передачи.

Password – –
Задание пароля аутентификации для
подключения сервера назначения передачи.

Passive Mode On / Off Off Включение и выключение пассивного режима.

Destination
Directory

– – Задание имени целевого каталога передачи.

Using Secure
Protocol

On / Off Off
Задает, требуется ли использовать (On) или не
использовать (Off) безопасную передачу по FTP.

Root Certificate – –

Загрузка корневого сертификата для безопасной
передачи по FTP.
Нажмите кнопку [Load] и выберите корневой
сертификат на открывшемся экране.
Нажмите кнопку [Delete], чтобы удалить
загруженный корневой сертификат.

Root Certificate
Status

– –
Отображение состояния загрузки корневого
сертификата.

Reset – –
Сброс настроек [Server Settings] на заводские
значения по умолчанию.
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SSL

Служит для задания настроек, относящихся к SSL.

SSL
Включение и отключение функции SSL.

SSL Server Authentication
Задание настроек, относящихся к аутентификации сервера SSL.

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Function
Disable / Enable / Enable (Allow HTTP
connection for some clients)

Disable
Включение и отключение
функции SSL.

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Certificate
Options

Use a self-signed
certificate (For test use)
/ Use an external
certificate

–
Задает способ установки сертификата сервера
SSL.

Status – –

Показывает, действителен ли сертификат
сервера SSL, когда для параметра [Certificate
Options] задано значение [Use a self-signed
certificate (For test use)].

Issuer DN – –

Показывает различающееся имя издателя
сертификата сервера SSL, когда для параметра
[Certificate Options] задано значение [Use a self-
signed certificate (For test use)].

Subject DN – –

Показывает различающееся имя субъекта
сертификата сервера SSL, когда для параметра
[Certificate Options] задано значение [Use a self-
signed certificate (For test use)].

Available
Period – –

Показывает период действия сертификата
сервера SSL, когда для параметра [Certificate
Options] задано значение [Use a self-signed
certificate (For test use)].

Extended Key
Usage

– –

Показывает способ использования расширенного
ключа, когда для параметра [Certificate Options]
задано значение [Use a self-signed certificate (For
test use)].
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Delete – –

Эта кнопка отображается, когда для параметра
[Certificate Options] задано значение [Use a self-
signed certificate (For test use)].
Служит для удаления установленного
сертификата сервера SSL.

Import – –
Установка внешнего сертификата сервера SSL из
списка, когда для параметра [Certificate Options]
задано значение [Use an external certificate].

Private Key
Password

– –

Задает пароль для информации закрытого ключа
сертификата сервера SSL, когда для параметра
[Certificate Options] задано значение [Use an
external certificate].

Reset – –
Эта кнопка очищает индикацию пароля закрытого
ключа для ввода нового пароля.

Self-Signed
Certificate
Generation

– –

Нажмите кнопку [Generate], чтобы создать
самоподписанный сертификат, когда для
параметра [Certificate Options] задано значение
[Use a self-signed certificate (For test use)].
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Referer Check

Задание настроек, относящихся к проверкам источника ссылки.

Exception List
Задание настроек, относящихся к списку исключений функции Referer Check.

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Setting On / Off On
Включение и отключение функции Referer
Check.

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

No. От 1 до 10 – Задание номера исключения из списка.

Host
Name

– – Задание имени узла исключения.

Port
Number

– – Задание номера порта исключения.

Set – –
Нажмите для регистрации настроенного исключения в
списке исключений.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Delete – –
Выберите исключение, которое хотите удалить, и нажмите
эту кнопку, чтобы удалить зарегистрированное исключение
из списка исключений.
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Brute Force Attack Protection

Служит для задания настроек, связанных с предотвращением атак методом перебора.

При обнаружении атаки отображается информация со списком источников атаки.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Setting On / Off On
Включение или выключение функции [Brute Force Attack
Protection].

Count От 3 до 100 8

Задание количества попыток, которое будет
рассматриваться как атака.
Доступно, когда для параметра [Setting] задано значение
On.

Release
Mode

Always / Timer Timer

Задание условия разблокировки.
Доступно, когда для параметра [Setting] задано значение
On.
Always: не удалять из списка источников атак.
Timer: удалять из списка источников атак по прошествии
времени, заданного параметром [Release Time].

Release
Time

От 30 до
86400 с

60

Задание времени разблокировки.
Доступно, когда для параметра [Setting] задано значение
On.
Когда для параметра Release Mode задано значение
[Timer], записи удаляются из списка источников атак по
прошествии времени разблокировки.
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Stream

Служит для задания настроек потоковой передачи (см. раздел “О потоковой передаче”).

Stream Setting
Задание настроек, относящихся к протоколу потоковой передачи.

Примечание

Для использования RTMP предварительно задайте для параметра [Stream] > [Audio Stream] > [Setting] значение [On].

RTSP
Следующие пункты отображаются, когда для параметра [Stream Setting] задано значение [RTSP].
Задание настроек, относящихся к потоковой передаче RTSP.

RTMP
Следующие пункты отображаются, когда для параметра [Stream Setting] задано значение [RTMP].
Задание настроек, относящихся к потоковой передаче RTMP.

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Setting
RTSP / RTMP / SRT-Caller / SRT-Listener
/ NDI|HX / Off

RTSP
Выбор протокола потоковой
передачи.

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Port Number
554, от 1024 до
65534

554 Задание номера порта RTSP.

Time Out От 0 до 600 60 Задает время ожидания команды Keep Alive для
потоковой передачи RTSP.

Authentication On / Off On
Включение или выключение функции
аутентификации RTSP.

Video Port
Number 1

От 1024 до
65534

51000
Задает номер порта для отправки видео 1 для
одноадресной потоковой передачи RTSP.

Video Port
Number 2

От 1024 до
65534

53000
Задает номер порта для отправки видео 2 для
одноадресной потоковой передачи RTSP.

Audio Port
Number

От 1024 до
65534

57000 Задает номер порта для отправки звука для
одноадресной потоковой передачи RTSP.
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SRT
Следующие пункты отображаются, когда для параметра [Stream Setting] задано значение [SRT-Caller] или [SRT-
Listener].
Задание настроек, относящихся к потоковой передаче SRT.

NDI|HX
Следующие пункты отображаются, когда для параметра [Stream Setting] задано значение [NDI|HX].
Задание настроек, относящихся к NDI|HX.

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Server URL – –
Задает URL-адрес пункта назначения RTMP или
RTMPS подключения.

Stream Key – –
Задает ключ потоковой передачи, полученный от
сервера RTMP.

Root
Certificate

– –

Загружает корневой сертификат, необходимый
для соединения с сервером RTMP.
Нажмите кнопку [Load] и выберите корневой
сертификат на открывшемся экране.
Нажмите кнопку [Delete], чтобы удалить
загруженный корневой сертификат.
Статус отображается в экране [Root Certificate
Status].

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Destination – –
Задает URL-адрес пункта назначения
подключения, когда устройство работает в
качестве вызывающего устройства.

Port
Number

От 1024 до 65534 4201
Задает номер порта для прослушивания, когда
устройство работает в качестве прослушивателя.

Latency От 20 до 8000 мс 120 Задает задержку.

TTL От 1 до 255 64 Задает значение TTL.

Encryption Off / AES128 /
AES256

Off Включение или выключение шифрования и
задание способа шифрования.

Passphrase
0 или строка длиной
от 10 до 79 символов

0

Задает парольную фразу, которая используется
для шифрования.
Нажмите Reset, чтобы очистить введенную
парольную фразу.

ARC On / Off On
Включение или выключение функции Adaptive
Rate Control.
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О потоковой передаче
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Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

License – –
Отображение состояния установки ключа
лицензии NDI.

Source Name – – Отображение имени источника NDI.

Group On / Off Off
Включение или выключение функции
группирования NDI.

Group Name – –
Отображается, если для функции группирования
NDI задано значение On.
Задание имени группы.

Discovery
Server 1

– – Задание сервера обнаружения NDI номер 1.

Discovery
Server 2

– – Задание сервера обнаружения NDI номер 2.

Multicast
Mode

On / Off Off
Включение или выключение многоадресной
потоковой передачи.

Multicast
Prefix

239.255.0.0 239.255.0.0

Отображается, когда для параметра [Multicast
Mode] задано значение On.
Задает префикс для использования при
многоадресной потоковой передаче.

Multicast
Netmask

255.255.0.0 255.255.0.0

Отображается, когда для параметра [Multicast
Mode] задано значение On.
Задает маску сети, которая определяет диапазон
адресов многоадресной передачи.

Multicast TTL От 1 до 256 3

Отображается, когда для параметра [Multicast
Mode] задано значение On.
Задает значение TTL для многоадресной
потоковой передачи.

Multi-TCP
Mode

On / Off Off Включение или выключение режима Multi-TCP.

Unicast UDP
Mode

On / Off On Включение или выключение режима Unicast UDP.
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Video Stream

Служит для задания настроек, относящихся к кодекам потоковой передачи видео.

Video Stream 1
Задание настроек, относящихся к видеокодеку 1.

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Codec 1 H.264 / H.265 H.264 Задание кодека изображения 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080 Задание размера изображения 1.

Frame Rate 1

Сведения о поддерживаемых
значениях частоты кадров см. в
разделе “Задание видеокодека
для потоковой передачи”.

–
Служат для задания частоты кадров
изображения 1.

I-Picture Mode
1

Time / Frame Time

Задание способа указания
интервала вставки кадров типа IDR-
Frame для изображения 1 в виде
времени или количества кадров.

I-Picture
Interval 1

1 / 2 / 3 / 4 / 5 c 1

Отображается, когда для параметра
[I-Picture Mode 1] задано значение
Time.
Задание интервала вставки кадров
IDR для стандартов H.264 и H.265 в
виде значения времени.

I-Picture Ratio
1

От 15 до 300 кадров 30

Отображается, когда для параметра
[I-Picture Mode 1] задано значение
Frame.
Задание интервала вставки кадров
IDR для стандартов H.264 и H.265 в
виде количества кадров.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Задание профиля H.264 или H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Задание режима сжатия скорости
потока данных для изображения 1.
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Video Stream 2
Задание настроек, относящихся к видеокодеку 2.

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Bit Rate 1

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
кбит/с

16000

Отображается, когда для параметра
[Bit Rate Compression Mode 1]
задано значение On.
Задание целевого значения
скорости потока данных, когда для
сжатия скорости потока данных
задан режим CBR (постоянная
скорость потока данных).

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Задание качества H.264 или H.265.

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Codec 2 H.264 / H.265 / Off Off Задание кодека изображения 2.

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 /
512×270

1920×1080 Задание размера изображения 2.

Frame Rate 2

Сведения о поддерживаемых
значениях частоты кадров см. в
разделе “Задание видеокодека
для потоковой передачи”.

–

Отображается, когда для параметра
[Codec 2] не задано значение Off.
Служат для задания частоты кадров
изображения 2.

I-Picture Mode
2

Time / Frame Time

Отображается, когда для параметра
[Codec 2] не задано значение Off.
Задание способа указания
интервала вставки кадров типа IDR-
Frame для изображения 2 в виде
времени или количества кадров.

I-Picture
Interval 2

1 / 2 / 3 / 4 / 5 c 1

Отображается, когда для параметра
[Codec 2] не задано значение Off, а
для параметра [I-Picture Mode 2]
задано значение [Time].
Задание интервала вставки кадров
IDR для стандартов H.264 и H.265 в
виде значения времени.

I-Picture Ratio
2

От 15 до 300 кадров 30

Отображается, когда для параметра
[Codec 2] не задано значение Off, а
для параметра [I-Picture Mode 2]
задано значение [Frame].
Задание интервала вставки кадров
IDR для стандартов H.264 и H.265 в
виде количества кадров.
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Video Stream 3
Задание настроек, относящихся к видеокодеку 3.

См. также

Задание видеокодека для потоковой передачи

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Profile 2
H.264: high / main / baseline
H.265: main

– Задание профиля H.264 или H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Отображается, когда для параметра
[Codec 2] не задано значение Off.
Задание режима сжатия скорости
потока данных для изображения 2.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000 /
5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 / 80000
кбит/с

8000

Отображается, когда для параметра
[Codec 2] не задано значение Off, а
для параметра [Bit Rate
Compression Mode 2] задано
значение [On].
Задание целевого значения
скорости потока данных, когда для
сжатия скорости потока данных
задан режим CBR (постоянная
скорость потока данных).

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Отображается, когда для параметра
[Codec 2] задано значение H.264, а
для параметра [Bit Rate
Compression Mode 2] задано
значение Off.
Задание качества H.264 или H.265.

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Codec 3 JPEG JPEG
Задание кодека
изображения 3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Задание размера
изображения 3.

Frame
Rate 3

Сведения о поддерживаемых значениях
частоты кадров см. в разделе “Задание
видеокодека для потоковой передачи”.

–
Служат для задания
частоты кадров
изображения 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Задание качества.
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Audio Stream

Служит для задания настроек, относящихся к кодекам потоковой передачи звука.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение по
умолчанию Описание

Setting On / Off Off
Включение или выключение выхода потоковой
передачи звука.

Codec
AAC (128kbps) / AAC
(256kbps)

AAC (128kbps)
Отображается, когда для параметра [Setting]
задано значение On.
Задание аудиокодека для потоковой передачи.
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Language

Установка языка интерфейса.

Примечание

Доступные языки могут отличаться в зависимости от страны или региона.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта Заводское значение по умолчанию Описание

Language – – Установка языка интерфейса.
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Accessibility

Служит для задания настроек, связанных с чтением вслух (преобразованием текста в речь).

Примечание

Эта функция доступна только на моделях, продаваемых в Северной Америке. Функция чтения с экрана может
использоваться только тогда, когда установлен английский язык (по состоянию на дату выпуска).

Включите функцию чтения с экрана в веб-браузере на устройстве, на котором выполняется веб-приложение.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Screen
Reader

On / Off Off 
Включение или выключение функции чтения с
экрана на панели изображения с камеры в веб-
приложении.

Speech
Rate

Slow2 / Slow1 / Normal /
Fast1 / Fast2 / Fast3 /
Fast4

Normal

Установка скорости речи для функции чтения с
экрана.
Демонстрационный отрывок зачитывается вслух
с заданной скоростью.

Speech
Volume

От 1 до 15 7

Задание громкости функции чтения с экрана в
веб-приложении.
Демонстрационный отрывок зачитывается вслух
с заданной громкостью.
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Clock Set

Задание настроек внутренних часов.
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Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Current
Date & Time

– –
Отображение текущего времени,
установленного на устройстве.

PC Clock – –
Отображение текущего времени,
установленного на планшете или компьютере,
используемых для настройки.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-
dd-yyyy hh:mm:ss / dd-mm-
yyyy hh:mm:ss

yyyy-mm-dd
Задание формата отображения даты и
времени.

12 h / 24 h 12 h / 24 h 24 h
Задание формата отображения времени: 12-
или 24-часовой формат.

Time
Setting

Keep current setting /
Synchronize with PC /
Manual setting / Synchronize
with NTP

– Задание способа настройки даты и времени.

yy-mm-dd
hh:mm:ss

yy: 19–37
mm: 01–12
dd: 01–31
hh: 00–23
mm: 00–59
ss: 00–59 (секунды)

–
Отображается, когда для параметра [Time
Setting] задано значение Manual setting.
Задание даты и времени вручную.

NTP Auto On / Off Off

Отображается, когда для параметра [Time
Setting] задано значение Synchronize with NTP.
Задание получения IP-адреса сервера NTP с
сервера DHCP.

NTP Server
IPv4/IPv6-адрес или имя
узла

–

Отображается, когда для параметра [Time
Setting] задано значение [Synchronize with
NTP], а для параметра [NTP Auto] задано
значение Off.
Задает сервер NTP, используемый для
синхронизации времени.

Time Zone
От UTC − 12:00 до UTC +
14:00

– Служит для выбора часового пояса.
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Reset

Служит для инициализации устройства.

Reboot
Перезагрузка устройства.

Reset
Служит для сброса настроек устройства.

Пункт Настройка
подпункта

Заводское значение по
умолчанию Описание

Reboot Execute –

Перезагрузка устройства.
Execute: выполнение функции.

Примечание

После перезагрузки заново загрузите страницу
в веб-браузере.

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

All Reset (except
for Network
Settings)

Execute –

Сброс всех настроек устройства (кроме сетевых
настроек).
Execute: выполнение функции.

Примечание

Импортированные базовые виды и файлы таблиц
LUT не удаляются.

Network Reset Execute –

Сброс сетевых настроек устройства.
Execute: выполнение функции.

Примечание

После выполнения команды Network Reset
устройство будет перезагружено. После перезагрузки
заново загрузите страницу в веб-браузере.
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Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

Factory Default Execute –

Восстановление для настроек устройства заводских
значений по умолчанию.
Execute: выполнение функции.

Примечание

После выполнения команды Factory Default
устройство будет перезагружено. После перезагрузки
заново загрузите страницу в веб-браузере.
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Information

Служит для отображения информации о камере и объективе. Также используется для обновления программного
обеспечения.

Camera
Отображение информации о камере и обновление программного обеспечения.

Lens
Отображение информации об объективе и обновление программного обеспечения.

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Model
Name

– – Отображение названия модели камеры.

Serial
Number

– – Отображение серийного номера камеры.

Version
Number

– –
Отображение версии программного обеспечения
камеры.

Version Up – –

Нажмите кнопку [Choose File] и следуйте инструкциям на
экране для обновления программного обеспечения
камеры.

Примечание

После обновления устройство будет перезагружено.
После перезагрузки заново загрузите страницу в веб-
браузере.

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Model
Name

– – Отображение названия модели объектива.

Serial
Number

– – Отображение серийного номера объектива.

Version
Number

– –
Отображение версии программного обеспечения
объектива.
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См. также
Обновление программного обеспечения объектива с байонетом E

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское значение
по умолчанию Описание

Version Up – –

Нажмите кнопку [Choose File] и следуйте инструкциям на
экране для обновления программного обеспечения
объектива.

Подробные сведения см. в разделе “Обновление
программного обеспечения объектива с байонетом
E”.

Примечание

После обновления объектива устройство будет
перезагружено. После перезагрузки заново загрузите
страницу в веб-браузере.
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System Log

Задание настроек, относящихся к системному журналу.

Полученный журнал отображается, как показано ниже.

См. также

Обновление программного обеспечения объектива с байонетом E

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical, Warning &
Info

Задание уровня для добавления записи в
системный журнал.

Log Size От 200 до 1024 1024
Задание размера журнала для сохранения в
системном журнале.

Download
as File

– –
Нажмите кнопку [Download] и сохраните
системный журнал на планшет или компьютер с
отображаемого экрана.
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HTTP Access Log

Задание настроек, относящихся к журналу доступа по HTTP.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка подпункта
Заводское

значение по
умолчанию

Описание

Log Level
Critical, Warning & Info /
Critical & Warning /
Critical

Critical, Warning &
Info

Задание уровня для добавления записи в
журнал доступа HTTP.

Log Size От 200 до 1024 1024
Задание размера журнала для сохранения в
журнале доступа HTTP.

Download
as File

– –
Нажмите кнопку [Download] и сохраните журнал
доступа HTTP на планшет или компьютер с
отображаемого экрана.
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Service

Служит для получения информации об устройстве. Используйте при обращении к представителю службы
технического обслуживания компании Sony.

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт Настройка
подпункта

Заводское
значение по
умолчанию

Описание

I agree to
download device
information.

– –

Установите этот флажок, чтобы согласиться на
получение информации об устройстве, и нажмите
кнопку [OK].
Нажмите отображаемую кнопку [Download]. Веб-браузер
сразу загрузит файл с именем deviceinformation.dat.

Примечание

После загрузки устройство будет перезагружено. Если
устройство не перезагружается автоматически,
выполните перезагрузку вручную. После перезагрузки
заново загрузите страницу в веб-браузере.
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EULA

Служит для отображения лицензионного соглашения конечного пользователя (EULA).

5-041-958-03(1) Copyright 2022 Sony Corporation
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Software

Служит для отображения лицензии на программное обеспечение.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Подключение внешних мониторов и устройств записи

Для показа на внешнем мониторе воспроизводимого или записанного изображения установите тип выходного
видеосигнала для внешнего монитора и используйте для подключения монитора соответствующий кабель.
Можно также подключить внешнее записывающее устройство для записи выходного сигнала с данного
устройства.
На внешний монитор можно вывести ту же информацию, которая отображается на панели изображения с
камеры, например информацию о состоянии и меню. Установите для требуемого типа системы для отображения
на экране значение On с помощью пункта [Monitoring] > [Output Display] в веб-меню.

Примечание

Если монитор, подключенный к разъему HDMI, не поддерживает формат вывода HDMI, настроенный в меню [Monitoring] в
веб-меню или меню камеры, изображение с камеры не будет выводиться в веб-приложение. Вывод потокового видео
также будет невозможен.

Для обоих параметров [Output Display] > [SDI] и [HDMI/Stream] можно задать значение [Off], но при этом будет невозможно
использовать меню камеры и функции, которые зависят от индикации на экране. Кроме того, уведомления об ошибках в
работе устройства будут ограничены индикаторами на устройстве (горят или мигают) и отображением метки уведомлений
в правом верхнем углу в веб-приложении. Для получения подробных сведений о состоянии установите для параметра
[Output Display] значение [On].

Совет

В заводских настройках по умолчанию для параметра [Output Display] > [SDI] задано значение [Off], а для параметра
[HDMI/Stream] — значение [On]. Чтобы использовать потоковую передачу в качестве основного видео, задайте для
параметра [SDI] значение [On], а для параметра [HDMI/Stream] — значение [Off], и контролируйте состояние камеры на
мониторе SDI.

Разъем SDI OUT (тип BNC)

Задайте выходной формат с помощью меню [Monitoring] в веб-меню или меню камеры.
Для подключения используйте имеющийся в продаже коаксиальный кабель на 75 Ом.

Примечание

Перед включением устройства удостоверьтесь в том, что подключение между данным устройством и внешним
устройством заземлено.

Рекомендуется включать данное устройство и внешнее устройство после подсоединения коаксиального
кабеля на 75 Ом.
Если внешнее устройство необходимо подключить к данному устройству, когда оно включено, подсоедините
коаксиальный кабель на 75 Ом сначала к внешнему устройству и только затем подсоедините его к данному
устройству.

Запуск записи одновременно на данном устройстве и внешнем устройстве
Когда выходной сигнал SDI включен, установите в пункте [Project] > [SDI/HDMI Rec Control] > [Setting] меню
камеры значение [SDI/HDMI Remote I/F] или [Parallel Rec], чтобы включить вывод сигнала запуска записи REC на
внешнее устройство, подключенное к разъему SDI OUT. Это обеспечит синхронную запись изображения с
данного устройства на внешнем устройстве.

Примечание
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Если подключенное устройство не поддерживает сигналы запуска записи REC, использовать его в этом режиме
невозможно.

Когда в меню камеры для параметра [Project] > [SDI/HDMI Rec Control] > [Setting] задано значение [SDI/HDMI Remote I/F] и
в настоящий момент никакой носитель не установлен, при нажатии кнопки записи START/STOP выводится только сигнал
запуска записи REC.

Разъем HDMI OUT (разъем типа A)

Задание для выхода настройки On/Off, а также задание выходного формата производится в меню [Monitoring]
меню камеры.

Запуск записи одновременно на данном устройстве и внешнем устройстве
Когда выходной сигнал HDMI включен, в меню камеры установите в пункте [TC/Media] > [HDMI TC Out] > [Setting]
значение [On], а в пункте [Project] > [SDI/HDMI Rec Control] > [Setting] — значение [SDI/HDMI Remote I/F] или
[Parallel Rec], чтобы включить вывод сигнала запуска записи REC на внешнее устройство, подключенное к
разъему HDMI OUT. Это обеспечит синхронную запись изображения с данного устройства на внешнем
устройстве.

Примечание

Если подключенное устройство не поддерживает сигналы запуска записи REC, использовать его в этом режиме
невозможно.

Когда в меню камеры для параметра [Project] > [SDI/HDMI Rec Control] > [Setting] задано значение [SDI/HDMI Remote I/F] и
в настоящий момент никакой носитель не установлен, при нажатии кнопки записи START/STOP выводится только сигнал
запуска записи REC.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Подключение к RCP/MSU

Некоторыми функциями устройства можно управлять дистанционно, подключив к нему с помощью кабеля
локальной сети панель дистанционного управления (RCP), например RCP-3500/3501, или ведущее задающее
устройство (MSU), например MSU-3500.
Способ подключения зависит от настройки соответствующих устройств и от приложения.

Подробнее о прямом подключении между устройством и RCP см. в разделе “Прямое подключение между
устройством и RCP”.
Подробнее о подключении нескольких камер с помощью MSU или программного обеспечения для управления
камерами см. в разделе “Использование устройства в среде нескольких камер с MSU/программным
обеспечением для дистанционного управления камерами”.

См. также

Прямое подключение между устройством и RCP

Использование устройства в среде нескольких камер с MSU/программным обеспечением для дистанционного
управления камерами

5-041-958-03(1) Copyright 2022 Sony Corporation
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Прямое подключение между устройством и RCP

Примечание

Используя “Список поддерживаемых функций”, настройте устройство таким образом, чтобы оно соответствовало
условиям работы в отношении функций, которые вы хотите использовать, затем активируйте подключение к RCP
в следующем порядке.

См. также

Список поддерживаемых функций

5-041-958-03(1) Copyright 2022 Sony Corporation

Включите каждое устройство.1

В веб-меню или меню камеры установите в пункте [Technical] > [RCP/MSU] > [CNS Mode] значение
[Bridge].

2

Задайте следующие параметры на RCP.

Подробнее о настройке см. в инструкции по эксплуатации RCP.

3

Задайте режим подключения Bridge.1.
Зарегистрируйте IP-адрес камеры.2.
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Использование устройства в среде нескольких камер с MSU/программным
обеспечением для дистанционного управления камерами

Можно подключить несколько камер с помощью MSU или программного обеспечения для дистанционного
управления камерами.

Примечание

Используя “Список поддерживаемых функций”, настройте устройство таким образом, чтобы оно соответствовало
условиям работы в отношении функций, которые вы хотите использовать, затем активируйте подключение к MSU или
программному обеспечению для дистанционного управления камерами в следующем порядке.

См. также
Список поддерживаемых функций
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Включите каждое устройство.1

Задайте сетевые параметры системы с помощью MSU или программного обеспечения для
дистанционного управления камерами.

Подробнее о настройке см. в инструкции по эксплуатации MSU или программного обеспечения для
дистанционного управления камерами.

2

Задайте следующие параметры, используя пункт [Technical] > [RCP/MSU] в веб-меню камеры.3

В случае использования MSU задайте для параметра [CNS Mode] значение [MCS]. В случае
использования программного обеспечения для дистанционного управления камерами задайте для
параметра [CNS Mode] значение [PC Control].

1.

Задайте IP-адрес ведущего устройства MSU или программного обеспечения для дистанционного
управления камерами в поле [Master IP Address].

2.

Задайте номер, под которым будет зарегистрирована камера, в поле [Camera No.].3.
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Список поддерживаемых функций

В следующей таблице приведены поддерживаемые функции и соответствующие условия их работы.

Панель
управления Функции устройства Условия работы

IRIS Регулировка диафрагмы вручную –

AUTO IRIS Включение или выключение Auto Iris –

ND
Переключение предварительно заданного
положения фильтра нейтральной плотности
(Clear/Preset1 на Preset3)

Эта функция включена, когда в меню
камеры для параметра [Shooting] > [ND
Filter] > [Mode] задано значение [Preset].

MASTER
GAIN

Регулировка усиления вручную (3 дБ)

Включена в том случае, когда в меню
камеры одновременно задан режим
съемки Custom и для параметра
[Shooting] > [ISO/Gain/EI] > [Mode]
задано значение [dB].

WHITE (R/B)
Регулировка баланса белого (R Gain/B Gain)
вручную

Доступно, когда для параметра [White
Mode] задано значение [Memory A(R/B)]
или [Memory A(T/T)].WHITE (Color

Temp)

Регулировка баланса белого (цветовая
температура/оттенок) вручную

RCP – [Color Temp]: цветовая температура
баланса белого
RCP – [Balance]: значение оттенка баланса
белого

ATW
Включение или выключение функции ATW
(автоматическое отслеживание баланса белого)

Включена, когда задан режим съемки
Custom.

BLACK R/B Регулировка баланса черного Включена, когда задан режим съемки
Custom.
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Примечание

Настройте устройство таким образом, чтобы оно соответствовало условиям работы в отношении функций, которые вы
хотите использовать, затем активируйте подключение к RCP/MSU. Если регулировать условия работы после
активирования подключения, возможно поведение, отличное от ожидаемого.

Панель
управления Функции устройства Условия работы

MASTER
BLACK

Регулировка контрольного уровня черного цвета

Включена, когда задан режим съемки
Custom.
H/V Ratio и Crispening включены,
когда в меню камеры для параметра
[Paint/Look] > [Detail] > [Manual
Setting] задано значение [On].

DETAIL

Включение или выключение функции деталей.
Установка уровня деталей
Установка H/V Ratio
Установка Crispening

User Matrix

Включение или выключение функции
пользовательской матричной коррекции
Установка значений матричной коррекции (R-
G/R-B/G-R/G-B/B-R/B-G)

Multi Matrix

Включение или выключение функции
мультиматричной коррекции
Выбор оттенка и насыщенности цвета,
используемого для мультиматричной коррекции

Knee

Включение или выключение функции коррекции
колена
Включение или выключение функции
автоматического излома
Установка точки излома и наклона колена

BARS Включение или выключение цветовых полос

SHUTTER

Включение или выключение функции
управления затвором.
Задание значения выдержки
(включение или выключение автоматического
управления затвором, настройка угла раскрытия
затвора, установка длительной выдержки и
настройка ECS (расширенный режим
синхронного считывания) не поддерживаются.)

Примечание

Настройки затвора RCP могут не отображаться
в зависимости от настроенного значения
выдержки.

Настройки затвора RCP могут отображаться
некорректно, если управление затвором с RCP
невозможно.

Если включена функция
автоматического управления затвором,
она будет продолжать работать даже
после выключения и включения затвора
или изменения значения выдержки
с RCP.
Когда для затвора задано значение
[Angle], включение/выключение затвора
или изменение выдержки с RCP не
поддерживается.
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Об управлении с помощью пульта дистанционного управления RM-IP500
(приобретается дополнительно)

Данным устройством можно управлять с помощью пульта дистанционного управления Sony RM-IP500 с
программным обеспечением версии 2.2 или новее. Устройства обмениваются данными с использованием
протокола VISCA over IP (LAN).
В зависимости от пункта, которым требуется управлять, может потребоваться просматривать индикацию на
экране данного устройства. Подготовьте монитор, на котором можно просматривать экранную индикацию.
С пульта дистанционного управления RM-IP500 поддерживаются следующие операции.

Выбор целевой камеры
Настройка кадрирования (поворот, наклон, масштаб)
Настройка фокусировки (исключая сенсорные операции)
Регистрация и вызов предварительно заданных положений
Управление меню устройства (исключая веб-меню)
Регулировка яркости
Регулировка баланса белого
Регулировка баланса черного
Регулировка входного уровня звука
Запуск/остановка записи
Выполнение функций программируемых кнопок устройства

Подробнее об использовании пульта RM-IP500 см. в инструкции по эксплуатации пульта RM-IP500.

Совет

При использовании пульта RM-IP500 устанавливайте накладку на панель для данного устройства, которая входит в
комплект поставки пульта RM-IP500.
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RM-IP500 (с накладкой на панель для данного устройства)
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Подключение пульта дистанционного управления RM-IP500

Подробнее о назначении функций см. в инструкции по эксплуатации пульта RM-IP500.
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Установите переключатель SETUP 3 данного устройства в положение ON, чтобы включить обмен
данными по интерфейсу VISCA over IP.

Примечание

Настройка этого переключателя применяется при следующем включении устройства.

1

Подключите пульт RM-IP500 к той же сети, что и данное устройство.2

Выполните процедуру из инструкции по эксплуатации пульта RM-IP500, чтобы настроить
подключение по интерфейсу VISCA over IP (LAN) в пульте RM-IP500.

Назначьте это устройство с помощью меню RM > AUTO IP SETUP > ASSIGN CAM.

3

Назначьте требуемые функции данного устройства кнопкам и ручкам, используя следующие пункты
меню RM пульта RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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О синхронизации с внешними устройствами

При съемке с использованием нескольких устройств их можно синхронизировать с конкретным опорным сигналом
или временным кодом через разъем GENLOCK устройств.

Подробные сведения о внешней синхронизации см. в разделе “Синхронизация фазы видеосигнала (Genlock)”.
Подробные сведения о синхронизации временных кодов см. в разделе “Привязка временного кода к другим
устройствам”.

См. также

Синхронизация фазы видеосигнала (Genlock)

Привязка временного кода к другим устройствам

5-041-958-03(1) Copyright 2022 Sony Corporation
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Синхронизация фазы видеосигнала (Genlock)

Для обеспечения внешней синхронизации можно подавать опорный сигнал на разъем GENLOCK.
Опорные сигналы, которые можно использовать, зависят от частоты системы выбранного формата записи.

Состояние внешней синхронизации можно проверить с помощью пункта [Technical] > [Genlock] > [Reference] в
меню камеры.

Примечание

Если опорный сигнал нестабилен, внешняя синхронизация может не устанавливаться.

Поднесущая не синхронизируется.
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Частота системы формата записи Поддерживаемые входные опорные сигналы

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Привязка временного кода к другим устройствам

Переведите устройство, подающее временной код, в режим, в котором поддерживается выдача временного кода
(например, Free Run или Clock).

Примечание

Проверьте, что взаимоотношение фаз подаваемого опорного сигнала временного кода и опорного видеосигнала
соответствует стандарту временного кода SMPTE.

При работе в режиме привязки к внешнему сигналу временной код мгновенно привязывается к внешнему источнику и
значение внешнего временного кода появляется в области отображения данных времени. Однако не начинайте запись
сразу же. Перед записью следует подождать несколько секунд, пока генератор временного кода не стабилизируется.

Если частота кадров опорного видеосигнала и частота кадров, заданная в устройстве, не совпадают, установить привязку
не удастся, а видеокамера не будет работать надлежащим образом. В этом случае привязка временного кода
видеокамеры ко внешнему временному коду не будет установлена.

В случае отсоединения источника внешнего временного кода временной код может смещаться на один кадр в час
относительно опорного временного кода.

Отключение внешней привязки
Измените настройку в меню камеры [TC/Media] > [Timecode].
Внешняя синхронизация также отключается при изменении частоты системы или при начале съемки в
специальном режиме (Slow & Quick Motion или Interval Rec).
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Задайте следующее в пункте [TC/Media] > [Timecode] меню камеры.

Задайте для параметра [Mode] значение [Preset].
Задайте для параметра [Run] значение [Free Run].

1

Нажмите программируемую кнопку, которой назначена функция [DURATION/TC/U-BIT], чтобы
отобразить временной код на экране.

2

Подайте опорный сигнал HD или SD на разъем GENLOCK, а опорный временной код — на разъем TC
IN.

Генератор временного кода устройства привязывается к опорному временному коду, и на экране появляются
символы “EXT-LK”.
После того, как пройдет примерно десять секунд после привязки временного кода, состояние,
сформированное привязкой к внешнему сигналу, будет поддерживаться даже в случае отключения внешнего
источника опорного сигнала временного кода.

3
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Подключение внешнего микрофона или внешнего аудиоустройства

Можно подавать сигнал с внешнего микрофона или внешнего аудиоустройства и внедрять этот аудиосигнал в
записываемое видео или в выходной видеосигнал на данном устройстве.

Подключите внешний микрофон или внешнее аудиоустройство с помощью кабеля XLR.

Если для звука задано значение [LINE] с помощью пункта [Audio] > [Audio Input] > [AUDIO IN Select] в меню
камеры, разъем AUDIO IN работает как разъем AUDIO IN CH-1 и разъем AUDIO IN CH-2.

1

Номер контакта Функция

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Выключите устройство и подсоедините кабель XLR к разъему AUDIO IN.2

Установите переключатель SETUP 2, чтобы включить фантомное питание, если оно требуется.

Переключите питание +48 В (фантомное питание), как описано ниже.
Переключатель 2
Задает, будет ли включено или выключено питание +48 В (фантомное питание) при подключении устройства
ввода звука.

3

Настройка Описание

OFF (по
умолчанию)

При этом отключается фантомное питание +48 В и в качестве источника звука CH-1 и
CH-2 задается вход LINE или MIC.
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Примечание

Когда этот переключатель находится в положении ON, если подключить микрофон, который несовместим с
источником питания +48 В, это может привести к повреждению подключенного устройства. Проверьте настройку
перед подключением устройства.

Настройка Описание

ON
При этом включается фантомное питание +48 В и в качестве источника звука CH-1 и
CH-2 задается микрофон, совместимый с фантомным питанием.

Включите данное устройство и задайте тип подключенного устройства с помощью параметра [Audio]
> [Audio Input] > [AUDIO IN Select] в меню камеры.

4
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Монтаж клипов и управление ими на компьютере

С помощью компьютера можно монтировать клипы и управлять ими.

Импорт клипов с помощью устройства чтения карт (не входит в комплект поставки)

Подключите устройство чтения карт CFexpress Type A или устройство чтения SD-карт к компьютеру и используйте
программное обеспечение, которое поддерживает формат записи данного устройства, например Catalyst Browse,
чтобы импортировать клипы.

Использование систем нелинейного монтажа

В системе нелинейного монтажа требуется наличие ПО для монтажа (не входит в комплект поставки), которое
поддерживает форматы, записываемые данным устройством.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Вывод оптоволоконного сигнала

Сигнал SDI, преобразованный в оптический сигнал, можно выводить, подключив модуль SFP+ (приобретается
дополнительно) к разъему OPTICAL данного устройства. Используйте модуль SFP+, соответствующий диапазону
сигнала каждого из форматов.
Диапазон сигнала

4K (59.94p, 50p): 12G
4K (кроме 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (кроме 59.94p, 50p): 1.5G

Примечание

Используйте модуль, соответствующий указанным ниже стандартам.

Стандарты SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Стандарты SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

На модуль SFP+ выводится тот же сигнал, что и на разъем выхода SDI.

Это устройство не поддерживает ввод оптоволоконного сигнала.

Для вывода оптоволоконного сигнала используйте модуль SFP+. Подробные сведения о проверенных модулях SFP+
можно получить у дилера или представителя службы технического обслуживания компании Sony.
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* Уровень мощности I (1,0 Вт)
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Подключение сигнала съемки

В этом разделе рассматривается управление сигналом съемки.

Включение индикатора съемки с помощью сигнала с пульта дистанционного
управления

Индикатор съемки можно включать с помощью команды интерфейса VISCA over IP с внешнего устройства,
например пультом RM-IP500.
В веб-меню или меню камеры установите в пункте [Technical] > [Tally] > [Tally Control] значение [External].

Включение индикатора съемки с внешнего устройства

Индикатор съемки устройства можно включать красным или зеленым цветом с внешнего устройства, например с
пульта RM-IP500 или коммутатора. Индикатором съемки можно управлять с помощью команд, передаваемых по
сети, или с помощью ввода сигнала съемки на разъеме OPTION устройства.
В веб-меню или меню камеры установите в пункте [Technical] > [Tally] > [Tally Control] значение [External].
При подаче сигнала съемки на разъем OPTION соедините накоротко контакт 7 с контактом GND (контакт 4 или 5),
чтобы включить зеленый индикатор съемки, или контакт 8 с контактом GND (контакт 4 или 5), чтобы включить
красный индикатор съемки.

Примечание

Когда для параметра [Tally Control] задано значение [External], состояние записи устройства не отображается
индикатором съемки.

Если красный и зеленый сигнал съемки вводятся одновременно, индикатор съемки на устройстве загорается красным
цветом.

Спецификации контактов разъема OPTION

Номер
контакта

Направление
сигнала Технические характеристики сигнала

1 – Сигнал передачи RS-232C (для контроллера объектива)

2 – Сигнал приема RS-232C (для контроллера объектива)

3 OUT

Вывод зеленого индикатора съемки
Вывод низкого уровня, когда горит зеленый индикатор съемки.
Вывод уровня Hi-Z (сигнал с открытым стоком), когда зеленый
индикатор съемки не горит.

466



Включение индикатора съемки внешнего устройства с помощью сигнала с данного
устройства

Индикатор съемки на внешнем устройстве можно включать с помощью сигнала с данного устройства, подключив
контакты 3 и 6 разъема OPTION так, как показано ниже.
Пример подключения контактов 3 и 6 разъема OPTION

Примечание

Не подавайте напряжение на контакты 7 и 8.

Не подключайте внешнее устройство, которое может подавать напряжение на разъем OPTION.

Если на контакт 3 или 6 будет подано пусковое напряжение или напряжение в обратной полярности, это может привести к
неполадкам, появлению дыма или возгоранию.

Задайте выходной сигнал в пункте [Technical] > [Tally] > [Tally Control] веб-меню или меню камеры.
[Internal]: состояние операции записи в данном устройстве
[External]: логическое “И” красного/зеленого сигналов индикатора съемки, получаемое данным устройством через сигналы
IN и пульты дистанционного управления.

5-041-958-03(1) Copyright 2022 Sony Corporation

Номер
контакта

Направление
сигнала Технические характеристики сигнала

4 – GND (Земля)

5 – GND (Земля)

6 OUT

Вывод красного индикатора съемки
Вывод низкого уровня, когда горит красный индикатор съемки.
Вывод уровня Hi-Z (сигнал с открытым стоком), когда красный
индикатор съемки не горит.

7 IN
Вход внешнего управления зеленым индикатором съемки
При коротком замыкании на землю (контакт 4 или 5) индикатор съемки на
устройстве загорается зеленым цветом.

8 IN
Вход внешнего управления красным индикатором съемки
При коротком замыкании на землю (контакт 4 или 5) индикатор съемки на
устройстве загорается красным цветом.
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Вывод данных отслеживания (free-d)

Устройство может выводить информацию об отслеживании поворота/наклона/масштабирования, фокусировки и
диафрагмы, синхронизированную с сигналом синхронизации.
Выводимые данные соответствуют протоколу free-d, являющемуся отраслевым стандартом. В качестве способа
вывода можно выбрать постоянный вывод или вывод по запросу клиента. Выберите способ вывода
в соответствии с используемой системой VR/AR (виртуальная/дополненная реальность).

Формат вывода данных

Совет

Технические сведения приведены в “Руководстве по интеграции с протоколом free-d”. Обратитесь в торговое
представительство Sony.

Данные отслеживания, выдаваемые устройством, включают в себя следующие данные в соответствии
с форматом, указанным в Type D0/D1 протокола free-d.
Type D0 – poll/command

Убедитесь, что устройство включено.1

Задайте способ вывода информации об отслеживании.

Постоянный вывод

Вывод по запросу от клиентов

2

В веб-меню установите в пункте [Technical] > [Tracking Data Output] > [Transfer Mode] значение [Always].1.
Задайте идентификатор устройства в пункте [Camera ID].2.
Задайте IP-адрес получателя выводимой информации в пункте [Destination Address].3.
Задайте номер порта получателя выводимой информации в пункте [Destination Port].4.
Нажмите кнопку [OK].5.

В веб-меню установите в пункте [Technical] > [Tracking Data Output] > [Transfer Mode] значение [On
Demand].

1.

Задайте идентификатор устройства в пункте [Camera ID].2.
Укажите номер порта для прослушивания запросов от клиентов в пункте [Listen Port].3.
Нажмите кнопку [OK].4.

Символ Содержание Описание

<D0> Message type

<CA> Camera ID

<CD> command

Поддерживаются следующие команды:

00 Stop stream mode
01 Start stream mode
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Type D1 – camera position/orientation data

Примечание

В следующих ситуациях данные отслеживания могут поступать с задержкой или значения могут не обновляться:

При выводе видео в формате RAW
При включенном замедлении/ускорении движения
При отображении меню камеры
При отображении экрана эскизов
При воспроизведении записанных клипов
При отображении веб-меню
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Символ Содержание Описание

<CK> Checksum

Символ Содержание Описание

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Угол поворота (от −170° до +170°)

<TH><TM><TL> Camera Tilt Angle Угол наклона (от -30° до +195°)

<RH><RM><TL> Camera Roll Angle Не поддерживается (всегда 0)

<XH><XM><XL> Camera X-Position Не поддерживается (всегда 0)

<YH><YM><YL> Camera Y-Position Не поддерживается (всегда 0)

<HH><HM><HL> Camera Height Не поддерживается (всегда 0)

<ZH><ZM><ZL> Camera Zoom Фокусное расстояние

<FH><FM><FL> Camera Focus Дистанция фокусировки

<SH><SL> Spare/User Defined Положение диафрагмы

<CK> Checksum
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Подключение контроллера объектива

Управлять масштабированием объектива с ручным масштабированием можно с помощью веб-приложения,
пульта дистанционного управления RM-IP500 (приобретается дополнительно) или инфракрасного пульта
управления, подключив контроллер объектива (приобретается дополнительно), совместимый с данным
устройством.
Подробнее о подключении контроллера объектива см. в руководстве по эксплуатации контроллера объектива.
Подробнее о регулировке масштаба с помощью контроллере объектива см. в разделе “Регулировка масштаба
с помощью контроллера объектива”.

Примечание

Перед использованием контроллера объектива внимательно прочитайте руководство по эксплуатации и убедитесь, что
вы полностью понимаете его назначение. Компания Sony не несет ответственности за претензии любого рода, возникшие
в результате использования контроллера объектива.

При включенном контроллере объектива функция Clear Image Zoom недоступна. Рекомендуется задать для Clear Image
Zoom коэффициент масштабирования, равный 1,0×, или отключить функцию Clear Image Zoom.

При включенном контроллере объектива запись или воспроизведение операций кадрирования камеры недоступны.

См. также

Регулировка масштаба с помощью контроллера объектива

5-041-958-03(1) Copyright 2022 Sony Corporation
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Регулировка масштаба с помощью контроллера объектива

Установка контроллера объектива (приобретается дополнительно) и настройка масштабирования выполняются
в следующем порядке.

Проверка состояния контроллера объектива

Подключите контроллер объектива к разъему OPTION на блоке разъемов устройства.

Подробнее о подключении см. в руководстве по эксплуатации контроллера объектива.

1

Настройте контроллер объектива в соответствии со своим объективом с масштабированием.

Подробнее см. в руководстве по эксплуатации контроллера объектива.

2

Заблокируйте поворот/наклон устройства и установите объектив с масштабированием.

Подробнее см. в разделе “Присоединение объектива”.

3

Настройте контроллер объектива так, чтобы он мог управлять объективом.4

Подберите баланс головки камеры вперед/назад, чтобы основание с направляющими было
расположено горизонтально.

Подробнее см. в руководстве по эксплуатации контроллера объектива и разделе “Присоединение
объектива”.

5

В веб-меню установите в пункте [Technical] > [Lens Controller] > [Setting] значение [On] и нажмите
кнопку [OK].

Устройство перезагрузится. Дождитесь завершения операции сброса поворота/наклона.

6

Нажмите кнопку  (Инициализировать контроллер объектива) на вкладке  (Others)
панели управления камерой в операционном экране веб-приложения.

Контроллер объектива начнет перемещаться для определения диапазона масштабирования. Подробнее см.
в руководстве по эксплуатации контроллера объектива.
Когда значок  (Ошибка контроллера объектива) в левом верхнем углу панели изображения с камеры
сменится на  (Контроллер объектива готов), подготовка будет завершена.

Примечание

Запомните рабочий диапазон объектива при инициализации контроллера объектива.

7

Отрегулируйте масштабирование с помощью ползунка [Zoom] в веб-приложении или с помощью
кнопок управления масштабированием на инфракрасном пульте управления.

8
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Нажмите кнопку  (Состояние камеры) в общей области экрана веб-приложения, чтобы вывести экран
состояния камеры.

Экран позволяет проверить состояние контроллера объектива.

Примечание

После замены объектива инициализируйте контроллер объектива.

При включенном контроллере объектива функция Clear Image Zoom недоступна. Рекомендуется задать для Clear Image
Zoom коэффициент масштабирования, равный 1,0×, или отключить функцию Clear Image Zoom.

5-041-958-03(1) Copyright 2022 Sony Corporation

Состояние Описание

Off Используйте сервопривод масштабирования в объективе с байонетом E.

Communication
Error

Произошла ошибка связи между устройством и контроллером объектива.
Проверьте соединение между устройством и контроллером объектива, затем обратитесь
к руководству по эксплуатации контроллера объектива и выполните инициализацию
контроллера объектива.

Uninitialized Выполните инициализацию.

Initializing Дождитесь завершения инициализации.

Initialization
Failed

Проверьте соединение между устройством и контроллером объектива, затем обратитесь
к руководству по эксплуатации контроллера объектива и выполните инициализацию
контроллера объектива.

Working Управление масштабированием может осуществляться с помощью контроллера объектива.

Rotation Error
Сохраненный диапазон масштабирования и диапазон перемещения объектива могут не
совпадать. Инициализируйте контроллер объектива.

System Error Проверьте соединение между устройством и контроллером объектива, обратитесь
к инструкции по эксплуатации контроллера объектива и выполните инициализацию
контроллера объектива, либо выключите и включите устройство и контроллер объектива.Unknown Error
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Предупреждения

Меры предосторожности при транспортировке и упаковке
При транспортировке и упаковке устройства соблюдайте указанные ниже условия и не подвергайте устройство
сильной вибрации или ударам.

Снимите объектив и установите крышку корпуса.
После перемещения головки камеры (A) вперед поверните рычаг блокировки головки камеры (B)
в направлении стрелки, чтобы заблокировать головку камеры.

Сориентируйте головку камеры так, чтобы она была обращена вперед, и заблокируйте ее с помощью рычага
блокировки поворота/наклона.

Отключите соединительные кабели.

Конденсация
Если устройство принесли с холода в теплое помещение или если резко повысилась температура окружающей
среды, на внешней поверхности устройства и/или внутри устройства может образоваться влага. Эта явление
называется конденсацией. В случае возникновения конденсации выключите устройство и дождитесь
исчезновения влаги перед использованием устройства. Использование влажного устройства может привести к его
повреждению.

Влияние на датчик изображения КМОП камеры

Примечание

Следующие возможные явления в изображениях специфичны для датчиков изображений. Они не означают
неисправность.
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Белые точки
Несмотря на то, что датчики изображения производятся с использованием высокопрецизионных технологий,
в редких случаях на экране могут возникать белые точки, вызванные космическими лучами и т. п.
Это объясняется принципом создания датчиков изображения и не является неисправностью. Регулярно
запускайте функцию APR (автоматическое восстановление пикселей).
Белые точки большей частью возникают в следующих случаях:

при высокой температуре окружающей среды
при повышении чувствительности

Дрожание
При съемке при освещении флуоресцентным светом, натриевыми лампами, ртутными лампами или
светодиодами может дрожать изображение на экране или могут изменяться цвета.

Объектив и блоки привода поворота/наклона
Если объектив и механизм привода поворота/наклона долго не использовались, может увеличиться вязкость
внутренней смазки, что приведет к невозможности перемещения. Регулярно используйте объектив и механизм
поворота/наклона.

Расходные материалы
Вентилятор и встроенный аккумулятор являются расходными деталями, которые необходимо периодически
заменять.
При работе при комнатной температуре замену необходимо проводить через каждые 5 лет. Однако данный
цикл является только рекомендуемым и не подразумевает гарантированную работу этих деталей в течение
этого времени.
Для получения дополнительной информации о замене деталей обратитесь в сервисный центр Sony или к
поставщику.

Средний срок службы адаптера переменного тока и электролитического конденсатора составляет около 5 лет
при нормальной температуре работы и нормальном использовании (8 часов в день, 25 дней в месяц). Если
использование превышает указанную выше нормальную частоту использования, продолжительность работы
может соответственно уменьшиться.

Рекомендуется проводить периодические осмотры для обеспечения должной работы устройства и увеличения
срока его службы. Для получения дополнительных сведений об осмотрах обратитесь к представителю службы
технического обслуживания компании Sony.

О встроенном элементе питания
В устройстве имеется встроенный аккумулятор для хранения данных о дате, времени и других данных даже в
случае выключения устройства. Встроенный аккумулятор зарядится через 24 часа, если устройство подключено к
электрической розетке с помощью адаптера переменного тока или подключено к питанию по технологии PoE++,
независимо от того, включено ли устройство. Аккумулятор полностью разрядится примерно за 2 месяца, если
адаптер переменного тока не подключен к электрической розетке. Используйте устройство после зарядки
аккумулятора. Однако, даже если этот аккумулятор не заряжен, на работу устройства это не повлияет, если при
работе не требуется записывать дату и время.

Места использования и хранения
Хранить на ровной поверхности в хорошо проветриваемом месте.
Не следует использовать или хранить устройство в следующих местах.

Места, в которые попадает дождь или вода (в том числе под карнизами)
Вне помещений и в местах, температура в которых превышает 40 °C
Помните, что летом в странах с жарким климатом температура внутри автомобиля с закрытыми окнами может
легко достигать значений, превышающих 50 °C.
В местах, температура в которых опускается ниже 0 °C.
В местах с высокой влажностью или большим количеством пыли. В местах, в которых на устройство может
попадать дождь

474



В местах, подверженных вибрации или ударам
В местах, в которых присутствует радиация, рентгеновское излучение и сильные магнитные поля.
Около радио или телевизионных передатчиков, формирующих сильные электромагнитные поля.
Под прямым солнечным светом или вблизи нагревательных приборов в течение длительного времени

Примечание в отношении лазерных лучей
Лазерные лучи могут повредить светочувствительные матрицы КМОП. При съемке эпизода, в котором
присутствуют лазерные лучи, не допускайте направления лазерного луча на датчик изображения КМОП камеры.
В частности, мощные лазерные лучи, испускаемые устройствами медицинского или иного назначения, могут
вызвать повреждения вследствие отражения или рассеивания света.

Во избежание электромагнитных помех от портативных коммуникационных устройств
Использование портативных телефонов и других коммуникационных устройств рядом с этим изделием может
привести к неполадкам и помехам аудио- и видеосигналов. Рекомендуется отключать питание портативных
коммуникационных устройств рядом с этим изделием.

Не размещайте данное изделие вблизи медицинских устройств
Данное изделие (включая аксессуары) оснащено магнитом(ами), который может влиять на работу
кардиостимуляторов, программируемых шунтирующих клапанов для лечения гидроцефалии или других
медицинских устройств. Не размещайте данное изделие вблизи лиц, пользующихся такими медицинскими
устройствами. Проконсультируйтесь с врачом перед использованием данного изделия, если вы пользуетесь
любым медицинским устройством.

Предупреждения по мерам безопасности
КОМПАНИЯ SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА КАКОЙ БЫ ТО НИ БЫЛО УЩЕРБ, ВОЗНИКШИЙ
ВСЛЕДСТВИЕ НЕСОБЛЮДЕНИЯ МЕР ПРЕДОСТОРОЖНОСТИ ПРИ ИСПОЛЬЗОВАНИИ УСТРОЙСТВ
ПЕРЕДАЧИ ДАННЫХ, НЕИЗБЕЖНЫХ УТЕЧЕК ИНФОРМАЦИИ, СВЯЗАННЫХ СО СПЕЦИФИКАЦИЯМИ
ПЕРЕДАЧИ ДАННЫХ, ИЛИ ПРОБЛЕМ БЕЗОПАСНОСТИ ЛЮБОГО РОДА.
В зависимости от операционной среды возможен несанкционированный доступ посторонних лиц к устройству.
При подключении устройства к сети убедитесь в том, что сеть надежно защищена.
При использовании устройства, подключенного к сети, в целях безопасности рекомендуется открыть окно
управления с помощью веб-браузера и изменить заводские настройки по умолчанию для ограничения
доступа. Также рекомендуется задавать пароль, состоящий из строки символов достаточной длины, который
сложно угадать, и хранить его в безопасном месте.
При подключении этого изделия к сети выполняйте подключение через систему, которая обеспечивает
функцию защиты, такую как маршрутизатор или брандмауэр. При подключении без такой защиты могут
возникнуть проблемы с безопасностью.

Питание
На устройстве отсутствует выключатель питания. Чтобы выключить устройство, убедитесь, что все операции
завершены и устройство находится в режиме ожидания электропитания, затем отсоедините адаптер
переменного тока. Если используется питание по технологии PoE++, отсоедините кабель локальной сети.
По мере возможности используйте источник питания в месте, в котором удобно подключать и отключать вилку
кабеля питания.
Если используемая розетка находится в пыльном месте, во избежание образования путей утечки тока
регулярно очищайте область вокруг розетки.
Отключите источник питания, если устройство не используется.

Меры предосторожности для подвижных частей
Следите, чтобы в движущиеся части не попадали посторонние материалы.
Не прикладывайте избыточную силу при перемещении подвижных частей руками. Это приведет к
повреждению устройства.
Не мешайте перемещению подвижных частей. Это может привести к их повреждению или травмам.
Подвижные части могут не работать должным образом, если устройство длительное время не
использовалось. Регулярно используйте функции поворота/наклона устройства.

475



Меры предосторожности при длительной эксплуатации
Устройство может быть запитанным 24 часа в сутки 365 дней в году (в режиме ожидания).
Всегда выполняйте тестовую съемку и проверяйте устройство на правильность функционирования.

Непрерывная съемка в течение более чем 24 часов не гарантируется.
Если съемка длится более 24 часов, переведите устройство в режим ожидания, а затем перезапустите его.

Обратите внимание, что компания Sony не несет никакой ответственности за компенсацию, вызванную
содержанием изображений, если вы не сможете осуществлять съемку вследствие каких-либо неисправностей
во время использования данного устройства.
Перед эксплуатацией данного устройства обязательно проверьте правильность его работы. КОМПАНИЯ
SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА КАКОЙ БЫ ТО НИ БЫЛО УЩЕРБ, ВКЛЮЧАЯ, В ЧИСЛЕ ПРОЧЕГО,
КОМПЕНСАЦИЮ ИЛИ ВОЗМЕЩЕНИЕ УБЫТКОВ В СВЯЗИ С УТРАТОЙ ИЛИ НЕДОПОЛУЧЕНИЕМ
ПРИБЫЛЕЙ ИЗ-ЗА НЕРАБОТОСПОСОБНОСТИ ЭТОГО УСТРОЙСТВА, КАК НА ПРОТЯЖЕНИИ
ГАРАНТИЙНОГО ПЕРИОДА, ТАК И ПОСЛЕ ИСТЕЧЕНИЯ СРОКА ГАРАНТИИ, А ТАКЖЕ ВСЛЕДСТВИЕ ЛЮБЫХ
ИНЫХ ВОЗМОЖНЫХ ПРИЧИН.
КОМПАНИЯ SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА ПРЕТЕНЗИИ ЛЮБОГО РОДА, ПРЕДЪЯВЛЕННЫЕ
ПОЛЬЗОВАТЕЛЯМИ ЭТОГО УСТРОЙСТВА ИЛИ ТРЕТЬИМИ ЛИЦАМИ.
КОМПАНИЯ SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА ПРЕКРАЩЕНИЕ ИЛИ ПРИОСТАНОВКУ
ПРЕДОСТАВЛЕНИЯ ЛЮБЫХ УСЛУГ, СВЯЗАННЫХ С ЭТИМ УСТРОЙСТВОМ, ВНЕ ЗАВИСИМОСТИ ОТ
ОБСТОЯТЕЛЬСТВ.

Меры предосторожности для функции записи
Всегда делайте пробную запись, а также удостоверьтесь в надлежащем качестве этой записи. КОМПАНИЯ
SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА КАКОЙ БЫ ТО НИ БЫЛО УЩЕРБ, ВКЛЮЧАЯ, В ЧИСЛЕ ПРОЧЕГО,
КОМПЕНСАЦИЮ ИЛИ ВОЗМЕЩЕНИЕ УБЫТКОВ В СВЯЗИ С ОТКАЗОМ ДАННОГО УСТРОЙСТВА ИЛИ
НОСИТЕЛЯ ИНФОРМАЦИИ ИЛИ ЛЮБЫХ ДРУГИХ НОСИТЕЛЕЙ ИЛИ СИСТЕМ ХРАНЕНИЯ ДАННЫХ И
НЕОСУЩЕСТВЛЕНИЕМ ЗАПИСИ ЛЮБОГО СОДЕРЖАНИЯ И ТИПА.
Перед эксплуатацией данного устройства обязательно проверьте правильность его работы. КОМПАНИЯ
SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА КАКОЙ БЫ ТО НИ БЫЛО УЩЕРБ, ВКЛЮЧАЯ, В ЧИСЛЕ ПРОЧЕГО,
КОМПЕНСАЦИЮ ИЛИ ВОЗМЕЩЕНИЕ УБЫТКОВ В СВЯЗИ С УТРАТОЙ ИЛИ НЕДОПОЛУЧЕНИЕМ
ПРИБЫЛЕЙ ИЗ-ЗА НЕРАБОТОСПОСОБНОСТИ ЭТОГО УСТРОЙСТВА, КАК НА ПРОТЯЖЕНИИ
ГАРАНТИЙНОГО ПЕРИОДА, ТАК И ПОСЛЕ ИСТЕЧЕНИЯ СРОКА ГАРАНТИИ, А ТАКЖЕ ВСЛЕДСТВИЕ ЛЮБЫХ
ИНЫХ ВОЗМОЖНЫХ ПРИЧИН.
КОМПАНИЯ SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА ПРЕТЕНЗИИ ЛЮБОГО РОДА, ПРЕДЪЯВЛЕННЫЕ
ПОЛЬЗОВАТЕЛЯМИ ЭТОГО УСТРОЙСТВА ИЛИ ТРЕТЬИМИ ЛИЦАМИ.
КОМПАНИЯ SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА ПОТЕРЮ, ИСПРАВЛЕНИЕ ИЛИ
ВОСПРОИЗВЕДЕНИЕ ЛЮБЫХ ДАННЫХ, ЗАПИСАННЫХ В СИСТЕМЕ ВНУТРЕННЕЙ ПАМЯТИ, НА
НОСИТЕЛЕ ИНФОРМАЦИИ ИЛИ НА ЛЮБЫХ ДРУГИХ НОСИТЕЛЯХ ИЛИ СИСТЕМАХ ХРАНЕНИЯ ДАННЫХ.
КОМПАНИЯ SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА ПРЕКРАЩЕНИЕ ИЛИ ПРИОСТАНОВКУ
ПРЕДОСТАВЛЕНИЯ ЛЮБЫХ УСЛУГ, СВЯЗАННЫХ С ЭТИМ УСТРОЙСТВОМ, ВНЕ ЗАВИСИМОСТИ ОТ
ОБСТОЯТЕЛЬСТВ.

5-041-958-03(1) Copyright 2022 Sony Corporation
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Форматы и ограничения для выходов

В этом разделе рассматриваются форматы и ограничения для выходов.

Примечание

Разрешение формата вывода ограничено настройками [Project] > [Rec Format] > [Frequency], [Codec] и [Video Format] в
веб-меню или меню камеры.

Разрешение формата вывода ограничено в сочетании с частотой кадров S&Q. В дополнение к приведенной далее
таблице выходных форматов разъемов SDI OUT и HDMI OUT выход HDMI переключается на разрешение Full HD или
ниже при соблюдении всех следующих условий.

Для параметра [Shooting] > [S&Q Motion] > [Setting] задано значение [On]
Значение параметра [Shooting] > [S&Q Motion] > [Frame Rate] превышает 60 кадров/с

Если указанные выше условия выполнены, варианты выбора выходного сигнала HDMI 4096×2160P и 3840×2160P для
параметра [Monitoring] > [Output Format] > [SDI/HDMI] отображаются серым цветом и недоступны для выбора.

Изображение выводится только при задании более высокого разрешения, чем разрешение воспроизводимого
изображения.

Форматы выходного сигнала на разъеме SDI OUT/HDMI OUT

При значении частоты системы 50/59.94 Гц

Настройка Выходной формат, доступный для выбора

Режим записи/
воспроизведения

Выходное разрешение
RAW/

Внутреннее разрешение
записи

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P (по
умолчанию)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P (по
умолчанию)
1920×1080i
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При значении частоты системы 25/29.97 Гц

Настройка Выходной формат, доступный для выбора

Режим записи/
воспроизведения

Выходное разрешение
RAW/

Внутреннее разрешение
записи

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (по
умолчанию)

1920×1080P (по
умолчанию)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A) (по
умолчанию)

1920×1080P (по
умолчанию)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A) (по
умолчанию)

1920×1080P (по
умолчанию)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Вывод остановлен)
720×480P2)

720×576P3)

На отображаемый экран не может быть наложено другое изображение.1)

При значении частоты системы 59.942)

При значении частоты системы 503)
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При значении частоты системы 23.98 Гц

Настройка Output Format (выходное разрешение)

Режим записи/
воспроизведения

Выходное разрешение
RAW/

Внутреннее разрешение
записи

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i (по
умолчанию)

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i (по
умолчанию)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (по
умолчанию)

1920×1080i (по
умолчанию)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF (по
умолчанию)

1920×1080i (по
умолчанию)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Настройка Output Format (выходное разрешение)

Режим записи/
воспроизведения

Выходное разрешение
RAW/

Внутреннее разрешение
записи

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P (по
умолчанию)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P (по
умолчанию)
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При значении частоты системы 24 Гц

5-041-958-03(1) Copyright 2022 Sony Corporation

Настройка Output Format (выходное разрешение)

Режим записи/
воспроизведения

Выходное разрешение
RAW/

Внутреннее разрешение
записи

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (по
умолчанию)

1920×1080P (по
умолчанию)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P (по
умолчанию)

1920×1080P (по
умолчанию)

1920×1080
1920×1080P (по
умолчанию)

1920×1080P (по
умолчанию)

Настройка Output Format (выходное разрешение)

Режим записи/
воспроизведения

Выходное разрешение
RAW/

Внутреннее разрешение
записи

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P (по
умолчанию)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P (по
умолчанию)

4096×2160P
1920×1080P (по
умолчанию)
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Устранение неисправностей

Питание

Вывод изображения

Признак
неисправности Причина Действия по устранению

Устройство не
включается.

Сетевой блок питания не подключен должным
образом к разъему DC IN.

Надежно до упора вставьте кабель
питания.

Кабель питания переменного тока не
подключен должным образом к сетевому
блоку питания или электрической розетке.

Надежно до упора вставьте кабель
питания.

Кабель локальной сети не подключен
должным образом между устройством питания
по технологии PoE++ и устройством.

Убедитесь, что кабель вставлен до
фиксации.

Кабель локальной сети подключен к разъему
OPTION, а не к разъему LAN.

Правильно подключите кабель локальной
сети к разъему LAN.

Данное устройство подключено к устройству
подачи питания, которое не поддерживает
технологию PoE++ (соответствующее
стандарту IEEE802.3bt, тип 4, класс 8).

Подключите устройство подачи питания,
которое поддерживает технологию PoE++
(соответствующее стандарту IEEE802.3bt,
тип 4, класс 8).

Общая потребляемая мощность превышает
максимальную мощность устройства подачи
питания по технологии PoE++.

См. инструкции по эксплуатации
клиентского устройства подачи питания
по технологии PoE++.

Подключен кабель локальной сети, категория
которого не поддерживает подачу питания по
технологии PoE++.

Подключайте к разъему LAN и
используйте кабель локальной сети
категории 5e или выше.

Камера, устройство подачи питания по
технологии PoE++ и периферийные
устройства не подключены к заземлению.

Подключите камеру, устройство подачи
питания по технологии PoE++ и
периферийные устройства к заземлению.

Признак
неисправности Причина Действия по устранению

Изображение не
выводится.

Неправильно подключены подключенные
устройства.

Правильно подключите
подключенные устройства.

Не выполнена начальная настройка.
Выполните начальную
настройку с помощью веб-
приложения.
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Признак
неисправности Причина Действия по устранению

Не выводится
изображение на разъем
HDMI.

Задан сигнал, который не поддерживается
устройством, подключенным к выходу HDMI.

Измените настройку формата
выходного сигнала HDMI или
используйте устройство,
поддерживающее
выводимый сигнал.

Используется кабель, который не поддерживает
используемый стандарт выходного сигнала HDMI.

Используйте кабель,
поддерживающий
используемый стандарт
выходного сигнала HDMI.

Не выводится
изображение на разъем
SDI.

Используется кабель, который не поддерживает
используемый стандарт выходного сигнала SDI.

Используйте кабель,
поддерживающий
используемый стандарт
выходного сигнала SDI.

Монитор, подключенный к разъему SDI, не
поддерживает выходной сигнал.

Используйте монитор,
поддерживающий стандарт
выходного сигнала SDI.

Для формата записи задан выходной сигнал RAW.
Измените формат записи на
настройку, отличную от
выходного сигнала RAW.

Для выходного сигнала HDMI задано разрешение
SD.

Задайте для выходного
сигнала HDMI разрешение,
отличное от SD.

На оптоволоконный
разъем не выводится
изображение, или
изображение искажено.

Используемый модуль не соответствует стандартам
SFF или SMPTE либо не соответствует уровню
мощности I (1,0 Вт).

См. пункт “Вывод
оптоволоконного сигнала”.

При использовании
внешней синхронизации
изображение не
выводится или
искажается.

Подаваемый сигнал внешней синхронизации не
подходит для установленного формата
видеосигнала.

Подайте сигнал внешней
синхронизации, подходящий
для установленного формата
видеосигнала.
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Пульт дистанционного управления

Инфракрасный пульт управления

RM-IP500

Признак
неисправности Причина Действия по устранению

В звуке слышен шум.

Камера, устройство подачи питания по технологии
PoE++ и периферийные устройства не подключены
к заземлению.

Подключите устройство,
устройство подачи питания
по технологии PoE++ и
периферийные устройства
к заземлению.

Данное устройство используется в месте, в котором
находятся другие устройства, генерирующие
сильные электрические и магнитные поля
(например, передающие телевизионные или
радиоантенны, любительские радиопередатчики,
двигатели систем кондиционирования воздуха,
силовые трансформаторы).

Не приближайтесь к
устройствам, генерирующим
сильные электрические и
магнитные поля.

Объектив, опора объектива и привод касаются
другого устройства или объекта, в результате чего
возникают посторонние шумы.

Правильно установите
объектив.

Убедитесь в отсутствии
препятствий рядом с
камерой.

Признак неисправности Причина Действия по устранению

Инфракрасный пульт
управления не работает
при нажатии.

Управление с инфракрасного
пульта управления отключено.

В веб-меню установите в пункте [Technical] >
[IR Remote] > [Setting] значение [On].

Элемент питания разряжен или
установлен в неправильной
полярности.

Используйте инфракрасный пульт
управления рядом с ИК-датчиком данного
устройства. Если мигает индикатор питания
Power, замените элемент питания.

Не выполнена начальная
настройка.

Выполните начальную настройку с помощью
веб-приложения.

Низкая скорость
поворота/наклона.

Для скорости поворота/наклона при
использовании инфракрасного
пульта управления задан обычный
режим.

Установите переключатель SETUP 4 на блоке
разъемов устройства в положение ON.

Пульт управляет не той
камерой, которой
требуется.

Инфракрасный сигнал был получен
другой камерой, отличной от
требуемой.

В пункте [Technical] > [IR Remote] > [Setting]
веб-меню той камеры, которой не требуется
управлять, задайте значение [Off].
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Веб-приложение

Признак неисправности Причина Действия по устранению

Камерой невозможно управлять с
пульта дистанционного управления
RM-IP500.

Не подключено питание
камеры.

Убедитесь, что индикатор POWER на
устройстве горит зеленым или оранжевым
цветом.

Камера или пульт
дистанционного
управления не
подключены к сети.

Проверьте подключение устройства и
пульта дистанционного управления.

Не выполнена начальная
настройка камеры.

Выполните начальную настройку с
помощью веб-приложения.

Не включена связь по
протоколу VISCA по IP.

Установите переключатель SETUP 3 на
панели разъемов устройства в положение
ON и перезагрузите устройство.

Изменился IP-адрес
камеры.

Проверьте IP-адрес камеры с помощью
пункта [Network] > [Wired LAN] в веб-меню
или меню камеры.

IP-адрес камеры был изменен с
помощью кнопки AUTO IP SETUP на
пульте дистанционного управления
RM-IP500.

Прошло не менее 20
минут с запуска камеры.

Перезагрузите устройство. IP-адрес
можно изменить с помощью кнопки AUTO
IP SETUP в течение первых 20 минут
после запуска устройства.
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Признак неисправности Причина Действия по устранению

Не удается подключиться с
помощью веб-браузера.

Не подключен кабель
локальной сети категории
5e или выше.

Подключите кабель локальной сети категории
5e или выше.

Неправильное
подключение к локальной
сети, или подключенная
сеть не работает должным
образом.

Убедитесь, что горит индикатор Link LED для
разъема LAN. Если индикатор Link LED не горит,
обратитесь к администратору сети.

Не подключено питание
камеры.

См. раздел “Питание” выше.

Для устройства не
настроен действительный
IP-адрес.

Выполните сброс сети.

Настроенный IP-адрес
используется другим
устройством.

Проверьте уникальность IP-адресов
периферийных устройств.

Настроенная маска подсети
не соответствует
используемой маске
подсети.

Выполните сброс сети.

Доступ к устройству в этой
же локальной сети
осуществляется через
прокси-сервер.

Измените конфигурацию, чтобы прокси-сервер
не использовался.

Для устройства настроен
неправильный шлюз по
умолчанию.

Выполните сброс сети.

Введен неправильный URL-
адрес.

Введите правильный URL-адрес и повторите
попытку.

Неправильный порт HTTP.

Откройте меню камеры на внешнем мониторе и
проверьте настройку параметра [Network] >
[Wired LAN] > [HTTP Port]. Если задано
значение, отличное от 80, добавьте этот номер
порта HTTP к имени узла или IP-адресу,
введенному в веб-браузере.
Например, если установлен порт HTTP 8080,
введите http://<IP-адрес>:8080

Номер порта HTTP данного
устройства фильтруется
или блокируется.

Измените номер порта HTTP данного
устройства на порт, который не фильтруется и
не блокируется.

Отрицательное влияние
оказывает старый кэш веб-
браузера.

Очистите кэш из веб-браузера.

485



Признак неисправности Причина Действия по устранению

Не удается подключиться к
веб-приложению с помощью
кода 2D (QR-кода).

Используемое устройство
не поддерживает mDNS.

Используйте устройство, которое поддерживает
mDNS.
Если используемое устройство не поддерживает
mDNS, введите IP-адрес напрямую в веб-
браузере.

Планшет или компьютер и
камера подключены к
разным сетям.

Подключите планшет или компьютер к той же
локальной сети, к которой подключено
устройство.

Не удается подключиться к
веб-приложению путем ввода
URL-адреса вручную.

Используемое устройство
не поддерживает mDNS.

Используйте устройство, которое поддерживает
mDNS.

Планшет или компьютер и
камера подключены к
разным сетям.

Подключите планшет или компьютер к той же
локальной сети, к которой подключено
устройство.

Постоянно отображается
экран аутентификации.

Не было введено
правильное имя
пользователя или пароль.

Введите зарегистрированные имя пользователя
и пароль. Если вы забыли зарегистрированную
информацию о пользователе, см. пункт
“Переключатель RESET” в разделе “Блок
разъемов”, чтобы инициализировать
информацию о пользователе для подключения к
сети.

Имя пользователя и пароль
могли быть изменены
пользователем,
выполнившим вход с
помощью другого веб-
браузера.

Уточните правильные имя пользователя и
пароль у администратора устройства.

Изображение с камеры не
отображается в веб-
приложении.

Для выходного сигнала
HDMI камеры задано
разрешение 720×480 или
720×576.

Измените разрешение выходного сигнала HDMI
устройства.

Подключенный монитор
HDMI не поддерживает
выходной сигнал HDMI
камеры.

Отсоедините монитор HDMI или используйте
монитор HDMI, который поддерживает
настройки выходного сигнала HDMI.

Устройство было
перезагружено, и сеанс
был разъединен.

Подождите около одной минуты и перезагрузите
веб-браузер.

Отрицательное влияние
оказывает старый кэш веб-
браузера.

Очистите кэш из веб-браузера.

Низкое разрешение
изображения с камеры,
отображаемого в веб-
приложении.

Для видеопотока 3,
используемого веб-
приложением, установлено
низкое разрешение.

Увеличьте значение с помощью пункта [Stream]
> [Video Stream] > [Size 3] в веб-меню.
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Съемка

Камера

Признак неисправности Причина Действия по устранению

Меню камеры не
отображается при нажатии
кнопки [Menu].

Меню камеры настроено
таким образом, что оно не
внедряется в выходной
сигнал HDMI.

В веб-меню установите в пункте [Monitoring] >
[Output Display] > [HDMI/Stream] значение [On].

Значение настройки на экране
настроек не обновляется или
не отображается должным
образом.

Экран настроек веб-
приложения не будет
автоматически отображать
настройки, измененные в
другом веб-приложении.

Нажмите кнопку [Reload] внизу экрана настроек
веб-приложения. Значения настроек на
отображаемом экране настройки будут
загружены заново и обновлены.

Мешают настройки
временных файлов
Интернета.

Очистите кэш из веб-браузера.

Не удается загрузить файл
конфигурации или журнал.

В веб-браузере отключена
функция загрузки файлов.

Включите в веб-браузере функцию загрузки
файлов.

Экран настроек веб-
приложения доступен, но
выполнение операций на
операционном экране и
экране воспроизведения
невозможно.

Операционный экран веб-
приложения заблокирован.

Установите переключатель блокировки
операций в правом верхнем углу веб-
приложения в положение  (Операции
разблокированы).

Открытие экрана веб-
приложения занимает
заметное время.

Потоковое изображение с
устройства одновременно
просматривают много
пользователей.

Уменьшите количество пользователей,
имеющих одновременный доступ к веб-
приложению.

Изображение искажено или
дергается.

Видеоданные не
передаются должным
образом из-за перегрузки в
тракте связи.

Уменьшите скорость потока данных потоковой
передачи или задайте для кодека [Video Stream
3] > [Size] минимально возможное значение,
чтобы создать запас по пропускной способности
тракта связи.

На планшете запущено
несколько веб-браузеров,
которые занимают память.

Закройте все веб-браузеры, работающие
в фоновом режиме.

Открыто слишком много
вкладок веб-браузера, что
замедляет работу.

Закройте все неиспользуемые вкладки.

Чрезмерное заполнение
кэша веб-браузера и
истории посещений
замедляет работу.

Очистите кэш веб-браузера.

Признак неисправности Причина Действия по устранению

В начале и в конце операции
поворота/наклона изображение
выглядит искаженным.

Изображение может искажаться, если
в объективе включена функция
стабилизации изображения.

Выключите в объективе
функцию стабилизации
изображения.
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Поворот/наклон

Признак неисправности Причина Действия по устранению

Угол обзора изменился без
вмешательства пользователя.

Проявляется эффект дыхания
объектива.

См. раздел “Компенсация
дыхания”.

Невозможно управлять фокусировкой,
масштабированием или диафрагмой.

Могут быть неправильно установлены
переключатели объектива.

См. раздел “Проверка
переключателей объектива”.

Признак неисправности Причина Действия по устранению

Не удается выполнить
сброс поворота/наклона.

Рычаг блокировки поворота/
наклона находится в положении
LOCK.

Переместите рычаг блокировки поворота/
наклона в положение UNLOCK.

Камера не
останавливается в
ожидаемом положении.

Блок камеры не сбалансирован.

Переместите блок камеры вперед или назад
в требуемое положение, как описано в
разделе “Присоединение объектива”, затем
снова включите устройство.

Установлен объектив, который не
поддерживает поворот/наклон.

Ознакомьтесь со сведениями о
совместимости объективов и установите
объектив, который поддерживает поворот/
наклон, затем снова включите устройство.

Не удается выполнить сброс
поворота/наклона.

Выполните сброс поворота/наклона, как
описано в разделе “Сброс поворота/наклона”.

К головке камеры было
приложено неожиданное усилие,
которое вызвало ошибку
управления поворотом/наклоном.

Камера не возвращается
в положение направления
вперед при нажатии

 (Начальное
положение поворота/
наклона).

Включен режим установки на
потолке.

Установите пункт [Pan-Tilt] > [P/T Direction] >
[Ceiling] в веб-меню в соответствии с
фактическим способом установки, затем
снова включите устройство. При установке на
потолке блок разъемов находится с передней
стороны камеры.

Операция поворота/
наклона ограничена.

Задано ограничение диапазона
поворота/наклона.

Если требуется, удалите ограничение
диапазона поворота/наклона, как описано в
разделе “P/T Range Limit”.

К головке камеры было
приложено неожиданное усилие,
которое вызвало ошибку
поворота/наклона.

Выполните сброс поворота/наклона, как
описано в разделе “Сброс поворота/наклона”.

Операция поворота/
наклона выполняется в
противоположном
направлении.

Настройка режима крепления на
потолке отличается от
фактического состояния
установки.

Установите пункт [Pan-Tilt] > [P/T Direction] >
[Ceiling] в веб-меню в соответствии с
фактическим способом установки.

Были изменены настройки,
связанные с направлением
поворота/наклона.

Проверьте настройки [Pan-Tilt] > [P/T Direction]
в веб-меню.

488



Признак неисправности Причина Действия по устранению

В начале и в конце
операции поворота/
наклона нарушена
плавность перемещения
изображения.

Установлено слишком высокое
значение ускорения/замедления
операции поворота/наклона.

С помощью пункта [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] в веб-меню или
меню камеры уменьшите настройку
ускорения/замедления поворота/наклона,
чтобы повысить плавность перемещения в
начале и в конце операции поворота/наклона.
Обратите внимание, что в результате время
разгона объектива до максимальной скорости
увеличится.

Операция поворота/
наклона остановлена.

Блок камеры не сбалансирован.

Переместите блок камеры вперед или назад
в требуемое положение, как описано в
разделе “Присоединение объектива”, затем
снова включите устройство.

Для кривой ускорения/
замедления задано значение,
слишком большое для
установленного объектива.

Если установлен крупный объектив,
уменьшите значение параметра [Pan-Tilt] >
[P/T Acceleration] > [Ramp Curve] в веб-меню
или меню камеры.

Используется большой объектив.
Обратитесь в службу технической поддержки
Sony.

При выполнении
поворота/наклона
устройство блокируется.

Рычаг зажима винта крепления
основания опоры объектива
ударяет по камере.

Поверните рычаг зажима винта крепления
основания опоры объектива, чтобы он
смотрел вверх.

Рычаг зажима опоры объектива
ударяет по камере.

Поверните рычаг зажима опоры объектива,
чтобы он смотрел вверх.

Рычаг блокировки головки камеры
ударяет по камере.

Удостоверьтесь, что рычаг блокировки
головки камеры полностью находится в
положении LOCK.

Во время поворота/
наклона слышны
посторонние звуки.

Камера не сбалансирована.

Переместите головку камеры вперед или
назад в соответствующее положение, чтобы
основание с направляющими находилось в
горизонтальном положении.

Для кривой ускорения/
замедления задано значение,
слишком большое для
установленного объектива.

Если установлен крупный объектив,
уменьшите значение параметра [Pan-Tilt] >
[P/T Acceleration] > [Ramp Curve] в веб-меню
или меню камеры.

Головка камеры не
зафиксирована в своем
положении, и во время
выполнения операции слышен
звук перемещения.

Установите рычаг блокировки головки камеры
в положение LOCK.

Невозможно сохранить
предварительно заданное
положение.

Предварительно заданное
положение нельзя сохранить при
использовании функции Clear
Image Zoom.

Задайте для коэффициента
масштабирования функции Clear Image Zoom
значение 1× (состояние, при котором
коэффициент не отображается справа от 
(Zoom ratio)).
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Запись / воспроизведение

Признак неисправности Причина Действия по устранению

При воспроизведении
предварительно
заданного положения
кадрирование
нарушается.

Температура окружающей среды
могла значительно измениться
с момента сохранения
предварительно заданного
положения до момента его
воспроизведения.

Сохраните предварительно заданное
положение повторно.

Не выполнена калибровка
объектива.

Выполните калибровку с помощью пункта
[Technical] > [Lens] > [Lens Calibration] в меню
камеры.

Установлен объектив, отличный
от того, который был установлен
при сохранении предварительно
заданного положения. Либо
используется другое положение
масштабирования при ручном
масштабировании.

Сохраните предварительно заданное
положение повторно.

Панель управления
кадрированием веб-
приложения отображается
серым цветом и
недоступна.

Операция поворота/наклона
недоступна, когда отображается
экран эскизов или во время
воспроизведения.

Выведите экран управления
воспроизведением и закройте экран эскизов
или остановите воспроизведение.

Операция поворота/наклона
недоступна, когда в веб-
приложении не может
отображаться изображение с
камеры.

См. пункт “Веб-приложение” в разделе
“Устранение неисправностей”.

Рычаг блокировки поворота/
наклона находится в положении
LOCK.

Переместите рычаг блокировки поворота/
наклона в положение UNLOCK.

Под панелью управления
кадрированием в веб-
приложении отображается
сообщение “Execute Pan-
Tilt Reset”.

К головке камеры было
приложено неожиданное усилие,
которое вызвало ошибку
поворота/наклона.

Выполните сброс поворота/наклона, как
описано в разделе “Сброс поворота/наклона”.

Признак неисправности Причина Действия по устранению

При нажатии кнопки
START/STOP (пуск/
остановка записи) запись
не начинается.

Карта памяти полностью
заполнена.

Замените карту памяти картой с
достаточным свободным пространством.

Карта памяти требует
восстановления.

Выполните восстановление карты памяти,
как описано в разделе “Восстановление
карт памяти”.

Индикатор записи/съемки
настроен как индикатор съемки,
поэтому состояние записи
невозможно определить по этому
индикатору.

Настройте индикатор записи/съемки, чтобы
он работал как индикатор записи, как
описано в разделе “Подключение сигнала
съемки”.
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Передача файлов

Потоковая передача

Признак неисправности Причина Действия по устранению

Запись звука невозможна.

Не подключен микрофон.
Подключите микрофон или
аудиоустройство к разъему AUDIO IN в
блоке разъемов.

Для настройки [Master Input Level]
установлено минимальное
значение.

Настройте значение параметра [Master
Input Level].

Звук записывается с
искажениями.

Задан слишком высокий входной
уровень звука.

Настройте параметры [CH1 Input Level] –
[CH4 Input Level] и [Master Input Level].

При использовании микрофона в шумной
обстановке, например на концертных
площадках, вначале отрегулируйте
параметры [AUDIO IN CH1 MIC Ref.] и
[AUDIO IN CH2 MIC Ref.].

В записанном звуке
слишком много шумов.

Задан слишком низкий входной
уровень звука.

Настройте параметры [Audio Input Level] и
[Audio] > [Audio] > [Audio Input] > [AUDIO IN
CH1 MIC Ref.] или [AUDIO IN CH2 MIC Ref.].

Клипы не воспроизводятся.

Клип редактируется.

Воспроизведение клипов невозможно, если
изменены имена файлов или папок или
если клип используется на компьютере. Это
не является признаком неисправности.

Клип был записан какой-то другой
камерой.

Клипы, записанные с помощью других
камер, могут не воспроизводиться или
могут отображаться с неправильным
размером. Это не является признаком
неисправности.

Признак неисправности Причина Действия по устранению

Не удается выполнить
отправку файлов.

Неправильные имя
пользователя и пароль на
сервере.

Имя пользователя или пароль на сервере могут
быть неправильными. Введите правильные
записи.
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Признак неисправности Причина Действия по устранению

Потоковая передача
недоступна.

Неправильные имя
пользователя или пароль,
введенные в клиентском
приложении для просмотра
потоковой передачи с данного
устройства.

Если для формата потоковой передачи данного
устройства задано значение [RTSP], [SRT-
Listener] или [NDI|HX], необходимо ввести имя
пользователя и пароль, заданные для данного
устройства в клиентском приложении. Введите
правильные имя пользователя и пароль.

Не задан протокол потоковой
передачи.

Выберите требуемый протокол в пункте [Stream]
> [Stream Setting] в веб-меню.

Задано шесть сеансов RTSP и
более.

Задайте количество сеансов, равное пяти или
менее.

Неправильно задан номер
порта UDP.

Задайте номер порта и другие настройки для
требуемого протокола с помощью пункта
[Stream] > [Stream] > [Stream Setting] в веб-меню.

Связь по UDP заблокирована.
Проверьте настройки защитного программного
обеспечения.

Потоковая передача
звука не производится.

Для потоковой передачи звука
задано значение [Off].

В веб-меню установите в пункте [Stream] >
[Audio Stream] > [Setting] значение [On].

Потоковая передача
отключена.

Во время потоковой передачи
была изменена настройка
протокола или настройки
кодека потоковой передачи.

Задайте настройку протокола и настройки
кодека потоковой передачи до начала потоковой
передачи.

Для [Video Stream 1]
невозможно установить
размер изображения
4096×2160 или
3840×2160.

Установлен размер
изображения 1920×1080, когда
для параметра [Output Format]
задано значение HDMI.

Размер изображения для потоковой передачи не
может быть больше размера изображения HDMI.
Измените размер изображения HDMI с помощью
пункта [Monitoring] > [Output Format] в веб-меню.

Для [Video Stream 1]
невозможно установить
частоту кадров 60 или 50
кадров/с.

Установлена частота кадров
потоковой передачи 29.97 или
менее.

Частота кадров, используемая для потоковой
передачи, ограничена частотой системы.
Измените частоту системы с помощью пункта
[Rec Format] > [Frequency] в веб-меню.

Поток [Video Stream 3]
недоступен.

[Video Stream 3] не
поддерживает RTSP/SRT/NDI.

Используйте [Video Stream 1] или [Video Stream
2].

Экран RTSP/SRT не
обновляется или не
отображается должным
образом.

Номер порта, используемого
для RTSP или SRT,
фильтруется или блокируется.

Измените номер порта RTSP или SRT на порт,
который не фильтруется и не блокируется
устройствами, принимающими потоковую
передачу. Или измените номер порта,
используемого для RTSP или SRT на данном
устройстве.

Изображение искажено
или дергается.

Видеоданные не передаются
должным образом из-за
перегрузки в тракте связи.

Уменьшите скорость потока данных потоковой
передачи или задайте для кодека [Video Stream
2] ([Codec 2]) значение [Off], чтобы создать запас
по пропускной способности тракта связи.

Порядок видеопакетов
изменился при передаче по
каналу связи.

Используйте одного поставщика услуг Интернета
как для устройства, так и для приемника.
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Соединение с внешними устройствами

Внешняя синхронизация

Tally

Контроллер объектива

Признак неисправности Причина Действия по устранению

Не определено как
устройство NDI.

Для протокола потоковой
передачи не установлено
значение NDI|HX.

Чтобы данное устройство определялось как
устройство NDI, должен быть установлен
протокол потоковой передачи NDI|HX. В веб-
меню установите в пункте [Stream] > [Stream
Setting] значение [NDI|HX].

Не может использоваться
как устройство NDI.

Не установлена лицензия
NDI|HX.

Установите лицензию NDI|HX. Наличие
лицензии NDI|HX можно проверить с помощью
пункта [Stream] > [Stream] > [Stream Setting] >
[NDI|HX] > [License] в веб-меню.

Признак
неисправности Причина Действия по устранению

Невозможно
синхронизировать с
внешним источником.

Подаваемый сигнал внешней
синхронизации не подходит
для установленного формата
видеосигнала.

Подайте сигнал внешней синхронизации,
подходящий для установленного формата
видеосигнала.

Для данного устройства
использованы два оконечных
устройства.

В данном устройстве предусмотрено встроенное
оконечное устройство сопротивлением 75 Ом.
Подключайтесь напрямую к источнику сигнала
(один к одному) или используйте распределитель
(расщепитель).

Признак
неисправности Причина Действия по устранению

Не загорается
индикатор съемки.

Для яркости индикатора съемки
установлено значение Off.

Задайте требуемую яркость с помощью пункта
[Technical] > [Tally] > [Tally Lamp Brightness] в
веб-меню.

Индикатор записи/съемки настроен как
индикатор записи.

Настройте индикатор записи/съемки, чтобы он
работал как индикатор съемки, как описано в
разделе “Подключение сигнала съемки”.

Подключен пульт ДУ RM-IP500, а
протокол VISCA over IP отключен.

Установите переключатель SETUP 3 на блоке
разъемов устройства в положение ON.

Неправильно подключен разъем
OPTION, или нужный контакт не
соединен накоротко с контактом GND
(Земля).

Накоротко соедините контакт 7 или 8 разъема
OPTION с контактом GND, как описано в
разделе “Подключение сигнала съемки”.
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См. также

Вывод оптоволоконного сигнала

Блок разъемов

Компенсация дыхания

Проверка переключателей объектива

Присоединение объектива

Сброс поворота/наклона

P/T Range Limit

Восстановление карт памяти

Подключение сигнала съемки

5-041-958-03(1) Copyright 2022 Sony Corporation

Признак
неисправности Причина Действия по устранению

В экране  (Состояние
камеры) отображается
[Communication Error].

Камера не может
установить связь
с контроллером
объектива.

Проверьте соединение между устройством и
контроллером объектива, затем включите питание
устройства и контроллера объектива.

В экране  (Состояние
камеры) отображается
[Rotation Error].

В контроллере
объектива произошла
ошибка вращения.

Сохраненный диапазон масштабирования и диапазон
перемещения объектива могут не совпадать.
Инициализируйте контроллер объектива.
Если проблема сохраняется, обратитесь к представителю
производителя контроллера объектива.

В экране  (Состояние
камеры) отображается
[System Error].

В контроллере
объектива произошла
системная ошибка.

Проверьте соединение между устройством и
контроллером объектива, обратитесь к инструкции по
эксплуатации контроллера объектива и выполните
инициализацию контроллера объектива, либо выключите
и включите устройство и контроллер объектива.
Если проблема сохраняется, обратитесь к представителю
производителя контроллера объектива.

В экране  (Состояние
камеры) отображается
[Unknown Error].

В контроллере
объектива произошла
неизвестная ошибка.

Проверьте соединение между устройством и
контроллером объектива, обратитесь к инструкции по
эксплуатации контроллера объектива и выполните
инициализацию контроллера объектива, либо выключите
и включите устройство и контроллер объектива.
Если проблема сохраняется, обратитесь к представителю
производителя контроллера объектива.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Предупреждения относительно эксплуатации

Если в устройстве возникло предупреждение, предостережение или рабочее состояние, требующее
подтверждения, на панели изображения с камеры отображается сообщение, а индикаторы POWER и
NETWORK — на передней панели, а также индикатор записи/съемки начинает мигать.

Примечание

Индикация мигающим индикатором записи/съемки включается только в том случае, если в веб-меню или меню камеры
для параметра [Technical] > [Tally] > [Tally Control] задано значение [Internal], а для параметра [Tally Lamp Brightness] не
задано значение [Off].

Сообщения об ошибках

Если индикаторы POWER и NETWORK мигают так, как указано ниже, примите следующие меры.

Устройство перестанет работать, когда отображается следующая индикация.

Предупредительные сообщения

Если на экране отображаются следующие сообщения, выполните приведенные инструкции.

Индикаторы
POWER

Индикаторы
NETWORK Причина и действия по устранению

Редко мигает
оранжевым

Редко мигает
зеленым

Устройство не может нормально работать. Подробные сведения см. в
пункте [Maintenance] > [System Log] в веб-меню. Если проблема
сохраняется даже после перевода устройства в режим ожидания или
выключения питания и его повторного включения, обратитесь в службу
технического обслуживания Sony.

Часто мигает
оранжевым

Часто мигает
зеленым

В устройстве возникла неполадка. Обратитесь в службу технического
обслуживания Sony.

Отображение
сообщений

Индикатор
записи/
съемки

Причина и действия по устранению

E + код ошибки
Быстрое
мигание

Указывает на нештатное состояние в устройстве. Запись останавливается,
даже если на панели изображения с камеры отображается значок ●REC.
Выключите данное устройство и проверьте все подключенные устройства,
кабели и носители. Если после повторного включения данного устройства
сообщение об ошибке снова появится, обратитесь к представителю службы
технического обслуживания компании Sony. Ошибка может не отображаться
или звуковой сигнал может не подаваться в зависимости от состояния
устройства.
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Отображение
сообщений

Индикатор
записи/съемки Причина и действия по устранению

Temperature High Мигает
Высокая внутренняя температура.
Выключите видеокамеру и дайте ей остыть перед тем, как
продолжить работу.

Media Temperature
High

Мигает
Высокая температура карты CFexpress.
Замените карту или дайте ей остыть, прежде чем снова
использовать.

Voltage Low Мигает Напряжение на входе DC IN слишком низкое (уровень 1). Проверьте
источник питания.

Insufficient Voltage Быстрое мигание
Напряжение на входе DC IN слишком низкое (уровень 2). Запись
отключена.
Подключите другой источник питания.

Media Near Full Мигает
На карте памяти остается мало свободного места.
Замените ее как можно скорее.

Media Full Быстрое мигание
Клипы нельзя записывать или копировать, поскольку на карте
памяти не осталось свободного места.
Замените ее немедленно.

Clips Near Full Мигает
Количество дополнительных клипов, которые можно записать на
карту памяти, мало.
Замените ее как можно скорее.

Clips Full Быстрое мигание

Достигнуто максимальное количество клипов, которые можно
записать на карту памяти.
Запись или копирование дополнительных клипов невозможно.
Замените ее немедленно.

Last Clip Recording Мигает

Текущий записываемый клип является последним клипом, который
может быть записан, так как достигнуто максимальное количество
клипов.
Подготовьте новую карту памяти.

Media(A) Life Near
End1) Мигает Срок службы карты памяти заканчивается. Замените ее как можно

скорее.

Media(A) Life End1) Быстрое мигание Срок службы карты памяти закончился. Замените ее немедленно.

Media(A) Near Full1) Мигает При использовании функции Simul Rec

Media(A) Full1) Быстрое мигание При использовании функции Simul Rec

Media(A) Clips Near
Full1) Мигает При использовании функции Simul Rec

Media(A) Clips
Full1) Быстрое мигание При использовании функции Simul Rec

Media(A) Last Clip
Rec1) Мигает При использовании функции Simul Rec
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Уведомления и сообщения о работе

В центре экрана могут отображаться следующие уведомления и сообщения о работе прибора. Для устранения
причины уведомления выполните приведенные инструкции.

Отображение
сообщений

Индикатор
записи/съемки Причина и действия по устранению

(Нет индикации) Мигает

В контроллере объектива произошла неизвестная ошибка.
Проверьте состояние камеры в веб-приложении.
Более подробные сведения см. в системном журнале в веб-
приложении.

“(B)” отображается для карты в гнезде B.1)

Сообщение на дисплее Причина и действия по устранению

Backup Battery End
Please Change

Оставшегося заряда резервной батареи недостаточно.
Подключите устройство к источнику питания не менее чем на 24 часа
для зарядки резервной батареи.

Unknown Media(A)1)

Please Change

Вставлена разбитая на разделы карта памяти или карта памяти,
содержащая больше клипов, чем может обработать устройство.
Такую карту нельзя использовать в устройстве. Ее необходимо
заменить.

Cannot Use Media(A)1)

Unsupported File System

Вставлена карта памяти с другой файловой системой или
неформатированная карта памяти.
Такую карту нельзя использовать в устройстве. Ее необходимо
заменить или отформатировать с помощью устройства.

Media Error
Media(A) Needs to be Restored1)

На карте памяти возникла ошибка. Необходимо выполнить
восстановление карты.
Восстановите карту памяти.

Media Error
Cannot Record to Media(A)1)

Возможно, карта памяти повреждена и ее больше нельзя использовать
для записи.
Воспроизведение возможно, поэтому рекомендуется сделать копию
данных и заменить карту памяти.

Media Error
Cannot Use Media(A)1)

Возможно, карта памяти повреждена и ее больше нельзя использовать
для записи или воспроизведения.
Такую карту нельзя использовать в устройстве. Ее необходимо
заменить.

Media(A) Error1)

Recording Halted
Playback Halted

Запись и воспроизведение были остановлены, потому что при
использовании карты памяти возникла ошибка.
Если проблема сохранится, замените карту памяти.

Media Reached Rewriting Limit
Change Media(A)1)

Срок службы карты памяти закончился.
Сделайте резервную копию и замените карту памяти немедленно. Если
продолжить использование карты, то запись и воспроизведение будут
возможны.
Для получения более подробных сведений см. инструкцию по
эксплуатации карты памяти.

The specified address is invalid.
Указан недопустимый адрес.
Проверьте правильность настройки.
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Информация об ошибке потоковой передачи RTMP

В устройстве может отображаться следующая информация об ошибке. При необходимости выполните
следующие действия.

Сообщение на дисплее Причина и действия по устранению

Cannot Use Specified Port Number
Указан недопустимый номер порта.
Проверьте правильность настройки.

Lens I/F Error(xx:xx)

При установленном объективе с байонетом E обнаружена ошибка
связи в интерфейсе объектива.
Проверьте состояние соединения с объективом с байонетом E.
Если неполадка сохраняется, обратитесь к представителю службы
технического обслуживания компании Sony и сообщите ему код ошибки
(пять символов в скобках).

Cannot add auto upload job of Proxy
file because maximum number of
upload jobs was reached.

Достигнуто максимальное количество заданий передачи.
Удалите ненужные задания. Кроме того, может быть неправильной
настройка пункта назначения автоматической отправки для файлов
прокси. Проверьте правильность настройки.

Fan Stopped

Перестал работать вентилятор.
Убедитесь в отсутствии пыли или посторонних материалов.
Если после удаления пыли и посторонних материалов ошибка
сохраняется, обратитесь к представителю службы технического
обслуживания компании Sony.

“(B)” отображается для карты в гнезде B.1)

Код ошибки
Описание Действия по устранению

RTMP RTMPS

1002
1004

2002
2004

Невозможно подключиться
к серверу RTMP.

Проверьте правильность URL-адреса сервера.
Проверьте сетевое подключение.

1003 2003
Невозможно разрешить
доменное имя.

Проверьте правильность URL-адреса сервера.
Проверьте подключение к DNS-серверу.

–
2005
2008

Ошибка CRL (список
аннулированных сертификатов)

Проверьте правильность URL-адреса сервера.
Убедитесь, что адресатом соединения является
доверенный сайт.

2006
Ошибка сертификата CA (центр
сертификации)

Проверьте правильность настройки часов.
Проверьте правильность сертификата CA.

– 2007
Сертификат CA не установлен.
Ошибка аутентификации
сертификата сервера.

Установите сертификат CA.
Убедитесь, что адресатом соединения является
доверенный сайт.

4002 Сеанс RTMP был прерван.

Возможно, устройство отключено на стороне сервера
RTMP.
Убедитесь, что настройки соответствуют
рекомендованному параметру кодека для данной
службы.

4003
Низкое качество сетевого
подключения. Проверьте сетевое подключение.
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Информация об ошибке потоковой передачи SRT

В устройстве может отображаться следующая информация об ошибке. При необходимости выполните
следующие действия.

5-041-958-03(1) Copyright 2022 Sony Corporation

Код ошибки
Описание Действия по устранению

RTMP RTMPS

Прочее Другие ошибки.

Код
ошибки Описание Действия по устранению

SRT-Caller

1001 Неожиданная ошибка
Возможно, устройство работает неправильно. Выключите и
включите устройство.

1002
Связь прервана из-за изменения
настроек

Связь была прервана из-за изменения настроек.
Восстановите соединение.

5001 Неожиданная ошибка
Возможно, устройство работает неправильно. Выключите и
включите устройство.

5005 Обрыв соединения Проверьте правильность настройки адресата соединения.

5006 Ошибка шифрования Проверьте правильность настройки шифрования.

5007 Неожиданная ошибка Возможно, устройство работает неправильно. Выключите и
включите устройство.5008 Неожиданная ошибка

5009 Сбой передачи
Устройство было отключено во время сеанса связи.
Проверьте сетевое подключение.
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Список пунктов меню

В следующих таблицах перечисляются пункты меню устройства.

Обозначения
“Меню камеры” и “веб-меню”
●: доступно
▲: доступны некоторые пункты
–: недоступно

“All File” и “Scene File”
Да: элемент сохраняется в файле ALL или файле сцены
Нет: элемент не сохраняется

“All Reset (except for Network Settings)”
При выполнении команды [Reset]> [Reset] > [All Reset (except for Network Settings)] из веб-меню:
Да: инициализированный элемент (не включает настройки сети)
Нет: неприменимо

“Network Reset”
При выполнении команды [Reset]> [Reset] > [Network Reset] из веб-меню:
Да: инициализированный элемент (настройка сети)
Нет: неприменимо

“Factory Default”
Да: элемент сброшен на заводское значение по умолчанию
Нет: неприменимо

Shooting

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Да Да Да Да Да

ND Filter ● – Да Да*1 Да Нет Да

Shutter ● – Да Да Да Нет Да

Iris ● – Да Да Да Нет Да

Auto Exposure ● – Да Да*2 Да Нет Да

White ● – Да Да*3 Да Нет Да

White Setting ● – Да Нет Да Нет Да

Offset White ● – Да Нет Да Нет Да

Focus ● ▲ Да Нет Да Нет Да

S&Q Motion ● – Да Нет Да Нет Да
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Project

Paint/Look

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Да Нет Да Нет Да

Noise
Suppression

● – Да Да Да Нет Да

Flicker Reduce ● – Да Нет Да Нет Да

SteadyShot ● – Да Нет Да Нет Да

Пункт [Mode] неприменим*1

Пункты [Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] неприменимы*2

Пункт [Preset White] неприменим*3

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Да Нет Да Нет Да

Rec Format ● ● Да Нет Да*1 Нет Да

Cine EI/Flex.ISO
Set

● – Да Нет Да Нет Да

Simul Rec ● ● Да Нет Да Нет Да

Proxy Rec ● ▲ Да Нет Да Нет Да

Interval Rec ● ● Да*2 Нет Да Нет Да

Picture Cache
Rec

● ● Да*2 Нет Да Нет Да

SDI/HDMI Rec
Control

● – Да Нет Да Нет Да

Assignable
Button

● – Да Нет Да Нет Да

All File – ● Нет Нет Нет Нет Нет

Пункт [Frequency] неприменим*1

Пункт [Setting] неприменим*2

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – Нет Нет Нет Нет Нет

Base Look ● ▲ Да*1 Нет Да*1 Нет Да*1

Reset Paint
Settings

● – Нет Нет Нет Нет Нет
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Pan-Tilt

TC/Media

Monitoring

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Да Да Да Нет Да

Knee ● – Да Да Да Нет Да

Detail ● – Да Нет Да Нет Да

Matrix ● – Да Да Да Нет Да

Multi Matrix ● – Да*2 Да*2 Да Нет Да

Данные LUT, импортированные как базовый вид, неприменимы*1

Пункт [Axis] неприменим*2

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● Нет Нет Да Нет Нет

P/T
Acceleration

● ● Нет Нет Да Нет Нет

P/T Range
Limit

– ● Нет Нет Да Нет Нет

P/T Direction – ● Нет Нет Да Нет Нет

P/T Preset – ● Нет Нет Да Нет Нет

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Да*1 Нет Да Нет Да

TC Display ● – Да Нет Да Нет Да

Users Bit ● – Да*1 Нет Да Нет Да

HDMI TC Out ● – Да Нет Да Нет Да

Clip Name
Format

● – *2 Нет Да Нет Да

Update Media ● – Нет Нет Нет Нет Нет

Format Media ● – Нет Нет Нет Нет Нет

Media Life ● – Нет Нет Нет Нет Нет

Пункт [Setting] неприменим*1

Пункт [Auto Naming] применим, пункт [Camera ID] неприменим*2
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Audio

Thumbnail

Technical

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output Format ● ● Да Нет Да Нет Да

Output Display – ● Да Нет Да Нет Да

Display On/Off ● – Да Нет Да Нет Да

Video Signal
Monitor

● – Да Нет Да Нет Да

Marker ● – Да Нет Да Нет Да

Пункт
(уровень

2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio Input ● ▲ Да Нет Да Нет Да

Audio
Output

● ▲ Да Нет Да Нет Да

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Нет Нет Нет Нет Нет

Set Clip Flag ● – Нет Нет Нет Нет Нет

Lock/Unlock Clip ● – Нет Нет Нет Нет Нет

Delete Clip ● – Нет Нет Нет Нет Нет

Transfer Clip ● – Нет Нет Нет Нет Нет

Transfer Clip
(Proxy)

● – Нет Нет Нет Нет Нет

Filter Clips ● – Нет Нет Нет Нет Нет

Customize View ● – Да Нет Да Нет Да

Пункт
(уровень

2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color Bars ● – *1 Нет *1 Нет Да

Genlock ● – Нет Нет Нет Нет Нет

503



Network

Stream

Пункт
(уровень

2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Tally ● ● Да Нет Да Нет Да

Rec
Review

● – Да Нет Да Нет Да

Zoom ● – Да Нет Да Нет Да

IR Remote – ● Нет Нет Да Нет Да

Lens ● – Да Нет Да Нет Да

APR ● – Нет Нет Нет Нет Нет

Пункт [Type] применим, пункт [Setting] неприменим*1

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● Нет Нет Нет Нет Да

User – ● Нет Нет Нет Да Да

Wired LAN*1 ▲ ● Нет Нет Нет Да Нет

File Transfer ● ▲ Да Нет Да Да Да

FTP Server 1 – ● Нет Нет Да Нет Да

FTP Server 2 – ● Нет Нет Да Нет Да

FTP Server 3 – ● Нет Нет Да Нет Да

SSL – ● Нет Нет Нет Да Да

Referer Check – ● Нет Нет Нет Да Да

Brute Force Attack
Protection

– ● Нет Нет Нет Да Да

Настройка с помощью меню камеры невозможна (только отображение)*1

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Нет Нет Да*1 Нет Да*1

Video
Stream

– ● Да Нет Да Нет Да

Audio
Stream

– ● Да Нет Да Нет Да
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Maintenance

5-041-958-03(1) Copyright 2022 Sony Corporation

Пункт [NDI|HX] > [License] неприменим*1

Пункт
(уровень 2)

Меню
камеры

Веб-
меню

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Да Нет Да Нет Да

Accessibility – ● Да Нет Нет Нет Да

Clock Set ● ● Да*1 Нет Да*2 Нет Да

Reset – ● Нет Нет Нет Нет Нет

Hours Meter ● – Нет Нет Нет Нет Нет

Information – ● Нет Нет Нет Нет Нет

System Log – ● Нет Нет Нет Нет Да

HTTP Access
Log

– ● Нет Нет Нет Нет Да

Service – ● Нет Нет Нет Нет Нет

EULA – ● Нет Нет Нет Нет Нет

Software – ● Нет Нет Нет Нет Нет

Информация о дате и времени неприменима*1

Информация [Time Zone], а также информация о дате и времени неприменимы*2
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Сохраняемые пункты предварительно заданных положений

“Да” означает, что настройка сохраняется для предварительно заданного положения, “Нет” — что не сохраняется.

Пункты поворота/наклона

Пункты масштабирования

Пункты фокусировки

Место отображения Пункт Цель
сохранения

Панель управления кадрированием операционного
экрана

Положение поворота/наклона Да

[Pan-Tilt Speed] Нет

[Pan-Tilt] в веб-меню

[P/T Speed] Нет

[P/T Acceleration] Нет

[P/T Range Limit] Нет

[P/T Direction] Нет

[P/T Preset] > [Pan-Tilt] Нет

[P/T Preset] > [Default] > [Pan-Tilt
Speed] Да1)

При сохранении предварительно заданного положения значения настроек сохраняются в качестве значений этого положения. После
сохранения значений их можно изменить для каждого предварительно заданного положения. Подробнее см. в разделе “Изменение
скорости перехода (поворот/наклон/масштаб/фокус) для предварительно заданных положений с помощью веб-приложения”.

1)

Место отображения Пункт Цель
сохранения

Панель управления кадрированием
операционного экрана

Положение масштабирования (фокусное
расстояние)

Да

[Zoom Speed] Нет

[Pan-Tilt] > [P/T Preset] > [Default] в веб-меню
[Zoom Sync] Да1)

[Zoom Speed] Да1)

[Technical] > [Zoom] в меню камеры [Zoom Type] Нет

При сохранении предварительно заданного положения значения настроек сохраняются в качестве значений этого положения. После
сохранения значений их можно изменить для каждого предварительно заданного положения. Подробнее см. в разделе “Изменение
скорости перехода (поворот/наклон/масштаб/фокус) для предварительно заданных положений с помощью веб-приложения”.

1)
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См. также

Изменение скорости перехода (поворот/наклон/масштаб/фокус) при восстановлении предварительно
заданного положения

5-041-958-03(1) Copyright 2022 Sony Corporation

Место отображения Пункт Цель
сохранения

Панель изображения с камеры
операционного экрана

Цель отслеживания, указанная для отслеживания AF в
режиме реального времени

Нет

Координаты, указанные для точечной фокусировки Нет

Вкладка  (Focus) операционного
экрана

Переключатель [Touch Focus] Нет

Переключатель [Auto Focus] Да

Состояние кнопки [Focus Hold] Нет

Состояние кнопки [Push AF/MF] Нет

[Face/Eye Detection AF] Да

[AF Subj. Shift Sens.] Да

[AF Transition Speed] Да

Положение фокусировки Да1)

[Shooting] > [Focus] в веб-меню

[Push AF Mode] (включая настройки с помощью
программируемых кнопок)

Нет

[Touch Function in MF] Нет

[AF Assist Control] Нет

[Pan-Tilt] > [P/T Preset] > [Default]
в веб-меню

[Focus Recall] Да2)

[MF Speed] Да2)

[Shooting] > [Focus] в меню камеры

Размер и положение области фокусировки, заданные
с помощью пункта [Focus Area]

Да

Положение области фокусировки, заданное
с помощью пункта [Focus Area (AF-S)]

Да

Не восстанавливается, когда переключатель [Auto Focus] установлен во включенное положение. Восстанавливается, если установлен в
выключенное положение.

1)

При сохранении предварительно заданного положения значения настроек сохраняются в качестве значений этого положения. После
сохранения значений их можно изменить для каждого предварительно заданного положения. Подробнее см. в разделе “Изменение
скорости перехода (поворот/наклон/масштаб/фокус) при восстановлении предварительно заданного положения”.

2)
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Блок-схемы

Audio Input

Audio Output

5-041-958-03(1) Copyright 2022 Sony Corporation
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Обновление программного обеспечения объектива с байонетом E

С помощью данного устройства можно обновлять программное обеспечение объективов с байонетом E.
Список объективов, для которых возможно обновление, и соответствующего программного обеспечения см. на
веб-сайте для объективов.
Программное обеспечение обновляется с помощью веб-меню.

Примечание

Не выполняйте указанные далее действия, пока не будет завершено обновление.

Отсоединение от сети
Снятие объектива
Выключение питания

Если отображается сообщение о том, что выполнить обновление не удалось, проверьте отображаемое описание и
попробуйте выполнить обновление еще раз.

5-041-958-03(1) Copyright 2022 Sony Corporation

Установите объектив с байонетом E на устройство.1

Проверьте [Maintenance] > [Information] > [Lens] > [Model Name] и [Version Number] в веб-меню.

Номер версии программного обеспечения объектива с байонетом E отображается сбоку.
Проверьте номер версии программного обеспечения, затем обновите программное обеспечение, если
требуется.

2

Загрузите файл обновления программного обеспечения объектива для Windows (расширение .exe) на
устройство, на котором работает веб-приложение.

3

В пункте [Maintenance] > [Information] > [Lens] > [Version Up] нажмите кнопку [Choose File] и выберите
загруженный файл обновления.

4

Следуйте инструкциям на экране.5
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Установка крышки кнопки отсоединения объектива

Случайное снятие объектива можно исключить, установив на кнопку отсоединения объектива крышку кнопки
отсоединения объектива, входящую в комплект поставки потолочного кронштейна CIB-PCM1 (приобретается
дополнительно).

Примечание

Это не защищает объектив от полного снятия.

См. также

Присоединение объектива

Установите объектив.

Подробные сведения об установке объектива см. в разделе “Присоединение объектива”.

1

Переместите рычаг блокировки поворота/наклона в положение LOCK, чтобы заблокировать поворот/
наклон головки камеры.

2

Переместите камеру назад в положение, в котором можно установить крышку отсоединения
объектива.

3

Установите крышку отсоединения объектива, чтобы она закрывала кнопку отсоединения объектива.4

Закрепите крышку отсоединения объектива с помощью винта крепления крышки отсоединения
объектива.

5
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Лицензии

Лицензия на портфель патентов для AVC MPEG-4

ДАННОЕ ИЗДЕЛИЕ ЛИЦЕНЗИРОВАНО В СООТВЕТСТВИИ С ЛИЦЕНЗИЕЙ НА ПОРТФЕЛЬ ПАТЕНТОВ AVC ДЛЯ
ПЕРСОНАЛЬНОГО ИСПОЛЬЗОВАНИЯ ПОТРЕБИТЕЛЕМ И ДРУГИХ ПРИМЕНЕНИЙ, В КОТОРЫХ НЕ
ПРЕДУСМОТРЕНО ВОЗНАГРАЖДЕНИЕ, ДЛЯ
(i) КОДИРОВАНИЯ ВИДЕО В СООТВЕТСТВИИ СО СТАНДАРТОМ AVC (“ВИДЕО AVC”) И/ИЛИ
(ii) ДЕКОДИРОВАНИЯ ВИДЕО AVC, КОТОРОЕ БЫЛО ЗАКОДИРОВАНО ПОТРЕБИТЕЛЕМ ДЛЯ СВОИХ ЛИЧНЫХ
НУЖД И/ИЛИ БЫЛО ПОЛУЧЕНО ОТ ВИДЕОПРОВАЙДЕРА, ИМЕЮЩЕГО ЛИЦЕНЗИЮ НА ПРЕДОСТАВЛЕНИЕ
ВИДЕО AVC.
НИ ДЛЯ КАКИХ ДРУГИХ СПОСОБОВ ПРИМЕНЕНИЯ ЛИЦЕНЗИЯ НЕ ПРЕДОСТАВЛЯЕТСЯ И ЕЕ ДЕЙСТВИЕ НЕ
ПОДРАЗУМЕВАЕТСЯ. ЗА ДОПОЛНИТЕЛЬНОЙ ИНФОРМАЦИЕЙ ОБРАЩАЙТЕСЬ В КОМПАНИЮ MPEG LA, L.L.C.
СМ. HTTP://WWW.MPEGLA.COM

Получение программного обеспечения в соответствии с лицензией GPL/LGPL

В этом изделии используется программное обеспечение, на которое распространяется действие лицензии
GPL/LGPL. Настоящим уведомляем вас о том, что в соответствии с условиями лицензии GPL/LGPL у вас есть
право на доступ, изменение и распространение исходного кода этих программ.
Исходный код опубликован в Интернете. Перейдите по следующему URL-адресу и выполните инструкции по
загрузке.
https://oss.sony.net/Products/Linux/
Мы просим вас не обращаться к нам по поводу содержимого исходного кода.

Исходный код μT-Kernel

В этом изделии исходный код μT-Kernel используется по лицензии T-License 2.1, предоставленной TRON Forum
(www.tron.org).
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Технические характеристики

Общие

Масса
Прибл. 4,6 кг (только корпус)
Прибл. 6,0 кг (включая объектив SELP28135G)

Габариты
См. “Внешние габариты”.

Требования к источнику питания
19,5 В пост. тока
PoE++ (соответствие IEEE802.3bt , тип 4 , класс 8)

Энергопотребление
19,5 В пост. тока: 80,0 Вт (макс.)
PoE++: 71,3 Вт (макс.) 

Рабочая температура
От 0 °C до 40 °C

Температура хранения
От −20 °C до +60 °C

Формат записи (видео)
XAVC Intra
Режим XAVC-I 4K/QFHD: VBR, скорость потока данных 600 Мбит/с (макс.), MPEG-4 AVC/H.264
Режим XAVC-I HD: CBG, 223 Мбит/с (макс.), MPEG-4 AVC/H.264

XAVC Long
Режим XAVC-L QFHD: VBR, скорость потока данных 150 Мбит/с (макс.), MPEG-4 H.264/AVC
Режим XAVC-L HD 50: VBR, 50 Мбит/с (макс.), MPEG-4 H.264/AVC
Режим XAVC-L HD 35: VBR, 35 Мбит/с (макс.), MPEG-4 H.264/AVC

Формат записи (аудио)
LPCM 24 бит, 48 кГц, 4-канальная

Частота кадров при записи

XAVC Intra
Режим XAVC-I 4K: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Режим XAVC-I QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Режим XAVC-I HD: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Режим XAVC-L QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Режим XAVC-L HD 50: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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Режим XAVC-L HD 35: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Время записи/воспроизведения
XAVC Intra
Режим XAVC-I QFHD: 59.94P, прибл. 30 мин (при использовании CEA-G160T)
Режим XAVC-I HD: 59.94P, прибл. 78 мин (при использовании CEA-G160T)

XAVC Long
Режим XAVC-L QFHD: 59.94P, прибл. 115 мин (при использовании CEA-G160T)
Режим XAVC-L HD 50: 59.94P, прибл. 155 мин (при использовании CEA-G80T)
Режим XAVC-L HD 35: 59.94P, прибл. 210 мин (при использовании CEA-G80T)

Примечание

Время записи/воспроизведения зависит от условий использования и характеристик памяти. Значения времени записи и
воспроизведения приведены с учетом непрерывной записи одного клипа. Фактическое время может быть короче (это
зависит от количества записанных клипов).

Привод поворота/наклона

Минимальная скорость поворота: 0,02°/с
Минимальная скорость наклона: 0,02°/с
Максимальная скорость поворота: 60°/с
Минимальная скорость наклона: 60°/с
Диапазон поворота: от −170° до +170°
Диапазон наклона: от −30° до +195°
Рейтинг по критерию шумности: NC35 или ниже
Предварительно заданные положения: 100

Камера

Датчик изображения
Полнокадровый КМОП-датчик Exmor R 35 мм (35,6 × 23,8 мм)

Количество пикселов
Прибл. 12,9 млн пикселов (общее число пикселов)
Прибл. 10,3 млн пикселов (эффективное число пикселов)

Auto Focus
Способ обнаружения: фазовое обнаружение/обнаружение по контрастности

Встроенные фильтры ND
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Линейная переменная нейтральная плотность: 1/4ND – 1/128ND

Чувствительность ISO
ISO 800/12800 (режим Cine EI, источник света D55)

Крепление объектива
Байонет E

Широтная характеристика
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15+ остановок

Выдержка затвора
От 64F до 1/8000 с (23.98P)

Угол раскрытия затвора
От 5,6° до 360°, от 2 до 64 кадров

Съемка с замедлением/ускорением движения
XAVC QFHD: от 1 до 120 кадров/с
XAVC HD: от 1 до 240 кадров/с
XAVC 4K: от 1 до 60 кадров/с
XAVC HD (S35): от 1 до 120 кадров/с

Баланс белого
От 2000 K до 15000 K

Усиление
От −3 дБ до +30 дБ (с шагом 1 дБ)

Базовый вид
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Аудио

Частота дискретизации
48 кГц

Квантование
24 бита

Частотная характеристика
Режим MIC входа XLR: от 20 Гц до 20 кГц (±3 дБ или менее)
Режим LINE входа XLR: от 20 Гц до 20 кГц (±3 дБ или менее)

Динамический диапазон
Режим MIC входа XLR: 80 дБ (обычно)
Режим LINE входа XLR: 90 дБ (обычно)

Искажение
Режим MIC входа XLR: 0,08% или ниже (входной уровень −40 дБн)
Режим LINE входа XLR: 0,08% или ниже (входной уровень +14 дБн)

Вход/выход

Входы
DC IN

Совместимый с EIAJ, 19,5 В пост. тока

AUDIO IN

Тип XLR, 5-контактный, гнездо
Возможность переключения LINE / MIC / MIC+48V
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MIC: опорный от −30 дБн до −80 дБн

GENLOCK IN

Разъем BNC, 1,0 размах, 75 Ом

TC IN

Разъем BNC

Выходы
SDI OUT

Разъем BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Разъем Type-A

Выходной разъем OPTICAL

Совместим с SFP+
* Это устройство не поддерживает ввод оптического сигнала.

Вход и выход
Разъем локальной сети

RJ-45, 1000BASE-T

Разъем OPTION

Входной/выходной разъем съемки RJ-45

Гнездо для носителя

Гнездо карты CFexpress Type A / SD-карты (2)

Поставляемые принадлежности

Адаптер переменного тока (1)
Шнур питания (1)
Инфракрасный пульт управления (1)
Крышка корпуса (1) (установлена на устройство)
Пластина крепления кабеля HDMI (1)
Перед использованием данного устройства (1)
Гарантийный талон (1)

Внешние габариты

Указаны приблизительные габариты.
Устройство: мм

Корпус камеры
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Потолочный кронштейн
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Конструкция и технические характеристики могут быть изменены без предварительного уведомления.
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Справочное руководство

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Товарные знаки

 является товарным знаком Sony Group Corporation.
XAVC и  являются зарегистрированными товарными знаками Sony Group Corporation.
Термины HDMI и HDMI High-Definition Multimedia Interface и Логотип HDMI являются товарными знаками или
зарегистрированными товарными знаками HDMI Licensing Administrator, Inc. в Соединенных Штатах и других
странах.
Microsoft и Windows являются товарными знаками или зарегистрированными товарными знаками корпорации
Microsoft Corporation в США и/или других странах.
Mac и macOS являются зарегистрированными товарными знаками корпорации Apple Inc. в США и/или других
странах.
Логотип Catalyst Browse является товарным знаком или зарегистрированным товарным знаком корпорации
Sony Group Corporation.
IOS является товарным знаком или зарегистрированным товарным знаком корпорации Cisco в США и других
странах и используется по лицензии.
iPadOS, Safari и iPad являются товарными знаками корпорации Apple Inc. , зарегистрированными в США и
других странах и регионах.
Android и Google Chrome являются товарными знаками или зарегистрированными товарными знаками
корпорации Google LLC.
Wi-Fi является зарегистрированным товарным знаком альянса Wi-Fi Alliance.
Логотип SDXC является товарным знаком компании SD-3C, LLC.
CFexpress и CFexpress Type A являются товарными знаками ассоциации CompactFlash Association.
NewTek™ и NDI® являются товарными знаками или зарегистрированными товарными знаками корпорации
NewTek, Inc.
JavaScript является зарегистрированным товарным знаком компании Oracle и/или ее дочерних предприятий.
Intel, Intel Core и логотип Intel являются товарными знаками или зарегистрированными товарными знаками
корпорации Intel Corporation или ее дочерних предприятий.
QR Code является товарным знаком Denso Wave Inc.
Все прочие названия компаний и продуктов являются зарегистрированными товарными знаками или
товарными знаками соответствующих владельцев. В настоящем документе элементы, являющиеся
товарными знаками, не обозначаются символами ™ или ®.
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